
Manual

© 1987-2022 SoftMaker Software GmbH

Presentations 2021



2Table of Contents

Welcome!
 
                                                                                                                              11

Technical support ........................................................................................................................... 12
About this manual .......................................................................................................................... 12
System requirements ...................................................................................................................... 13

Installation and program startup
 
                                                                                    14

Installing on Windows ................................................................................................................... 14
Installing on macOS ....................................................................................................................... 15
Installing on Linux ......................................................................................................................... 16
Installing on Android devices ........................................................................................................ 16
Installing on iOS devices ................................................................................................................ 16

Basics
 
                                                                                                                                     17

Application window ....................................................................................................................... 18
Title bar .................................................................................................................................... 19
User interface: Ribbon ............................................................................................................. 20
User interface: Classic menus .................................................................................................. 22
User interface on Android/iOS ................................................................................................ 23
Context menu ........................................................................................................................... 26
Document tabs ......................................................................................................................... 26
Document ................................................................................................................................. 28
Status bar .................................................................................................................................. 29

Concepts ......................................................................................................................................... 31
Slides ........................................................................................................................................ 31
Objects ..................................................................................................................................... 33
Slide designs ............................................................................................................................ 34
Slide layouts ............................................................................................................................. 36
Color schemes .......................................................................................................................... 37
Text .......................................................................................................................................... 38

File operations ................................................................................................................................ 40
Starting a new presentation ...................................................................................................... 40
Opening a presentation ............................................................................................................. 42
Saving a presentation ............................................................................................................... 44
Printing a presentation ............................................................................................................. 45
Exiting the application ............................................................................................................. 45

The Presentations tour
 
                                                                                                      46

Entering text ................................................................................................................................... 46
When something goes wrong... ...................................................................................................... 47
Using another slide design ............................................................................................................. 48
Inserting a new slide ....................................................................................................................... 49
Inserting a picture ........................................................................................................................... 50



3Table of Contents

Applying a different color scheme ................................................................................................. 52
Creating a bulleted list ................................................................................................................... 53
Inserting a table .............................................................................................................................. 54
Applying slide transitions ............................................................................................................... 57
Applying object animations ........................................................................................................... 58
Saving a presentation ..................................................................................................................... 59
Start running the slide show ........................................................................................................... 60
Finished! ......................................................................................................................................... 60

Working with selections
 
                                                                                                    61

Selecting in the Windows, Mac or Linux version .......................................................................... 61
Selecting in the Android/iOS version ............................................................................................ 62

Working with slides
 
                                                                                                            63

Creating a new presentation ........................................................................................................... 64
Inserting a new slide ....................................................................................................................... 65
Inserting slides from other presentations ........................................................................................ 66
Navigating between slides .............................................................................................................. 67
Working with the mini sorter ......................................................................................................... 67
Working with the mini outliner ...................................................................................................... 69
Using the slide sorter and outline ................................................................................................... 70
Changing the order of slides ........................................................................................................... 71
Deleting slides ................................................................................................................................ 71
Copying, cutting and pasting slides ................................................................................................ 72
Duplicating slides ........................................................................................................................... 72
Renaming slides ............................................................................................................................. 73
Resetting slides ............................................................................................................................... 73
Hiding slides ................................................................................................................................... 73
Changing the slide design .............................................................................................................. 74
Changing the slide layout ............................................................................................................... 75
Slide management .......................................................................................................................... 77
Creating headers and footers .......................................................................................................... 77

Footers on slides ...................................................................................................................... 78
Headers and footers on notes pages and handouts ................................................................... 80
Changing headers/footers in master view ................................................................................ 80

Changing the orientation of slides .................................................................................................. 82
Inserting a summary slide ............................................................................................................... 83
Changing slide color scheme and background ............................................................................... 85

Applying a color scheme .......................................................................................................... 86
Creating and editing a color scheme ........................................................................................ 87
Slide background ..................................................................................................................... 88

Using slide transitions .................................................................................................................... 90
Applying slide transitions via the ribbon tab ........................................................................... 90
Applying slide transitions via the dialog box ........................................................................... 92



4Table of Contents

Adding object animations .............................................................................................................. 94
Using the sidebar ............................................................................................................................ 95
Adding notes .................................................................................................................................. 97
Printing handouts ........................................................................................................................... 98

Working with masters
 
                                                                                                        99

The ribbon tab "Slide master" ...................................................................................................... 100
Changing the text formatting in masters ...................................................................................... 102
Notes and handout master ............................................................................................................ 104

Working with objects
 
                                                                                                       106

Objects – basic procedures ........................................................................................................... 106
Inserting objects ..................................................................................................................... 107
Selecting objects .................................................................................................................... 108
Changing position and size of objects ................................................................................... 108
Rotating and flipping objects ................................................................................................. 110
Changing the order of objects ................................................................................................ 111
Creating columns for inner text of objects ............................................................................. 111
Duplicating objects ................................................................................................................ 112
Changing the names of objects .............................................................................................. 112
Aligning and distributing objects ........................................................................................... 113
Grouping objects .................................................................................................................... 113
Hiding objects ........................................................................................................................ 114
Changing the AutoShape of objects ....................................................................................... 114
Combining shapes .................................................................................................................. 115
Editing shapes retroactively ................................................................................................... 117
Adding object actions ............................................................................................................ 120
Changing object properties via the dialog box ....................................................................... 122

Object properties, Format tab ......................................................................................... 122
Object properties, Fill tab ............................................................................................... 123
Object properties, Lines tab ............................................................................................ 125
Object properties, Shadow tab ........................................................................................ 125
Object properties, 3D tab ................................................................................................ 126
Object properties, Effects tab ......................................................................................... 127
Object properties, Properties tab .................................................................................... 127
Object properties, AutoShapes tab ................................................................................. 128
Additional tabs ............................................................................................................... 128
Changing the default settings for objects ....................................................................... 129

Text frames ................................................................................................................................... 131
Inserting text frames ............................................................................................................... 131
Changing text frame properties via the ribbon tab ................................................................. 131
Changing text frame properties via the dialog box ................................................................ 133
Changing the text area ............................................................................................................ 135

Placeholders ................................................................................................................................. 135



5Table of Contents

Inserting placeholders ............................................................................................................ 136
Editing placeholders ............................................................................................................... 136
Changing placeholder properties ........................................................................................... 138
Resetting placeholder properties ............................................................................................ 139
Deleting and restoring placeholders ....................................................................................... 140

Pictures ......................................................................................................................................... 141
Inserting pictures .................................................................................................................... 141
Inserting a photo album .......................................................................................................... 142
Scanning pictures ................................................................................................................... 144
Inserting pictures from the gallery/camera (Android and iOS) .............................................. 144
Changing picture properties via the ribbon tab ...................................................................... 145
Changing picture properties via the dialog box ..................................................................... 146

Charts ........................................................................................................................................... 149
Inserting charts ....................................................................................................................... 149

Inserting charts via PlanMaker ....................................................................................... 150
Inserting charts manually ................................................................................................ 150

Editing charts ......................................................................................................................... 152
Changing the chart type .................................................................................................. 154
Entering/editing the data of a chart ................................................................................. 158
Showing/hiding chart elements ...................................................................................... 160

Showing/hiding axes and axis titles ........................................................................ 160
Showing/hiding chart titles ..................................................................................... 162
Showing/hiding data labels ..................................................................................... 163
Showing/hiding error bars ....................................................................................... 163
Showing/hiding gridlines ........................................................................................ 164
Showing/hiding the legend ...................................................................................... 165
Showing/hiding lines ............................................................................................... 166
Showing/hiding the trendline .................................................................................. 166
Showing/hiding up/down bars ................................................................................. 167

Editing chart elements .................................................................................................... 169
Chart area ................................................................................................................ 171
Plot area ................................................................................................................... 172
Walls (three-dimensional charts only) .................................................................... 173
Floor (three-dimensional charts only) ..................................................................... 173
Corners (three-dimensional charts only) ................................................................. 174
Data series and data points ...................................................................................... 174
Trendlines ................................................................................................................ 178
Category axis (X axis) ............................................................................................. 180
Value axis (Y axis) .................................................................................................. 181
Series axis (Z axis) .................................................................................................. 183
Axis title .................................................................................................................. 184
Chart title ................................................................................................................. 185
Gridlines .................................................................................................................. 186
Legend ..................................................................................................................... 186

Changing chart properties via the dialog box ................................................................. 188



6Table of Contents

Saving charts as pictures ........................................................................................................ 191
OLE objects .................................................................................................................................. 192

Embedding OLE objects ........................................................................................................ 193
Editing OLE objects ............................................................................................................... 194
Editing links to OLE objects .................................................................................................. 195
Changing OLE object properties via the ribbon tab ............................................................... 195
Changing OLE object properties via the dialog box .............................................................. 197
Using the SoftMaker Equation Editor .................................................................................... 198

Tables ........................................................................................................................................... 200
Inserting tables ....................................................................................................................... 200
Ribbon tab "Table" ................................................................................................................. 202
Moving in tables .................................................................................................................... 203
Selecting table cells and cell contents .................................................................................... 203
Deleting, copying, moving cell contents ................................................................................ 204
Deleting and inserting table cells ........................................................................................... 204

Deleting cells from a table .............................................................................................. 204
Inserting cells in a table .................................................................................................. 205

Splitting and merging table cells ............................................................................................ 207
Splitting table cells ......................................................................................................... 207
Merging table cells ......................................................................................................... 207

Formatting tables ................................................................................................................... 208
Distributing rows and columns evenly ........................................................................... 208
Changing row properties ................................................................................................ 209
Changing cell properties ................................................................................................. 209
Changing general table properties .................................................................................. 213

Media objects ............................................................................................................................... 215
Inserting media objects .......................................................................................................... 215
Ribbon tab "Media object" ..................................................................................................... 216
Changing the properties of media objects .............................................................................. 218

Drawings ...................................................................................................................................... 222
Inserting drawings .................................................................................................................. 222
Adding text to AutoShapes .................................................................................................... 224
Changing drawing properties via the ribbon tab .................................................................... 225
Changing drawing properties via the dialog box ................................................................... 227

AutoShapes tab (available only for AutoShapes) ........................................................... 227
Inner text tab (available for AutoShapes with text added) ............................................. 228
Text tab (available only for TextArt objects) ................................................................. 229
Transformation tab (available only for TextArt objects) ................................................ 229

Animations
 
                                                                                                                          230

Object animations ......................................................................................................................... 230
Applying object animations via the ribbon tab "Animation" ................................................. 231
Applying object animations via the dialog box ..................................................................... 234
Animation properties in detail ............................................................................................... 238

Slide animation schemes .............................................................................................................. 241



7Table of Contents

Working with text
 
                                                                                                             244

Character formatting .................................................................................................................... 244
Font and font size ................................................................................................................... 246
Text styles .............................................................................................................................. 247
Font color ............................................................................................................................... 249
Superscripts and subscripts .................................................................................................... 250
Letter spacing and character pitch .......................................................................................... 250
Kerning .................................................................................................................................. 251
Hyperlinks .............................................................................................................................. 252
Format painter ........................................................................................................................ 253
Resetting the character formatting ......................................................................................... 254
Replacing fonts ...................................................................................................................... 255

Paragraph formatting .................................................................................................................... 256
Indents .................................................................................................................................... 257
Line spacing ........................................................................................................................... 259
Spacing above/below a paragraph .......................................................................................... 260
Paragraph alignment .............................................................................................................. 261
Non-breaking space ................................................................................................................ 262
Changing the character format for whole paragraphs ............................................................ 262
Tabs ........................................................................................................................................ 262

Bulleted and numbered lists ......................................................................................................... 266
Bulleted lists ........................................................................................................................... 266
Numbered lists ....................................................................................................................... 270

Searching and replacing ............................................................................................................... 274
Search ..................................................................................................................................... 274
Replace ................................................................................................................................... 275
Repeating a search/replace ..................................................................................................... 276

Moving, deleting and copying ...................................................................................................... 277
Paste (special) ............................................................................................................................... 278
Inserting special characters .......................................................................................................... 280

Comments
 
                                                                                                                           282

Running a slide show
 
                                                                                                        284

Starting a slide show .................................................................................................................... 284
Slide show setup ........................................................................................................................... 285
Custom slide shows ...................................................................................................................... 287
Slide show interaction .................................................................................................................. 289
Using the presenter view .............................................................................................................. 291

Outputting presentations
 
                                                                                               295

Printing a presentation .................................................................................................................. 296



8Table of Contents

Exporting a presentation as a PDF file ......................................................................................... 299
Sending a presentation by e-mail ................................................................................................. 303
Exporting a presentation as HTML files ...................................................................................... 303
Exporting a presentation as picture files ...................................................................................... 305
Exporting a presentation as a movie file ...................................................................................... 306
Portable slide show ...................................................................................................................... 308

Language tools
 
                                                                                                                  310

Setting the language ..................................................................................................................... 310
Spell check ................................................................................................................................... 311

Manual spell check ................................................................................................................ 312
Checking the spelling as you type .......................................................................................... 313
Conversion to the new German spelling ................................................................................ 314

Enabling conversion to the new German spelling .......................................................... 315
Correcting words with old German spellings ................................................................. 315
Info command of the spell check .................................................................................... 316

Editing user dictionaries ........................................................................................................ 317
Hyphenation ................................................................................................................................. 318
Thesaurus ..................................................................................................................................... 319
Research ....................................................................................................................................... 321
SmartText ..................................................................................................................................... 322

Creating SmartText entries .................................................................................................... 322
Inserting SmartText entries .................................................................................................... 323
Editing SmartText entries ...................................................................................................... 324

Document management
 
                                                                                                  325

Quick paths ................................................................................................................................... 325
Document summary ..................................................................................................................... 327
File manager ................................................................................................................................. 328
Searching with the file manager ................................................................................................... 329
Backup copies (file versions) ....................................................................................................... 332

Document protection
 
                                                                                                       335

Enabling document protection ..................................................................................................... 335
Disabling document protection .................................................................................................... 337

Working with other file formats
 
                                                                                    338

Working with multiple documents
 
                                                                                340

Creating or opening a document .................................................................................................. 341
Switching between open documents ............................................................................................ 341
Arranging documents on the screen ............................................................................................. 342
Closing a document ...................................................................................................................... 344



9Table of Contents

Customizing Presentations
 
                                                                                            346

Changing Presentations settings ................................................................................................... 347
Settings, View tab .................................................................................................................. 347
Settings, General tab .............................................................................................................. 349
Settings, Edit tab .................................................................................................................... 349
Settings, Appearance tab ........................................................................................................ 353
Settings, Language tab ........................................................................................................... 357
Settings, Files tab ................................................................................................................... 358
Settings, Backup tab ............................................................................................................... 360
Settings, System tab ............................................................................................................... 361
Settings, Fonts tab .................................................................................................................. 363
"Manage" button .................................................................................................................... 364

Export/import settings .................................................................................................................. 365
Changing document properties ..................................................................................................... 368

Document properties, Summary tab ....................................................................................... 368
Document properties, View tab ............................................................................................. 368
Document properties, Colors tab ........................................................................................... 369
Document properties, Statistics tab ........................................................................................ 370
Document properties, Protection tab ...................................................................................... 371
Document properties, Fonts tab ............................................................................................. 371

Customizing the document display .............................................................................................. 373
Zoom level ............................................................................................................................. 374
Full screen view ..................................................................................................................... 375

Customizing the ribbon ................................................................................................................ 376
Showing and hiding the ribbon .............................................................................................. 377
Customizing icons and groups in the ribbon .......................................................................... 378
Changing the position of the Quick access toolbar ................................................................ 382
Customizing icons on the Quick access toolbar .................................................................... 382

Customizing toolbars ................................................................................................................... 384
Showing and hiding toolbars ................................................................................................. 384
Positioning toolbars on the screen ......................................................................................... 386
Managing toolbars .................................................................................................................. 387
Customizing toolbar icons ..................................................................................................... 388
Using the toolbar menu .......................................................................................................... 392

Creating user-defined icons .......................................................................................................... 393
Customizing shortcut keys ........................................................................................................... 393
Using the grid ............................................................................................................................... 396
Using guides ................................................................................................................................. 397
Installing additional dictionaries .................................................................................................. 400

Installing additional SoftMaker dictionaries .......................................................................... 400
Installing Hunspell dictionaries ............................................................................................. 401
Choosing a different dictionary for a language ...................................................................... 402



10Table of Contents

Appendix
 
                                                                                                                             403

Ribbon commands and corresponding menu commands ............................................................. 403
Shortcut keys ................................................................................................................................ 416

Shortcut keys in Windows and Linux versions ...................................................................... 416
Shortcut keys in Mac version ................................................................................................. 420

Command-line parameters ........................................................................................................... 425

Index 428



11Welcome!

Welcome!
Welcome to Presentations! You have acquired a presentation graphics program that combines user-friendliness
with a practical scope of features and high compatibility with common programs!

You can use Presentations to quickly create impressive and informative presentations. From two-slide
presentations to dynamic multimedia slide shows, Presentations provides easy-to-use tools that enable you to
produce professional presentations.

Presentations is also highly compatible with Microsoft PowerPoint. You can easily reuse existing PowerPoint
presentations and can always open, edit and save presentations which you receive in PowerPoint format from
colleagues, customers or friends.

Note: This manual was written in order to describe how to use the program via the new ribbon user
interface. A description of its use via classic menus with toolbars can only be found in older manuals.

Tip: A table in the appendix shows you which ribbon command corresponds to which menu command:
Ribbon commands and corresponding menu commands

Note: Some features have been disabled in SoftMaker FreeOffice (the free version of SoftMaker Office).
Features that are not available in the free version are marked with a red box like this one.

Some features of Presentations

§ Available for Windows, Mac, Linux, Android and iOS 

§ Well-designed, ergonomic user interface – either with a modern "ribbon" or classic menus with toolbars

§ Ability to insert pictures, movies, sounds and drawings directly into a slide

§ Animated objects and numerous versions of attractive slide transitions ensure that interesting
presentations can be created.

§ Many attractive design templates are included to enable you to quickly find an appealing design for your
slide show and thus save time.

§ Wide range of functions for text formatting

§ Integrated outline view for structuring your thoughts before and during slide shows

§ The practical mini sorter enables you to always maintain an overview of your slides even for extensive
slide shows.

§ Document scanning – scanning via WIA is also supported in addition to TWAIN

§ Save your slide shows in PowerPoint format or export slides as image files.

§ Print handout sheets (a printed version of the slide show) for your audience.

... and much more!



12Welcome!

Presentations is being developed continually. If, when working, you discover the need for a feature that is not
yet available or if you have any other suggestions, please contact us as we want Presentations to meet the needs
of users!

Android version and iOS version

Presentations is also available for Android and iOS devices and contains practically all features of the Windows
version.

Technical support
If you have any questions, our technical support team will be happy to assist you. You can reach us as follows:

Website

Our website provides the latest program updates, tips and tricks, free downloads and much more.

For more information, see: www.softmaker.com

Support forums

In our support forums, you can ask our technical support team any technical questions you may have, while also
communicating with other users.

These forums can be found at: forum.softmaker.com

Inquiries to our support team

If you have any problems with our software, we will happily assist you.

You can post your questions here: www.softmaker.com/en/support-assistant

About this manual
Presentations has a wide variety of functions – but don't worry: you don't have to master all of them! While
you're getting started, just use those you need. If you would like to make use of Presentations’ more advanced
functions at a later stage, you can review the appropriate pages in the manual.

This manual is structured as follows:

§ The chapter Installation and program startup deals with the installation of Presentations. You also learn
how to start the program. 

§ The chapter Basics provides information on Presentations' user interface and its basic functions and
concepts. It is ideal for beginners!

http://www.softmaker.com/
http://forum.softmaker.com
http://www.softmaker.com/en/support-assistant
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§ The chapter The Presentations Tour deals with the subject of "Creating a simple presentation" in tutorial
form and shows you how to use Presentations by means of some practical examples.

§ The chapter Working with selections and the following chapters are the reference part of this manual.
These chapters are organized by topic and provide a detailed description of all functions of Presentations.

System requirements
In order to run this software, you require the following hardware and software:

Windows version

§ Windows 11, 10, 8 or 7 (32-bit or 64-bit) 

Mac version

§ macOS as of version 10.12 (Sierra) 
§ Intel or ARM based CPU

Linux version

§ Any x86 Linux (64-bit) 

Android version

§ Android 5.0 or higher 
§ ARM-compatible CPU (32-bit or 64-bit)

iOS version

§ iOS 14.0 or higher 
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Installation and program startup
This chapter provides information on installing and starting Presentations.

It is divided by operating system into the following sections:

§ Installing on Windows 

§ Installing on macOS

§ Installing on Linux

§ Installing on Android devices

§ Installing on iOS devices

Please read the section for your operating system.

Installing on Windows

Download

If you obtained the software by downloading it from our website, you will find installation instructions in the e-
mail that you automatically received after purchasing the software.

CD-ROM

If you obtained the software on a CD-ROM, please start the installation program provided in the root folder of
the CD. Then follow the installation program's instructions to install the software.

Starting the programs

To start the installed programs, use the Start menu (the button with the Windows logo) in the lower left corner
of the screen. You will find your SoftMaker Office applications in a sub-folder called SoftMaker Office.
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Installing on macOS
You will find information on installing the software in the e-mail that you automatically received after
purchasing it.

Is an error message displayed when you start the installation program?

Depending on your system settings, the following error message may be displayed when you try to start the
installation program:

This occurs when your system's security settings specify that only programs that have been downloaded from
the App Store may be run.

Clicking on the question mark in the lower left corner of the message reveals how you can still run the
installation program. You then see a help window in which the following procedure is recommended:

1. Close the error message.

2. Hold down the Ctrl key and click on the installation program.

3. A context menu is displayed. Choose the command Open.

4. You then see a message which asks you if you really want to open the program. Confirm this by clicking on
the Open button.

The installation program will now start.

Starting the programs

After the installation is complete, icons for each of the installed programs will be displayed in both the
Launchpad and the Dock at the bottom of the screen. To start one of the programs, simply click on its icon.
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Installing on Linux
You will find information on installing the software in the e-mail that you automatically received after
purchasing it.

Starting the programs

In most Linux distributions, the installation program automatically creates shortcut icons for all SoftMaker
Office applications in the menu. To start any of the applications, click on the corresponding icon.

Alternatively, the following scripts are available for starting the programs:

§ textmaker21free starts TextMaker. 

§ planmaker21free starts PlanMaker.

§ presentations21free starts Presentations.

You can execute these scripts in a shell, for example.

Installing on Android devices
If you download an application via the Google Play Store on your Android device, you do not need to do
anything as the application will be automatically installed after downloading it.

Installing on iOS devices
If you download an application via the Apple App Store on your iOS device, you do not need to do anything as
the application will be automatically installed after downloading it.
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Basics
This chapter gives you a brief description of Presentations' application window and its basic functions and
concepts. It is divided into the following sections:

§ Application window 

Description of the most important elements of the Presentations user interface

§ Concepts 

Description of Presentations' basic operating concepts, such as working with slides, objects, slide designs,
layouts, color schemes and text.

§ File operations 

Description of important file operations, such as opening, saving or printing presentations

We recommend that you also read the chapter The Presentations tour. It shows you step by step how to create
and design a simple presentation.
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Application window
The following pages contain an introduction to the individual components of the Presentations user interface,
both for the ribbon interface and for the classic menu interface.

In all other chapters, this manual is designed for the user interface with the ribbon.

If you would like to continue working with the classic menu interface, a table in the appendix shows you
which ribbon command corresponds to which menu command: Ribbon commands and corresponding menu
commands.

Tip: You can switch the user interface between ribbon and classic menus at any time. To do so, choose the
command File | Options in the ribbon (or choose Tools > Options in the classic menu). On the Appearance
tab, click on the User interface button.

Alternatively: Right-click on a free space in the ribbon or toolbar, and choose User interface.

Program window with the "Ribbon" user interface

Presentations with the "Ribbon" user interface (Windows version)
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Tip: Even when using the ribbon user interface, the classic menu commands are always accessible in the

ribbon view. To access them, use the "hamburger menu" (the icon  to the left of the Quick access toolbar,
highlighted in red). There, you will find all familiar menu commands from the classic menu user interface.

Program window with the "classic menus" user interface

Presentations with the "classic menus" user interface (Windows version)

Note: Most of the illustrations in this manual were produced with the Windows version of Presentations. On
other operating systems, some of the controls look slightly different, but their functionality is the same.

Title bar

In the top line of the program, you will find the title bar.

This displays the program name and the name of the document that you are currently editing.
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If the document contains changes that have not yet been saved, an asterisk is displayed after its name.

User interface: Ribbon

If, in the settings, you have selected that you would prefer to use the Ribbon interface instead of Classic menus,
the upper area of the program window will look like this on your device:

The "Ribbon" and the Quick access toolbar (at the bottom)

Ribbon

Ribbons are a modern type of user interface that combines menus and toolbars to simplify the use of the
software.

As you can see, the ribbon has several tabs whose tab headers are displayed at the top: File, Home, Insert, etc.
Each of these "ribbon tabs" contains logically combined groups (for example, on the ribbon tab Home: Edit,
Slide, Character, etc.) with related commands for a certain task area.

To switch to another ribbon tab, click on its tab header.

Tip: You can also switch between the ribbon tabs with a shortcut key: Use Ctrl+F12 to switch to the next
tab and Ctrl+Shift+F12 to switch to the previous tab. You can also scroll with the middle mouse wheel
while pointing to the top bar with the tabs.

Each icon represents a specific command. If you click on it, the corresponding command is chosen. In the group
Character on the ribbon tab Home, for example, you will find commands for formatting texts, such as font,
bold, italics, etc., which you can both read and change.

If you select a section of text beforehand, formatting changes will affect only the selected text. Otherwise, the
text that you subsequently type will be affected.

To choose a different font, for example, click on the small arrow to the right of the font name to open the list,
and then choose a font.

Other icons are switches that you can enable or disable by clicking on them – for example, the B for bold.

There are also split buttons, where you can either click on the icon to directly apply the displayed command or
use the corresponding small arrow to the right of the icon to open its menu. This is the case, for example, when
choosing the font color.
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Tip: If you hover the mouse cursor over an icon (without clicking), the program will display a text box called
a "tooltip", which describes the icon's function. This requires Show tooltips to have been enabled in the
settings.

The group arrows  in the bottom right corner of each command group indicate that there are other options and
commands available for that group. Simply click on this arrow to open the dialog box belonging to the group,
where you can make further settings.

The Quick access toolbar

The Quick access toolbar is displayed below the ribbon. It provides a choice of frequently used commands.

§ Touch mode 

If you enable this button, all icons in the ribbon will be slightly enlarged. This is useful when operating the
software with your finger (for example, on a tablet).

§ Create a new document 

This button opens a new document. For more information, see Starting a new presentation.

§ Open an existing document

This button opens an existing document. For more information, see Opening a presentation.

§ Save the current document 

This button saves the document that is open in the current window. For more information, see Saving a
presentation.

§ Undo 

This button undoes the last change made to the current document. You can also choose this command
several times in succession to undo the last x changes. For more information, see When something goes
wrong.

§ Redo 

This button restores the last undone change(s). For more information, see When something goes wrong.

To the right of the Quick access toolbar, there is a double arrow . You can use its menu to add/remove
common buttons directly from the Quick access toolbar. You can also change the position of the Quick access
toolbar here and add additional icons via the command Customize (for Quick access toolbar and ribbon, see
below).

To the left of the Quick access toolbar, you will find the "hamburger-menu" . Even if you have selected
the "ribbon" as the user interface, the "hamburger menu" is still available in the Quick access toolbar in case
you would like to access the menu commands of the classic menu.
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Creating your own ribbon and Quick access toolbar

You can change the ribbon and the Quick access toolbar at will and add additional icons. To do so, either
choose File | Customize in the ribbon or right-click on a free space in the ribbon. In the menu that is then
displayed, you will find the entries Customize ribbon or Customize Quick access toolbar to open a
corresponding dialog box.

You can also hide the ribbon display completely (Minimize ribbon) or change the position of the Quick access
toolbar.

For more information, see Customizing the ribbon.

User interface: Classic menus

If, in the settings, you have selected that you would prefer to use Classic menus instead of the Ribbon interface,
the upper area of the program window will look like this on your device:

Classic menus with toolbars

Menu bar

The Menu bar is found directly under the title bar.

It contains all of Presentations' commands in the form of clearly arranged menus. Click on a menu item to open
a menu and choose a command.

Standard toolbar

The Standard toolbar is displayed below the menu bar. It contains icons for Presentations’ most frequently used
commands.

Toolbars such as the Standard toolbar enable quick access to the functions of a program. Each icon represents a
specific command. If you click on it, the corresponding command is chosen.

Tip: If you hover the mouse cursor over an icon (without clicking), the program will display a tooltip that
describes the icon's function. This requires Show tooltips to have been enabled in the settings.
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Formatting toolbar

The Formatting toolbar can be found below the toolbar. You can use it to both read and change the most
common text formatting (font, bold, italics, etc.).

If you select a section of text beforehand, formatting changes will affect only the selected text. Otherwise, the
text that you subsequently type will be affected.

To choose a different font, for example, click on the small arrow to the right of the font name to open the list,
and then choose a font.

Other icons in the Formatting toolbar are switches that you can enable and disable by clicking on them – for
example, the B for bold.

There are also split buttons, where you can either click on the icon to immediately apply the displayed
command or use the corresponding small arrow to the right of the icon to open its menu. This is the case, for
example, when choosing the font color.

Object toolbar

The Object toolbar can be found below the Formatting toolbar.

This toolbar contains icons for inserting different types of objects into your presentation.

You can read more about objects and how to use them in Working with objects.

Additional toolbars

There are additional toolbars in Presentations that you can enable and disable as you choose. To do so, either
choose the menu command View > Toolbars or right-click on one of the displayed toolbars. You then see a
menu in which you can select toolbars that you would like to have displayed.

Customizing toolbars

You can customize the default toolbars to your liking and even create your own toolbars. For more information,
see Customizing toolbars.

User interface on Android/iOS

In addition to the ribbon and classic menus user interfaces, the Android/iOS version provides another option:
the toolbar user interface.

The toolbars interface is designed in a manner that makes it easier to use Presentations on smartphones and
tablets. It constitutes a mixed form of the functionalities of ribbon and classic menus. On smartphones,
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Presentations is started by default with this toolbars interface the first time you open it, while it is opened by
default with the ribbon interface on tablets.

To switch the interface, choose the command File | Options  in the ribbon interface or choose Tools >
Options in the classic menus interface. In the following dialog box, the Appearance tab contains the dropdown
list User interface. Here, you can choose between toolbars, ribbon or classic menus with different colors.

Tip 1: In the toolbars interface, you reach this dialog box by opening the "hamburger menu"  to the left of
the toolbar and choosing the command Tools > Options.

Tip 2: The hamburger menu also contains all other menu commands of the classic menu interface.

Using the "toolbars" user interface

The toolbars user interface contains a bar with icons at the bottom of the program window, and each icon
represents a group of commands. If you click on a group icon, another bar opens with the corresponding group
commands.

Behind the File group icon , for example, you will find the commands Open document, Save document,
Print document, etc. To hide the displayed bar with the commands, simply click on the group icon again.

By default, the toolbar contains the following groups:

Group Commands (among others)

File Open document, Save document, Print document, etc.

Edit Undo, Format painter, Copy & Paste, Search, etc.

Character Font, Font size, Font color, Text styles (bold, italics, etc.)

Paragraph Paragraph alignment, Bulleted lists, etc.

Insert Objects (picture, table, text frame, AutoShape, etc.), Hyperlinks

Edit objects Border lines, Color, Align objects

Slide Add, Slide layout, Slide design, Page setup, etc.

Animations Insert and edit transitions/animations

View Start slide show, Slide navigation, Ruler, Sidebar, etc.

"Keyboard" button

In Options , the System tab contains an option Show/hide keyboard automatically. Once this setting is
enabled, it automatically opens the on-screen keyboard when you type something into the document.

If you disable the option, this behavior is suppressed and a freely movable Keyboard button  is displayed
instead on the document. If you click on the button, the keyboard is shown. By clicking on the button again, you
hide the keyboard.
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Note: This setting is possible in any user interface for smartphones and tablets. For tablets, the Keyboard button
is only freely movable on the document in the toolbars interface if you disable the above option. In the ribbon
and classic menus interfaces, the Keyboard button is displayed instead in a fixed manner in the upper left area
of the command bar.

Change input mode

Presentations supports the use of certain input modes from Android/iOS devices.

§ Android 

The command Input method allows you to switch to a different keyboard mode on an Android device.
Presentations accesses the on-screen keyboard settings of your Android device for this.

In the classic menus interface, you change the mode with the menu command View > Input method. In the

ribbon or toolbars user interfaces, you can choose this command via the hamburger menu  .

§ iOS

When Scribble mode is enabled in Presentations, you can write directly in the document on an iOS tablet
using the Apple Pencil. Your handwritten entries are converted directly into text. For other edits – for
example of objects – you have to disable the mode again.

In the classic menus interface, you enable or disable the mode with the menu command View > Scribble. In

the ribbon or toolbars user interfaces, you can choose this command via the hamburger menu  .

Note: The command View > Scribble is only available for iOS tablets, but not for smartphones. Also, please
make sure that you have enabled the option Apple Pencil > Scribble in the system settings of your iOS
tablet.

Unlocking locked commands

Some commands are locked in the Android/iOS version (recognizable by the lock in the command icon), but
they can be unlocked if necessary.

To unlock the commands, click on the command icon. The program opens a dialog box with the following
options: Users of SoftMaker Office NX Home and NX Universal can use their product key to unlock
commands. Users of other versions have the option of unlocking the functions via Google Play/Apple App
Store (subject to a fee).

Customizing command groups

You can customize the default groups as desired by adding/removing commands. Note: However, you cannot
add or delete an entire group in this interface.

In the hamburger menu , choose the command Tools > Customize. This opens the dialog box Customize
user interface, which is structured as follows:

§ On the left side, you will find all of the commands that are available in Presentations. On the right side, the
dropdown list Customize contains the groups that are in the toolbar. The list below it displays the
commands that are currently in the selected group. 
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§ You can add new commands to each group (or remove them, change their position or insert separators). This
works in a similar manner to that described for the classic menus with toolbars user interface in the
Customizing toolbar icons section. Difference: Instead of "toolbar icons", you customize "group icons".

Context menu

Regardless of the user interface in which you work, there is also another way to choose commands: via the
context menu.

This menu contains different commands depending on the current situation. If, for example, you select some
text and then right-click to open the context menu, it offers commands for cutting, copying or formatting that
text.

Depending on what you have previously selected (text, objects, tables, etc.), you will be offered a variable –
contextual – selection of commands when opening the context menu. This makes it much easier for you to
quickly navigate to situational commands without a long search.

Android/iOS: In these versions, you can also open the context menu with your finger by tapping on the screen
and holding your finger there for about a second.

Document tabs

FreeOffice: The function for working with document tabs is not included in SoftMaker FreeOffice.
However, you can open several documents in different program windows.

Android/iOS: This function is not available for smartphones. For tablets, actions are possible with the tabs
within the same program window.

A bar with tabs can be seen above the document. It displays one tab for each open document.
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Document tabs

The tabs can be used to perform the following actions:

§ To make a document become the active document, left-click its tab. This enables you to rapidly switch
between the open documents. 

§ To close a document, click on its tab with the middle mouse button.

Alternatively, left-click on the x icon displayed on the far right of each tab.

§ You can change the order of the tabs by dragging a tab to the desired position on the tab bar while holding
down the left mouse button. 

§ To release a tab and display it in a separate program window, drag it to a position outside the current
program window while holding down the left mouse button.

By the way, documents can also be started in a new program window when they are opened. For more
information on working with multiple documents, see Working with multiple documents.
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Document

The document itself takes up most of the program window.

A slide with mini sorter (on the left) and sidebar (on the right)

For a better overview with a minimized ribbon, see Showing and hiding the ribbon

The workspace for editing a document consists of the following components:

Slide

The current slide is displayed in the center.

Mini sorter (or mini outliner)

To the left of the slide, there is a pane that contains small previews of all slides in the presentation. This pane is
called the mini sorter. It enables you to quickly move, duplicate, delete or modify slides in other ways.

For more information, see Working with the mini sorter.

Instead of the mini sorter, you can display the mini outliner that reproduces an outline of the entire text on the
slides. To do so, click on the "Outline" tab above the mini sorter. Click on the "Slides" tab to switch back to the
mini sorter.

For more information, see Working with the mini outliner.
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Sidebar

The pane to the right of the slide is called the sidebar and is a particularly useful tool.

It can be used to display, for example, a list of all available slide layouts. If you click on one of these layouts,
the current slide immediately adopts the selected layout.

Use the small toolbar at the top of the sidebar to select what you want to display in the sidebar (slide layouts,
color schemes, object animations, etc.)

You can enable or disable the sidebar at any time and also change the position of the sidebar in the program
window. To do so, choose the ribbon command View | group Windows | Sidebar (View > Sidebar in the
classic menu interface), and select whether to show the bar to the left, right or not at all.

Tip: When the sidebar is displayed, you can also click on the narrow vertical button with the small arrow at
the edge of the sidebar to expand or collapse it. You can also adjust the width of the sidebar by using the
mouse to drag the separator between the sidebar and the slide to the left or right.

FreeOffice: In SoftMaker FreeOffice, the sidebar occasionally opens automatically at program startup in
order to display some interesting information on SoftMaker Office.

For more information on the sidebar, see Using the sidebar.

Status bar

The Status bar is found at the bottom of the program window.

Note: If you do not see the status bar, you will have to change the settings for it as described in Settings,
Appearance tab (for the ribbon interface) or as described in Showing and hiding toolbars (for the classic
menu interface).

You can read the following information in the status bar:

Example Explanation

Font color,
Picture1,
etc.

Different information is displayed on the far left. If you hover the mouse cursor over a command icon, the
function of this command is displayed here. If you select an object, its name is displayed here. If you move
or resize an object, its current position/size is displayed, etc.

Slide 2 of 3 This shows that slide 2 of a presentation with a total of 3 slides is currently displayed.

Slide2 This shows the name of the current slide.

Ins This shows whether Insert mode (Ins) or Overwrite mode (Ovr) is enabled:

Ins: Insert mode is enabled – newly entered text will be inserted in front of existing text.

Ovr: Overwrite mode is enabled – newly entered text will be written over existing text.
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The default setting is Ins. You can use the Ins key on your keyboard to switch between these two modes
(or by clicking on the Ins/Ovr display).

The Ins key can also be disabled, see section Settings, Edit tab.

Further elements of the status bar

§ View mode 

To the right of the status bar, there are also some buttons that enable you to rapidly switch between the
available view modes.

From left to right, these icons represent the following functions:

ú View slide 

ú View slide sorter

ú View outline

ú View notes

ú Start slide show (with the first slide or  with the current slide)

§ Zoom level 

The status bar also contains a zoom slider that allows you to change the zoom level for the document:

To do so, either drag the slider with your mouse or click on the plus or minus icon (see Zoom level).

Tip: Configuring the status bar

If you click on the double arrow  on the far right of the status bar, you will find the following options:

§ You can use the option Add/remove buttons to show or hide the individual preset elements of the status
bar. 

§ The option Customize opens the dialog box Customize user interface, where you can freely configure the
status bar from all commands available in Presentations.

In the dialog box, select the item "Status bar" in the list Customize (top right). You can then add or remove
buttons from the status bar and change their order. For more information, see Customizing icons and groups
in the ribbon.

§ Reset this toolbar restores all changes made to the status bar back to their original state.
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Concepts
This section introduces the most important components of a presentation graphics program in general and
explains the underlying concepts by illustrating how Presentations is used.

A presentation contains the following basic elements:

§ Slides: These are the "pages" of a presentation. 

§ Objects: These are slide components, such as pictures, drawings or tables, that you can insert into your
presentations.

§ Slide designs: These are predefined design templates that make it easier for you to create attractive
presentations with a consistent look. 

§ Slide layouts: These are predefined layout schemes with predefined areas for texts and objects. They are
suitable for both new slides and for changing the layout of existing slides.

§ Color schemes: These are predefined sets of coordinated colors that let you change the color scheme of
your entire presentation with just a few clicks.

§ Text: The last section introduces functions for working with text.

Each of these components is described in detail in the following sections.

Slides

Do you remember those bulky "overhead projectors" from your classroom, lecture hall or from conference
rooms? Transparencies with text and drawings were placed on the projector and projected onto the wall. The
modern-day equivalent of such overhead slides are the slides in Presentations files that you can easily create on
a computer and then view on its screen or show with a projector.

In Presentations, a slide is a page on which you create drawings, place images, enter text, etc. The purpose of
slides is to organize your presentation topics and provide a visual aid to your audience to clarify and reinforce
your message.

With software like Presentations, you no longer have to worry about the cumbersome task of working with
transparencies. You also don't have to search at length for the right slide if someone wants to see something
specific after the presentation.The software manages your presentation and always keeps all slides in the correct
order. This is especially useful when someone in your audience asks a question, and you need to use a
particular slide to help make a point.

Above all, Presentations minimizes the laborious aspect of creating attractive slides by providing many
automatic design functions, such as predefined slide layouts, color schemes and slide transitions.

The next few pages contain some basic information on working with Presentations. You will learn how to
create and edit slides and how to add and change individual elements. You can then read more detailed
information on these topics in the other chapters of the manual.
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Designing slides

When you start Presentations, the program displays an application screen that may look as follows:

The current slide is displayed in the large area in the middle of the screen. This slide is still empty, although its
predefined layout is already shown on the screen.

Slides can be assigned a different slide layout at any time. The slide layout defines the underlying structure of
the slide, among other things,as it determines the predefined areas in which you can type text or insert an
object.

These defined areas in the slide layout are called placeholders. In the above figure, the placeholders can be seen
as rectangular areas with a dashed border that contain such text as "Click to add title", for example. To edit the
content of one of these placeholders, simply click in it and type in the desired text. Many placeholders also have
icons in the center, which you can use to insert an object into the placeholder instead of text. For more
information on slide layouts, see Slide layouts.

Presentations offers many features which enable you to redesign complete presentations at the touch of a
button. For example, you can use slide designs to give your presentation an appealing and consistent look
across all slides. For more information on slide design, see Slide designs.

You can also add interesting effects to make your presentation more entertaining and visually appealing. For
example, slide transitions ensure that moving from one slide to the next is accompanied by interesting effects.
For more information, see Using slide transitions.
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Objects

Each slide you create is a kind of "container" for the objects which you insert in it. A frequently used object
type is the text frame, for example. Pictures and tables are also objects that you can insert into a slide. Overall,
Presentations supports the following types of objects:

§ Placeholders (as described in the previous section) 

§ Text frames

§ Tables

§ Pictures

§ Charts

§ OLE objects (only available on Windows)

§ Drawings (lines, rectangles, circles, etc.)

§ AutoShapes (arrows, stars, smileys, speech bubbles, etc.)

§ TextArt objects (lettering with text effects, similar to Microsoft WordArt)

§ Media objects (movies and sounds)*
* Movies can only be inserted and played on Windows and macOS. Sounds are only possible on Windows, macOS and Android/iOS.

When you create a slide, you usually fill existing elements with content. Most slides already contain predefined
placeholders for either entering text or inserting a picture to emphasize your point. Furthermore, you can add
more objects at any time to make a presentation more varied.

Tip: Be careful not to include excessive objects in your slides and thus lose the attention of your audience.

Inserting objects

To insert an object into a presentation, choose one of the commands on the ribbon tab Insert | group Objects
(alternatively: ribbon tab Home | group Objects | New object).

You would thus choose the ribbon command Insert | group Objects | Picture frame  if you wanted to insert
a picture, for example.

The selected object is either inserted immediately in the slide or the program opens a dialog box with further
instructions – this picture, for example, contains a prompt to select a corresponding file.

Editing objects

After inserting an object, you can change its position and size at any time. To change its position, click on the
object and drag it to the desired location while holding down the mouse button. To change its size, drag one of
the round handles surrounding the object.

All objects have certain properties that you can change at any time – for example, their fill color, border lines,
etc. To change them, select the object by clicking on it and switch to the contextual ribbon tab Object (or:
ribbon tab Picture). This ribbon tab appears automatically as an additional tab on the far right as soon as you
select an object.

Alternatively: To open the dialog box with advanced settings for Object properties, right-click on the object in the context menu to select
(Picture:) Properties.
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To delete an object, click on it to select it and press the Del key.

For more information on working with objects, see Working with objects.

Slide designs

Thanks to Presentations, you don't have to be a qualified graphic designer in order to create attractive
presentations. Presentations offers you numerous predefined slide designs that you can apply with just one
mouse click. A suitable design can be swiftly found for every subject – from a classically elegant to a vividly
colored design.

FreeOffice: SoftMaker FreeOffice includes only some of the predefined slide designs.

If you start a new presentation with the command File | New , simply select a design from the Design gallery
and all new slides of this presentation will automatically be created with this design. For more information, see
Starting a new presentation).

Of course, you can also apply a different design to your presentation afterwards, and even different designs to
individual slides if desired.

To select a different slide design, choose the command Design  on the ribbon tab Design. For more
information, see Changing the slide design.

Here is an example of the same presentation, but with two different slide designs applied to it:
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Slide design "Blue Sky"

Slide design "City"

As you can see, the two slide designs give the presentation a fairly different overall look.
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Slide designs determine the following properties of slides:

§ The position and size of placeholders on the slide 

§ The colors and color schemes (color schemes are sets of coordinated colors)

§ The fonts and font styles of headings and regular text

§ The background (full color, gradient, picture, etc.)

§ The transitions between the slides and the object animations

For more information on designs, see Changing the slide design.

Slide layouts

A slide layout is a template that contains certain rectangular areas with a dashed border. These areas are called
placeholders and can be filled with text or an object.

A title placeholder

More specifically, placeholders can be filled with titles, subtitles, text or objects. When empty, placeholders
contain an info text that indicates what is to be done, for example, "Click to add title". Clicking anywhere in the
placeholder will make the info text disappear, and you can start entering text directly.

In addition to a title placeholder in which only text can be entered, most slide layouts also contain one or more
placeholders that can be filled either with text or with an object (table, picture, chart, media object or OLE
object).

A generic placeholder

Such generic placeholders contain the info text "Click to add text" at the top and a small bar with icons in the
center. To add text, simply click in the placeholder (but not on one of the icons) and you can start to enter text.
To add one of the aforementioned objects instead of text, click on one of the icons in the center. Depending on
the selected object type, different dialog boxes appear to enable you to select the object to insert.

For more information on placeholders, see Placeholders.

Changing the slide layout

Presentations provides various predefined slide layouts with different numbers, sizes and arrangement of
placeholders, which enables you to find a layout that fulfills your needs for each slide.

To change the layout of a slide, choose the ribbon command Design | group Design | Layout  (alternatively:
Home | group Slide | Layout).
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The program displays a dialog box that offers all available layouts. Small pictures indicate how the
placeholders are arranged on the slide. Select the desired layout here and click on Apply.

The slide layout dialog box

For more information on slide layouts, see Changing the slide layout.

Color schemes

A color scheme is a predefined set of matching colors for different parts of your slides, such as background,
title, text and lines, hyperlinks or fill areas.

These color schemes enable you to quickly and easily change all colors of a presentation without having to do
so individually for each element of the presentation.

Each slide design already includes several predefined color schemes. Simply choose the ribbon command
Design | group Scheme | Color scheme , select a suitable color scheme and apply it. Two examples of color
schemes are illustrated in the following screen images.



38Basics

A presentation with a green color scheme

The same presentation after applying a different color scheme

For more information on color schemes, see Changing slide color scheme and background.

Text

Slide layouts already described how text can be entered in a placeholder: You simply click into the placeholder
and then start entering text.

Apart from the predefined placeholders, you can enter additional text by inserting a text frame:

1. Choose the ribbon command Insert | group Objects | Text frame .
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Alternatively: Home | group Objects | New object | Text frame

2. The text frame is now inserted.

You can then move or resize the text frame:

Click with the mouse on the border of the text frame in order to move it. While still holding the mouse
button down, drag the text frame to the desired position.

To change the size, drag one of the round handles surrounding the text frame.

After inserting the text frame, you can start typing immediately.

Selecting text

For some commands, you can select a section of text before you execute them. The command is then applied
only to the selected text.

For more information on selecting, see Working with selections.

To select text, proceed as follows:

§ Windows, Mac and Linux 

Here, you can select text as in a word processing application: While holding down the mouse button, drag
the mouse cursor over the text you want to select – or use the arrow keys while holding down the Shift
keyñ.

§ Android/iOS 

In the Android and iOS version, on the other hand, proceed as follows: Double-click on the word that you
want to use as the starting point of the selection. The word should now be selected. This is indicated by the
large "handles" that appear in front of and behind the word:

These two handles represent the beginning and end of the selection. To extend the selection to additional
text, simply drag the two handles to the desired positions.

Tip: Choose the ribbon command Home | Select all  to select all text in a placeholder.

Formatting text

Text in a placeholder or in a text frame can be formatted as in a word processing application. To do so, choose
the commands on the ribbon tab Home | group Character (for font, font size, bold, etc.) or Home | group
Paragraph (for indents, tabs, alignment, etc.).

Character formatting options that you select will then be applied to the text that you enter afterwards. You can
also change the character formatting of text that you have already entered. To do so, select the text, choose the
desired command from the ribbon tab Home | group Character and make the appropriate adjustments.

Changes to paragraph formatting will be applied immediately to the paragraph in which the text cursor is
positioned – or if you have selected several paragraphs, they will be applied to those selected paragraphs.
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For more information on formatting text, see Working with text.

Moving, deleting and copying text

You can use the commands on the ribbon tab Home | group Edit to copy or cut selected text and paste it again
in another place. For more information, see Moving, deleting and copying.

Tip: Deleting text with key combinations

All users make typos occasionally and want to delete them again. Presentations enables you to do so via several
key combination options:

Deleting characters: To delete a character, use the Backspace keyÕ. This key deletes the character to the left of
the text cursor. The following text moves back automatically.

You can also delete in the opposite direction with the Del ("Delete") key. It deletes the character to the right
rather than to the left of the text cursor.

Deleting word on the right: If you place the cursor before the first letter of a word and then press Ctrl+Del, the
entire word is deleted. If the text cursor is positioned in the middle of the word, this key combination deletes
only the letters following the cursor to the end of the word.

The key combination Ctrl+BackspaceÕ works analogously for words to the left of the cursor.

Deleting long sections of text: The aforementioned delete keys are well suited for removing short sections of text,
but are far too laborious for deleting longer sections of text. For this reason, there is another deletion method
whereby you first select the text and then delete it completely, for example, by pressing the Del key.

File operations
In this section, you will find a description of Presentations' basic file operations, such as opening, saving or
printing documents.

Starting a new presentation

To enable you to start a new presentation immediately, an empty document with the default slide design is
always created after the program starts.

Otherwise, choose the command File | New  to start a new presentation. (Click directly on the icon itself.)
Incidentally, this command is also in the Quick access toolbar.

(Note: If you click on the icon's arrow instead, you'll see the slide designs you previously used. See "List of
slide designs used" below.)
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Tip: Use the key combination Ctrl+N to quickly open a new presentation with the current default slide
design, while skipping the dialog box shown below.

After you click on the File | New icon , the following dialog box appears:

The dialog box of the command File | New

FreeOffice: SoftMaker FreeOffice includes only some of the predefined slide designs.

In the dialog box, select the desired slide design for the new presentation. Otherwise, the default slide design
Normal.prvx is preset.

Once you confirm with OK or double-click on the slide design, the new presentation is created with the
selected design and you can start designing your presentation.

Note: You can subsequently change the slide design at any time using the ribbon command Design  on the
ribbon tab Design. For more information, see Changing the slide design.

Using slide designs

The above dialog box contains the following options:

Template: The Templates folder displays all available slide designs in the view window on the right.

The Favorites folder contains all "pinned" templates, which are permanently displayed at the top in the list of

the command File | New  for quick access. (For more information, see the paragraph below "List of slide
designs used").
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Pinned templates are recognizable by the vertical pin icon . The default slide design always remains pinned,
while all other templates can be pinned or unpinned by clicking on the pin icon.

View: You can switch between small, medium and large for a clear arrangement of the available templates in
the dialog box.

Set as default: You can change the default slide design by clicking on a design and then pressing this button. In
future, a new document will always be opened with this design.

Option "New program window"

The option New program window means the following: If it is enabled, the new document will be displayed in
its own program window. If the option is disabled, the new document will be created with a new tab in the
existing program window.

This setting is also saved and applied each time a document is opened, both when creating new presentations
and opening existing presentations.

(Note: In the Android/iOS version for smartphones and in SoftMaker FreeOffice, a separate program window is
always opened, while in the version for tablets, a new tab is always opened in the same program window.)

List of slide designs used

If you click on the small arrow of the File | New button , the program opens a list of previously used slide
designs, which you can apply directly:

Default template: The current default slide design is displayed here. If you just want to select the default slide
design, you can also click on it here in the list and skip the dialog box.

Unpinned templates: This is displayed if you have already used designs other than the default slide design.
You can thus use these designs directly from the list for a new presentation without performing a long search.

If you click on the pin icon  of a design, the status changes to Pinned templates: These are permanently
displayed at the top of the list (and in the Favorites folder of the dialog box, see above). You can unpin the

design by clicking on the pin icon  again.

If you click on the cross icon , you remove the entry completely from the list. The command Delete all
unpinned items deletes all entries from the list – except the pinned designs and the default slide design.

The command More will take you again to the dialog box described above.

Opening a presentation

To open an existing presentation, choose the command File | Open  by clicking directly on the icon itself.
Incidentally, this command is also in the Quick access toolbar.

(Note: If you click on the icon's arrow instead, you'll see a list of recently used files. For more information, see
"List of recently opened files" below.)

After you have clicked directly on the Open icon , the program will display a dialog box which may look as
follows:
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The dialog box of the command File | Open

This dialog box may look slightly different depending on the operating system, but its function always remains
the same. Use this dialog box to tell Presentations which presentation to open.

To do so, you could simply type in the name of the file you want to open manually. However, the dropdown list
with the files is more convenient because all files are listed here in the current folder and can be easily selected.

Option "New program window"

The option New program window means the following: If it is enabled, the new document will be displayed in its
own program window. If it is disabled, the document will be opened with a new tab in the existing program
window.

This setting is also saved and applied each time a document is opened, both when creating new presentations
and opening existing presentations.

(Note: In the Android/iOS version for smartphones and in SoftMaker FreeOffice, a separate program window is
always opened, while in the version for tablets, a new tab is always opened in the same program window.)

Previewing a document

When the option Preview is enabled, a little box displaying a preview of the currently selected document is
displayed to the right of the dialog box.
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Opening other file formats

In addition to opening its own files, Presentations can also open files created with other presentation software,
such as Microsoft PowerPoint. All you have to do is select the desired format from the list of file types.

For more information, see Working with other file formats.

Using Quick paths

You can use the Quick path button to create and choose quick paths in order to quickly switch to a specified
folder when opening or saving files.

For more information, see Quick paths.

File manager

FreeOffice: The File manager is not included in SoftMaker FreeOffice. 

The File manager button opens the integrated file manager. This displays a list of your presentations and
allows you to open, print, view or delete them, as well as perform searches.

For more information, see File manager.

List of recently opened files

If you click on the small arrow below the Open button, you will see a list of recently opened files. Simply click
on one of these files to open it again.

In this file list, you can also select the following options:

If you click on the pin icon  of a file, it will appear in the list as a pinned file and will be displayed
permanently at the top of the list. Unpinned files will eventually be removed from the list of recently opened
files if the number of entries exceeds the limit that was set. For more information, see "Recently used files in
the File menu" in Settings, Files tab.

Click on the pin icon  again to unpin the file or click on the cross icon  to remove an entry from the list.
The command Delete all unpinned items deletes all entries from the list – except the pinned files.

The command Browse documents will take you again to the dialog box described above.

Saving a presentation

When you have completed a document, you should save it to retain it permanently. To do so, click on the
ribbon command File | Save .

Tip: This command can also be found by default in the Quick access toolbar below the ribbon.

If the document does not yet have a name, Presentations automatically prompts you to assign a file name to it
before saving it.
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Saving under a different name or in a different location

Presentations also has a ribbon command called File | Save as. This also saves your presentation, but you can
first assign it another name or select another folder in which to save it.

Saving in a different file format

You can use the ribbon command File | Save as to also save a presentation in the file format of another
program. To do so, select the desired format in the list Save as type. For more information, see also Working
with other file formats.

Saving all open presentations

If you have multiple documents open at the same time, you can use the ribbon command File | Save all to save
all of them at once. Presentations checks whether the files have been changed since they were last saved and
saves only those that have been changed.

Printing a presentation

To print the current presentation, choose the ribbon command File | Print.

The program will display a dialog box in which you can specify the slides and the number of copies to be
printed. The default setting is the printing of one copy of the whole document.

For more information on printing and sending presentations, see Outputting presentations.

Exiting the application

To exit presentations, choose the command File | Close  and then File | Exit .

Alternatively, just click on the X icon on the far right of the title bar or tab.

If one of the open documents has been changed since it was last saved, Presentations automatically asks you
whether you want to save it before closing it.
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The Presentations tour
Welcome to the Presentations tour!

On the next pages, we will introduce you to Presentations' most important functions using practical examples.

We will create a small presentation for the company "Escher & Sons". More specifically, this will include a
title slide and two content slides with some presentation material as part of a proposed solution for a new
courthouse building.

Our small tour of Presentations includes the following sections:

§ Entering text 

§ When something goes wrong...

§ Using another slide design

§ Inserting a new slide

§ Inserting a picture

§ Applying a different color scheme

§ Creating a bulleted list

§ Inserting a table

§ Applying slide transitions

§ Applying object animations

§ Saving a presentation

§ Start running the slide show

Note: When working through the exercises, don't be afraid to experiment with new commands as you become
familiar with them! Even if something goes completely wrong, it won't matter at all. The exercises are not
intended to ultimately provide a complete presentation. You will just create a few sample slides that will give
you a feel for working with Presentations and its functions.

Entering text
After the program starts, it always displays an empty slide with the default slide design in which you can start
typing immediately.

This will be the title slide of your new presentation. This is the first slide of a presentation, where you usually
enter the title of your presentation. To do so, click in the title placeholder that contains the text "Click to add
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title" and enter "Escher & Sons Project Proposal" as the title. If you want, you can insert a line break after
"Escher & Sons" by pressing the Enter key¿.

The title slide layout also contains a placeholder for a subtitle, which contains the text "Click to add subtitle".
Click inside this placeholder and enter "Proposal to build a new municipal court building". Of course, you can
also enter any other text. The goal is just to familiarize you with entering text in placeholders.

If you have followed our example so far, your presentation should now look as follows:

The title slide with text

Note: Most of the illustrations in this manual were produced with the Windows version of Presentations. On
other operating systems, some of the controls look slightly different, but their functionality is the same.

When something goes wrong...

Presentations has a very practical feature: You can use the command Undo  in the Quick access toolbar to
undo the most recent changes made to a document. If, for example, you format text in a different font and then
don't like it, all you have to do is choose the command Undo and it will be undone again.

This not only works for formatting, but for virtually all changes – for example, you can undo typing or the
deletion of text.
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The command Undo can be applied repeatedly if necessary. For example, you can choose it five times to
reverse the last five changes.

If you click on the small arrow next to the Undo button, you will see a list of recent changes to which you can
revert. If you click on an entry in the list, several steps can be undone at the same time.

Redoing undone actions

There is also a counterpart to the command Undo: the Redo button  on the Quick access toolbar. This
restores the last action you undid. You can thus undo the cancellation of text changes.

This command can also be chosen several times in succession. If, for example, you choose the command Undo
five times, the last five text changes will be undone. If you then choose the command Redo five times, you will
restore the original text.

Again, you can use the small arrow next to the Redo button to select entries from the list of recent actions to
restore multiple steps at the same time.

Using another slide design
The title slide you created uses the default slide design (pure white without any graphic elements) and thus
looks very plain. It can be very quickly improved enormously by using a different slide design. You can change
the background, color scheme and formatting of the placeholders in a single step.

To do so, choose the command Design  on the ribbon tab Design, select a desired design and click on Apply
to all. In our example, we applied the "City" slide design:
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Title slide after applying the "City" design

You have now created the title slide of your first presentation. You can now add more slides that show the
actual content of the presentation. You will learn about various functions that can be used to make this content
appealing – for example, formatting text, slide transitions, bullet lists, pictures and much more.

Inserting a new slide
You can insert a new slide in the following ways: Right-click in the mini sorter on the left side of the window
and choose the command Insert new slide from the context menu.

Android/iOS: In these versions, you can also open the context menu with your finger by tapping on the screen
and holding your finger there for about a second.

Alternatively, you can also use the ribbon command Insert | Slide .

In all cases, the following dialog box appears:
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There are numerous layouts for a wide range of possible uses. In our example, you will be placing a picture
next to a block of text on your slide. As a result, you will need a slide layout with a title and two placeholders
for content (one for the picture and one for the text). The layout called "Title and two contents" is very suitable
in this case. Thus, select this option.

As soon as you confirm, the slide is created and appears on the screen.

Incidentally, you can subsequently change the slide layout of a slide at any time by choosing the ribbon
command Design | group Design | Layout. For more information on slide layouts, see Changing the slide
layout.

Inserting a picture
Our presentation involves the design and construction of a new building, and the newly created slide should
contain a list of the most important points.

Let's first give it a heading. To do so, click in the title placeholder at the top of the slide and type the title
"Important Tasks".

Next, we want to insert a picture of the proposed new building.

To insert a picture, click on the picture icon  in the center of the left placeholder. The program opens a
dialog box in which you can select the desired picture.
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A suitable example picture named court_new.jpg has been provided. This is located in the folder containing
the example documents for SoftMaker Office. Depending on the operating system, these can be found as
follows:

§ Windows: In the SoftMaker\Samples folder in your Documents folder. 

§ macOS: In the SoftMaker/Samples folder in your Documents folder.

§ Linux: In the SoftMaker/Samples folder in your Home folder.

§ Android: In the SoftMaker/Samples folder on your SD card.

§ iOS: In the SoftMaker/Samples folder on your App folder.

In the dialog box, select the picture court_new.jpg. When you confirm your choice, the picture is inserted
into the slide.

The size is automatically adjusted so that it fits exactly in the designated placeholder. Of course, you can resize
the picture at any time by dragging one of its borders or one of the corners.

Copyright notice for the picture: This file was released under the GNU Free Documentation License. It is permitted to copy, distribute and/or modify
the file under the terms of the GNU Free Documentation License, version 1.2 or any later version published by the Free Software Foundation. There
are no fixed sections, no front cover text or back cover text. A copy of the license can be found at http://www.gnu.org/copyleft/fdl.html.
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Applying a different color scheme
The slide design "City" that we applied at the start is actually very appropriate for our presentation, but its
colors don't match the inserted picture. Fortunately, each slide design also includes several appropriate "color
schemes" from which to choose.

Color schemes provide a simple method of instantly changing the coloring of slides (or entire presentations).
You determine not only the text color, but also the colors for the background, the filling of drawing objects, etc.

To change the color scheme, proceed as follows:

1. Choose the ribbon command Design | group Scheme | Color scheme . (Click directly on the icon itself
because this opens the dialog.)

2. If you click on one of the available color schemes, you can see a preview of it in the document. The Preview
checkbox must be selected in this case.

3. Once you have decided on a color scheme, simply click on Apply to all. The colors of all slides in your
presentation will now change accordingly. In our example, we select the scheme with the light gray
background and blue element colors (second from the left in the second row of the Additional schemes
section).

The presentation now has a completely different look and the colors of the design also match the colors of the
inserted picture better:
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Creating a bulleted list
Lists in which each item is presented in its own paragraph preceded by a marker are particularly clear and are
often used in presentations. Such markers are called bullets and lists with bullets are called bulleted lists.

In our presentation example, such a bullet listed is very suitable for listing the most important points that must
be taken into account in our new building. To type them, click in the placeholder on the right (but not on the
icons in the center). The info text and icons disappear and you can enter text.

The placeholder is already preformatted for bulleted lists. Simply enter the bullets in the placeholder. As soon
as you start typing, you will see that there is already a bullet in front of the text. To start the next bullet point,
press the Enter key¿ and type the second point. Enter the following list in this manner in your presentation:

§ Building materials 

§ Roofing materials

§ Electrical wiring

§ Plumbing

§ Interior fittings

After entering the list, you can change its formatting.

Formatting the bulleted list

We'd now like to make the list entries a little more eye-catching in our presentation example. For this purpose,
we will make the font bold and change the bullets.

To change all list entries, first select the entire list by clicking on any list entry and then choose the ribbon
command Home | group Selection | Select all. Alternatively, use the keyboard command Ctrl+A.

Then click on the Bold icon  on the ribbon tab Home | group Character to make the text bold.

Finally, let's change the bullets a little:

1. To do so, select the entire list again as described above.

2. On the ribbon tab Home | group Paragraph, select the bullets icon . Click on the icon's arrow for the
dropdown menu.

3. In the menu that is then displayed, you can choose from different groups of bullet types.

Note: You can use the entry Format bullets to customize the bullets. For more information, see Bulleted
lists.

For our presentation, we select the filled diamond from the Default bullets.
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The filled diamond option is the third bullet from the left

The second slide in your presentation should now look as follows:

The second slide with a bulleted list of the tasks

Inserting a table
To complete the presentation, we'll add a third slide detailing the proposed project timeline as a table. To do so,
we choose the ribbon command Insert | Slide to create a new slide for which we select the layout with a title
placeholder and a single large content placeholder. It is called "Title and content".

Choose it and confirm it.
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In the new slide, first enter "Proposed Timeline" in the title placeholder at the top.

Let's insert a table into the slide as the next step. It should contain five rows and two columns. To do so,
proceed as follows:

1. Click on the table icon  in the center of the large placeholder.

2. Set the number of rows to "5" and columns to "2".

3. Confirm with OK.

The placeholder is now replaced by the desired table.

Note: An additional ribbon tab is also displayed on the far right as a tab: the contextual ribbon tab Table.
This always appears automatically when you place the text cursor in the table and contains options for
editing the table.

Now enter the following date information in the left column and the corresponding action in the right column.
You can jump from one table cell to the next using the Tab key:

01/2018 – 07/2018 Planning and Preparation

07/2018 Groundbreaking Ceremony

07/2018 – 07/2019 Construction

07/2019 – 12/2019 Inspection and Acceptance

01/2020 Grand Opening

Finally, let's change the column width and align the text in a nicer manner:

Changing the column width

Since some of the texts in the right column do not fit in one row, we should widen the column. To do so, move
the mouse cursor over the vertical line between the two table columns. When the cursor becomes a double
arrow, click on it and hold down the left mouse button in order to drag the vertical line a little to the left.

Aligning text

The text in our table looks like it was "sticking" to the top edges of the cells. It might be a good idea to finally
center the text entries vertically.

The table is already selected as a result of the previous action. If not, select the table again

(for example, by choosing the command Select  on the contextual ribbon tab Table).

Then proceed as follows:

1. Choose the command Text alignment  on the contextual ribbon tab Table | group Format.

2. In the following menu, click on the Align center to left button:
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Changing the font size

If the font seems too small, select the cells and change the font size, for example, from 18 to 28, on the ribbon
tab Home | group Character.

For more information on font size, see Font and font size.

Your final slide should now look similar to this:

The third slide with a table for the timeline

For more information on working with tables, see Tables.
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Applying slide transitions
In the previous sections, we created three simple slides and filled them with content. We are now going to jazz
up the presentation a bit by applying visual effects. Let's start with slide transitions.

Slide transitions are effects that appear when you switch from one slide to the next while presenting a slide
show. Presentations offers a number of different transition effects to help you create engaging presentations.

Slide transitions can be applied either to individual slides or to all slides in a presentation at once. In our
example, we will apply a transition effect to the entire presentation.

Proceed as follows:

1. On the ribbon tab Transition, click on the group arrow  of the command group Transitions to open the
dialog box shown below.

Tip: You can also use the buttons on the ribbon tab Transition or in the sidebar to apply all slide
transition commands directly. For demonstration purposes only, we selected the route via the dialog box
for the sake of compact clarity.
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2. Select, for example, the Diagonal effect and To right and bottom variant.

3. If desired, you can also change the Speed. You can preview any change to the effect directly in the
document window (if the Preview option is enabled).

4. Confirm with Apply to all.

The slide transition has now been applied to all slides in the presentation.

Tip: In the mini sorter, which is displayed to the left of the slide, a small icon  now appears in the top left
corner of each slide. It indicates that the corresponding slide uses a slide transition. When you click on this
icon, a preview of the transition effect is displayed in the thumbnails.

For more information on slide transitions, see Using slide transitions.

Applying object animations
Object animations are motion effects that can be applied to individual objects. Like slide transitions, animations
can be used to make presentations more entertaining. They can also be used to highlight particularly important
points.

Object animations

There are three main types of object animations: animations to make objects appear, to emphasize objects and
to make objects disappear:

§ An example of an Appear animation is to have an object "fly in" when the associated slide is displayed. 

§ An Emphasize animation might be used to highlight an important section of text, for example, by changing
its color or font size.

§ A Disappear animation involves an object disappearing when you switch to the next slide, for example, by
"flying out" of the slide.

Each type is divided into several categories, and each category contains many individual effects from which to
choose.

Feel free to try out various animations for this exercise. You can preview each effect before applying it. Of
course, you can also follow our example described below.

Tip: You can also use the buttons on the ribbon tab Animation or in the sidebar to apply all object
animation commands directly. For demonstration purposes only, we selected the route via the dialog box for
the sake of compact clarity.

We will now animate the picture on the second slide as an example:

1. Go to the second slide and click on the picture to select it.

2. Then right-click on the picture to open the context menu and select the entry Animations.
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3. In the dialog box that appears, click on Add.

4. The program displays another dialog box which shows the animation types, the associated categories and the
individual effects:

5. Enable the Preview checkbox and click on the various effects to see their effect on the slide.

6. First, select the Appear type, then the Transformations category and finally the Faded zoom effect for our
example.

7. Confirm with Add. You will now see the selected effect with a short description in the dialog box
Animations.

8. Click on Close.

If you now click on the small icon  in the top left corner of slide 2 in the mini sorter, you will first see a
preview of the slide transition you applied earlier and then the animation of the image you just added.

In the Presentations tour, we intentionally chose a very simple animation example just to introduce this
function. Object animations have numerous options and can be varied and combined in many ways. For more
information, see Animations.

Slide animation schemes

Tip: Unlike object animations which are always applied to individual objects on a slide, the Animation schemes
in Presentations provide an easy way to apply animations to all objects on a slide or even to the entire
presentation at once. For more information, see Slide animation schemes.

Saving a presentation

To save your presentation, choose the command File | Save .

Tip: This command can also be found in the Quick access toolbar below the ribbon.
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When you choose the command Save for the first time in a newly created presentation, the dialog box Save as
opens. There, type any name for the presentation in the box File name. You can also switch to another folder if
you want to save the file somewhere else.

Let's name the presentation Practice. Thus, enter "Practice" in the box File name, and click on Save to
confirm your entry. Presentations will save the file under the specified name and will automatically append the
extension .prdx. Thus, the complete file name in this example is Practice.prdx.

The next time you choose the command Save, the program will no longer display this dialog box because the
presentation now has a name. It will thus be saved immediately under its name.

Start running the slide show
You have now created your first small presentation. Thus, let's run your slide show! To do so, choose the
command Slide show | group View | Start.

Your slide show will then be displayed on the full screen, slide by slide, from start to finish. You can use the
space bar or the left mouse button to switch from one slide to the next. A right-click opens a context menu with
some functions for interacting with the current slide show.

Android/iOS: In these versions, you can also open the context menu with your finger by tapping on the screen
and holding your finger there for about a second.

For more information, see Running a slide show.

Finished!
Our Presentations tour ends here. You were introduced to the basic functions of Presentations using simple
exercises and were thus shown how to create your own presentations in future.

The rest of this manual is for reference purposes only. It has been intentionally structured so that you only need
to read the sections that you really require. Thus, you can gradually familiarize yourself with the functions as
you want to use them.

Have fun with Presentations!
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Working with selections
For some Presentations' commands, you can select a section of text (or an object) before you execute them. The
command is then applied only to the selected text or object.

The selection procedure differs depending on the operating system in use. Thus, this section is split into two
parts:

§ Selecting in the Windows, Mac or Linux version 

§ Selecting in the Android/iOS version

Selecting in the Windows, Mac or Linux version
In the Windows, Mac or Linux version of Presentations, you can select something as follows:

Selecting via the mouse

To select something via the mouse, proceed as follows:

§ Selecting text 

To select a section of text of any length, position the mouse cursor at the beginning of the section, press and
hold down the left mouse button, and drag the cursor to the end of the desired section.

To select a word, double-click on the word.

To select a whole line, click on the left of the line and drag the mouse cursor over to the right of the line.
You can also select multiple lines by dragging the mouse cursor down.

§ Selecting objects 

To select an object (for example, a picture, a drawing, etc.), simply click on it with the mouse. A frame will
then appear around the object to indicate that it is now selected. For objects with text (for example,
placeholders), you have to click exactly on their frame in order to select them.

To select several objects at once, use the mouse to draw a frame around the desired objects. Alternatively,
you can click successively on several objects while holding down the Shift keyñ to select them together.

Tip: Use the ribbon command Home | Select all  to select all text in a placeholder or all objects on a slide.

Selecting via the keyboard

Alternatively, you can use the keyboard. To do so, proceed as follows:
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§ Selecting text

Move the text cursor to the start of the text you want to select. Press the Shift keyñ, hold it down, and then
move the text cursor in any direction with the arrow keys.

For example, you can select the following:

a single character with Shift+ß or Shift+à

a single word with Ctrl+Shift+ß or Ctrl+Shift+à

(for Mac: Alt+Shift+ß or Alt+Shift+à)

To select all text in a placeholder, you can press the key combination Ctrl+Home, followed by the key
combination Ctrl+Shift+End.

§ Selecting objects 

Objects can only be selected with the mouse or the ribbon command Home | Select all  (see above).

Selecting in the Android/iOS version
Selecting works a little differently on Android/iOS devices. You can use either your finger or a mouse. Proceed
as follows:

§ Selecting text 

The easiest way to select a section of text is as follows:

Double-click on the word that you want to use as the starting point of the selection. The word should now be
selected. This is indicated by the large "handles" that appear in front of and behind the word:

These two handles represent the beginning and end of the selection. To extend the selection to additional
text, simply drag the two handles to the desired positions.

§ Selecting objects

To select an object (for example, a picture or drawing, etc.), simply click on it. A frame will then appear
around the object to indicate that it is now selected.

Tip: Use the ribbon command Home | Select all  to select all text in a placeholder or all objects on a slide.



63Working with slides

Working with slides
Slides are a visual aid for giving a presentation. The presentation is easier to structure and the audience can also
follow the information you are talking about on the screen.

Presentations provides many features that enable you to tailor the slides of a presentation to your audience and
assist you in effectively conveying your message.

A slide first starts as a blank sheet. You can either design it yourself from scratch or you can avail of the many
useful tools included in Presentations. You can be as creative as you like. You can also benefit from the
predefined designs, layouts and color schemes that allow you to simply pick and choose without having to do
all of the work.

This chapter will introduce you to all of the techniques you need in order to be able to use slides perfectly. The
information covers the following topics:

§ Creating a new presentation 

§ Inserting a new slide

§ Inserting slides from other presentations

§ Navigating between slides

§ Working with the mini sorter

§ Working with the mini outliner

§ Using the slide sorter and outline

§ Changing the order of slides

§ Deleting slides

§ Copying, cutting and pasting slides

§ Duplicating slides

§ Renaming slides

§ Resetting slides

§ Hiding slides

§ Changing the slide design

§ Changing the slide layout

§ Slide management

§ Creating headers and footers 

§ Changing the orientation of slides

§ Inserting a summary slide
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§ Changing slide color scheme and background

§ Using slide transitions

§ Adding object animations

§ Using the sidebar

§ Adding notes

§ Printing handouts

Creating a new presentation
Each presentation that you create is saved as a separate file. You can open multiple presentations at the same
time and work on them in parallel. For example, you can quickly copy information from one presentation to
another. For more information, see Working with multiple documents.

To enable you to start a new presentation immediately, an empty document with the default slide design is
always created after the program starts.

Otherwise, choose the command File | New  to start a new presentation. (Click directly on the icon itself.)
Incidentally, this command is also in the Quick access toolbar.

(Note: If you click on the icon's arrow instead, you'll see the slide designs you previously used. For more
information, see Starting a new presentation.)

Tip: Use the key combination Ctrl+N to quickly open a new presentation with the current default slide
design, while skipping the dialog box shown below.

After you have clicked on the File | New icon , the following dialog box appears:
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FreeOffice: SoftMaker FreeOffice includes only some of the predefined slide designs.

The dialog box shows you an overview of all slide designs that Presentations provides. Select the desired design
and confirm with OK. Presentations will then create your new presentation.

You can subsequently change the slide design at any time using the command Design  on the ribbon tab
Design.

Notes:

§ If you have external templates that you want to use instead of the predefined designs, select the Load from
file button in the dialog box of the command Design on the ribbon tab Design. You will find this
information and other information on slide designs in Changing the slide design. 

§ The meaning of the pins , the Favorites folder and all other features in the dialog box shown above are
described in the Starting a new presentation section.

Inserting a new slide

To create a new slide in the current presentation, choose the command Insert | Slide  (or the ribbon tab
Home | group Slide | Add).
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Alternatively: Right-click in the mini sorter on the left side of the window to open the context menu and select
the entry Insert new slide. You can also simply use the shortcut keys: Ctrl+M.

The program displays a dialog box that offers all available slide layouts:

Note: You can also skip the dialog box by clicking on the arrow of the Slide icon  instead of clicking on the icon itself. In the
dropdown menu that appears, the desired layout for the new slide can be inserted directly via a mouse click.

The thumbnails in the dialog box show how the placeholders will be arranged on the new slide. Select the
desired slide layout and confirm with OK. The new slide will then be inserted behind the current slide.

For more information on slide layouts, see Changing the slide layout.

Inserting slides from other presentations
Presentations provides several options for copying slides from other presentations to the current presentation.
One option is to simply open both presentations and use the copy-and-paste method. Alternatively, there are
two commands that can be used to copy all slides of a presentation in one step:

In the mini sorter, select the slide behind which the slides are to be inserted.

Then click on the icon's arrow of the command Insert | Slide  and select Slides from presentation or Slides
from outline from the dropdown menu.

The difference between these two commands is that Slides from presentation inserts slides of a normal
presentation file (Presentations or PowerPoint file) and Slides from outline inserts slides of presentations that
have been saved as an outline in RTF format.

A file dialog appears when you choose one of these commands. Select the desired file and confirm that it has
been opened. The entire content of the selected file will then be inserted into the current presentation.
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Navigating between slides
To navigate between the slides of a presentation, use the following keys:

Key Function

PageUpá Jump to the previous slide

PageDownâ Jump to the next slide

Home Jump to the first slide

End Jump to the last slide

Using the "Go to slide" command

Furthermore, you can jump to a specific slide with the ribbon command Home | group Search | Go to .

If you choose this command, a dialog box appears with a list of all of the slides in the document. Select the
desired slide and confirm with OK to jump to the selected slide.

Using the mini sorter

You can also use the mini sorter to jump to a specific slide. The mini sorter is usually displayed to the left of
the current slide. It shows small thumbnails of all slides. To jump to one of these slides, simply click on its
thumbnail.

For more information on the mini sorter, see the next section.

Working with the mini sorter
The mini slide sorter (short: mini sorter) shows small thumbnails of the slides of a presentation. It not only
provides an overview of all slides, but also offers some additional functions. For example, you can use it to
rearrange, add and delete slides. You can also preview slide transitions and animations in it.

By default, the mini sorter is displayed as a vertical bar on the left side of the document window and may look
as follows:
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The mini sorter

To choose certain functions via the mini sorter, right-click on one of the slides displayed in it. A context menu
with all available commands then appears.

Selecting slides in the mini sorter

You can also select more than one slide in the mini sorter and then apply commands to all selected slides at
once. To do so, click on the relevant slides while pressing and holding down the Ctrl key. Then choose the
function you want to apply to the selected slides.

Alternatively, you can also select all slides between the first and last slide you clicked by pressing and holding
down the Shift keyñ.

Another option is to choose the ribbon command Home | Select all  in order to select all slides in the mini
sorter.

Information displayed in the mini sorter

As shown in the above figure, each of the thumbnails displayed in the mini sorter is labeled with the
corresponding slide's name (usually "Slide" followed by a consecutive number). For slides that have been
hidden (see Hiding slides), the name of the slide is struck through in red.

For slides that use slide transitions or animations (see Using slide transitions and Animations), a small icon
with an arrow is displayed in the top left corner of those slides in the mini sorter. If you click on this icon ,
you will see a small preview of the slide transition and all animations of this slide.

Changing the position of the mini sorter

You can use the ribbon command View | group Windows | Mini sorter  to select where you want to place
the mini sorter in the document window. The Hide option will hide the mini sorter.

Alternatively, you can find these options in the context menu (right-click in the mini sorter) via the entry Mini sorter.
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Working with the mini outliner
The mini outliner shows a small outline view of the presentation. It is similar in function to the mini sorter (see
the previous section), but it shows the content of the slides (title and text) in text form rather than thumbnails.
This view enables you to have a better overview of the actual content of your presentation and allows you to
verify that the text is organized in a fluent and logical manner.

Just like the mini sorter, the mini outliner can be placed on different sides of the document window or can be
hidden completely.

To do so, choose the ribbon command View | group Windows | Mini outliner .

By default, both mini sorter and mini outliner are placed on the left side of the document window. To switch
between these two views, their tabs are displayed at the top: click on Slides for the mini sorter or on Outline
for the mini outliner.

The mini outliner

Entering text in the mini outliner

You can enter text directly into the mini outliner, just as you would do so in a slide. To do so, click in the
desired location to place the text cursor there and start entering text. The slide is automatically updated when
you make changes to the mini outliner.
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Using the slide sorter and outline
The large slide sorter and the large outline (commands View | Slide sorter and View | Outline) work just like
the mini sorter and the mini outliner – with one difference: they use the entire window to display the content.
This gives you a correspondingly better overview of the presentation.

For a detailed description of the functions available in these views, see Working with the mini sorter and
Working with the mini outliner.

To return to the normal slide view from the slide sorter or outline view, choose the command View | Slides.

The slide sorter
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The outline view

Changing the order of slides
You can use the mini sorter or the large slide sorter (command View | Slide sorter) to very quickly reorder the
slides of a presentation. You simply click on the desired slide and drag it anywhere else in the sorter while
holding down the mouse button. A line shows you where the slide will be positioned when you release the
mouse button.

Deleting slides
To delete the current slide, you can choose the ribbon command Home | group Slide | Manage | Delete slide.
This will delete the current slide (after confirmation).

Even faster: Select one or more slides in the mini sorter, right-click to open the context menu and choose the
command Delete. Alternatively, simply use the Del key after selecting.
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Copying, cutting and pasting slides
Slides can be copied in the mini sorter (or the large slide sorter) or cut out of the presentation and pasted
elsewhere.

All necessary commands can be found on the ribbon tab Home | group Edit:

Command Explanation

Copy The ribbon command Home | Copy copies the selected slide to the clipboard.

If multiple slides have been selected, all of them will be copied. To select a slide, click on it in the
mini sorter. To select multiple slides, click on each of them successively while holding down the Ctrl
or Shift key.

You can then choose the command Paste (see below) to paste the copied slides elsewhere in your
presentation.

Cut The ribbon command Home | Cut works similarly, but it deletes the slides from the document at the
same time. Use this command if you want to move slides rather than copy them.

Paste The ribbon command Home | Paste inserts the slides from the clipboard before the current slide.

Tip: You can also find all aforementioned commands in the context menu by right-clicking in the mini sorter.

Using shortcut keys

You can also use the keyboard for these commands:

Command Windows/Linux Mac

Copy Ctrl+C Cmd+C

Cut Ctrl+X Cmd+X

Paste Ctrl+V Cmd+V

Duplicating slides
To create a duplicate of the current slide, choose the ribbon command Home | group Slide | Manage |
Duplicate slide. An exact copy of the current slide will be pasted before the current slide.

Alternatively: Right-click on the slide in the mini sorter to open the context menu and select the entry Duplicate.

If multiple slides have been selected before you execute this command, all of them will be duplicated.

Tip: In the mini sorter, you can also duplicate slides directly with the mouse: While holding down the Ctrl
key, drag the slide to the place in the sorter where you want the duplicates to appear.
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Renaming slides
By default, slides are named Slide1 , Slide2, Slide3, etc. (with a consecutive number at the end). When you add,
delete or move slides, the numbering adjusts accordingly. However, you can also give slides a specific name for
identification purposes. This is especially advantageous when working with extensive slide shows.

To give a slide an individual name, select it in the mini sorter and choose the ribbon command Home | group
Slide | Manage | Rename slide.

Alternatively: Right-click on the slide in the mini sorter to open the context menu and select the entry Rename slide.

In the following dialog box, you can enter a new name.

Resetting slides
With the ribbon command Home | group Slide | Reset, you can reset all placeholders on the current slide.

When you choose this command, the following two things happen:

§ All settings for all placeholders in the slide are reset to their default values, including object properties, text
format and position/size. 

This corresponds to choosing the ribbon command Design | group Placeholders | Reset placeholder | Reset all properties (for all
placeholders in the slide). For more information, see Resetting placeholder properties.

§ In addition, any placeholders that were deleted in the current slide will be restored. 

This corresponds to choosing the ribbon command Design | group Placeholders | Restore. For more information, see Restoring
deleted placeholders.

Hiding slides
You will sometimes create a presentation that contains information which you do not want to show to everyone
– for example, a presentation about company strategies, which also includes slides that your board should see,
but not your potential new partner companies. Of course, you could create a copy of the presentation and delete
the unwanted slides there. However, it is easier to simply hide the relevant slides. They will still appear in the
document, but will be skipped when running the slide show.

To hide a slide, select the slide (or several slides) in the mini sorter and choose the ribbon command Slide show
| group Manage | Hide slide.

Alternatively: Right-click in the mini sorter to open the context menu and select the entry Hide slide.

You can still see hidden slides and can edit them without restrictions. However, they are no longer displayed
when you run the slide show.
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Incidentally, you can recognize hidden slides by the fact that their name is struck through in red in the mini
sorter.

Restoring hidden slides

To restore a hidden slide, use the same procedure. The option Hide slide appears dark when enabled for a slide.
If you click on the option again, the coloring will be removed and the slide will be displayed again when
running the slide show.

Changing the slide design
Of course, you can create the design of a presentation entirely by yourself, but Presentations provides you with
a whole range of attractive design templates that you can use for your presentations.

FreeOffice: SoftMaker FreeOffice includes only some of the predefined slide designs.

To apply one of these designs, choose the command Design  on the ribbon tab Design. The following dialog
box appears:

Use the scroll bar to browse through the collection for a suitable design. Then click on the desired design and
press the Apply button to apply the design to the current slide or the Apply to all button to apply it to all slides.
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Tip: You can even create your own slide designs by saving a presentation as a template. To do so, choose the
command File | Save as and select the Presentations template format as the file type.

Such self-created designs can then be applied using the Load from file button in the above dialog box. If you
have external templates, they can also be applied here.

Tip: Using the sidebar

The slide design can be changed even faster using the sidebar, which is displayed to the right of the slide by
default.

To do so, click on the icon  in the small toolbar above the sidebar. The sidebar now displays a list of all
available slide designs. Simply click on one of them, and it will be applied immediately to the current slide.

For more information on the sidebar, see Using the sidebar.

Changing the slide layout
Each slide design (see previous section) contains several "slide layouts".

A slide layout primarily serves as a template for the placeholders in a slide. Placeholders appear in slides as
rectangular areas with a dashed border and contain a prompt such as "Click to add text".

Each of the available slide layouts has different combinations and arrangements of placeholders. For more
information on placeholders, see Placeholders.

With the ribbon command Design | group Design | Layout , you can change the layout of a slide at any time
– even if it is already filled with content.

Alternatively, choose the command Home | group Slide | Layout or simply right-click to open the context menu and select Slide layout.

The following dialog box appears:
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From the dialog box, select the layout you want to apply to the current slide and then click on the Apply button.
The new layout is immediately applied to the slide.

Tip: Using the sidebar

The slide layout can be changed even faster using the sidebar, which is displayed to the right of the slide by
default.

To do so, click on the icon  in the small toolbar above the sidebar. The sidebar now displays a list of all
available slide layouts. Simply click on one of them, and it will be applied immediately to the current slide.

For more information on the sidebar, see Using the Sidebar.

Editing the masters of slide layouts

Incidentally, slide layouts not only determine the position and size of placeholders, but can also contain
numerous other settings – including the slide background, the color scheme, the formatting of text in
placeholders, etc. They are templates for all intents and purposes for the overall appearance of slides.

If required, you can edit the predefined slide layouts by choosing the Slide master view. In this view, you can
change the master of each slide layout as desired. (In other words, you can edit the slide layouts directly.)

Note: Changes that you make to a slide layout in the master view affect all slides that use this layout.

To switch to the master view, choose the ribbon command View | group Master | Slide master.

For more information, see Working with masters.
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Slide management

Common slide commands can be easily applied directly with the Manage button  on the ribbon tab Home |
group Slide. These commands were already described in the previous sections, but they are sometimes
controlled by different buttons there.

The following slide commands are available in a compact manner via the Manage button :

§ Create slide: This option is used to insert a new slide into the presentation. For more information, see
Inserting a new slide. 

§ Duplicate slide: This option is used to create a duplicate of the current slide. For more information, see
Duplicating slides.

§ Delete slide: This option is used to delete the current slide. For more information, see Deleting slides.

§ Rename slide: This option is used to give the slide an individual name. For more information, see Renaming
slides.

§ Hide slide: This option is used to hide the selected slides when running the slide show. For more information,
see Hiding slides.

Tip: The commands mentioned here and some others can also be found via the context menu by right-
clicking on a slide in the mini sorter.

Creating headers and footers
Headers and footers allow you to display information such as page numbers, date, company name, copyright
notices or the name of the presentation. These then appear at the top (header) or at the bottom (footer) of the
page.

§ Headers can only be used in notes and handouts. The same header appears on each note page or handout
page. 

§ Footers can also be used on normal slides. You can either create individual footers for specific slides or
assign a footer to all slides in the entire presentation.

You can specify exactly how the headers and footers should appear. You decide the content, placement, size,
formatting and all other aspects of the headers and footers as follows:

§ To create headers and footers and edit their content settings, choose the ribbon command Insert | group
Text | Header / footer. 

§ To then change the formatting, position or size of headers/footers on individual slides, select the appropriate
bordered areas at the top or bottom of the page. Their position and size can be changed with the mouse and
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their formatting with the commands from the command groups Character, Paragraph and Objects on the
ribbon tab Home.

§ You will also find additional options for the general object properties on the contextual ribbon tab Object
(which appears when you select a header or footer).

To insert headers and footers at a higher level, switch to the respective master view on the ribbon tab View |
group Master and use the commands described above accordingly.

More information can be found on the following pages.

Footers on slides

Footers are placed in the lower part of a slide and are divided into three footer areas: on the left, a date area, in
the center, a title area (or any other information), and on the right, a page number area.

To insert and fill these footer areas with content, choose the ribbon command Insert | group Text | Header /
footer, which is available in both the master view and the normal slide view.

The following dialog box is displayed:

In front of each area, you will see a checkbox. Enable it for all areas that should appear on the slide. Then
change the contents of the individual areas as required.
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The dialog box provides the following options:

§ At the top of the dialog box, you can specify whether the Date and time should appear on the slide. This
will then be displayed in the lower left corner of the slide. 

The option Update automatically uses the system date and time and updates them on an ongoing basis. In
the dropdown list below, you can specify the format of the date and time.

The option Fixed lets you manually enter any date, such as the creation date of the presentation.

§ In the Footer area, you can enter any text, such as the title or author of the presentation. This area is
centered at the bottom of the slide. 

§ The last part of the footer is for displaying the Slide number, which appears in the lower right corner of the
slide. The slides are automatically numbered for this purpose. If desired, you can also specify here the
number which should be assigned to the first slide of the presentation.

§ Title slides in a presentation generally do not have footers. You can achieve this by enabling the option Hide
on title slides.

The buttons on the right side of the dialog box give you the option of either applying the settings you made to
all slides in your presentation (Apply to all button) or applying them only to the previously selected slides
(Apply to selection button).

Note: The Apply to selection button is not available in the master view, but only in the normal slide view.
Changes you make in the master view in the above dialog box always affect all slides.

You can then select the inserted areas on the slide and adjust them further if necessary. However, these changes
will only affect the current slide.

The following operations are possible:

§ To change the formatting of the content, use the usual commands of the command groups Character and
Paragraph on the ribbon tab Home. 

§ To move an area, use your mouse to drag it to the desired position. 

§ To change its size, drag one of the handles surrounding its borders.

§ You can edit the contents of the areas in each slide individually by clicking in a created area on the slide and
typing your changes directly.

§ In the command group Objects on the ribbon tab Home, you can edit the object properties (fill color, line
color, etc.) of an area.

§ On the contextual ribbon tab Object (which appears as soon as you select a header or footer), you will find
additional options for the general object properties that correspond to those of text frames. For more
information, see Changing text frame properties via the ribbon tab. 

Note: For information on changing footers for all slides or only for specific slide layouts using the master
view, see Changing headers/footers in master view.
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Headers and footers on notes pages and handouts

The aforementioned dialog box for the headers and footers has a second tab: Notes and handouts. This allows
you to specify and change headers and footers on notes and handouts. The dialog box works in the same way as
the one described for the Slide tab, except that you can also specify headers in addition to footers in notes and
handouts.

As mentioned earlier, there is only one header or footer for notes and handouts, which is the same on all pages.

Changing headers/footers in master view

To change the formatting, position or size of headers and footers for slides at a higher level, you must first
switch to the respective master view. This can be done with one of the following commands on the ribbon tab
View | group Master:

§ For normal slides: ribbon command Slide master  

(Then select the slide layout that you want to modify in the mini sorter. Note: Changes made to the top
layout in the list affect all other layouts.)

§ For handouts: ribbon command Handout master  

§ For notes: ribbon command Notes master 

In these views, the areas designated for headers and footers are displayed at the top (headers) and bottom
(footers). In the slide master, for example, the footer consists of the Date area, the Footer area and the Page
number area:
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Master view for the slide master (Note: Header areas are only available in the notes and handout master.)

To create headers and footers and to edit their content, choose the ribbon command Insert | group Text |
Header / footer as in the normal slide view. (Typing content directly into the areas of the master view does not
produce any results.)

In addition, the content of these areas can be subsequently edited individually in the slide view for each slide by clicking into a created
area and typing in your changes.

If you select an area in the master view (for example, by clicking on its border), you can make the following
changes:

§ To change the formatting of the content, use the usual commands of the command groups Character and
Paragraph on the ribbon tab Home. 

§ To move an area, use your mouse to drag it to the desired position. 

§ To change its size, drag one of the handles surrounding its borders.

§ In the command group Objects on the ribbon tab Home, you can edit the object properties (fill color, line
color, etc.) of an area. 

§ On the contextual ribbon tab Object (which appears as soon as you select a header or footer), you will find
additional options for the general object properties that correspond to those of text frames. For more
information, see Changing text frame properties via the ribbon tab. 

Note: In the Slide master, you can also make these changes specifically for a certain slide layout; the changes
will then affect all slides with the corresponding layout. Exception: The contents of the footer (using the
command Insert | group Text | Header / footer to enter it in the dialog box!) are always applied to all slides.

For more information on the master view, see Working with masters.
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Changing the orientation of slides
In Presentations, slides are displayed in landscape format by default, while notes and handouts are displayed in
portrait format. You can change these default settings at any time for the entire presentation. However, the
orientation of individual slides cannot be changed.

To customize the slides format, proceed as follows:

Directly via the icons of the command group "Page setup"

You can easily choose from some common formats using the buttons on the ribbon tab Design | group Page
setup.

To do so, click on the small arrow of the Page size icon and insert the predefined slide formats directly. The
"screen" formats are automatically set to Landscape format. For all other formats, you can use the Page
orientation button to switch between Landscape and Portrait.

To access the dialog box with additional paper sizes and user-defined slide formats, click directly on the Page
size icon itself or click on More in the dropdown menu of the icon's small black arrow. The dialog box also
contains the settings for the notes and handouts format (see below).

Additional options: Via the dialog box "Page setup"

Advanced slide format options can be found via the dialog box. Access it as described above (alternatively: via
the ribbon command File | group Print | Page setup).

The dialog box has two tabs, one for setting up the slides and the other for notes and handouts.
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The Slides format tab of the dialog box has two options from which to select. If you select the option On-
screen slide show, you can choose between a number of predefined slide formats for on-screen slide shows
(4:3, 16:9, etc.) to the right of this option. The orientation of the slides is always set to landscape. If you would
like to change the orientation, select the option Custom. The Orientation and Paper size sections are now
enabled and you can switch between portrait and landscape.

The Paper size settings can be used to resize the slides or printouts. The dropdown list contains the most
common paper sizes. If you need a different size, you can also specify the values for Width and Height
individually.

Note: If you change the orientation or paper size, all objects on all slides are scaled accordingly.

In the Notes & handouts format tab, you can also set whether you want to use the printer's default paper
format for Notes and Handouts or customize the values to suit your needs.

Inserting a summary slide

FreeOffice: The Insert summary slide function is not included in SoftMaker FreeOffice.
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With the ribbon command Insert | group Slide | Summary slide, you can create a slide that lists the headings
of all slides of the entire presentation. This enables you to quickly and easily place a table of contents or agenda
at the start of a presentation.

Tip: Alternatively, you can choose the command by right-clicking in the mini sorter to open the context menu.

The following dialog box appears:

You can use the options in this dialog box to determine how the summary slide should look:

§ Make summary of: If All slides is enabled, the headings of each slide in the presentation are listed on the
summary slide. If Selected slides only is enabled, only the headings of those slides that you have currently
selected in the mini sorter will be listed. 

§ Place summary slide: Here, you can determine whether the summary slide is inserted into the presentation
before or after the currently selected slides (or the current slide).

§ Make hyperlinks: If this option is enabled, a hyperlink is created to the corresponding slide for each
heading listed on the summary slide. If the option is not selected, however, pure text (without links) is
created.

§ Skip slides without title: If this option is selected, slides that do not contain a title will not be included on
the summary slide.

§ Keep title formatting: If this option is selected, the formatting (font, font size, etc.) of the actual slide titles
is used to generate the titles on the summary slide.

If the information that should appear on the summary slide is too extensive and thus does not fit on the slide,
the following warning dialog box appears:
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Here, you can decide whether you want to distribute the text among several summary slides or reduce the space
required for the text by reducing the font size. If you use multiple summary slides, you can also select a two-
column layout.

Changing slide color scheme and background
By default, Presentations uses a white background with black text for new presentations. However, you can add
colors to the different elements of a presentation at any time. Well-coordinated color combinations can help to
make a presentation both more pleasing to the eye and more memorable.

In Presentations, you can specify the colors for eight different types of elements:

§ Text and lines 

§ Title text 

§ Filled areas (for example, in drawings)

§ Accent

§ Shadow

§ Hyperlink

§ Hyperlink used

§ Background (see also Slide background)

You can view the color scheme of a presentation with the command Design | group Scheme | Color scheme.
The dialog box displays all color schemes defined in the current slide design. Not only can you select a color
scheme here in order to apply it to single slides or to the entire presentation, but you can also change existing
color schemes or create new ones.

For more information, see the following pages.
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Applying a color scheme

To apply a color scheme to slides, choose the ribbon command Design | group Scheme | Color scheme .
(Click on the icon itself.)

Tip: If you want to apply a color scheme immediately without further editing, click on the icon's arrow and apply the desired color
scheme directly from the dropdown menu. The entry More color schemes will take you to the dialog box below with additional options.

The following dialog box appears:

The dialog box offers all available color schemes of the slide design currently in use. If the Preview option is
enabled, a preview of the relevant color scheme appears in the slide in the document when you click on a color
scheme. This lets you judge how well a color scheme suits your presentation before you apply it.

To apply a color scheme, simply select it and click on the Apply to selection button. The color scheme is now
applied to the current slide (or to all selected slides if you have previously selected some in the mini sorter).

Alternatively, you can assign the selected scheme to all slides of the presentation by clicking on the Apply to
all button.

The description of the New and Edit buttons can be found in the next section.

Tip: Using the sidebar

The color scheme can be changed even faster using the sidebar, which is displayed to the right of the slide by
default.
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To do so, click on the icon  in the small toolbar above the sidebar. The sidebar now displays a list of all
available color schemes. Simply click on one of them, and it will be applied immediately to the current slide.

Below the list, you will also find buttons for creating a new color scheme or for editing or deleting the current
color scheme.

For more information on the sidebar, see Using the sidebar.

Creating and editing a color scheme

You can create any number of your own color schemes for each presentation.

To create a new color scheme, choose the ribbon command Design | group Scheme | Color scheme (click on
the icon itself) and then select the New button in the dialog box.

This will open another dialog box for editing the individual colors:

You can now change the colors of the different elements of your presentation as you like. To do so, open the
corresponding dropdown list and select the desired color. The thumbnail in the bottom right corner of the dialog
box shows the currently set colors.

Tip: Color lists only offer a few default colors, but you can select different colors at any time. To do so, click
on More color schemes... at the end of the respective dropdown list.

The program displays a dialog box in which you can select any color you like. You can even save colors that
you need frequently under a name of your choice. For more information on this dialog box, see Document
properties, Colors tab.

Once you have selected the desired color, click on OK.
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Of course, you can also change existing color schemes in the open dialog box of the ribbon commands Design |
group Scheme | Color scheme (see previous section). To do so, click on the scheme to be changed and then
click on the Edit button.

Color schemes are always saved in the presentation and are not available in other presentations.

Slide background

Each color scheme also contains a Background color, which you can change with the ribbon command Design
| group Scheme | Color scheme (see previous section). The background of the slide will then change its color
accordingly.

However, more sophisticated options for selecting the slide background are available via the ribbon command
Design | group Page setup | Background.

Alternatively: Right-click in the mini sorter to open the context menu and select Background.

The command opens the following dialog box:

Use the dropdown list Fill type to determine the type of fill for the slide background. You can choose to apply a
solid color, a pattern, a picture or different types of color gradients.
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Depending on the Fill type you select, there are several options that you can use to specify the appearance of
the background.

Note For more information on the above dialog box, see Object properties, Fill tab. It describes the "Fill" tab
for objects, which is almost identical to this dialog box.

If required, you can also use the option Do not display objects from the slide master to specify whether the
slide should also display the objects that are on the master for the slide layout of this slide. This allows you to
purposefully hide these objects, if any, for specific slides. (For general information on masters, see Working
with masters.)

When all settings are made, select either Apply to selection to apply the changes to the selected slides or
Apply to all to apply the changes to all slides in the presentation.

Tip: Using the sidebar

The background can be changed even faster using the sidebar, which is displayed to the right of the slide by
default.

To do so, click on the icon  in the small toolbar above the sidebar. The sidebar now displays all available
options for the background. Select the desired fill type and the desired fill. The changes are immediately
applied to the current slide.

For more information on the sidebar, see Using the sidebar.
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Using slide transitions
A slide transition is the manner in which one slide moves into the next slide when running a slide show.
Presentations offers many different transition effects from which to choose and which you can apply to
individual slides or to all slides.

Conveniently apply slide transitions directly via the buttons on the ribbon tab Transition (or via the sidebar).
Alternatively, select the path via the dialog box for a more compact overview and with almost identical options.

Please read one of the following two sections depending on your preference:

§ Applying slide transitions via the ribbon tab 

§ Applying slide transitions via the dialog box

Applying slide transitions via the ribbon tab

Switch to the ribbon tab Transition to apply transition effects directly via the ribbon buttons. You can assign
the same transition effect to all slides or select a different effect for each slide.

The following functions are available on the ribbon tab Transition (from left to right):

§ Start preview: This option lets you view the currently applied slide transition in the document window.
(See below for a preview of the applied slide transition in the mini sorter.) 

§ Automatic preview: If you have enabled this option, every effect that you select here on the ribbon tab will
be demonstrated immediately in the slide.

§ Transitions: You can select the desired transition effect in this list. The effects are divided into categories
for the sake of clarity.

Note: The categories starting with "SoftMaker…" provide particularly impressive transitions. However,
please read the "Notes on using the SoftMaker effects" below.

§ Variants: Some transitions also offer several variants, which you can select here. 

§ Dropdown list of the command group Duration: This option determines how fast the slide transition is
played. You can either select one of the presets from the list (slow, medium, fast, etc.), or you can manually
enter a number to specify the duration of the transition in seconds.
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§ Smooth start / Smooth end: Here, you can also specify whether the transition effect should be slowed
down at the start/end, which looks more professional for most effects.

§ Size: For some effects, you can choose whether the animated elements are large, medium or small.

§ Background: For some effects, you can also specify the background color.

§ Sound: Here, you can add a sound effect that will be played during the slide transition. Available options:

No sound: No sound is played. This is the default setting.

Stop previous sound: This option stops whatever sound was playing in the current slide.

Load sound: This option plays the selected sound file. Select the sound file to be played from the list or
click on the File button to specify a sound file on your hard drive.

§ Loop sound: For very short sounds, this option repeats the sound for the duration of the slide transition.

§ Command group Progress: Here, you can set whether the switch to the next slide is triggered after a mouse
click (or keystroke) or whether it takes place automatically after a specified time.

§ Apply to all slides: Click on this button to apply the selected transition to all slides in your presentation.
Otherwise, the transition will only be applied to the previously selected slide(s).

Notes on using the SoftMaker effects

In the dropdown list Transitions , there are several categories that start with "SoftMaker...". These
categories contain particularly impressive slide transitions that use a graphics technology called OpenGL. The
following restrictions apply when you use these effects:

§ Some of the SoftMaker effects can be saved only in Presentations documents. When you save your
presentation as a PowerPoint document, they will be replaced by simple fade effects. 

§ When running a slide show, these effects can only be played accordingly in Presentations but not in
Microsoft PowerPoint.

Alternative method (1): Using the sidebar

Slide transitions can also be applied very conveniently via the sidebar, which is displayed to the right of the
slide by default.

To do so, click on the icon  in the small toolbar above the sidebar. The sidebar now displays a list of all
available slide transitions. Simply click on one of them, and it will be applied to the current slide immediately.

Below this list, you can also set some options for the transitions, just like on the ribbon tab Transition
described above.

For more information on the sidebar, see Using the sidebar.

Alternative method (2): Using the dialog box

You can also apply transitions via the dialog box Slide transition, which has almost identical options for
applying transitions and displays the options in a more compact overview.

For more information, see the next section Applying slide transitions via the dialog box.
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Tip: Using the preview icon in the mini sorter

In the mini sorter, slides that have a transition effect are indicated with a little arrow icon in their top left corner
(see image below). When you click on this icon, you will see a preview of the respective slide transition
executed in the mini sorter.

Applying slide transitions via the dialog box

On the ribbon tab Transition, click on the group arrow  of the command group Transitions. Alternatively,
right-click on the slide to open the context menu and select Slide transition to open the dialog box.

The following dialog box appears...

... in which you can make the following settings:
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§ Effect: You can select the desired transition effect in this list. The effects are divided into categories for the
sake of clarity. 

Note: The categories starting with "SoftMaker…" provide particularly impressive transitions. However,
please read the "Notes on using the SoftMaker effects" below.

Tip: When you select an effect and the option Preview is enabled, Presentations shows you the a preview of
this effect directly in the document window. This lets you determine whether the effect is what you want
before you apply it.

§ Variants: Some transitions also offer several variants that you can select from the list Variants. 

§ Speed: This option determines how fast the slide transition is played. You can either select one of the
presets from the list (slow, medium, fast, etc.), or you can manually enter a number to specify the duration of
the transition in seconds.

§ Acceleration: Here, you can also specify whether the transition effect should be displayed at a constant
speed, or slowed down at the start/end, which looks more professional for most effects.

§ Background: For some effects, you can also specify the background color.

§ Next slide: Here, you can set whether the switch to the next slide is triggered by a mouse click (or
keystroke) or whether it takes place automatically after a specified time.

§ Sound: Here, you can add a sound effect that will be played during the slide transition. Available options:

No sound: No sound is played. This is the default setting.

Stop previous sound: This option stops whatever sound was playing in the current slide.

Play new sound: This option plays the selected sound file. Select the sound file to be played from the list or
click on the File button to specify a sound file on your hard drive.

§ Loop sound: For very short sounds, this option repeats the sound for the duration of the slide transition. 

To apply the selected transition to all slides of your presentation, click on the Apply to all button. If, on the
other hand, you click on the Apply to selection button, the transition effect will only be applied to the
previously selected slide(s).

Notes on using the SoftMaker effects

FreeOffice: SoftMaker FreeOffice does not include all SoftMaker effects.

In the list of available effects, there are several categories that start with "SoftMaker...". These categories
contain particularly impressive slide transitions that use a graphics technology called OpenGL. The following
restrictions apply when you use these effects:

§ The SoftMaker effects can be saved only in Presentations documents. When you save your presentation as
a PowerPoint document, they will be replaced by simple fade effects. 

§ When running a slide show, these effects can only be played accordingly in Presentations but not in
Microsoft PowerPoint. 
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Alternative method: Using the sidebar

In addition to the directly usable buttons of the ribbon tab Transition (see previous section), slide transitions
can also be applied quickly and conveniently via the sidebar, which is displayed to the right of the slide by
default.

To do so, click on the icon  in the small toolbar above the sidebar. The sidebar now displays a list of all
available slide transitions. Simply click on one of them, and it will be applied to the current slide immediately.

Below this list, you can also set some options for the transitions, just like in the above dialog box.

For more information on the sidebar, see Using the sidebar.

Tip: Using the preview icon in the mini sorter

In the mini sorter, slides that have a transition effect are indicated with a little arrow icon in their top left corner
(see image below). When you click on this icon, you will see a preview of the respective slide transition.

Adding object animations
In addition to slide transitions, you can also apply animations to the objects on a slide. Object animations are
visual effects that, unlike slide transitions, are applied to individual objects to emphasize them or make the
presentation more visually appealing. For example, you can show the individual objects of a slide successively
in the slide or let them fly into the slide from different directions.

You can apply animations either to individual objects, to all objects on a slide, or to all objects in the entire
presentation (via predefined "slide animation schemes").

With the commands on the ribbon tab Animation or in the sidebar, Presentations provides a wide range of
different animations from which to choose.

For more information on animations and slide animation schemes, see Animations.
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Using the sidebar
In the previous sections, you learned how to change the layout of slides, apply a different color scheme, etc. In
this section, you will learn about a tool that will help you do all of these tasks much faster and more effectively:
the sidebar.

The sidebar is the small pane that is displayed by default on the far right of the document window.

Tip 1: You can enable or disable the sidebar at any time. To do so, choose the ribbon command View | group
Windows | Sidebar and select whether the bar should be displayed on the left, right or not at all (hidden).

Tip 2: When the sidebar is enabled, it can also be collapsed or expanded by clicking on the narrow vertical
button at the edge of the sidebar. To adjust the width of the sidebar, drag the separator between the sidebar
and the slide to the left or right with the mouse.

A document window with mini sorter (on the left) and sidebar (on the right)

The sidebar can be used to display, for example, all available slide layouts. To change the layout of the current
slide, all you have to do is click on one of the layouts listed in the sidebar. The change will be then be applied
immediately to the slide.

Thus, the sidebar allows you to change the layout of a slide (and many other settings) with a single mouse-click.
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Note: Unlike dialog boxes, the sidebar does not have OK and Cancel buttons. Instead, changes are applied
immediately. However, you can undo inadvertent changes at any time via the command Undo  in the
Quick access toolbar.

Configuring the sidebar

You can use the small toolbar at the top of the sidebar to choose which function the sidebar should currently
have. The following icons are available (from left to right):

Icon Function

Change slide layout. For more information, see Changing the slide layout.

Change slide design. For more information, see Changing slide design.

Change color scheme. For more information, see Applying a color scheme.

Change background. For more information, see Slide background.

Apply slide transition. For more information, see Using slide transitions.

Apply object animations. For more information, see Object animations.

Apply slide animation scheme, see Slide animation schemes.

By clicking on one of these icons, you can change the sidebar function at any time, depending on what you need
at the time.

The toolbar also has a menu that you can expand by clicking on the black arrow to the right of the toolbar. The
menu contains two options that can be used to change the appearance of the toolbar as follows:

§ If you select the option Display as icons, all of the aforementioned functions are displayed side by side as
icons in the toolbar. 

§ If, on the other hand, you select the option Display as list, only the currently selected function is displayed
at the top instead, but all other functions can be accessed via the dropdown menu.
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Adding notes
A useful tool for preparing and giving a lecture are the notes that you can add to your presentations. There is a
separate note page for each slide. You can make any annotations you want – or type in all the text you want to
present. The notes pages can then be printed and used as a "script" for your presentation.

To edit the note page of a slide, choose the command View | group Views | Notes. As shown below, you will
now see a page with a reduced view of the slide and a text box below it. In this text box, you can enter and edit
your notes on the current slide.

To print the notes pages (including a reduced view of the slides), choose the command File | Print and select
Notes under Type in the section Print content.

For information on all other options in the dialog box Print, see Printing a presentation.

Tip: If desired, you can choose a design for your note pages that is different from the current slide design.
For more information, see Notes and handout master.
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Printing handouts
You can print handouts of your presentation and distribute them to your audience. Each page may contain one,
two, three, four, six or nine slides of the presentation in printed form.

In order to print handouts, choose the command File | Print and select Handouts under Type in the section
Print content.

For information on all other options in the dialog box Print, see Printing a presentation.

Note: Handouts are for printing only. There is no corresponding screen view of them. However, you can
change the layout and formatting of handouts at any time via the command View | group Master | Handout
master. For more information, see Notes and handout master.
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Working with masters
As mentioned in the section Changing the slide design, the appearance of a presentation largely depends on the
slide design used in it.

Each slide design consists of several slide layouts, which primarily serve as a "template" for the arrangement of
the placeholders on a slide. (For more information, see also Changing the slide layout.)

If required, you can edit the predefined slide layouts by choosing the Slide master view. In this view, you can
change the master of each slide layout as desired. (In other words, you can edit the slide layouts directly.)

Note: Changes that you make to a slide layout in the master view affect all slides that use this layout in the
current document.

To switch to the master view, choose the command View | group Master | Slide master.

The master view of each slide layout in a slide design

A change is immediately noticeable in this view:

The mini sorter on the left side of the screen no longer displays a list of all slides, but a list of all slide layouts
contained in the current slide design. You can select which slide layout you want to edit by clicking on it in the
list.
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The higher-level entry in the list (for example, Default design or Blue sky here, depending on the slide design)
has a special meaning in that it represents the entire slide design. If you change something in this layout, for
example, set a different slide background, all subordinate slide layouts in the design will inherit this change.

Editing slide layouts

As shown in the figure above, each master for a slide layout usually has the following parts:

§ One or more placeholders 

§ The individual areas of the footer (date area, footer area, etc.)

You can modify these in the slide master as desired, for example, change their position and size.

However, slide layouts not only determine the position and size of the placeholders, but can also contain
numerous other settings – including the slide background, coloring, text formatting, etc. They are practically
templates for the overall appearance of slides.

Thus, there is much more that you can change in the master view than just the arrangement of the placeholders.
In the master view, you can make the following changes:

§ Change the position, size and type of any placeholder/area 

§ Change the character formatting, paragraph formatting and formatting of bulleted lists in a placeholder (For
more information, see section Changing the text formatting in masters.)

§ Adding/removing placeholders

§ Adding/removing other types of objects

§ Changing background, color scheme and slide transition

§ Managing layouts (adding, deleting, renaming, etc.)

§ More commands are available on the ribbon tab Slide master, which is covered in the next section The
ribbon tab "Slide master".

Note: Changes that you make to a slide layout in the master view affect all slides that use this layout in the
current document.

Note, however, that changes you make in the normal slide view always take precedence over changes made
in the master view. If, for example, you set a different background for a certain slide, it will remain the same
even if you subsequently select a different background in the master view.

The ribbon tab "Slide master"
If you switch to the master view with the ribbon command View | group Master | Slide master, an additional
ribbon tab Slide master will automatically appear on the far right. This contains commands that are specifically
responsible for working with the masters for slide layouts.

Before choosing one of its commands, select the slide layout to which you want to apply the command. To do
so, click on the desired layout in the mini sorter (the pane on the left side of the window).
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Note: The higher-level entry (for example, Default design, Blue sky, etc.) in the thumbnail overview
represents the entire design. If you select this entry, some of the commands on the ribbon tab Slide master
change: For example, the command Delete layout  will be replaced by the command Delete design – which
accordingly deletes the entire design, and not just a single slide layout.

The following commands are available on the ribbon tab Slide master:

Ribbon tab "Slide master" (with "Title slide" selected in the master view)

§ New design: With this command, you can create a completely new design – and not just a new slide layout
as with the command Add layout. You can also use multiple designs within a presentation and apply
different designs to different slides. 

Tip: Although it is possible to use several designs within a single presentation, this is not recommended.
Simple, concise presentations are usually more appealing than those with a number of inconsistent
designs.

§ Duplicate layout (or Duplicate design if the higher-level design is selected in the thumbnail overview):
This command creates a copy of the currently selected slide layout/design. 

§ Add layout: Use this command to add a new slide layout to the current design.

§ Delete layout (or Delete design if the higher-level design is selected in the thumbnail overview): This
command deletes the currently selected slide layout/design from the master view.

Note: A final layout/design must always remain and cannot be deleted.

§ Rename layout (or Rename design if the higher-level design is selected in the thumbnail overview): This
command allows you to change the name of the selected slide layout/design.

§ Restore: This command restores parts of the slide layout that you previously deleted (for example,
placeholders).

§ Insert placeholder: This command inserts a new placeholder into the slide layout. (You can change its
position and size by moving the placeholder or by dragging one of its round handles with the mouse).

§ Title and Footers: These commands switch the title placeholder or footers on/off on the current slide layout.

§ Color scheme, Background: These commands enable you to specify the color scheme and background for
the selected slide layout. The changes affect all slides in the presentation that use the corresponding slide
layout.

For more information on how to change these properties, see Changing slide color scheme and background.

Note about the command Background: If an object is added to the higher-level design (for example, Default design, Blue sky, etc.)
in the Master view, you can enable the option Do not display objects from the slide master of the command Background separately
for each subordinate slide layout. The display of objects will then be suppressed on all slides with this slide layout. If an object has

also been added to a single slide layout in the Master view, the display of this object can be suppressed in the normal Slide view via
the command Background.
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§ Page size and Page orientation: These commands allow you to adjust the slide format. The "screen
formats" are automatically set to Landscape format. For all other formats, you can switch the page
orientation between Landscape and Portrait. For more information, see Changing the orientation of slides.

§ Slide transition (only accessible via the context menu or sidebar): This command allows you to specify the
slide transition for the selected slide layout, if required. The changes affect all slides in the presentation that
use the corresponding slide layout.

For information on how to change these properties, see Using slide transitions.

To exit the slide master, click on the Close master  button.

Changing the text formatting in masters
In the master view, the placeholders in the individual slide layouts are usually filled with sample text. This is to
illustrate how text in the corresponding placeholder will look later in the slides of your presentation. You can
change the character format and paragraph format separately in each placeholder. The same applies to the
footer areas, if available. This specified text formatting will then be used on all slides in your presentation that
use the corresponding slide layout.

In order to change the text formatting of a placeholder or footer area, you do not have to select the text it
contains. Simply click in the placeholder/area so that the blinking text cursor appears in it.

Then use the command groups from the ribbon tab Home | group Character (for font, font size, etc.) or Home |
group Paragraph (for indents, tabs, alignment, etc.) to change the format of all text in the area. For more
information on these two commands, see Character formatting and Paragraph formatting.

Changing the formatting of bulleted lists in placeholders

Some placeholders contain a bulleted list, as shown in the picture below. Additional formatting options are
available here.

The bulleted lists in such placeholders are hierarchical. The list thus consists of different list levels, which can
be used to structure the text. Each list level can have a different character formatting and indentation, so that the
individual levels are more distinct:
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In the center: a placeholder with a hierarchical bulleted list

If you enter text for a list entry in the normal slide view and increase or decrease the level of the entry, the font
size and the bullet size change according to the format that you set here in the master view. You can even set
the bullet type and its color for each list level to your liking.

To change the formatting of this bulleted list, first switch to the master view with the ribbon command View |
group Master | Slide master and click in the desired placeholder. You can now change the formatting of each
list layer as follows:

§ Change character formatting: To change the character formatting of a list level, click anywhere within the
text for that level. Then switch to the ribbon tab Home | group Character and change the formatting as
desired. 

Alternatively: Right-click to open the context menu and select the entry Character.

For more information on this dialog box, see Character formatting.

§ Change paragraph formatting: The different list levels are indented differently. You can change these
indents with paragraph formatting. To do so, click again with the mouse button in the respective list level,
then switch to the ribbon tab Home | group Paragraph and make the desired changes. You can change all
other paragraph properties in addition to the indents, of course. 

Alternatively: Right-click to open the context menu and select the entry Paragraph.

For more information on this dialog box, see Paragraph formatting.

§ Change bullets: You can also change the bullets displayed in the list. Right-click in the desired list level,
select the entry Bullets and numberings from the context menu to open the dialog box and make the
desired changes. 

Alternatively: On the ribbon tab Home | group Paragraph | Bullets  or Numbering , you can
directly apply predefined bullets or numbering. (Click on the icon's arrow for the respective dropdown
menu.) The entries Format bullets or Format numbering in these dropdown menus will take you again to the
aforementioned dialog box with additional options.
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Note: By default, the color and size of the bullets are set to Auto in the dialog box. This means that they
automatically adjust to the color and size of the text to the right. However, you can choose a different
color or size at any time, which then cancels this automatic link.

For more information on formatting bullets and numbering, see Bulleted and numbered lists.

Notes and handout master
In the previous sections, you learned about the command View | group Master | Slide master, which enables
you to edit the masters for slide layouts.

Furthermore, there are two additional masters for special tasks:

§ The Notes master determines the appearance of the notes pages in a presentation. 

§ The Handouts master determines the appearance of the handouts for a presentation.

These two masters function in a similar manner to the masters for slide layouts. A master view is available for
each of them. In this view, you can change the placement and formatting of all parts of notes pages or handouts.
These changes will then affect all notes/handouts for the current presentation.

In this section, you will learn everything you need to know about these two types of masters.

Notes master

The master view for notes can be opened with the command View | group Master | Notes master. An
additional ribbon tab Notes master will then automatically appear on the far right. Here, you can specify the
color scheme, background, and page formatting for notes pages (regardless of the slide design).

You can also use the mouse to change the size, position, and formatting of the areas displayed on the notes
master, which include the following areas:

§ Slide area: This is the large area in the top half where a reduced view of the slide appears on notes pages. 

§ Notes area: The area for notes is located below. This area also contains a hierarchical bulleted list as
described in Changing the text formatting in masters.

§ There are also areas for header and date (at the top) and footer and page number (at the bottom). For general
information on headers and footers, see Creating headers and footers.

To edit these areas, use the usual procedures: You can use the mouse to change the position and size, or you can
use the commands of the ribbon tab Home | group Character and group Paragraph, for example, to change
the formatting.

To exit the notes master, click on the Close master  button.

For more information on adding notes to your presentations, see Adding notes.
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Handout master

The master view for handouts can be opened with the command View | group Master | Handout master. An
additional ribbon tab Handout master will then automatically appear on the far right. Here, you can specify the
appearance (color scheme, background and page format) of the "handouts" that you can print for your audience.
Their layout and formatting can be specified in a completely different manner to the design of the slides in your
presentation.

Furthermore, you can use the command Number of pages in the Handout master to specify how many slides
should appear on the handouts, or whether you would prefer to print the outline (title and text content – without
graphic elements) instead of the slides on the handouts.

You can also change the size, position, and formatting of the header and footer areas, as described above for the
Notes Master.

Note: However, the size and position of the slide areas in handouts is predetermined and cannot be changed.

To exit the handout master, click on the Close master  button.

For more information on printing handouts for your presentations, see Printing handouts.
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Working with objects
You can insert different types of objects into your documents – such as pictures, text frames, drawings, etc.

In the following chapter, you will learn everything you need to know about the general use of objects:

§ Objects – basic procedures 

Here, you will learn about basic functions such as inserting, selecting and editing objects. You will also
learn about more unusual options, such as how to hide objects, group them, etc. The other settings that you
will find in the dialog box Object properties will also be explained in a separate section.

There will then be a detailed presentation of the individual types of objects:

§ Text frames 

§ Placeholders

§ Pictures

§ Charts

§ OLE objects

§ Tables

§ Media objects

§ Drawings

Objects – basic procedures
In these sections, you will find basic functions for working with objects:

§ Inserting objects 

§ Selecting objects

§ Changing position and size of objects

§ Rotating and flipping objects

§ Changing the order of objects

§ Creating columns for inner text of objects

§ Duplicating objects

§ Changing the names of objects
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Other less frequently used features for working with objects will be covered in the following sections:

§ Aligning and distributing objects

§ Grouping objects

§ Hiding objects

§ Changing the AutoShape of objects

§ Combining shapes

§ Editing shapes retroactively

§ Adding object actions

The options of the dialog box Object properties will then be explained:

§ Changing object properties via the dialog box

Inserting objects

In order to insert an object (e.g., a picture) into a slide, proceed as follows:

1. Choose the ribbon command Insert | group Objects | Picture frame .

(To do so, click directly on the icon itself or use the icon's arrow and select the entry From file.)

2. A dialog box appears. Select the desired picture file in it and confirm it.

3. The picture frame is now inserted.

You can then move or resize the frame:

To move it, click on the frame with the mouse, and then drag it to the desired location (while still holding
down the mouse button).

To adjust its size, drag one of the round handles surrounding the frame.

The process for inserting other types of objects is similar.

Note: As soon as you have inserted an object, an additional contextual ribbon tab Object (or picture, chart,
etc.) will appear on the far right and will enable you to conveniently edit the object properties via the
corresponding buttons.

For more information on the different types of objects and how to adjust their properties, see Text frames, etc.
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Selecting objects

If you want to edit an object, you must first select it. For most types of objects, it is sufficient to simply click on
the desired object. A frame will then appear around the object to indicate that it is selected.

Note: For objects that are filled with text (for example, text frames), you must click on the border in order to
select the object.

To select several objects at once, use the mouse to draw a frame around the desired objects. Alternatively, you
can click successively on several objects while holding down the Shift keyñ to select them together.

Tip: Use the ribbon command Home | Select all  to select all objects.

Jumping from object to object

If you have selected an object, you can jump between all objects on the slide using the following keys:

Key Result

Tab Selects the next object

Shift+Tab Selects the previous object

Changing position and size of objects

In this section, you will learn how to change the position and size of objects:

Changing the position of objects

To change the position of an object, click on it to select it. You can now either drag it with the mouse to the
desired position or move it with the arrow keys on the keyboard.

You will also find such a handle  on all objects for moving the object with the mouse. This makes it easier
for you to handle small objects.

Alternatively via the dialog box: Right-click on the object to open the context menu and select the last entry
Properties. In the dialog box, switch to the Format tab. You can specify the exact position there.

Tip: To enable or disable positioning aids for accurate object placement, please also read the sections Using
the grid and Using guides.
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Changing the size of objects

The size of an object can be changed as follows:

§ Dragging the handles on the selection frame 

Click on the object to select it. The object will then be surrounded by a blue selection frame which also
contains some round "handles". When you drag one of these handles with the mouse, the size of the object is
changed accordingly.

§ Via the dialog box 

You can also resize objects via the dialog box. Right-click on the object to open the context menu and select
the last entry Properties. On the Format tab, these settings can be specified exactly in numeric values. For
more information on this dialog box, see Object properties, Format tab.

§ Via the ribbon tab 

If you have selected an object, you will also find input fields for the Width and Height in the group Resize
on the far right of the object-specific ribbon tab. Type the desired values here or increase/reduce the values
with the small arrow keys next to the input field.

If the option Keep aspect ratio is enabled, changes in height automatically have a proportional effect on
width (and vice versa).

For OLE objects, an additional option named Keep scaling is available. If it is enabled, any changes made
to the object's size inside its source application will automatically affect the object in Presentations. If it is
disabled, the object will always remain the same size in Presentations. (Note: Not all OLE source
applications support this feature.)

Using rulers

The document window displays two rulers: a horizontal ruler (at the top) and a vertical ruler (on the left).

Tip: With the ribbon command View | Ruler , you can show or hide the rulers.

When you edit text, these rulers display margins, indents, and tabs. Otherwise, the rulers extend to the total size
of your slide and help you determine positions and sizes when you move or resize objects.

The units of measure used by the rulers are inches or centimeters, depending on your computer's regional
settings.

The "origin" of the rulers (the location where the horizontal and vertical rulers intersect) is in the top left corner
of the slide by default. However, you can move the origin anywhere, which can be useful when positioning
objects:

To move the origin, click on the icon  in the top left corner where the rulers intersect, and drag the mouse
cursor to the desired location in the slide while still holding down the mouse button. If you simply click on the
icon, you can switch the origin back and forth between the top left corner and the center of the slide.
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Note: The values for the position of objects that you can view and change in the Object properties dialog box
(on the Format tab) are always calculated from the origin of the rulers. If you move the origin, Presentations
changes these values accordingly. (You open the dialog box by right-clicking on the object and selecting the
last entry Properties in the context menu.)

Preventing changes to the position and size of objects

By locking an object, you can prevent it from being moved or resized with the mouse or the arrow keys on the
keyboard.

Select the object, right-click on it to access the context menu and then select the last entry Properties to open
the dialog box. On the Properties tab, enable the option Locked.

Now the object can no longer be moved with the mouse, and it cannot be resized by dragging its boundary lines.
The object also cannot be moved with the arrow keys of the keyboard. The position and size can only be
changed by entering values in the dialog box.

If you disable the option Locked again, the position and size of the object can also be changed with the mouse.

Rotating and flipping objects

Note: Only text frames, placeholders, drawings and pictures can be rotated and flipped; this is not possible
for other types of objects.

When you select an object that can be rotated, an additional green handle will appear on one of its boundary
lines. If you drag this handle with the mouse, the object will rotate.

Tip: If you hold down the Shift keyñ, the rotation occurs at exactly 22.5° angles.

Furthermore, there are the following ways in which you can also flip (mirror) drawings and pictures in addition
to rotating them:

§ You can use the Rotate object button  on the object-specific ribbon tab. 

Note: An object-specific ribbon tab appears on the far right as an additional tab when you select an object.
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§ You can do so via the context menu (right-click on the object) by selecting the entry Rotate or flip.

§ You can also set the desired rotation angle manually in the dialog box. Right-click on the object to open the
context menu and select the last entry Properties. In the dialog box, switch to the Format tab and enter the
angle in the Rotation section. In the Flip section, you can flip the object vertically or horizontally.

Changing the order of objects

If several objects overlap, you can determine the display order of these objects (which object is in the
foreground, which is in the background, etc.).

To do so, proceed as follows:

1. Right-click on the desired object.

2. Choose the command Order from the context menu. The program opens a submenu with the following
commands:

Bring to front: This option brings the object in front of all other objects.

Send to back: This option sends the object behind all other objects.

Bring forward one level: This option brings the object forward by one level.

Send backward one level: This option sends the object back by one level.

Tip: You can also execute these commands on the object-specific ribbon tab on the far right via the Bring to
front and Send to back buttons (in the group Position).

Creating columns for inner text of objects

Note: You can split the inner text into columns only for AutoShape drawings, Text frames and Placeholders.

If you not only want to arrange your text in an object in sequence, but also side by side, you can split the inner
text into several columns.

Use the ribbon command Columns  on the contextual ribbon tab Object | group Inner text to determine the
number of columns. If you click on the icon's arrow, you can select up to three columns directly from the
dropdown menu.
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If you need more than three columns, select the entry More. This takes you to the dialog box Object
properties, Inner text tab. In the Columns section, you can set both the desired number of columns as well as
the spacing between them.

Alternatively, you can access this dialog box by clicking directly on the icon  itself.

Duplicating objects

To obtain a duplicate of an object, you can copy it to the clipboard in the usual way and then paste it back from
there.

Alternatively, you can also use the Duplicate button  on the object-specific ribbon tab. This command
immediately creates a copy of the selected object.

Note: An object-specific ribbon tab appears on the far right as an additional tab when you select an object.

Tip: Duplicating an object is even faster with the mouse: If you drag an object while holding down the Ctrl
key, you immediately obtain a duplicate of that object.

Changing the names of objects

Every object in a document must have a unique name.

Normally, you do not have to worry about these names as they are automatically assigned by Presentations: If
you insert a rectangle into an empty document, it is automatically called "Rectangle1". If you insert a picture, it
is called "Picture1", the next picture is called "Picture2", etc.

Tip: The name of the currently selected object is displayed on the left in the status bar.

However, you can change the names of objects at any time. To do so, right-click on the object to access the
context menu and select the last entry Properties to open the dialog box. Switch to the Properties tab and
change the entry in the Name field.

Remember that names must be unique. If you attempt to assign a name to an object that is already in use for
another object, Presentations will reject it and display an error message.
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Aligning and distributing objects

To align or evenly distribute objects, select them and click on the Align objects button  on the object-
specific ribbon tab.

Note: An object-specific ribbon tab appears on the far right as an additional tab when you select an object.

If only one object is selected, you can use the command Align Objects to place the object left-aligned, right-
aligned, at the top, bottom or centered on the slide.

If multiple objects are selected, the command Align objects will align or distribute them as follows:

§ Align left: This option aligns objects to the left edge of the object placed furthest left. 

§ Align center: This option aligns the objects horizontally centered to each other.

§ Align right: This option aligns the objects to the right edge of the object placed furthest right.

§ Align top: This option aligns the objects to the top edge of the top object.

§ Align middle: This option aligns the objects vertically centered to each other.

§ Align bottom: This option aligns the objects to the bottom edge of the bottom object.

§ Distribute horizontally: This option distributes objects evenly between the left edge of the object furthest
left and the right edge of the object furthest right.?

§ Distribute vertically: This option distributes objects evenly between the top edge of the top object and the
bottom edge of the bottom object.

The last two commands only work if at least three objects are selected.

Tip: You will also find the commands for aligning and distributing objects in the context menu by right-
clicking on the selected objects and selecting the entry Align or distribute.

Grouping objects

When you group several objects, you combine them into a unit that can be selected and manipulated like a
single object.

In practice, this means the following: If you select an object that belongs to a group, the entire group is always
selected. If you move this object, all objects in the group are also moved.

Grouping also prevents related objects from being inadvertently moved against each other with the mouse.

To group objects, proceed as follows:

1. Select the objects to be grouped.

Note: To do so, click on the objects successively while holding down the Shift keyñ or drag a rectangle
around all objects to be selected (without placeholders) while holding down the mouse button.



114Working with objects

2. Click on the Group icon  (in the group Objects) on the object-specific ribbon tab, or right-click the
selected objects to open the context menu and choose the command Group to group the objects.

Ungrouping objects

To ungroup objects, proceed as follows:

1. Select the group by clicking on one of the objects in it.

2. Click on the Group icon  again or choose the command Ungroup via the context menu.

Hiding objects

If necessary, you can hide an object so that it will not appear on the screen and/or on a printout.

To do so, select the desired object and right-click to open the context menu. Select the last entry Properties to
open the dialog box, switch to the Properties tab and proceed as follows:

§ If you disable the option Visible, the object will no longer be displayed on the screen. 

§ If you disable the option Printable, the object will no longer appear in the printout.

Tip: If you have inadvertently made an object invisible, you can always choose the ribbon command File |
Properties and enable the option Show invisible objects on the View tab. Now all hidden objects are
displayed again. Thus, you can now select the object and enable the option Visible to make it visible again.

Changing the AutoShape of objects

Objects can be replaced afterwards with another shape using the ribbon command Change AutoShape ,
while retaining the existing formatting.

Tip: For more options for changing the shape of objects, see Combining shapes and Editing shapes
retroactively.

Replacing the shape of drawings and text frames

To replace the shape of drawings (AutoShapes, lines, curves, TextArt objects) or text frames with another
shape, proceed as follows:

1. Select the desired object.

2. Click on the Change AutoShape button  (not available in SoftMaker FreeOffice) on the contextual
ribbon tab Object | group Edit.
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Alternatively via the dialog box: Right-click on the object to open the context menu and select the last entry
Properties. In the dialog box, switch to the "AutoShapes" tab.

3. Select the desired new shape in the list.

The contours of the object will then change to the selected shape.

Replacing the shape of pictures

To replace the shape of pictures with another shape, proceed as follows:

1. Select the desired object.

2. Click on the small arrow of the Cropping icon  on the contextual ribbon tab Picture | group Size and
select the entry Change shape in the menu that appears.

Alternatively via the dialog box: Right-click on the object to open the context menu and select the entry
Change shape there.

3. Select the desired new shape from the list.

The contours of the picture frame will then change to the selected shape.

Tip: The command Photo frame  (not available in SoftMaker FreeOffice) on the contextual ribbon tab
Picture | group Format provides another method of changing the shape of pictures. Here, you can choose from

different variants. Some of these variants display handles  that enable you to further adjust certain parameters
of the shape by dragging them. You can also use the small square  in the center to display the shadow with a
varying offset.

Combining shapes

FreeOffice: The Combine objects function is not included in SoftMaker FreeOffice.

Note: This option is only available for drawings and text frames; it is not possible for other types of objects.

In Presentations, you can combine two or more shapes into one overall shape using the command Combine
objects, and different variants of the merge can be selected. This allows you to quickly create individual
drawing objects.

Important: The new overall shape always assumes the formatting of the first selected object.

Proceed as follows:

1. Select two or more objects (drawings/text frames) that you want to combine.

To do so, click on the objects successively while holding down the Shift keyñ.

2. Choose the command Combine objects  (in the group Edit) on the contextual ribbon tab Object.

Alternatively, you will find the command in the context menu after right-clicking on the selected objects.

3. In the command's menu, select the desired variant for combining the objects (see below).
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Variants of the command "Combine objects"

As mentioned at the start, the first selected object is the reference object whose formatting will be applied to the
new overall shape when each variant of the command Combine objects is chosen. This is the fill color, for
example, in the following illustrations.

The following variants are available:

§ Union 

This option creates a new common shape with a consistent outer contour of all selected shapes:

§ Combine 

The non-overlapping parts of the shapes are preserved, while the overlapping areas become transparent:

§ Fragment 

New separate shapes are formed along the intersecting lines of overlapping shapes. These can then be moved
individually – as shown on the far right in the following figure:

§ Intersect 

This is the counterpart to Combine. Only the overlapping area is preserved, and the non-overlapping areas
disappear:
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§ Subtract 

The overlapping areas are removed from the first selected shape, and the following selected shapes
themselves disappear:

You can move the new shape like a "normal" object, resize it, add text to it, etc. There are also black corners or
vertices that allow you to customize the contours of the shape. For more information, see the next section
Editing shapes retroactively).

Editing shapes retroactively

There are several methods of retroactively adjusting the shape of objects:

§ Drawings/text frames can be given a different AutoShape via the ribbon command Change AutoShape 
(in the group Edit). For more information, see Changing the AutoShape of objects. 

§ You can also use the command Combine objects  (in the group Edit) to combine two or more shapes
into one overall shape. For more information, see Combining shapes.

§ Additional handles  are displayed for some types of AutoShapes. If you drag one of these handles, a
parameter controlling the shape of the object is changed. For stars, for example, the length of the points can
be changed, and for rounded rectangles, the rounding of the corners can be changed.

For pictures whose shape has been changed via the ribbon command Photo frame  (in the group
Format), these handles also appear for some variants.

In this section, the command Edit points  is used to describe a very individual method of customizing
certain objects (drawings, text frames or pictures) to your liking – by editing points of the object via the "Bezier
tools". Technically, you use this command to convert an AutoShape into a curve.

FreeOffice: The Edit points function is not included in SoftMaker FreeOffice.

To do so, proceed as follows:

1. Select the object and choose the command Edit points  on the contextual ribbon tab Object | group Edit.

Tip: For pictures, you will find the command only via the context menu. (Right-click on the object.)

After switching to "Bezier Mode" via the command Edit points, you will see small black corners or vertices
on the object's contour line (Note: Bezier mode remains constantly for the object once enabled).

2. Drag the black points via the mouse to change the shape.
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3. Optional: For shapes with curves, a blue line (tangent) with a small square (handle) also appears when you
left-click on one of the black points. Use the mouse to take hold of the blue square in order to change the
angle of inclination and length of the curve. See also the next section "Other options via the context menu".

Note: If you ensure that you are positioned exactly on the points (or the line segments, see below) with the
mouse, the mouse cursor will change to crosshairs .

Other options via the context menu

You will find additional editing options in the context menu by right-clicking on one of the small black points
or on a line segment of the object.

For points, you can choose between the following options in the context menu:

§ Auto point 

The angle and length of the tangent are set to a default value for automatic smoothing. No tangent for
adjusting the angle and length appears accordingly for this option.

§ Straight point

A blue tangent appears. Both tangent halves are firmly connected, by angle and length. If one handle is
moved, the other handle changes analogously in terms of angle and length.

§ Smooth point

A blue tangent appears. Only the angle of the two tangent halves is connected but not the length. If one
handle is moved, the other handle changes analogously in terms of angle. The length (and thus the gradient
of the curve) can be set independently.

§ Corner point

A blue tangent appears. Both tangent halves can be moved independently, both by angle and length.

§ Delete point

This option removes the selected point from the contour line.

For line segments, the context menu provides the following options:

§ Straight segment

The selected line segment between two points is straightened.

§ Curved segment

The selected line segment between two points becomes a curved line.

§ Add point

This option adds another editing point to the selected line segment.

§ Open curve/Close curve

You use Open curve to remove the line segment between two points. The option Close curve closes an
open shape and inserts a new line segment between the open ends.
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The entry Curve properties opens a dialog box where you can edit the properties of the created shape (fill, line
color, etc.) as with any other object. For more information, see Changing object properties via the dialog box.
Many of these options can also be found directly on the contextual ribbon tab Object (or Picture).
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Adding object actions

You can assign an action to an object. This is executed when running the slide show – either when clicking on
this object or when the mouse is positioned over it.

To assign an action to an object, select the desired object.

Then choose the ribbon command Insert | group Links | Actions  (or the ribbon tab Animation | Actions).

The following dialog box appears:

The dialog box has two tabs. The tab Mouse click determines what happens when the object is clicked on with
the mouse. The tab Mouse over determines the desired action when the mouse cursor is moved over the object.
Both tabs have exactly the same options.

Tip: You do not have to select something on both tabs. If, for example, you only want to specify an action
for clicking, then select options only on the Mouse click tab and leave the other tab empty.

In the Type section, you can specify the desired action:

§ None: Do not perform any action. This is the default setting. (The settings in the Effects section will still
work independently.) 
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§ Slide navigation: Jump to another slide. To do so, select the desired slide from the list.

§ Custom slide show: Start a custom slide show. To do this, select the desired slide show from the list. For
information on creating custom slide shows, see Custom slide shows. 

§ URL: Display the specified URL (Internet address or path to a locally stored HTML file). For web pages,
your web browser is automatically started. In the Bookmark input field, you can also enter a bookmark on
the specified web page if desired.

§ File: Display or run the specified file. You can enter either an executable file or a document. The associated
application then starts automatically.

§ E-mail: Send an e-mail. Enter the e-mail address of the recipient and (optionally) the subject.

§ Object action: This option allows you to perform special actions for certain types of objects (for example,
starting the playback of a media object).

The Effects section can be used to add a sound effect and specify whether the object should be highlighted
during the action:

§ No effect: If this option is enabled, no sound is played when you click on the object while running the slide
show. This is the default setting. 

§ Stop previous sound: If this option is enabled, the playback of all currently playing sounds will be stopped
whenever you click on the object while running the slide show.

§ Play new sound: This option plays the selected sound file whenever you click on the object while running
the slide show. Select the sound file to be played from the list or click on the File button to specify a sound
file on your hard drive.

§ Highlight object: If this option is enabled, the object is highlighted in a different color when you click on it
while running the slide show.

Note: The actions on the Mouse over tab work in the same way, but they are triggered as soon as the mouse
cursor is moved over the object (without clicking on it) and not only when you click on the object.
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Changing object properties via the dialog box

The properties of an object include, for example, its size, fill color, borders, etc. These properties can be edited
centrally using the dialog box Object properties.

Note: Many object properties can also be conveniently edited directly via the icons of the contextual ribbon tab
Object (or Picture, Chart, etc.). Information about these ribbon tabs can be found in the respective section of
the corresponding object. However, some other options can only be set via the dialog box.

To change the properties of an object via the dialog box, right-click on the object frame to open the context
menu and select the last entry Properties. A corresponding dialog box appears.

Tip: For most types of objects, you can also open this dialog box quickly by double-clicking on the object (or
its border).

The dialog box has several tabs that you can switch between by clicking on one of the tabs at the top.

You will find detailed information on each tab and the options it contains on the following pages.

Object properties, Format tab

You can use the Format tab to make settings with respect to the format of the object, such as resizing it.

Available options:

§ Size and Scaling sections 

You can resize the object here. To do so, enter the desired Width and Height. Alternatively, you can change
an object's size by specifying the width as a percentage of the original width in Horz. scaling and the height
as a percentage of the original height in Vert. scaling.

If the option Keep aspect ratio is enabled, changes in height automatically have a proportional effect on
width (and vice versa).

There is an additional option named Keep scaling for OLE objects. If this option is enabled, any changes
made to the OLE object's size within its source application automatically affect the object in Presentations.
If it is disabled, the object will always remain the same size in Presentations. (Note: Not all OLE source
applications support this feature.)

§ Position section 

Here, you can set where the object should be placed on the slide. To do so, enter the horizontal and vertical
start point (upper left corner of the object).

Note: The values depend on the origin of the rulers (see Changing position and size of objects).
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§ Rotation section 

Here, you can rotate the object. To do so, enter the angle at which you want to rotate the object clockwise.
(This option is not available for tables, OLE objects and media objects.)

§ Flip section 

Here, you can flip the object horizontally or vertically. (This option is not available for tables, OLE objects
and media objects.)

Object properties, Fill tab

Note: This tab is only available for certain types of objects. For pictures, changes to the fill affect only the
transparent parts of the picture.

You can use the Fill tab to specify with what the object should be filled.

First, select the desired type of fill in the dropdown list Fill type. You can then make various settings for each
fill type.

The following fill types and settings are available:

Tip: You can also apply some of these options directly on the object-specific ribbon tab via the command
Fill color in the group Format.

§ No fill 

If you select the first fill type in the list, the object is not filled and thus remains transparent.

§ Solid color 

This fill type fills the object with a uniform color shade. Select the desired color in the list Colors.

Tip: Color lists only offer a few standard colors, but you can always compose your own colors. To do so,
click on More colors and then proceed as described in Document properties, Colors tab.

If desired, you can also use the option Transparency to change the transparency of the fill. You can enter
any value between 0% (no transparency) and 100% (full transparency). If, for example, you set the
transparency value to 25, the fill will have 25% transparency.

§ Pattern 

This fill type fills the object with a pattern. In the list Patterns, select the type of pattern and then set the
desired color for the foreground and background.

If desired, you can also use the option Transparency to change the transparency of the fill. You can enter
any value between 0% (no transparency) and 100% (full transparency).

§ Picture 

This fill type fills the object with a picture file. You can use the Open button to determine the picture file
which you want to use for the fill. The most recently used picture files are displayed in the list Pictures and
can be selected there by clicking on them with the mouse.
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Additional options:

Rotate with object: If you enable this option, the picture will also be rotated whenever you rotate the object
to be filled.

Mirror type: This option allows you to mirror the picture horizontally or vertically.

Transparency: If desired, you can use this option to change the transparency of the fill. You can enter any
value between 0% (no transparency) and 100% (full transparency).

Tile as texture: If this option is enabled, the picture is repeated in the object like a tile pattern.

You can then use the settings in the Tile options section to change the size and position of the tiles: X scale
and Y scale change the size (in percent), while X offset and Y offset change the position. The option
Alignment can be used to determine to which edge of the object the tiles should be aligned.

If the option Tile as texture is disabled, only Offsets (relative to the edges of the object) can be set for the
picture.

Save: You can use this button to export the currently selected picture, thus save a copy of it under any name
on your hard disk.

§ Linear gradient, Rectangular gradient, etc. 

The bottom five fill types are different types of color gradients. First, select the desired type of gradient in
the dropdown list Fill type and then select one of the subtypes in the list Variants.

In the Options section, you can specify the appearance of the gradient even more precisely:

X offset and Y offset enable you to move the center of the gradient. The Angle option allows you to set the
angle of rotation.

Tip: You can also change these settings by using the mouse to move or rotate the cross-hair displayed in
the Sample field.

If you enable the option Double gradient, for example, a black-white gradient will become a black-white-
black gradient.

In the Colors section, you can change the colors for the gradient as follows:

To change a color, first click on one of the small triangles below the bar representing the gradient. The left
triangle stands for the initial color, while the right triangle stands for the final color:

Then select the desired color from the dropdown list Color below.

You can use the option Transparency to change the transparency of the selected color if desired. You can
enter any value between 0% (no transparency) and 100% (full transparency).

Additional colors can be added to the gradient by double-clicking on the desired position in the bar and
selecting a color. In the same way, namely by double-clicking on the triangle, additional colors can also be
deleted from the gradient.
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Object properties, Lines tab

Note: This tab is only available for certain types of objects.

Use the Lines tab to specify the type of lines to use for the object. For drawings, this applies to the lines used to
draw the object; for all other objects, it applies to the lines that border the object.

Available options:

Tip: Many of these options can also be found directly on the object-specific ribbon tab in the command
group Format.

§ Variants 

Here, you can select the desired line style.

The entries in this list are merely default variants. If required, you can specify the appearance of the lines
more precisely via the options of the dialog box.

§ Color 

This option lets you specify the color of the lines.

§ Dashed 

Here, you can specify whether solid or dashed lines should be used.

§ Thickness 

Here, you can specify the exact thickness of the lines (in points).

§ Transparency 

If desired, you can use the option Transparency to change the transparency of the lines. You can enter any
value between 0% (no transparency) and 100% (full transparency).

§ Start point and End point (only available for lines, curves and connectors) 

Here, you can specify whether an icon should be drawn at the start point or end point of the line. If, for
example, you select an arrow icon for the end point, the line will look like an arrow. If necessary, you can
also change the Width and the Height of the icon.

Object properties, Shadow tab

Note: This tab is only available for certain types of objects.

Use the Shadow tab to add a shadow to the object.

Available options:
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Tip: You can also apply many of these options directly on the object-specific ribbon tab via the command
AutoShape effects in the group Format.

§ Variants 

Here, you can select the desired type of shadow.

The entries in this list are only default variants; the other options in the dialog box allow you to specify the
appearance of the shadow even more precisely if necessary.

§ Scaling 

Here, you can change the size of the shadow (relative to the size of the object).

§ Offset 

Here, you can change the position of the shadow (relative to the object).

§ Perspective 

Here, you can change the Skew angle of the shadow.

For certain variants of the "Perspective shadows" type, the Horizon can also be changed, which distorts the
shadow in terms of perspective. If Horizon is a positive value, the shadow is in front of the object; if it is
negative, the shadow is behind the object.

§ Color 

Here, you can change the color of the shadow.

§ Blur 

If you enter a value greater than zero here, a blur effect is added to the shadow. The larger the value, the
softer the edges of the shadow are drawn.

§ Transparency 

Here, you can change the transparency of the shadow. You can enter any value between 0% (no
transparency) and 100% (full transparency). If, for example, you set the transparency value to 25, the
shadow will have 25% transparency.

Object properties, 3D tab

Note: This tab is only available for text frames and drawings.

Use the 3D tab to add a three-dimensional effect to the object.

Select the desired type of 3D effect in the Variants section. The entries in this list are only default variants; the
other options on the 3D tab allow you to specify the appearance of the effect even more precisely if required.

In the preview field Sample, you can follow the result of your adjustments and finally confirm with OK if you
want to apply the settings.
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Object properties, Effects tab

Note: This tab is only available for certain types of objects.

On the Effects tab, you can add various effects to the object.

The following effects and options are available:

§ Reflection 

If you enable the option Use reflection effect, the object is displayed as if it was located on a reflective
surface. The following variations are possible:

Visible part of object: This option specifies how much of the object should be visible in the reflection (in
percent).

Starting transparency: The reflection is softly faded out downwards. This value determines how
transparent the reflection should be at the top (in percent).

Y offset: This option moves the reflection upwards or downwards.

§ Soft edges 

If you enable the option Use soft edges effect, the borders of the object will be given a blur effect. The
following variations are possible:

Width: This option specifies the width of the blur effect.

§ Glow 

If you enable the option Use glow effect, the borders of the object will be surrounded by a glow effect. The
following variations are possible:

Width: This option specifies the width of the glow effect.

Color: This option specifies the color of the glow effect.

Object properties, Properties tab

On the Properties tab, you can change the general settings for an object.

Available options:

§ Name 

Presentations automatically assigns a unique name to every object in a document. For example, rectangles
are called rectangle1, ...2, ...3, etc. If desired, you can enter another name here.

Tip: The name of the currently selected object is displayed on the left in the status bar.

For more information on using names for objects, see Changing the names of objects.
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§ Visible 

This option is enabled by default. It causes the object to be displayed on the screen. If you disable this
option, the object becomes invisible (even when running the slide show). For more information, see also
Hiding objects.

§ Printable 

This option is enabled by default. If you disable this option, the object will not be printed. For more
information, see also Hiding objects.

§ Locked 

If you enable this option, the size of the object and its position cannot be changed with the mouse or
keyboard. Position and size can then only be changed by entering values in this dialog box (Object
properties, Format tab).

In the case of pictures, the file name of the picture is displayed at the bottom of the dialog box, while some
information about the picture that was used (resolution, color depth, etc.) is shown in the right half of the dialog
box.

Object properties, AutoShapes tab

Note: This tab is only available for text frames, placeholders, pictures and AutoShape drawings.

On the AutoShapes tab, you can assign an AutoShape to the object. Thus, you can turn a rectangle into a
speech balloon or any other shape you like, for example.

To change the shape, simply click on the desired AutoShape in the list.

Tip: You will also find this option as the command Change AutoShape directly on the contextual ribbon tab
Object. For more information, see Changing the AutoShape of objects.

For more information on AutoShapes, see Inserting drawings.

Additional tabs

There are additional tabs with more options for some object types. For information on these tabs, see the
section on the relevant object.
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Changing the default settings for objects

You can change the default settings for objects (drawings, pictures, etc.) at any time. This is particularly
relevant for drawings (AutoShapes and lines). For certain other objects, there are restrictions on applying the
default settings.

If, for example, you don't like the default line thickness for drawings, simply set it to a different value. You can
also alter other default settings – for example, the default fill for drawings as well as the settings for shadows
and 3D effects.

Note: Changes to the default settings for objects only affect objects that you insert afterwards. Existing
objects remain untouched.

To change the default settings for objects, use the Set as default button in the dialog box Object properties.

For example, the default line thickness for drawings can be changed as follows:

1. Insert a new drawing (or click on an existing drawing).

2. Right-click on the object to access the context menu and select the last entry Properties to open the dialog
box.

3. Make the desired settings. To change the default setting for the line thickness, for example, switch to the
Lines tab and simply set the desired line thickness.

4. Important: Click on the Set as default button and not on OK.

5. The program displays another dialog box in which you can also limit which default settings should be
changed if necessary. As a rule, there is no need to change anything in this dialog box.

6. If you confirm with OK, the settings currently made in the dialog box will be set as the default settings for
new drawings.

7. Confirm again with OK to exit the dialog box completely.

All drawings that you insert from now on will use the line thickness set in this way by default.

Note: The default settings for objects can be set separately for each document.

This concludes the general description of objects. The following sections present the various types of objects in
detail:

§ Text frames 

§ Placeholders

§ Pictures

§ Charts

§ OLE objects

§ Tables
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§ Media objects

§ Drawings



131Working with objects

Text frames
You can use text frames to insert additional text boxes into a slide. You can enter, edit and format text as
desired in a text frame.

Note: Text frames, by the way, are just AutoShapes (in this case, simple rectangles) to which text has been
added.

In this section, you will learn everything you need to know about working with text frames. The information
covers the following topics:

§ Inserting text frames 

§ Changing text frame properties via the ribbon tab

§ Changing text frame properties via the dialog box

§ Changing the text area

See the following pages for more information.

Inserting text frames

To insert a text frame, proceed as follows:

1. Choose the ribbon command Insert | group Objects | Text frame .

2. The text frame is now inserted.

You can then move or resize the text frame:

Important: Click with the mouse on the border of the text frame in order to move it. While still holding the
mouse button down, drag the text frame to the desired position.

To adjust its size, drag on one of the round handles surrounding the frame.

The text frame is now created, and you can start entering text in it immediately.

Changing text frame properties via the ribbon tab

Numerous properties of text frames can be changed directly via the buttons of the contextual ribbon tab Object.
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The contextual ribbon tab "Object", left section

The contextual ribbon tab "Object", right section

This ribbon tab appears automatically when you select a text frame by clicking on its border. It contains the
following buttons (from left to right):

§ New object: This option allows you to insert a new object into the document and different object types are
available. 

§ AutoShape: This option allows you to insert a new AutoShape into the document.

§ Lines: This option allows you to insert simple lines, curves and also connectors (which you can "dock" to the
text frame) into the document.

§ AutoShape templates (not included in SoftMaker FreeOffice): This option allows you to apply various
predefined color formats to the text field.

§ AutoShape effects (not included in SoftMaker FreeOffice): Here, you can apply effects such as shadows,
reflections, etc. This option largely corresponds to the options of the tabs Shadow, 3D and Effects of the
dialog box "Object properties". For more information, see the next section.

§ Fill color: The fill can be changed here. For more information, see Object properties, Fill tab.

§ Line color, Line style, Line thickness, Line endings: These options allow you to edit borders for the text field or
the inserted lines. For more information, see Object properties, Lines tab.

§ Change AutoShape (not included in SoftMaker FreeOffice): This option allows you to assign a different
AutoShape to the text frame (formatting is retained). For more information, see Changing the AutoShape of
objects.

§ Edit points (not included in SoftMaker FreeOffice): This option allows you to give the text frame an
individual shape with the "Bezier tools". For more information, see Editing shapes retroactively.

§ Combine objects (not included in SoftMaker FreeOffice): This option allows you to combine two or more
shapes from different variants into one overall shape. For more information, see Combining shapes.

§ Text rotation: This option allows you to rotate the inner text by the specified angle.

§ Vertical alignment: This option determines how the inner text should be aligned between the top and bottom
edges of the frame.
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§ Change text area (not included in SoftMaker FreeOffice): This option allows you to adjust the size of the
inner text area. For more information, see Changing the text area.

§ Columns: This option allows you to split the inner text into several columns. For more information, see
Creating columns for inner text of objects.

§ Bring to front, Send to back: These options allow you to arrange the order of overlapping object frames. For
more information, see Changing the order of objects.

§ Rotate object: This option allows you to rotate the text frame in 90° increments or flip it
vertically/horizontally. For more information, see Rotating and flipping objects.

§ Align objects: This option allows you to align or evenly distribute two or more object frames. For more
information, see Aligning and distributing objects.

§ Group: This option allows you to combine several selected objects into one unit, which can then be treated
like a single object. For more information, see Grouping objects.

§ Duplicate: This option creates an immediate copy of the selected object.

§ Reset placeholder: This option allows you to restore the original properties of a placeholder after you have
selected it. For more information, see Resetting placeholder properties.

§ Width, Height: These options change the size of the object. For more information, see Changing position and
size of objects.

Many (but not all) of these functions and some additional options can be found in the dialog box Object
properties, which you can access, for example, via the context menu. For more information, see the next
section.

Changing text frame properties via the dialog box

To edit the properties of a text frame via the dialog box, first select it. To do so, click on the border surrounding
the text frame. Then right-click to open the context menu and select the entry Properties, whereupon a
corresponding dialog box appears.

Also possible: Click on the group arrow  in the bottom right corner of any command group of the ribbon tab
Object.

Tip: You can also open this dialog box by double-clicking on the text frame.

The following settings can be made in this dialog box:

Format, Fill, Lines tabs, etc.

These tabs are available for almost all object types. They allow you to change the following settings:

§ Format: On this tab, you can change the size and position of the object. For more information, see Object
properties, Format tab. 
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§ Fill: This option allows you to change the fill. For more information, see Object properties, Fill tab.

§ Lines: This option allows you to apply border lines. For more information, see Object properties, Lines tab.

§ Shadow: This option allows you to apply a shadow. For more information, see Object properties, Shadow
tab.

§ 3D: This option allows you to apply a 3D effect. For more information, see Object properties, 3D tab.

§ Effects: This option allows you to apply different effects. For more information, see Object properties,
Effects tab.

§ Properties: This option allows you to change general settings. For more information, see Object properties,
Properties tab.

In the case of text frames, there are two additional tabs with further options:

Inner text tab

You can use this tab to change settings for the text in the text frame.

Available options:

§ Inner margins section 

Here, you can change the margins between the text frame and the text it contains. If you enable the option
Automatic, Presentations will automatically determine suitable margins.

§ Columns section 

You can split the text within the text frame into several columns. Enter the Number of columns and the
Spacing between the columns.

§ Rotate by... section 

Here, you can rotate the text by the specified angle.

§ Vertical alignment section 

This setting determines how the inner text should be aligned between the top and bottom edges of the frame:

Option Explanation

Top The text is aligned to the top edge of the frame. (This is the default setting.)

Centered The text is centered between the top and bottom edges of the frame.

Bottom The text is aligned to the bottom edge of the frame.

§ Autofit options section 

The following settings can be made here:

Resize shape to fit text: When this option is enabled, the size of the text frame automatically adapts to the
amount of text it contains. If, for example, you enter more text than the text frame can hold, the text frame
will expand automatically.
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Wrap text in shape: This option determines whether the text in the text frame should be wrapped
automatically. When you disable this option, the text will always be displayed in one single line, regardless
of its length.

AutoShapes tab

A text frame is actually an AutoShape that has been filled with text. AutoShapes are predefined shapes (such as
rectangles, ellipses, arrows, speech bubbles, etc.).

By default, a simple rectangle is used as an AutoShape for text frames. However, you can assign a different
AutoShape to the text frame at any time. Simply select the desired shape from the AutoShapes tab.

For more information on AutoShapes, see Drawings.

Changing the text area

FreeOffice: The Change text area function is not included in SoftMaker FreeOffice.

For text frames and also for drawings to which text has been added (see Drawings), you can resize the text area
for the inner text in Presentations.

To do so, proceed as follows:

1. Click on the frame of the object to select it.

2. Choose the command Change text area  on the contextual ribbon tab Object | group Inner text (or via
the context menu by right-clicking on the text frame).

Note: For drawings (AutoShapes, curves, etc.), you must first add text to the shape so that you can use the commands for the inner
text.

3. The frame of the inner text is now selected and some round navy "handles" appear. Drag one of these
handles via the mouse to resize the text area.

When your adjustments are complete, choose the command Change text area again or simply click anywhere
in the document.

Placeholders
When you create a new presentation, the first slide displays two areas containing dashed borders for entering
text. These areas are called placeholders.

Every time you add another slide to your presentation, the program displays a dialog box in which you can
select the desired slide layout. These layouts differ in the type, number and arrangement of the placeholders
used.
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The following types of placeholders are available in Presentations' slide layouts:

§ Title placeholders 

Title placeholders are used to enter a title for the slide. They can be filled with text only. Most slide layouts
contain a title placeholder at the top of the slide.

§ Generic placeholders 

Generic placeholders are provided for the actual content of the slide. They can either be filled with text or
with an object (table, picture, chart, media object or OLE object). Virtually all slide layouts contain one or
more generic placeholders of different sizes and arrangements.

§ Special placeholders 

Special placeholders are a special case: They are not used in Presentations' slide layouts but are found in
older PowerPoint files. Special placeholders can only be filled with one specific object type. There are, for
example, picture placeholders (for pictures only), table placeholders (for tables only), etc.

See the following pages for more detailed information on working with placeholders. The information covers
the following topics:

§ Inserting placeholders 

§ Editing placeholders

§ Changing placeholder properties

§ Resetting placeholder properties

§ Restoring deleted placeholders

Inserting placeholders

Unlike all other object types (picture frames, text frames, etc.), placeholders cannot be inserted directly into a
slide.

Placeholders are provided only via Presentations' predefined slide layouts that you can apply to a slide. Each
slide layout contains a different number and arrangement of placeholders.

To change the layout of a slide, choose the ribbon command Design | group Design | Layout  and select the
desired layout.

For more information, see Changing the slide layout.

Editing placeholders

In this section, you will learn how to insert content into the different types of placeholders and how to edit
them.
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Title placeholders

Title placeholders can be filled with text only. Almost all slide layouts contain a title placeholder for the slide
title at the top of the slide.

A title placeholder

A title placeholder is an area marked by a dashed border that contains the text "Click to add title". To enter text,
simply click in the predefined text. This will then disappear and you can start typing immediately.

Tip: When entering text into placeholders, you can use the key combination Ctrl+¿ to move the text cursor
to the next placeholder and Ctrl+Shift+¿ to move it to the previous placeholder.

Generic placeholders

Generic placeholders can be filled with either text or an object (table, picture, chart, media object or OLE
object). They are thus the most versatile type of placeholders. Virtually every slide layout contains one or more
generic placeholders in different arrangements.

A generic placeholder

To add content to a generic placeholder, proceed as follows:

§ In order to add text to a generic placeholder, click on the "Click to add text" prompt displayed in it and just
start typing. 

Note: Unlike text frames, text in placeholders is formatted as a bulleted list by default. You can simply
type in text and press Enter¿ for each new entry, whereupon each paragraph you enter is automatically
provided with a bullet. For more information on working with bulleted lists, see Bulleted and numbered
lists.

§ To fill the placeholder with an object instead of text, click on one of the icons in the center of the
placeholder. The icons can be used to insert the following types of objects (from left to right): 

Table: Use this icon to insert a table. After clicking on this icon, you will be prompted to enter the number
of rows and columns for the table.

Picture: Use this icon to insert a picture. After clicking on the icon, the program displays a dialog box in
which you can select the desired picture file.

Chart: Use this icon to insert a chart. After clicking on the icon, the program displays a dialog box in which
you can set up the chart. For more information, see Charts.
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Media object*: Use this icon to insert a movie clip or a sound. After clicking on the icon, the program
displays a dialog box in which you can select the desired movie or sound file.

OLE object: Use this icon to insert an OLE object (available on Windows only). After clicking on the icon,
the program displays a dialog box prompting you to either create a new OLE object or to insert an existing
file.

* Movies can only be inserted and played on Windows and macOS. Sounds are only possible on Windows, macOS and Android/iOS.

Special placeholders

In Presentations and in PowerPoint 2007 and later, most content placeholders are generic placeholders with the
aforementioned properties.

In older PowerPoint versions (2003 and older), however, there were no generic placeholders but only
placeholders that could only be filled with one object type – which are known as special placeholders.

For compatibility reasons, Presentations also supports this type of placeholder, of course. You can thus easily
open, edit and save older PowerPoint files that contain such placeholders. However, the slide layouts included
with Presentations do not use special placeholders.

A picture placeholder

To add content to special placeholders, follow the instructions given inside the placeholder. For example, the
text "Double-click to add picture" is displayed in a picture placeholder. When you do so, the program opens a
dialog box in which you can select a picture file.

Changing placeholder properties

To change the properties of a placeholder, select it by clicking on its border.

Then select your preferred path (ribbon commands or dialog box) from the following options for editing it:

Changing placeholder properties via the ribbon tab

If you want to edit the placeholder directly via the ribbon buttons, switch to the contextual ribbon tab that
appears as a tab on the far right as soon as a placeholder is selected. You will find numerous commands
intuitively arranged here, but some additional options can only be accessed via the dialog box (see below).

The options of the displayed ribbon tab depend on the content of the placeholder. For more information on each
option, see the following sections:
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Content See section...

Text Changing text frame properties via the ribbon tab

Table Ribbon tab "Table"

Picture Changing picture properties via the ribbon tab

Chart Editing charts

Media object Changing the properties of media objects

OLE object Changing OLE object properties via the ribbon tab

Changing placeholder properties via the dialog box

If you would prefer to edit the placeholder via the dialog box, right-click to open the context menu and select
the last entry Properties.

The options of the displayed ribbon tab depend on the content of the placeholder. For more information on each
option, see the following sections:

Content See section...

Text Changing text frame properties via the dialog box

Table Formatting tables

Picture Changing picture properties via the dialog box

Chart Changing chart properties via the dialog box

Media object Changing the properties of media objects

OLE object Changing OLE object properties via the dialog box

Resetting placeholder properties

Since each slide layout has predefined placeholders, the original properties of a placeholder can be restored at
any time. To do so, select the placeholder.

Then choose the ribbon command Design | group Placeholders | Reset placeholder .

Tip: Alternatively, you will also find the command in the context menu or on the contextual ribbon tab Object, which appears as a tab
on the far right.

Then select one of the following options:



140Working with objects

§ Reset object properties: This option resets the object properties of the placeholder to the original state
(except text formatting, size and position). 

§ Reset text properties: This option resets all character and paragraph formatting for the placeholder.

§ Reset size and position: This option resets the size and the position of the placeholder.

§ Reset all properties: This option resets all three of the aforementioned properties (object properties, text
properties, size and position). For more information, see also Resetting slides.

Deleting and restoring placeholders

You can delete a placeholder like any other object by selecting it and then pressing the Del key. Alternatively,
you can right-click on the placeholder to open the context menu and select Delete here.

If you choose the ribbon command Design | group Placeholders | Restore , all placeholders that you have
deleted in the current slide will be restored with their original properties (size, position, formatting).

This command is available only if placeholders were actually deleted from the slide.

For more information, see also Resetting slides.
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Pictures
Presentations allows you to easily insert pictures into your slides.

In this section, you will learn everything you need to know about working with pictures. The information covers
the following topics:

§ Inserting pictures 

§ Inserting a photo album

§ Scanning pictures

§ Inserting pictures from the gallery/camera (Android and iOS)

§ Changing picture properties via the ribbon tab

§ Changing picture properties via the dialog box

See the following pages for more information.

Inserting pictures

To insert a picture into a slide, proceed as follows:

1. Choose the ribbon command Insert | group Objects | Picture frame .

(To do so, click directly on the icon itself or use the icon's arrow and select the entry From file.)

2. A dialog box appears. Select the desired picture file in it and confirm it.

3. The picture is now inserted.

If you want, you can then move or resize the picture:

To move it, click on the picture with the mouse, and then drag it to the desired location (while still holding
down the mouse button).

To adjust its size, drag on one of the round handles surrounding the picture.

Options of the dialog box

The options in the above dialog box mean the following:

§ Save within document 

If this option is enabled, Presentations saves a copy of the picture in the document and uses this copy instead
of the original.

If it is disabled, Presentations saves only a reference to the original picture file in the document.
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Note: Saving pictures within the document may significantly increase the file size of the document.

§ Copy to document's folder 

If this option is enabled, Presentations creates a copy of the picture file in the folder where the document is
located and uses this copy instead of the original.

This option is available only if the document has already been saved.

Inserting a photo album

FreeOffice: The Insert photo album function is not included in SoftMaker FreeOffice.

With the ribbon command Insert | group Slide | Photo album , you can insert several picture files into your
presentation at once.

A new slide will be created for each picture file. If desired, borders and captions can be added to the pictures.
This allows you to create an attractive slide show from a collection of pictures with minimal effort.

Proceed as follows:

1. Go to the slide where you want to start inserting the pictures.

2. Choose the ribbon command Insert | group Slide | Photo album . A corresponding dialog box then
appears.

3. First, specify which pictures are to be inserted.

To do so, click on the Add button. A file dialog appears. Use it to switch to the folder that contains the
pictures, and select all the pictures which you want to insert.

Tip: You can select an entire range of files in the file dialog by clicking on the first file and then clicking on
the last file while holding down the Shift keyñ. You can add or remove individual files by clicking on them
while holding down the Ctrl key.

4. When the desired picture files are selected, confirm with Open.

5. Specify the appearance of the slides to be inserted by setting the other options in the dialog box as desired
(see below).

6. Confirm with OK.

The selected pictures are now inserted accordingly.

Options of the dialog box

The options in the dialog box for this command have the following functions:

§ List Pictures 

Here, you specify which graphic files are to be inserted.
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To add more pictures to the list at any time, click on the Add button and proceed as described above.

To remove pictures from the list, select them and click on the Remove button.

You can use the arrow buttons (to the right of the list) to change the order of the pictures. If, for example,
you select a picture in the list and click on the down arrow, the picture will be moved down by one position.

§ Layout 

Use this option to specify the layout of the slides that will be created for each picture:

Fit to slide: This option scales the picture exactly to the height (or width) of the slide.

Picture only: This option scales the picture so that it covers a large part of the slide, but still leaves margins.

Title and picture: This option is like the previous option except an empty title placeholder is inserted above
the picture (where you can subsequently enter text).

§ Decoration 

Use this option to specify whether the pictures are to be decorated with a border or shading.

§ Caption 

Use this option to specify whether the pictures are to be labeled with their file name. This is then inserted as
a text frame below the picture.

§ Save pictures in document 

If this option is enabled, Presentations saves copies of all the pictures used in the document and uses the
copies instead of the originals. If it is disabled, Presentations only saves references to the original picture
files in the document.

§ Buttons below the Preview 

You can use the buttons below the preview of the current picture file to perform various types of
manipulations on the pictures that are to be inserted. Your changes will be applied only to the current
presentation; they will not be saved in the original picture files.

First, select the desired picture in the list Pictures. You can also select several pictures at once (using the
Ctrl or Shiftñ keys).

From left to right, these buttons have the following functions:

Rotate 90 degrees clockwise

Rotate 90 degrees counter-clockwise

Increase brightness

Decrease brightness

Increase contrast

Decrease contrast

Reduce colors to grayscale

Use the original colors of the picture

Discard any changes made with the above buttons
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Scanning pictures

FreeOffice: Scanning pictures directly into a document is not included in SoftMaker FreeOffice.

Note: Scanning pictures directly into a document is possible only with the Windows version of
Presentations.

With Presentations for Windows, you can scan originals directly into a document. You must have connected a
scanner to your computer and installed the corresponding software.

To scan something into the current document, proceed as follows:

1. Turn on the scanner and insert the original that is to be scanned.

2. On the ribbon tab Insert | group Objects | Picture frame , click on the arrow of the icon and select the
entry From scanner from the dropdown menu.

Presentations now enables your scanner's software. Make the desired settings (see scanner manual) and start the
scanning process. When this is complete, the scanned result will appear as a picture in the Presentations
document.

Selecting another source

If several scanners are connected to your PC, you can use the command Insert | Picture frame  | Select
source to decide from which of these sources you want to scan when you use the command Insert | Picture

frame  | From scanner.

Inserting pictures from the gallery/camera (Android and iOS)

Note: This function is available only in the Android and iOS version.

With the Android/iOS version, you can also insert pictures via the Gallery or Camera application on your
device.

To do so, proceed as follows:

Inserting a picture from the gallery

1. Choose the command Insert | group Objects | Picture frame  | From gallery.

2. Your Android/iOS device automatically opens its Gallery app. Select the desired picture by tapping on it.

The picture is now inserted.
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Inserting a picture from the camera

1. Choose the command Insert | group Objects | Picture frame  | From camera.

2. Your Android/iOS device automatically opens its Camera app. Take a picture.

The picture is now inserted.

Changing picture properties via the ribbon tab

Numerous properties of pictures can be changed directly via the buttons of the contextual ribbon tab Picture.

The contextual ribbon tab "Picture", left section

The contextual ribbon tab "Picture", right section

This ribbon tab appears automatically when you select a picture. It contains the following buttons (from left to
right):

§ New object: This option allows you to insert a new object into the document and different object types are
available. 

§ Cropping: You can enable/disable crop mode via this button. In this mode, additional handles appear on the
borders of the picture. Drag these handles with the mouse to crop the picture accordingly. To exit the mode,
click on the button again. You can also use the button's small arrow to select a cropping from different
shapes or to remove the cropping.

For more information, see also the next section ("Picture tab" in the dialog box).

§ Brightness, Contrast, Saturation: Drag the slider or click on    and   to change the respective values for
the picture. For more information, see also the next section ("Picture tab").

§ Recolor picture: This option provides a list of predefined variations of the picture – for example, other color
modes (grayscale, black/white, etc.) and variations where the image was colored. For more information, see
also the next section ("Picture tab").
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§ Change source: Replace the picture with another one (formatting is retained).
 This corresponds to the File button in the dialog box. For more information, see next section ("Picture
tab").?

§ Reset: Reset the image-specific changes made to the picture, such as brightness, shading, rotate object, etc.,
to their default values. The non-image-specific settings are not reset, for example, line thickness and photo
frames.

§ Photo frame (not available in SoftMaker FreeOffice): This option allows you to apply a photo frame effect to
a picture.

§ AutoShape effects (not available in SoftMaker FreeOffice): Here, you can apply effects such as shadows,
reflections, etc. This option largely corresponds to the options of the tabs Shadow, 3D and Effects of the
dialog box "Object properties". For more information, see the next section.

§ Fill color: The fill can be changed here. For more information, see Object properties, Fill tab.

§ Line color, Line thickness: These options allow you to apply border lines. For more information, see Object
properties, Lines tab.

§ Bring to front, Send to back: These options allow you to arrange the order of overlapping object frames. For
more information, see Changing the order of objects.

§ Rotate object: This option allows you to rotate a picture in 90° increments or flip it vertically/horizontally.
For more information, see Rotating and flipping objects.

§ Align objects: This option allows you to align or evenly distribute two or more object frames. For more
information, see Aligning and distributing objects.

§ Group: This option allows you to combine several selected objects into one unit, which can then be treated
like a single object. For more information, see Grouping objects. 

§ Duplicate: This option allows you to create an immediate copy of the selected picture.

§ Width, Height: These options change the size of the picture. For more information, see Changing position and
size of objects.

Many (but not all) of these functions and some additional options can be found in the dialog box Object
properties. You open the dialog box by double-clicking on the picture. For more information, see the next
section.

Changing picture properties via the dialog box

The properties of an object can be edited centrally using the dialog box Object properties. An object's
properties include, for example, its size, margins and numerous other settings options.

To edit the properties of a picture, right-click on the picture to open the context menu and select the entry
Picture: Properties, which opens the corresponding dialog box.

Also possible: Click on the group arrow  in the bottom right corner of any command group on the contextual
ribbon tab Picture.
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Tip: You can also open this dialog box by double-clicking on the picture.

The following settings can be made in this dialog box:

Format, Fill, Lines tabs, etc.

These tabs are available for almost all object types. They allow you to change the following settings:

§ Format: Here, you can change the size and position of the picture and rotate it. For more information, see
Object properties, Format tab. 

§ Fill: This option allows you to change the fill. It is only visible for pictures with transparent areas. For more
information, see Object properties, Fill tab.

§ Lines: This option allows you to apply border lines. For more information, see Object properties, Lines tab.

§ Shadow: This option allows you to apply a shadow. For more information, see Object properties, Shadow
tab.

§ 3D: This option allows you to apply 3D effects. For more information, see Object properties, 3D tab.

§ Effects: This option allows you to apply different effects. For more information, see Object properties,
Effects tab.

§ Properties: This option allows you to change general settings. It also displays information about the picture
you are using. For more information, see Object properties, Properties tab.

§ AutoShapes: Here, you can assign a different shape from AutoShapes to the picture. For more information,
see Object properties, AutoShapes tab.

For pictures, there is an additional tab with further options:

Picture tab

On the Picture tab, you can make settings that are specific to pictures:

Tip: Some of these options can also be found directly as commands on the contextual ribbon tab Picture |
group Adjust.

§ Variants 

This list offers some predefined variations of the picture – for example, different color modes (grayscale,
black & white, etc.) as well as colored variants of the image.

Simply click on the desired variant. The options in the dialog box are then automatically set to the
corresponding settings.

Tip: You will also find these variants via the command Recolor picture directly on the contextual ribbon tab Picture.

§ Options section 

Here, you can change brightness, contrast, saturation and gamma value (an alternative way to change
brightness).
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§ More button 

This button opens a dialog box with the following additional options:

If you enable the option Mix with color and select a color below, the picture will be colored accordingly.

The options in the Cropping section can be used to crop the picture. This is useful if you only need part of
the picture. If, for example, the upper quarter of the picture is to be truncated, first select Use relative
values and enter the number "25" (percent) for Top.

If you select Use absolute values, the entries will be truncated in absolute units of length rather than as a
percentage. If you enter negative values, the areas of the picture will not be truncated, but will be extended
with a frame.

Tip: You will also find a corresponding command Cropping directly on the contextual ribbon tab Picture. For more information,
see the previous section Changing picture properties via the ribbon tab.

§ Transparency section 

Here, you can make settings for the transparency of the picture:

Use picture settings: Presentations reads from the picture file which parts of the picture have been marked
as transparent and displays the picture accordingly. Note: Only files in GIF or PNG format contain such
transparency information.

No transparency: The picture will not be displayed transparently, even if it is a picture file with
transparency information.

Color: This option lets you select the color to be displayed transparently. If, for example, you select white,
all white areas of the picture will become transparent.

§ Sample 

In the small toolbar below the sample, you will find the option Pick transparent color (the pipette icon).
You can use it to make certain colored parts of the picture transparent, for example, to remove a distracting
background from the picture. To do so, use the pipette icon to click on an area of the thumbnail that you
want to make transparent.

The other toolbar buttons help you to fine-tune the picture (Zoom in, Zoom out, Pan picture), but do not
affect the appearance of the picture in the document.

Note: You must first select a tool in the toolbar by clicking on it with the mouse. You can then work on the
thumbnail with the enabled tool.

§ File button 

You can use this button to replace the picture with another one and the formatting will be retained.

Tip: This corresponds to the command Change source on the contextual ribbon tab Picture.

§ Export button 

This option is available only for pictures that are saved in the document. You can use this button to export
the picture file, that is, to save a copy of it on your hard disk under any name. The dialog box "Save as"
appears for this purpose.

If you enable the option Create a link to file here, Presentations also replaces the picture saved in the
document with a reference to the destination file. Thus, the picture is no longer saved within the document.
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Charts

FreeOffice: SoftMaker FreeOffice does not support the creation of new charts. However, they are displayed
if you open a document that contains charts.

You can use charts to graphically display numeric values.

In this chapter, you will learn everything you need to know about charts. It is divided into the following
sections:

§ Inserting charts 

First, you will learn how to create a chart. The most convenient way is to take a small "detour" via the
PlanMaker spreadsheet application. You can also simply insert an empty chart and manually type in the
values to be displayed.

§ Editing charts 

This section contains all the information you need to edit charts. You will learn how to enter/edit the
numeric values to be displayed in a chart, how to work with the individual chart elements (data series, axes,
legend, etc.) and how to change the general properties of charts.

§ Saving charts as pictures 

The command Save as picture, which you can access via the context menu by right-clicking on the chart,
allows you to save a picture of a chart in a picture file.

Inserting charts

FreeOffice: You cannot create charts in SoftMaker FreeOffice.

There are two ways to insert a chart into the current slide:

§ Inserting charts via PlanMaker 

The most convenient way: Create or open a chart in the spreadsheet application PlanMaker and copy it to
the clipboard. Then switch to Presentations and paste it there.

§ Inserting charts manually 

Alternatively, you can simply create a new empty chart using the ribbon command Insert | Chart frame 
in Presentations. You then enter the numeric values to be displayed in a dialog box, which you can open
with the Edit data button.

More information can be found on the following pages.
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Inserting charts via PlanMaker

The most convenient way to insert a chart is to take a little "detour" and use the spreadsheet application
PlanMaker to create the chart. Then copy the chart to the clipboard, switch to Presentations and paste it there.

The advantage of this method is that PlanMaker is simply the most suitable option for entering data and also for
creating charts. It has many features that you can only find in a spreadsheet application. (Of course, this method
only works if you have PlanMaker installed.)

Proceed as follows:

1. In PlanMaker (not in Presentations!), enter the numeric values to be displayed in table cells.

Alternatively, you can simply open a file that already contains this data.

2. Select the cells with this data and choose the ribbon command Insert | Chart frame to create a chart. (For
more information, see the "Charts" chapter in the PlanMaker manual.)

Alternatively, you can simply open a file that already contains the desired chart.

3. If the chart is not already selected, click on it to select it.

4. Use the ribbon command Home | Copy to copy the chart to the clipboard.

5. Switch to Presentations.

6. Use the ribbon command Home | Paste to insert the chart.

The chart is now inserted in the current slide.

Note: The chart is not converted into a picture when it is inserted, but remains a chart. Thus, you can
subsequently change its chart type or edit its data and settings at any time, for example.

Inserting as an OLE object

A chart copied and pasted as described above has no connection to the original chart in PlanMaker. Thus, if you
subsequently change the original in PlanMaker, this will have no effect on its copy in Presentations.

If you want to insert a chart that maintains a connection to the original chart in PlanMaker, you must insert it as
an OLE object. To do so, use the ribbon command Insert | OLE object frame and select PlanMaker Chart as
the object type.

For more information on handling OLE objects, see OLE objects.

Inserting charts manually

The previous section described how to create charts using PlanMaker and then copy them to your Presentations
document. Alternatively, you can simply insert an empty chart into the Presentations document and then
manually fill it with data.

To do so, proceed as follows:
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Step 1: Insert an empty chart

First, insert an empty chart as follows:

1. Move to the desired slide in your Presentations document.

2. Choose the ribbon command Insert | group Objects | Chart frame  to open the dialog box. (Click on the
icon itself.)

Alternatively, you can click on the small arrow of the icon to list a dropdown menu with various chart types that you can insert
directly by clicking on them. If you choose More here, the dialog box will be shown again.

3. In the dialog box, you can specify which type of chart you want to insert. To do so, select the required
Chart type and Subtype.

For more information about chart types, see Changing the chart type.

4. Confirm with OK.

5. The chart is now inserted.

You can then move or resize the chart:

To move the chart, click on it and (with the left mouse button still held down) drag it to the desired position.

To resize it, drag one of the round handles surrounding the chart.

Step 2: Enter the data to be displayed

When you create a new chart, it is filled with the values 1, 2, 3, 4 by default. These values are just sample
values to ensure that the chart is not completely empty when displayed. You should enter your own values here,
of course.

To do so, proceed as follows:

1. If the chart is no longer selected, click on it to select it.

The contextual ribbon tab Chart appears as soon as a chart has been selected.

2. Choose the ribbon command Chart | Edit data .

3. A dialog box appears. In the Y values column, enter the values to be displayed in the chart.

Don't worry about the other columns and options; they are irrelevant for most chart types. (For more
information on this dialog box, see Entering/editing the data of a chart.)

4. When you have finished entering the values, confirm with OK.

The chart now updates and displays the values that you have entered.

If you want to change the values again later, select the chart and choose the ribbon command Chart | Edit data
again.
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Editing charts

FreeOffice: You cannot create charts in SoftMaker FreeOffice.

You will learn how to edit existing charts in the next sections. The information covers the following topics:

§ Changing the chart type 

Use the ribbon command Chart | Chart type to determine the form in which the data will be represented in
the chart – for example, as bars, lines or in the form of a pie chart, etc.

§ Entering/editing the data of a chart 

You can use the ribbon command Chart | Edit data to edit the data of a chart – thus enter or change the
numeric values to be displayed.

§ Showing/hiding chart elements 

A chart contains various elements, such as data series, axes, a legend, etc. You can use the ribbon command
Chart | Add chart element to show or hide certain elements of the chart if necessary.

§ Editing chart elements 

You can select the elements of a chart by clicking on them and then edit them. You will learn how to do so
in this section.

§ Changing chart properties via the dialog box 

In addition to the properties of individual chart elements, there are also common chart properties that you
can change. These include various layout options, the chart type, settings for the data series, etc. You can
change these options on the contextual ribbon tab Chart (see below) or in the Properties dialog box
(accessible via the context menu).

For basic information on working with objects, see Objects.

Using the ribbon tab "Chart"

When you select a chart, the contextual ribbon tab Chart appears automatically.

The contextual ribbon tab "Chart", left section
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The contextual ribbon tab "Chart", right section

This ribbon tab contains icons for the most important functions for editing charts:

§ New object: This option allows you to insert a new object into the document, and different object types are
available. 

§ Chart type/Chart subtype: This option allows you to select a chart type. (A subtype is only available for some
chart types.) For more information, see Changing the chart type.

§ Edit data: This option allows you to enter and change numeric values for the chart. For more information, see
Entering/editing the data of a chart.

§ Chart colors: This option allows you to change the color scheme of the chart.

§ Add element: This option allows you to show or hide chart elements such as axis titles, gridlines, legends,
etc. For more information, see Showing/hiding chart elements.

§ List of all chart elements contained in the chart. If you click on an element in the list, it will be selected in the
chart – if you select an element in the chart, it will be displayed in the list.

§ Edit properties: You click on this option to edit the selected chart element and the corresponding dialog box
opens. For more information, see Editing chart elements.

§ Fill color, Line color, Line style, Line thickness: You can use these options to change the fill and border lines of
the selected chart elements. For more information, see Editing chart elements.

§ Bring to front, Send to back: These options allow you to arrange the order of overlapping object frames. For
more information, see Changing the order of objects.

§ Align objects: This option allows you to align or evenly distribute two or more objects. For more information,
see Aligning and distributing objects.

§ Group: This option allows you to combine several selected objects into one unit, which can then be treated
like a single object. For more information, see Grouping objects. 

§ Duplicate: This option allows you to create an immediate copy of the selected chart.

§ Width, Height: These options change the size of the chart. For more information, see Changing position and
size of objects.

Using the dialog box

Many (but not all) of these functions and some additional options can be found in the Object properties dialog
box that you open via the context menu (entry Chart: Properties).

Alternatively, you can open the dialog box by clicking on the group arrow  in the bottom right corner of any
command group of the ribbon tab Chart.

All options of the dialog box are explained in Changing chart properties via the dialog box.
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Changing the chart type

The chart type determines how data will be displayed in a chart – for example, as columns, bars, lines, etc.

To change the chart type, proceed as follows:

Directly via the icons of the command group "Type"

Many chart types can be used directly via the icons of the command group Type on the contextual ribbon tab
Chart:

1. Select the chart by clicking on it.

2. Click on the Chart type icon  on the ribbon tab Chart | group Type.

3. Select the desired Chart type from the dropdown menu (see below for explanations of the different chart
types). You may use the icon below it to select a Chart subtype (only available for certain chart types).

Additional options via the dialog box of the command group "Type"

You will find some more options via the dialog box of the command group Type on the contextual ribbon tab
Chart. Here, you can also survey the possible appearance of the chart in a preview.

1. Select the chart by clicking on it.

2. On the ribbon tab Chart | group Type, click on the group arrow  in the bottom right corner.

3. In the dialog box, switch to the ribbon tab Chart type.

4. Select the desired Chart type and Subtype.

Tip: A small preview of the currently selected chart will be shown in the right half of the dialog box. You
can enable or disable this preview at any time using the >> button or the << button.

The following chart types are available:

   Column chart

Column charts are a good way to compare values. Each value is represented by a correspondingly high
column.

   Bar chart

Bar charts correspond to column charts; however, the values are displayed horizontally rather than vertically.
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   Line chart

Line charts display values as points and/or connecting lines.

   Area chart

Area charts are line charts where the space between the X axis and the individual lines is filled with color.

   XY scatter chart

XY scatter charts display values as points and/or lines. Unlike line charts, the data area must contain both the
X and Y coordinates of the data points.

   Bubble chart

Bubble charts display values as filled circles ("bubbles"). Bubble charts are usually based on data series
containing three values: X coordinate, Y coordinate, and bubble size.

   Radar chart

Radar charts display values in a web. The zero point is in the center of the web.

   Surface chart

Surface charts display values as a three-dimensional shape. Areas plotted in the same color indicate that they
contain similar values.

The values to be displayed should have the following structure:

(Z values determine the height.)
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   Pie chart

Pie charts are well suited to displaying the percentage of individual values of the total value. The size of each
"pie slice" shows the ratio of the value to the total and to the other values.

Tip: You can highlight values by extracting the related slice of the pie from the pie. Select the slice of the pie
and extract it via the mouse.

   Doughnut chart

Doughnut charts, like pie charts, show the percentage of individual values of the total value. Unlike pie charts,
however, they can display any number of data series (rings) and not just a single series.

       Cylinder, Cone and Pyramid charts

Cylinder, Cone and Pyramid charts correspond to column and bar charts. However, they use cylinders, cones
or pyramids instead of columns/bars to display the values.

   Stock chart

Stock charts (also known as general high-low charts) are suitable for displaying the development of stock
prices, among other things. They enable the highest price, lowest price and closing price to be seen at a glance,
for example.

The following subtypes are available:

§ Stock chart (High, Low, Close) 

This type of chart displays the following values: highest price, lowest price, closing price.

It requires 3 data series in the above order.

An example of the possible structure of the data (with the date added in column A):
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§ Stock chart (Open, High, Low, Close) 

This type of chart displays the following values: opening price, highest price, lowest price, closing price.

It requires 4 data series in the above order.

§ Stock chart (Volume, High, Low, Close) 

This type of chart displays the following values: trading volume, highest price, lowest price, closing price.

It requires 4 data series in the above order.

The trading volume is displayed as an additional column with its own value axis.

§ Stock chart (Volume, Open, High, Low, Close) 

This type of chart displays the following values: trading volume, opening price, highest price, lowest price,
closing price.

It requires 5 data series in the above order.

The trading volume is displayed as an additional column with its own value axis.

   Box plot chart

Box plots (or box and whisker plots) are useful for data analysis in statistics. Detailed explanations relating to
the application of box plots would go beyond the scope of this manual. You can find further information on
them via your preferred Internet search engine.

There are two subtypes: Horizontal and Vertical.

Depending on the number of data series passed to the chart, different variants of box plots will be rendered:

Note: You can display any type of value in a box plot. The following lists show examples only.

§ 3-point box plot 

This box plot displays, for example, the following values:

Lower quartile (lower border of the box)
Median (position of the line within the box)
Upper quartile (upper border of the box)

This box plot requires exactly 3 data series in the above order.

§ 5-point box plot 

This box plot displays, for example, the following values:

Lower whisker (line below the box)
Lower quartile (lower border of the box)
Median (position of the line within the box)
Upper quartile (upper border of the box)
Upper whisker (line above the box)

This box plot requires exactly 5 data series in the above order.

§ 7-point box plot 

This box plot displays, for example, the following values:

Minimum (as a single marker)
Lower whisker (line below the box)
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Lower quartile (lower border of the box)
Median (position of the line within the box)
Upper quartile (upper border of the box)
Upper whisker (line above the box)
Maximum (as a single marker)

This box plot requires exactly 7 data series in the above order.

Entering/editing the data of a chart

When you create a new chart, the values 1, 2, 3, and 4 are entered in it by default. These values are just sample
values to ensure that the chart is not completely empty when displayed.

You can use the ribbon command Chart | Edit data to edit these values at any time and enter your own values.

Proceed as follows:

1. Click to select the relevant chart and the contextual ribbon tab Chart will appear.

2. Choose the command Chart | Edit data  here.

3. The dialog box "Data source" opens. In the Y values column, enter the values to be displayed in the chart.

Don't worry about the other columns and options; they are irrelevant for most chart types.

(For more information on all options in this dialog box, see below.)

4. Confirm with OK.

The chart now updates and displays the values that you have entered.

Alternatively, you can open this dialog box by right-clicking on the chart and selecting Chart: Properties from
the context menu.

In the following dialog box "Object properties", switch to the Series tab, and click on the Edit button there to
open the dialog box "Data source".

Options of the dialog box

The aforementioned dialog box "Data source" has the following options:

§ Series 

Here, you can select which series to display in the dialog box in the case of charts with multiple data series.

Tip: To manage the data series of a chart, right-click on the chart and choose the command Chart:
Properties from the context menu. Switch to the Series tab. You can add, delete and edit data series, among
other things, on this tab.

§ Rename button 

This button allows you to rename the data series that is currently selected in the Series list. Tip: This name
is also displayed in the legend of a chart.

The largest part of the dialog box is occupied by a table where you can enter the values:
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§ X values 

The left column represents the X values. These values are required only by a few special chart types (for
example, XY scatter charts). For all other chart types, this column is set to Automatic by default (via the
appropriate checkbox above this column).

§ Y values 

The middle column represents the Y values. Here, you usually enter the values to be displayed in the chart.

§ Bubble sizes 

The right column is only to be filled for bubble charts and determines the size of the bubbles.

§ Insert row button: This button allows you to insert an additional row above the current row. 

§ Append row button: This button allows you to append an additional row below the last row.

§ Delete row button: This button allows you to delete the current row.

§ Paste button: This option overwrites the values in the current data series with the values that are currently
on the clipboard.

Copy the desired Y values to the clipboard beforehand. Use a new line for each value.

See also the following notes.

Some notes on the "Paste" button:

§ The Paste button can fill only one data series with data at a time. This means that you cannot copy, for
example, a whole table to the clipboard and then paste it as multiple data series. 

Tip: However, you can achieve this at any time via a small "detour": Paste the contents of the table into the
spreadsheet application PlanMaker (as table cells), create the chart from them, copy it to the clipboard, and
then paste it into Presentations. For more information, see also Inserting charts via PlanMaker.

§ If you want to insert X and Y values using the Paste button, first disable the Automatic checkbox above the
X values column. The clipboard must, of course, contain two values in each row (X and Y). Separate them
with a tab, a semicolon or the list separator set in your system. 

§ The same applies to bubble charts. Here, the clipboard can contain up to three values per row: X, Y and the
bubble size.

§ Text strings on the clipboard normally return the value 0 (zero). If a text string also contains numbers,
however, the first number is extracted from it.

Some examples:

"Euro" returns the value 0.

"50 Euro" returns the value 50.

"Euro 50" returns the value 50.

"50 Euro, 20 Cent" also returns the value 50. (Only the first number is always taken into account.)
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Adding/deleting data series

If you want to add a new data series to the chart or remove an existing data series, right-click on the chart and
choose the command Chart: Properties in the context menu. In the following dialog box "Object properties",
switch to the Series tab.

Click on the Add button here to add a data series. The new data series then appears in the list on the upper left
of this dialog box. Then press the Edit button, and enter the values to be displayed in the following dialog box
"Data source", as described above.

To remove a data series, select it in the list on the upper left of the dialog box "Object Properties", and click on
the Delete button.

Showing/hiding chart elements

Certain elements of the chart can be shown or hidden if necessary. Some of them are shown automatically when
you create the chart, for example, the axes and the legend.

Tip: See Editing chart elements for an illustration of the most important chart elements.

The following elements can be shown/hidden:

§ Axes and axis titles 

§ Chart title

§ Data_labels

§ Error bars

§ Gridlines

§ Legend

§ Lines

§ Trendline

§ Up/down bars

For more information, see the following sections.

Showing/hiding axes and axis titles

The horizontal X axis of a chart is also known as the category axis.

The vertical Y axis of a chart is also known as the value axis.

The Z axis of a chart is also known as the series axis. It is only available for certain three-dimensional chart
types.
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Note: The X axis and Y axis are shown automatically when the chart is created.

To show or hide an axis, proceed as follows:

Via the "Add chart element" icon

You can use the Add chart element icon  on the contextual ribbon tab Chart to show or hide the X axis
and/or Y axis (the Z axis only in the dialog box, see below).

To do so, select the chart and use the ribbon command Add chart element  to select the entry Axis. In the
following submenu, you can use the entry Primary horizontal to show or hide the X axis and Primary vertical
to show or hide the Y axis.

The entry More takes you to a dialog box with additional options (see below).

Axis title: To add, change or remove axis titles, proceed as follows:

§ Adding axis title 

If you want to add an axis title to the axis, choose the ribbon command Add chart element and then select
the entry Axis title. Primary horizontal shows an axis title for the X axis, while Primary vertical shows it
for the Y axis.

The entry More also takes you to the dialog box here (see below).

§ Changing an axis title 

To rename an axis, double-click on the axis title and switch to the Text tab in the following dialog box.
Enter the desired text here.

§ Removing an axis title 

To remove an axis title, hide it again via the command Add chart element or select it directly in the chart
and press the Del key.

Via the dialog box

For additional axis options (for example, the Z axis or secondary axes), choose the path via the dialog box:

1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Axis (or Axis title) and select
More in the following submenu to open the dialog box.

Alternatively: Right-click to open the context menu and select the entry Chart: Properties. 

3. Switch to the Elements tab.

Axes: The checkbox in front of each axis can be used to enable/disable the display of the relevant axis.

Axis title: To the right of the axis, you can give it a name. This will then be displayed below/next to the
axis.

For more information on the options of the "Elements" tab, see Chart properties, Elements tab.
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Editing axes and axis titles

For more information on editing the properties of axes, see Category axis (X axis), Value axis (Y axis) and
Series axis (Z axis).

For information on editing the properties of the axis title, see Axis title.

Showing/hiding chart titles

You can show or hide a chart title for the chart. The title will then be displayed above the chart.

To do so, proceed as follows:

Via the "Add chart element" icon

Select the chart and use the ribbon command Chart | Add chart element  to choose the entry Chart title. In
the following submenu, select Above chart to add a chart title. If you select None, the chart title will be
removed.

If you select More, you will be taken to the dialog box (see below) where you can rename the chart title.

Alternatively: Double-click on the chart title and you can then rename the title on the Text tab.

To remove a chart title, select it and press the Del key.

Via the dialog box

To show or hide the chart title via the dialog box, proceed as follows:

1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Chart title and select More in
the following submenu to open the dialog box.

Alternatively: Right-click to open the context menu and select the entry Chart: Properties.

3. On the Elements tab, you will find an input field for the Chart title at the top. Type the desired title here.

To delete the chart title, simply remove the text from this input field.

For more information on the options of the "Elements" tab, see Chart properties, Elements tab.

For information on editing the properties of the chart title, see Chart title.
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Showing/hiding data labels

The data points of a chart can be labeled. This allows you to display the exact value of the data points in the
chart.

To show or hide data labels, proceed as follows:

Via the "Add chart element" icon

Select the chart and use the ribbon command Chart | Add chart element  to choose the entry Data labels.
In the following submenu, you can choose between different options for positioning the data label (left,
centered, above, etc.). A check mark in front of it indicates the setting which is currently enabled.

If you choose the entry None, the data labels will be removed.

Tip: To remove a single label, select it and press the Del key.

The entry More takes you to the dialog box with additional options (see below).

Via the dialog box

For additional options for data labeling, choose the path via the dialog box:

1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Data labels and select More
in the following submenu to open the dialog box.

Alternatively: Select the desired data series and right-click to open the context menu and select the entry
Series: Properties.

3. Switch to the Data labels tab and make the desired settings here.

For more information on the options of the dialog box, see Data series and data points, "Data labels" tab.

Showing/hiding error bars

Note: This chart element is only available for certain two-dimensional chart types, such as column, bar and
line charts.

You can draw error bars for the data points of a data series. Error bars display the possible/tolerable error of
the values in the form of a line with a short dash at the end.

To show or hide error bars, proceed as follows:
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Via the "Add chart element" icon

Select the chart and use the ribbon command Chart | Add chart element  to choose the entry Error bars.
In the following submenu, you can choose from a predefined selection for displaying the values. A check mark
in front of it indicates the setting which is currently enabled.

If you choose the entry None, the data labels will be removed.

The entry More takes you to the dialog box with additional options (see below).

Via the dialog box

Additional options for error bars can be found via the dialog box:

1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Error bars and select More in
the following submenu to open the dialog box.

Alternatively: Select the desired data series and right-click to open the context menu and select the entry
Series: Properties.

3. Switch to the Error bar tab and select the desired settings here.

For more information on the options of the dialog box, see Data series and data points, "Error bar" tab.

Showing/hiding gridlines

Showing gridlines in a chart can improve the legibility of its values. Gridlines are a network of lines that extend
across the plot area, starting from one of the axes of the chart.

The following types of gridlines are available:

§ Major gridlines are indicated at every major tick mark on the axis. 

§ Minor gridlines subdivide the major grid into an even finer grid if necessary.

You can enable gridlines separately for each axis.

To show or hide gridlines, proceed as follows:

Via the "Add chart element" icon

Select the chart and use the ribbon command Chart | Add chart element  to choose the entry Gridlines. In
the following submenu, you can enable or disable horizontal (for the Y axis) and vertical (for the X axis) major
gridlines and minor gridlines for the primary axis. A check mark in front of them indicates the gridlines which
are currently enabled.

The entry More takes you to the dialog box with additional options (see below).
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Via the dialog box

For additional options (for example, gridlines for secondary axes), choose the path via the dialog box:

1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Gridlines and select More in
the following submenu to open the dialog box.

Alternatively: Right-click to open the context menu and select the entry Chart: Properties. 

3. Switch to the Elements tab and enable the option Major grid and/or Minor grid for the desired axes.

For more information on editing gridlines, see Gridlines.

Showing/hiding the legend

If desired, you can show (or hide) a legend in the chart. A legend is a small box that shows which data series
are displayed in which color/pattern.

To do so, proceed as follows:

Via the "Add chart element" icon

Select the chart and use the ribbon command Chart | Add chart element  to choose the entry Legend. In
the following submenu, you can specify where to position the legend. A check mark in front of it indicates the
option which is currently enabled.

You can hide the legend by selecting the entry None.

The entry More takes you to the dialog box with additional options (see below).

Via the dialog box

For additional options, choose the path via the dialog box:

1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Legend and select More in the
following submenu to open the dialog box.

Alternatively: Select the legend and right-click to open the context menu and select the entry Legend:
Properties.

3. On the Legend tab, specify where the legend should be positioned. If you select the option Custom, the
legend can be moved to any position (using the mouse). If you select the option None, the legend will not be
displayed.

Tip: If you choose the entry Chart: Properties via the context menu, the main dialog box for charts
opens. You will find the option Legend here also on the Elements tab.
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For more information on editing the properties of a legend, see Legend.

Showing/hiding lines

Note: This option can only be used for line charts and area charts.

You can use the options for lines, for example, to illustrate the spacing between the individual data series in a
line chart.

The following types of lines are available:

§ Drop lines are lines displayed from the data points to the horizontal axis. 

§ High-low lines are lines displayed between the highest and lowest data points (for two or more data series).

To show/hide drop lines or high-low lines, proceed as follows:

Via the "Add chart element" icon

Select the chart and use the ribbon command Chart | Add chart element  to choose the entry Lines. In the
following submenu, you can choose between Drop lines and High-low lines. A check mark in front of it
indicates the option which is currently enabled.

You can hide the lines by selecting the entry None.

The entry More takes you to the dialog box with additional options (see below).

Via the dialog box

For additional options, choose the path via the dialog box:

1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Lines and select More in the
following submenu to open the dialog box.

Alternatively: Select the desired data series and right-click to open the context menu and select the entry
Series: Properties.

3. Switch to the Options tab and enable the desired settings.

For more information on the options of the dialog box, see Data series and data points, "Options" tab.

Showing/hiding the trendline

Note: Trendlines are available only for certain chart types (including two-dimensional column, bar, and line
charts). Other limitation: They are not available for stacked chart types.

If desired, you can add trendlines to the data series of a chart.
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Trendlines can be used to graphically display the trend of a data series (i.e., to what extent the data series
rises/falls on average). Trendlines can also be extended beyond the given data points, so that they display a
forecast for future values.

A statistical technique called regression analysis is used to calculate trendlines.

To show/hide trendlines, proceed as follows:

Via the "Add chart element" icon

Select the desired data series to which you want to add a trendline.

Use the ribbon command Chart | Add chart element  to choose the entry Add trendline. In the following
submenu, select one of the predefined trendline types.

The entry Remove all removes all trendlines. (Select the chart for this purpose.) To remove individual
trendlines, select the desired trendline and then choose Remove all or simply press the Del key.

The entry More takes you to the dialog box with additional options (see below).

Via the dialog box

You will find more trendline types and additional options via the dialog box:

1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Add trendline and select
More in the following submenu to open the dialog box.

Alternatively: Select the desired data series and right-click to open the context menu and select the entry
Add trendline.

3. Switch to the Trend tab and enable the desired settings.

For more information on the options of the dialog box, see Trendlines.

Showing/hiding up/down bars

Note: This option can only be used for line charts.

You can use the option Up/down bars to display bars between the first and last data series, for example, in a
line chart with two or more data series.

To do so, proceed as follows:

Via the "Add chart element" icon

Select the chart and use the ribbon command Chart | Add chart element   to choose the entry Up/down
bars. In the following submenu, select the same entry.

You can use the entry None to remove the up/down bars.
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The entry More takes you to the dialog box (see below) where you can also set the spacing between the bars.

Via the dialog box

Choose the path via the dialog box to make further settings:

1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Up/down bars and select
More in the following submenu to open the dialog box.

Alternatively: Select any data series and right-click to open the context menu and select the entry Series:
Properties.

3. Switch to the Options tab and enable the checkbox in front of Show up/down bars with gap. In the input
field below, you can set the gap between the bars.

For more information on the options of the dialog box, see Data series and data points, "Options" tab.
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Editing chart elements

Charts consist of several components. In addition to the data series themselves, for example, there are axes, a
legend, etc. These individual components of a chart are called the chart elements.

The following figure shows the most important chart elements:

Series 1, Series 2, etc., represent the chart's data series.

Three-dimensional charts types contain some additional chart elements (floor, walls, etc.), which will also be
described on the following pages.

Each of these chart elements can be selected at the click of a mouse and then edited.

Selecting chart elements

To select a chart element, first click on the chart itself to select it and then click on the desired chart element.
To select a data series, for example, click on any value within this series.

Note: To select a single value within a data series, first click on the data series and then click on the desired
single value.

Tip: Alternatively, you can select chart elements by expanding the list of elements on the ribbon tab Chart |
group Chart elements and selecting the desired element from it. Here, you can always see which chart
element is currently selected.
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Changing the position and size of chart elements

The position and size of some chart elements (for example, the legend) can be changed. To move an element,
select it and and then drag it to the desired position. To change its size, drag one of the round handles
surrounding the element.

Changing the fill and borders of chart elements

The fill color and border lines of chart elements can be applied directly with the buttons of the command group
Chart elements on the ribbon tab Chart. To do so, select a chart element and make the desired adjustments
using the buttons Fill color, Line color, Line style and Line thickness.

Note: In the case of the buttons Fill color and Line color, the last color that you used will be applied again when you click directly on the
icon itself. By clicking on the icon's arrow, you open the color palette.

Only for the Fill color button: If you click on the icon's arrow, you can use the entry More Fills to also apply more complex fills. For
more information, see Object properties, Fill tab. By clicking on the entry More colors, you reach a dialog box with color definitions,
which you use according to the descriptions of the section Document properties, Colors tab.

You will also find fill and border settings via the dialog box of the chart elements (see next paragraph). You can
also change other properties here, depending on the type of chart element.

Changing properties of chart elements

In addition to changing the properties of the chart itself, as described later in Changing chart properties via the
dialog box, you can also edit the properties of individual chart elements.

To change the properties of a chart's legend, for example, proceed as follows:

1. Select the chart by clicking on it.

2. Right-click on the legend to open its context menu.

Android/iOS: In these versions, you can also open the context menu with your finger: Just tap on the screen
and hold your finger there for about a second.

3. In the context menu, choose the command Legend: Properties (not the command Chart: Properties).

A dialog box will now appear in which you can make the desired settings.

Tip: Alternatively, you open the dialog box via the ribbon command Edit properties .

Even faster: Open the dialog box by double-clicking on the desired element.

The properties that you can change in this dialog box depend on the type of chart element for which you opened
it. The following sections provide more information about all available chart elements and their respective
properties:

§ Chart area 
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§ Plot area

§ Walls (three-dimensional charts only)

§ Floor (three-dimensional charts only)

§ Corners (three-dimensional charts only)

§ Data series and data points

§ Trendlines

§ Category axis (X axis)

§ Value axis (Y axis)

§ Series axis (Z axis)

§ Axis title

§ Chart title

§ Gridlines

§ Legend

Chart area

The chart area is the entire area of a chart frame.

Edit properties: To change the properties of the chart area, select it, right-click to open the context menu and
choose the command Chart area: Properties.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to simply double-click on the chart area.

You can make the following settings:

Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section 

Here, you can add a border to the entire chart. Auto gives the chart a thin gray standard line as a border.
None removes the border. The option Custom lets you customize the line style.

If you enable the option Shadow, the chart frame will also be highlighted with a shadow. The Adjust button
opens additional settings for the appearance of the shadow effect.

§ Fill section 

Here, you can change the fill of the chart area. Auto gives the chart area a white fill area. The fill will be
transparent if you use the option None. You can use the option Color to customize the color for the fill.



172Working with objects

If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.

Font tab

Here, you can change the text formatting for all chart elements.

To do so, select the desired font, font size, alignment, etc.

Important: Changes will affect all chart elements, even if they were previously formatted in a different font.

Plot area

The plot area of a chart is the area where the data series, axes and gridlines are drawn.

Edit properties: To change the properties of the plot area, select it, right-click to open the context menu and
choose the command Plot area: Properties.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the plot area.

You can make the following settings:

Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section 

Here, you can add a border to the plot area. To do so, use the option Custom to select the desired line style.
The option None removes the border.

§ Fill section 

Here, you can change the fill of the plot area. To do so, use the option Color to select the desired fill color.
The fill will be transparent if you use the option None.

If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.
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Walls (three-dimensional charts only)

 Walls are the back walls of charts that use a three-dimensional chart type.

Edit properties: To change the properties of the walls, select one of the walls, right-click to open the context
menu and choose the command Walls: Properties.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the walls.

You can make the following settings:

Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section 

Here, you can add a border to the walls. To do so, use the option Custom to select the desired line style. The
option None removes the border.

§ Fill section 

Here, you can change the fill of the walls. To do so, use the option Color to select the desired fill color. The
fill will be transparent if you use the option None.

If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.

3D view tab

Here, you can set the 3D effect for the entire chart. For more information, see Chart properties, 3D view tab.

Floor (three-dimensional charts only)

Floors are only present in three-dimensional chart types.

Edit properties: To change the properties of the floor, select it, right-click to open the context menu and choose
the command Floor: Properties.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the floor.

You can make the following settings:
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Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section 

Here, you can add a border to the floor. To do so, use the option Custom to select the desired line style. The
option None removes the border.

§ Fill section 

Here, you can change the fill of the floor. To do so, use the option Color to select the desired fill color. The
fill will be transparent if you use the option None.

If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.

3D view tab

Here, you can set the 3D effect for the entire chart. For more information, see Chart properties, 3D view tab.

Corners (three-dimensional charts only)

Corners are only present in three-dimensional chart types.

Edit properties: To change the properties of the corners, select one of them, right-click to open the context menu
and choose the command Corners: Properties.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements.

You can make the following settings:

3D view tab

Here, you can set the 3D effect for the entire chart. For more information, see Chart properties, 3D view tab.

Data series and data points

Data series are the most important chart elements. They represent the data to be evaluated – in the form of
columns, bars, lines, pie segments, etc., depending on the chart type selected.

A data series is the graphical representation of a column or row of cell values on which the chart is based. Each
data series, in turn, consists of multiple data points, thus the individual cell values.
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Edit properties: To change the properties of data series or single data points, proceed as follows:

§ If you click on any of the data points of a data series, the entire data series will be selected. You can now
edit the properties of this data series by right-clicking it to open the context menu and then choosing the
command Series: Properties. 

§ If you click on the same data point once again, only this single data point will be selected. The command in
the context menu is then called Point: Properties.

Tip: Alternatively, you can choose these commands via the Edit properties icon  on the ribbon tab
Chart | group Chart elements after you have selected the data series (or the data point).

You can make the following settings:

Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section (or Line section) 

Here, you can change the line style used to draw the graph. To do so, use the option Custom to select the
desired line style. The option None removes the line.

If you enable the option Shadow, the graph will also be highlighted with a shadow. You can use the Adjust
button to make other settings for the appearance of the shadow effect. (For some chart types, the option
Smooth line appears here instead, which enables you to give the graph a smoother gradient.)

§ Fill section 

Here, you can change the fill of the data series/data points. Auto gives the fill area a standard color. The fill
will be transparent if you use the option None. You can use the option Color to customize the color for the
fill. The color for negative values can be assigned a different color for certain chart types.

If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.

§ Marker section (available only for certain chart types) 

Some chart types (for example, certain types of line charts) draw markers for each data point. Here, you can
customize the appearance of such markers.

3D format tab

Note: The options on this tab are available only for certain chart types.

Use this tab to add a light effect or bevels to the data points to be displayed.

§ Material 

Here, you can select the material that should be simulated to display the data points.
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§ Light 

Here, you can select the type of light that should be simulated.

§ Angle 

Here, you can change the angle of the light source.

Tip: The above effects usually look better if you also use the following option to add bevels to the data
points.

§ Bevels section 

Here, you can add a bevel effect to the graphical representation of the data points. If you apply these options
to a bar chart, for example, the edges of the bars will be rounded. The larger the value, the rounder the edges
will be displayed.

Data labels tab

Use this tab to add labels to the selected data points. This is useful, for example, if you want to have the exact
values displayed for each data point.

§ Display section 

Here, you can specify the type of label to be displayed. The default option is Don't show, thus no label is
displayed. If, for example, you select the option Show value, the value of the relevant data point will be
displayed, while the option Show data point will display its name, etc.

§ Display legend key in label 

If you enable this option, the legend keys of the relevant data points will be displayed before the labels. The
legend key is a small square in the same color as the data point.

§ Placement section 

Here, you specify where the label should be placed (relative to the respective data point).

Note: If you label data points, you can also click on these labels in the chart. Thus, you can change their
properties by selecting a different font or changing the text you want to display, for example.

The following program response also applies here: clicking once selects all labels of a data series, while
clicking again selects a single label.

Error bar Y tab

Note: This tab is available only for certain two-dimensional chart types (including column, bar and line
charts).

You can use this tab to add error bars to the data points of the selected data series. Error bars display the
possible/tolerable error of the values in the form of a line with a short dash at the end.
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Chart with "Plus" and "Minus" error bars

To add error bars, select the desired type of error bar in the Display section: Plus only displays a positive error
bar, Minus only displays a negative error bar, Plus and minus displays both error bars.

The option Show as lets you determine the appearance of the error bars: with or without short dashes at the
ends.

In the Value section, you can change the length of the indicator line. If, for example, you select the option
Fixed, the line will always have the specified length, while if you select the option Percent, the length will
correspond to the specified percentage of the respective Y value, etc.

Error bar X tab

Note: This tab is only available for XY scatter charts and bubble charts.

This tab is identical to the Error bar Y tab (see above), except that it displays error bars for the X values instead
of the Y values.

Helper lines tab

Note: This tab is available only for certain two-dimensional chart types (including column, bar and line
charts).

You can use this tab to display various guides in the chart. If, for example, you enable the option Average, a
dashed line indicating the average value of the selected data series will be displayed in the chart.

You can enable guides for Average, Minimum/maximum, Standard deviation, and Linear approximation
(linear trend).

Tip: You can use the ribbon command Chart | Add chart element  | Add trendline to show other types of
trendlines in the chart if necessary. For more information, see Trendlines.

Options tab

This tab shows different settings for displaying the data series/data points, depending on the chart type, for
greater clarification of the results.

For a line chart, for example, you will find the following settings:
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Note: For other chart types, you will find different settings on the Options tab.

§ Displaying drop lines 

If you enable this option, lines will be drawn from the data points to the horizontal axis.

§ Displaying high-low lines 

If you enable this option, lines will be displayed between the highest and lowest data points (for two or more
data series).

§ Up/down bars with gap 

You can use this option to display bars between the first and last data series, for example, in a line chart with
two or more data series. In the input field below, you can also set the gap between the bars.

For the above options, you can choose between different settings of the display in the section Empty cells are
... in case individual data points are missing.

If you select the option Vary color for each data point, the data points will be automatically colored with
different colors (not available if there are multiple data series).

Tip: You can also format these chart elements, if enabled, by selecting them and right-clicking to open the
context menu where you choose the relevant entry (Drop lines, High-low lines, Up/down bars):
Properties.

Trendlines

Note: Trendlines are available only for certain chart types (including two-dimensional column, bar, and line
charts). Furthermore, they should not be stacked.

If desired, you can have a trendline shown for each data series of the chart. For more information, see
Showing/hiding the trendline.

Trendlines can be used to graphically display the trend of a data series (i.e., to what extent the data series
rises/falls on average). Trendlines can also be extended beyond the given data points, so that they display a
forecast for future values.

A statistical technique called regression analysis is used to calculate trendlines.

Edit properties: To change the properties of a trendline, select it, right-click it to open the context menu and
choose the command Trendline: Properties.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to simply double-click on the trendline.

You can make the following settings:
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Format tab

§ Line section 

Here, you can change the appearance of the trendline. Auto uses a thick black standard line. None removes
the line. The option Custom lets you customize the line style.

Trendline tab

§ Type section 

Here, you can select the type of trendline to be displayed. In addition to linear trendlines (i.e., simple best-fit
lines), trendlines such as exponential or polynomial trendlines can also be displayed.

The available types of trendlines are based on the following formulas:

Linear: y = ax + b

Polynomial: y = b + c1x + c2x
2 + c3x

3 + ... + c6x
6

Exponential: y = cebx   (e = Euler's number)

Logarithmic: y = c ln(x) + b

Potential: y = cxb

Moving average: f(xi) = (xi + xi-1 + xi-2 + ... + xi-n+1) / n

§ Based on series 

Here, you can specify the data series for which the trendline is to be displayed.

§ Forecast section 

Here, you can extend the trendline beyond the existing data points.

If, for example, there are 3 data points (for example, the sales results for the 1st, 2nd and 3rd year), you can
enter a 1 for Forward. The line is then extended by an additional period (1 data point), thus displaying a
forecast for sales in the 4th year.

§ Crossing point 

Here, you can force the trendline to intersect the Y axis at a specific Y coordinate. This option is available
only for certain types of trendlines.

§ Show formula in chart 

If this option is enabled, the formula used to calculate the trendline will be displayed in the chart.

§ Show correlation in chart 

If this option is enabled, the correlation coefficient R2 of the data series will be displayed in the chart.
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§ Name section 

Here, you can change the name of the trendline if desired. This name is displayed in the legend. To do so,
select the option Custom and enter the desired name.

Category axis (X axis)

The X axis of a chart is also called the category axis.

Tip: For more information on showing or hiding axes, see Showing/hiding axes and axis titles.

Edit properties: To change the properties of the category axis, select it, right-click it to open the context menu
and choose the command Category axis: Properties.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to simply double-click on the axis.

You can make the following settings:

Format tab

Tip: Lines can also be conveniently adjusted directly via the buttons of the ribbon tab Chart | group Chart
elements. For more information, see Editing chart elements.

§ Line section 

Here, you can change the line style used to draw the axis. Auto uses a thin gray standard line. None removes
the line. The option Custom lets you customize the line style.

§ Major ticks and Minor ticks sections 

Here, you can determine whether small tick marks should be displayed to divide the axis and specify their
appearance.

§ Tick labels section 

Here, you can determine whether labels should be displayed for the tick marks and where to place them.

Scale tab

You can use this tab to change the scale of the axis.

Note: If the category axis contains date values, other settings appear here that are similar to the scaling
options of the value axis (Y axis). For more information, see the descriptions in the next section Value axis
(Y axis), "Scale tab".

§ Axis ends... section 

This option allows you to determine where to end the visible part of the axis: In categories or Between
categories.
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Explanation: The first, second, third, etc., data point of all data series is called the category of a chart.

§ Number of categories between... section 

By default, Presentations makes a tick mark on the axis for each category and labels it. You can change
these intervals via the following options:

The option Tick marks determines which categories are marked with a tick mark. Enter 1, and a tick mark
is set for every category. Enter 2, and a tick mark is set for every second category, etc.

The option Tick labels determines which tick marks to label. Enter 1, and each tick mark is labeled. Enter 2,
and every second tick mark is labeled, etc.

§ Intersection between X and Y axis section 

You can use this option to determine where the X axis (category axis) should intersect the Y axis (value
axis): At low end (where the category axis begins), At high end (where the category axis ends) or at the
specified category number.

§ Invert axis direction 

If this option is enabled, the direction of the axis is reversed. The order of the categories is also reversed
accordingly; the chart thus starts with the last category and ends with the first category.

Font tab

Use this tab to change the formatting of the axis labels.

In addition to font, font size, and text styles, you can also set the alignment, rotate the labels and change the
numeric format.

Value axis (Y axis)

The Y axis of a chart is also called the value axis.

Tip: For more information on showing or hiding axes, see Showing/hiding axes and axis titles.

Edit properties: To change the properties of the value axis, select it, right-click it to open the context menu and
choose the command Value axis: Properties.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the axis.

You can make the following settings:

Format tab

Tip: Lines can also be conveniently adjusted directly via the buttons of the ribbon tab Chart | group Chart
elements. For more information, see Editing chart elements.
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§ Line section 

Here, you can change the line style used to draw the axis. Auto uses a thin gray standard line. None removes
the line. The option Custom lets you customize the line style.

§ Major ticks and Minor ticks sections 

Here, you can determine whether small tick marks should be displayed to divide the axis and specify their
appearance.

§ Tick labels section 

Here, you can determine whether axis labels should be displayed and where to place them.

Scale tab

You can use this tab to change the scale of the axis.

§ Lowest value and Highest value sections 

These options determine where the visible part of the axis should begin and where it should end. Select
either the option Auto, which results in Presentations automatically determining the most appropriate
values, or select Custom and enter the desired value yourself.

§ Intersection between X and Y axis section 

You can use this option to determine where the X axis (category axis) should intersect the Y axis (value
axis):

If Auto is selected, Presentations automatically determines the most appropriate value, and if Maximum
value is selected, the X axis is positioned at the end of the Y axis. You specify your own Y value if you
select Custom value.

§ Major step value section 

Here, you can set the interval for the tick marks and labels on the axis. If you select the option Auto,
Presentations automatically determines the most appropriate values.

§ Minor step value section 

Here, you can set the interval between minor tick marks on the axis. If you select the option Auto,
Presentations automatically determines the most appropriate values.

§ Invert axis direction 

If this option is enabled, the direction of the axis is reversed. In a column chart, for example, the columns are
no longer drawn from bottom to top, but from top to bottom.

§ Logarithmic scale 

If this option is enabled, the axis will use a logarithmic scale (for example, 10, 100, 1000, etc.) rather than a
linear scale.

Font tab

You can use this tab to change the formatting of the axis labels.
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In addition to font, font size, and text styles, you can also set the alignment, rotate the labels and change the
numeric format.

Series axis (Z axis)

The Z axis of a chart is also called the series axis. It is only available for certain three-dimensional chart types.

Tip: For more information on showing or hiding axes, see Showing/hiding axes and axis titles.

Edit properties: To change the properties of the series axis, select it, right-click it to open the context menu and
choose the command Series Axis: Properties.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the axis.

You can make the following settings:

Format tab

Tip: Lines can also be conveniently adjusted directly via the buttons of the ribbon tab Chart | group Chart
elements. For more information, see Editing chart elements.

§ Line section 

Here, you can change the line style used to draw the axis. Auto uses a thin gray standard line. None removes
the line. The option Custom lets you customize the line style.

§ Major ticks and Minor ticks sections 

Here, you can determine whether small tick marks should be displayed to divide the axis and specify their
appearance.

§ Tick labels section 

Here, you can determine whether labels should be displayed for the tick marks and where to place them.

Scale tab

You can use this tab to change the scale of the axis.

§ Number of series between... section 

By default, Presentations makes a tick mark on the axis for each data series and labels it. You can change
these intervals via the following options:

The option Tick marks determines which data series are marked with a tick mark. Enter 1, and a tick mark
will be set for every data series. Enter 2, and a tick mark will be set for every second data series, etc.

The option Tick labels determines which tick marks to label. Enter 1, and each tick mark will be labeled.
Enter 2, and every second tick mark will be labeled, etc.
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§ Invert axis direction 

If this option is enabled, the direction of the axis will be reversed. The order of the data series will also be
reversed accordingly; the chart will thus start with the last series and end with the first series.

Font tab

You can use this tab to change the formatting of the axis labels.

In addition to font, font size, and text styles, you can also set the alignment, rotate the labels and change the
numeric format.

Axis title

You can name each axis. This will then be displayed below/next to the axis. For more information, see
Showing/hiding axes and axis titles.

Edit properties: To change the properties of the axis title, select it and right-click to open the context menu and
choose the command (Category/Value) axis title: Properties.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the axis title.

You can make the following settings:

Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section 

Here, you can change the line style for the border of the axis title. To do so, use the option Custom to select
the desired line style. The option None removes the border.

If you enable the option Shadow, the axis title will also be highlighted with a shadow.

§ Fill section 

Here, you can change the fill of the axis title. To do so, use the option Color to select the desired fill color.
The fill will be transparent if you use the option None.

If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.

Text tab

Here, enter the desired axis title. If you delete the text completely from the input field, the axis title, as a chart
element, will be removed.
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Font tab

On this tab, you can change the formatting of the axis title.

In addition to font, font size, and text styles, you can also set the alignment, rotate the labels and change the
numeric format.

Chart title

Here, you can enter a title for the chart. This is then displayed above the chart. For more information, see
Showing/hiding chart titles.

Edit properties: To change the properties of the chart title, select it and right-click to open the context menu and
choose the command Chart title: Properties.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the chart title.

You can make the following settings:

Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section 

Here, you can change the line style for the border of the chart title. To do so, use the option Custom to
select the desired line style. The option None removes the border.

If you enable the option Shadow, you can also highlight the chart title with a shadow.

§ Fill section 

Here, you can change the fill of the chart title. To do so, use the option Color to select the desired fill color.
The fill will be transparent if you use the option None.

If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.

Text tab

Here, enter the desired title of the chart. If you delete the text completely from the input field, the chart title, as
a chart element, will be removed.

Font tab

On this tab, you can change the formatting of the chart title.
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In addition to font, font size, and text styles, you can also set the alignment, rotate the labels and change the
numeric format.

Gridlines

You can show gridlines to make the values in a chart easier to read. (For more information, see Showing/hiding
gridlines.)

Gridlines are a network of lines that extend across the plot area, starting from one of the axes of the chart.

The following types of gridlines are available:

§ Major gridlines are indicated at every major tick mark on the axis. 

§ Minor gridlines subdivide the major grid into an even finer grid if necessary.

Edit properties: To change the properties of the major gridlines of the value axis, for example, select one of its
gridlines, right-click on it to open the context menu and choose the command Value axis major gridlines:
Properties.

Tip: Alternatively, you can chose this command via the Edit properties icon  on the ribbon tab Chart.

You can make the following settings:

Format tab

Tip: The appearance of the lines can also be conveniently adjusted directly via the buttons of the ribbon tab
Chart | group Chart elements. For more information, see Editing chart elements.

§ Line section 

Here, you can change the line style used to draw the gridlines. Auto uses thin gray standard lines. None
removes the lines. The option Custom lets you customize the line style.

Changing the scale of gridlines

To change the distances between the gridlines, select the corresponding axis, choose its properties and make the
desired changes on the Scale tab.

Legend

If desired, you can show a legend in the chart. For more information, see Showing/hiding the legend.

A legend is a small box that shows which data series are displayed in which color/pattern.
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Edit properties: To change the properties of the legend, select it, right-click it to open the context menu and
choose the command Legend: Properties.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the legend.

Note: If you only want to edit a single legend entry (you can also apply a formatting to it that differs from that of the legend as a whole),
then click again in the area of the desired legend entry after selecting the legend. You can now choose the command Legend entry:
Properties via the context menu.

You can make the following settings:

Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section 

Here, you can change the line style of the legend's border. To do so, use the option Custom to select the
desired line style. The option None removes the border.

If you enable the option Shadow, the legend will also be highlighted with a shadow.

§ Fill section 

Here, you can change the fill of the legend. To do so, use the option Color to select the desired fill color.
The fill will be transparent if you use the option None.

If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.

Font tab

You can use this tab to change the character format (font, font size, text styles, etc.) of the legend.

Legend tab

Here, you can specify where the legend should be displayed.

If you select the option Custom, the legend can be moved to any position (using the mouse).

If you select None, the legend will be hidden.
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Changing chart properties via the dialog box

The previous sections discussed how to edit the properties of specific chart elements. This section discusses the
properties of the chart itself.

To change the properties of a chart, click to select the chart and right-click to open the context menu. Select the
entry Chart: Properties.

Tip: Alternatively, you can open the dialog box by clicking on the group arrow  in the bottom right corner
of any command group of the ribbon tab Chart.

The following settings can be made in this dialog box:

Format tab

On the Format tab, you can change the position and size of the chart.

For more information, see Object properties, Format tab.

Properties tab

Here, you can change the general settings of the chart.

For more information, see Object properties, Properties tab.

Chart type tab

Here, you can change the chart type:

First, select the desired Chart type on the left and then the desired Subtype on the right. For more information
on the available chart types, see Changing the chart type.

Color palette: You can change the color scheme of the chart here.

Reset all settings in chart: This option restores any changes you made to the properties of the chart back to
their original state.

On the right side of the dialog box, a Preview shows the result of your customizations. If necessary, use the

button  to open the preview.

Series tab

Data series are the most important chart elements. They represent the data to be evaluated – in the form of
columns, bars, lines, etc., depending on the chart type selected.

The Series tab allows you to make settings for each data series of a chart. Here, you can also enter and change
the numeric values that you want to display in the chart (via the Edit button).

In the Series list, select the series you want to change. Then make the desired settings:

§ Series 

The list Series contains a list of all data series currently included in the chart.
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You can use the arrow buttons to the right of the list to change the order of the data series.

Use the Add and Delete buttons to add or remove data series.

The Edit button can be used to edit the numeric values contained in the selected data series. For more
information, see also Entering/editing the data of a chart.

§ Data sources section 

Here, you can specify which data should represent the selected data series.

The fields in this section are filled in automatically, and there is usually no need to change them.

Note: Do not manually edit the fields in this section. Use the Edit button instead (located below the
Series list). It opens a dialog box where you can enter/edit these values in a more convenient manner. For
more information on this dialog box, see Entering/editing the data of a chart.

The following fields can be found here:

Name: The name of the data series. This field can also be left empty, whereupon the data series receives an
automatically generated name (for example, "Series 1", "Series 2", etc.).

Y values: The Y values for each data point of the data series. To edit these values, it is best to use the Edit
button (located below the Series list).

Explanation: For most chart types, the Y values are the values that should be displayed in the chart. For example, the Y values
determine the height of the columns in a column chart.

X values: The X values of the data series. To edit these values, also use the Edit button (located below the
Series list).

Explanation: For most chart types, the X values are irrelevant and are set to "Auto" (i.e., automatic) because they are only used to
label the category axis (X axis). XY scatter charts and bubble charts are the exception, however, as the X and Y values determine
the coordinates of the data points in these charts.

Bubble sizes: For bubble charts, there is a third parameter in addition to X and Y values: the size of the
bubbles for each data point. You should use the Edit button to edit the values here also.

§ Display this series as section 

Here, you can specify how the selected data series is displayed in the chart. If, for example, you have
selected a column chart as the chart type, but want a particular series to appear as a line chart, you select the
option Lines for this data series.

§ Use secondary axis for this series 

If you enable this option, a secondary value axis (Y axis) will be added to the chart for this data series.
Secondary value axes can have a different scale to primary value axes.

Explanation: It is useful to represent specific data series on a secondary axis if these data series require an axis with a completely
different scale because they contain significantly larger values than the other data series.

Elements tab

On the Elements tab, you can show/hide and label the various chart elements:

§ Chart title 

Here, you can enter a title for the chart. The title will then be displayed above the chart.
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§ Primary axes section 

Here, you can make settings for the primary axes:

You can use the checkbox in front of each axis to enable/disable the display of this axis.

To the right of the checkbox, you can give the axis a name. This will be displayed below/next to the axis.

The options Major grid and Minor grid determine whether gridlines should be displayed in the background
of the chart. These grids make it easier to read the values.

§ Secondary axes section 

If the chart has secondary axes, you can configure them here, similar to the primary axes (see above).

§ Legend 

Here, you can specify the position of the legend. A legend is a small box that shows which data series are
displayed in which color/pattern.

3D view tab

Note: This tab is only available for three-dimensional chart types.

On the 3D view tab, you can change the 3D effect for the chart (for three-dimensional chart types).

§ Rotation angle and Elevation angle 

Here, you can set the viewing angle (in degrees) from which the viewer sees the chart. Rotation angle
rotates the chart around the vertical axis, while Elevation angle rotates the chart around the horizontal axis.

§ Perspective 

If this option is enabled, the chart will be distorted in terms of perspective. You can also specify the amount
of distortion (from 0 to 100%).

§ Height  and Depth 

Here, you can change the height and depth of the chart (as a percentage of its original size).

Radar tab

Note: This tab is only available for radar charts.

On the Radar tab, you can make additional settings for displaying the chart (for radar charts).

§ Starting angle 

This option allows you to rotate the chart by the specified angle.

§ Orientation 

This option specifies whether the values should be arranged clockwise or counterclockwise.
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§ Round radar chart 

If this option is enabled, pie segments are drawn between the axes instead of lines.

§ Polar coordinates 

If this option is enabled, polar coordinates are used instead of Cartesian coordinates. The polar coordinates
are only available if Round radar chart is enabled.

If Angle between axes is set to x, an axis will be plotted every x degrees.

If Angle between axis descriptions is set to x, an axis label will be plotted every x degrees.

§ Limit plot area to radar 

If this option is enabled, only the area inside the radar will be filled. If it is disabled, the entire rectangle
surrounding the radar will also be filled.

Saving charts as pictures

You can save an image of a chart as a picture file at any time. This makes it easier to share the chart with others
or to insert it into a web page or any other document.

To do so, proceed as follows:

1. Select the desired chart by clicking on it.

2. Right-click on the chart and choose the command Save as picture from the context menu.

3. In the Save as type list, select the desired picture format.

Tip: The PNG format is always a good choice here since it offers good and completely lossless compression.

4. Enter the file name under which you want to save the picture and confirm with OK.

5. Another dialog box appears. Select the desired resolution for the picture or manually enter your own values
for the width and height. Then confirm with OK.

Presentations now creates a corresponding picture file with an image of the chart.
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OLE objects

Note: The use of OLE objects is only possible with the Windows version of Presentations.

With Presentations for Windows, you can embed objects created with other applications (drawings, pictures,
etc.) in your document.

Example: You can use the ribbon command Insert | OLE object frame (click directly on the icon itself) to
start the Windows Paint program from Presentations and draw something in it. If you exit Paint, the drawing
will appear in the Presentations document. It is now embedded in the document.

Advantage: You only have to double-click the drawing in the Presentations document and Paint will then be
restarted automatically. If you now edit the drawing in it and exit Paint again, your changes will be imported by
Presentations.

For this to work, the application that you choose must support OLE. OLE stands for Object Linking and
Embedding. The object that is imported from the other application into Presentations is called an OLE object.

Depending on your preference, you can either embed an OLE object in a document or insert it in the form of a
link to a file.

§ When embedding an OLE object, the object is newly created by another program and then permanently
integrated into the Presentations document. Thus, it exists only in the Presentations document. 

§ Linking works in a similar way, except that the OLE object (the drawing, picture, etc.) exists as a separate
file in this case. You only insert a link to this file in the Presentations document. If you subsequently use
another program to change something about the original file and then open the Presentations document, the
changes will also be visible there. Thus, the OLE object itself is not embedded in the Presentations
document but only a copy of the object.

All further information on working with OLE objects can be found on the following pages. The information
covers the following topics:

§ Embedding OLE objects 

§ Editing OLE objects

§ Editing links to OLE objects

§ Changing OLE object properties via the ribbon tab

§ Changing OLE object properties via the dialog box

§ Using the SoftMaker Equation Editor
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Embedding OLE objects

Note: The use of OLE objects is only possible with the Windows version of Presentations.

By choosing the ribbon command Insert | OLE object frame  (click directly on the icon itself), you embed
an object into a Presentations document, which you created with another application. After embedding such an
object, you can still edit it with the application that you originally used to create it.

The command opens a dialog box with a list of all applications that can provide OLE objects. The entries which
are displayed here depend on the OLE-enabled programs that are installed on your system.

If you select "Paintbrush Picture", for example, a window from Window’s Paint program (called Paintbrush in
some versions of Windows) will open. Create a picture in it and then exit Paint. The picture is now embedded
in the slide. It can be edited again at any time – simply double-click on the picture in the slide.

To embed an OLE object, proceed as follows:

1. Choose the ribbon command Insert | group Objects | OLE object frame . To do so, click directly on the
icon itself.

2. A dialog box appears. From the list Object Type, select the source application from which you want
Presentations to receive the OLE object.

3. When you confirm with OK, Presentations will start the application that corresponds to the selected object
type.

4. Create the object in the application.

5. Exit the application.

6. The application may now ask if you want to update the object in the Presentations document. Confirm this
with "Yes".

7. The OLE object created in the other application is now embedded in the Presentations document.

You can then move or resize the object:

To move it, click on the object and then drag it to the desired position (while still holding the mouse button
down).

To adjust its size, drag one of the round handles surrounding the object.

Tip: If you click on the icon's arrow under Insert | OLE object frame instead of on the icon itself, you will
find a small selection of useful applications for quick access: PlanMaker worksheet object, PlanMaker chart
object, TextMaker object. For other applications, select More to access the dialog box described above.
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Creating an OLE object from a file

If you don't want to create a new OLE object, but want to embed an existing file from another application as an
OLE object, you still choose the ribbon command Insert | OLE object frame, but you select the option Create
from File in this case.

The appearance of the dialog box changes: Instead of the list Object Type, the File input field is displayed.
Here, enter the full file name or click on the Browse button to open a dialog box that will enable you to search
your hard disk for the file.

If you specify a file and confirm with OK, the file will be inserted as an OLE object.

In doing so, Windows checks the file name extension to see if it is associated with a program that can be started
and it responds accordingly. If the file name extension is not registered, only an icon will appear for the
embedded file. If, on the other hand, Windows can associate the name extension with an OLE-enabled program,
the content of the embedded file will be displayed.

Creating a link to the original file

For the option Create from File in the aforementioned dialog box, you can also select whether the file to be
inserted should be embedded or linked. If you leave the option Link disabled, Presentations will insert a copy of
the file into the document as an OLE object and save this copy in the document – the object will thus be
embedded in the usual way.

If, on the other hand, you enable the option Link, Presentations will insert the OLE object in the form of a link
to the original file. This does not change anything in terms of use. If you subsequently change the original file
of the OLE object with another program and reopen the Presentations document, however, the OLE object will
have also changed accordingly – the OLE object will thus be linked to the original file.

Editing OLE objects

Existing OLE objects can be edited as follows:

Select the OLE object and click on the OLE object icon  on the contextual ribbon tab OLE object. In the
menu that appears, select the entry Edit.

Tip: Alternatively, simply double-click on the OLE object to edit it. The object will be opened immediately
in the associated application, where it can be edited.

Another alternative: You can also use the context menu to edit an OLE object. Proceed as follows:

1. Click on the OLE object to select it.

2. Right-click on the OLE object to open the context menu and select the menu item with the object name (for
example, Bitmap object). Selecting this menu item opens a submenu containing all OLE commands that are
available for this object. There is a command Edit for editing the object. Choose this command.

3. The source application associated with the OLE object will now start. Make the desired changes.
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To return to Presentations, simply exit the object's source application. When exiting some applications, you will
be asked if you want to update the object in the Presentations document. Answer "Yes" – your changes will be
discarded otherwise.

Editing links to OLE objects

If you have created an OLE object from a file and enabled the option Link, you can edit this link to the source
file. To do so, right-click on the OLE object to open the context menu and choose the command Link.

Alternatively, simply click on the Edit link icon  on the contextual ribbon tab OLE object.

The program will display a dialog box which lists all links in the current document. When you select a link, the
file name and type of the associated source file are displayed in the lower part of the dialog box.

The buttons of the dialog box allow you to perform the following actions:

Button Function

Update now This button updates the OLE object. Use this button if the source file has been changed by
another program and the changes are not visible in the Presentations document.

Open source This button starts the application associated with the OLE object and lets you edit the
object in it. Tip: Double-clicking on the object has the same effect.

Change source This button lets you select a different file as the source for the OLE object.

Break link/
Remove

This severs the link to the source file. The object is then embedded permanently in the
Presentations document. Changes to the source file no longer have any effect on the
document. However, the object can still be edited by double-clicking on it.

Update:
Automatic or
Manual

If you have selected the option Automatic, changes that you make to the source file using
the Open Source button are always updated automatically for the OLE object. If Manual
is selected, changes to the source file are not updated for the OLE object until you click on
the Update Now button.

Changing OLE object properties via the ribbon tab

Numerous properties of OLE objects can be changed directly via the buttons of the contextual ribbon tab OLE
object.
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The contextual ribbon tab "OLE object", left section

The contextual ribbon tab "OLE object", right section

This ribbon tab appears automatically when you select an OLE object. It contains the following buttons (from
left to right):

§ New object: This option allows you to insert a new object into the document and different object types are
available. 

§ OLE object: You can Edit, Open or permanently Convert the selected object here.

§ Edit link: If you have created an OLE object from a file and enabled the option Link, you can edit this link to
the source file. For more information, see Editing links to OLE objects.

§ Cropping: You can enable/disable crop mode via this button. In this mode, additional handles appear on the
borders of the object. Drag these handles with the mouse to crop the object accordingly. To exit the mode,
click on the button again. You can also use the button's small arrow to select a cropping from different
shapes or to remove the cropping.

See also the next section ("Picture tab" in the dialog box).

§ Brightness, Contrast, Saturation: Drag the slider or click on    and   to change the respective values for
the object. For more information, see also the next section ("Picture tab").

§ Recolor picture: This option provides a list of predefined variations of the object – for example, other color
modes (grayscale, black/white, etc.) and variations where the object was colored. For more information, see
also the next section ("Picture tab").

§ AutoShape effects (not included in SoftMaker FreeOffice): Here, you can apply effects such as shadows,
reflections, etc. This option largely corresponds to the options of the tabs Shadow, 3D and Effects of the
dialog box "Object properties". For more information, see next section.

§ Fill color: The fill can be changed here. For more information, see Object properties, Fill tab. However, this
function is not supported by all OLE applications. 

§ Line color, Line thickness: These options allow you to apply border lines. For more information, see Object
properties, Lines tab.

§ Bring to front, Send to back: These options arrange the order of overlapping objects. For more information,
see Changing the order of objects.
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§ Align objects: This option allows you to align or evenly distribute two or more object frames. For more
information, see Aligning and distributing objects.

§ Group: This option allows you to combine several selected objects into one unit, which can then be treated
like a single object. For more information, see Grouping objects. 

§ Duplicate: This option creates an immediate copy of the selected object.

§ Width, Height: These options change the size of the object. For more information, see Changing position and
size of objects.

Many (but not all) of these functions and some additional options can be found in the dialog box Object
properties, which you can access, for example, via the context menu. For more information, see the next
section.

Changing OLE object properties via the dialog box

The properties of an object can be edited centrally using the Object properties dialog box. An object's
properties include, for example, its size, margins and numerous other settings options.

To edit the properties of an OLE object, first click on it to select it. Then open the dialog box by clicking on the
group arrow  in the bottom right corner of any command group on the contextual ribbon tab OLE object.

Alternatively: Right-click on the OLE object to open the context menu and select the entry OLE object
properties.

The following settings can be made in this dialog box:

Format, Fill, Lines tabs, etc.

These tabs are available for almost all object types. They allow you to change the following settings:

§ Format: You can change the size and position of the OLE object here. For more information, see Object
properties, Format tab. 

§ Fill: This option allows you to change the fill. This function is not supported by all OLE applications. For
more information, see Object properties, Fill tab.

§ Lines: This option allows you to apply border lines. For more information, see Object properties, Lines tab.

§ Shadow: This option allows you to apply a shadow. For more information, see Object properties, Shadow
tab.

§ Effects: This option allows you to apply different effects. For more information, see Object properties,
Effects tab.

§ Properties: This option allows you to change general settings. For more information, see Object properties,
Properties tab.

§ AutoShapes: Here, you can assign a different shape from AutoShapes to the object. For more information,
see Object properties, AutoShapes tab.

In the case of OLE objects, there is an additional tab with further options:
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Picture tab

On the Picture tab, you can make settings that affect the graphical representation of the OLE object.

Note: Depending on the type of OLE object, some of these options may not work.

Available options:

§ Variants 

This list offers some predefined variations – for example, different color modes (grayscale, black & white,
etc.) as well as colored variants of the object.

Simply click on the desired variant. The options in the dialog box are then automatically set to the
corresponding settings.

§ Options section 

Here, you can change brightness, contrast, saturation and gamma value (an alternative way to change
brightness).

§ More button 

This button opens a dialog box with additional settings:

If you enable the option Mix with color and select a color below it, the object will be colored accordingly.

The options in the Cropping section can be used to crop the object. This is useful if you only need a section
of the object. If, for example, you want the upper quarter of the object to be truncated, first select Use
relative values and enter "25" (percent) for Top.

If you select Use absolute values, the entries will be truncated in absolute units of length rather than as a
percentage. If you enter negative values, the areas of the object will not be truncated, but will be extended
with a frame instead.

Using the SoftMaker Equation Editor

FreeOffice: The SoftMaker Equation Editor is not included in SoftMaker FreeOffice.

Note: The SoftMaker Equation Editor is available only on Windows and is not included in all versions of
Presentations.

The SoftMaker Equation Editor allows you to graphically display mathematical and technical equations.

Presentations communicates with the Equation Editor via OLE, as described in the previous sections. In order to
add a graphical representation of an equation to your document, insert an OLE object that uses the Equation
Editor as the source application.

To do so, proceed as follows:

1. In Presentations, choose the ribbon command Insert | OLE object frame. To do so, click directly on the
icon itself.
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2. In the list Object Type of the dialog box, select SoftMaker Equation Editor.

3. Confirm with OK to start the Equation Editor.

Tip: You can insert an equation even faster via the ribbon command Insert | Equation Editor object .

4. Create the desired equation.

5. When the equation is complete, simply exit the Equation Editor.

The equation is now embedded in the Presentations document as an OLE object.

You can subsequently edit such Equation Editor objects at any time by double-clicking on them. The Equation
Editor is then restarted and opens the equation. Make the desired changes and then simply exit the Equation
Editor again.

You can also change the properties of the Equation Editor object by right-clicking on the Equation Editor
object, opening the context menu, and choosing the command OLE object properties.

Information from the creators of the Equation Editor

The SoftMaker Equation Editor is a special version of the MathType program from Design Science. If you frequently use equations in your documents,
you might find that MathType itself is even better suited to your needs than the SoftMaker Equation Editor. While just as easy to use as the Equation
Editor, MathType has a number of additional functions that can help you to become more productive and create more complex equations.

MathType is available in English, German and other languages. For information about how to purchase MathType, contact your software vendor or
Design Science directly.

Design Science, Inc.
140 Pine Avenue, 4th Floor
Long Beach, CA 90802
USA

Phone (USA): +1 (562) 432-2920 (for international customers)
+1 (800) 827-0685 (for customers within the USA and Canada)

Fax (USA): +1 (562) 432-2857

E-mail (English): sales@dessci.com
Website: www.dessci.com
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Tables
Would you like to arrange text or figures in a presentation in a clear tabular form? Then use the practical table
function of Presentations.

In this section, you will learn everything you need to know about working with tables. The information covers
the following topics:

§ Inserting tables 

§ Ribbon tab "Table"

§ Moving in tables

§ Selecting table cells and cell contents

§ Deleting, copying, moving cell contents

§ Deleting and inserting table cells

§ Splitting and merging table cells

§ Formatting tables

See the following pages for more information.

Inserting tables

To insert a table into a slide, use one of the following methods:

Inserting quickly via the grid

Tables with a limited number of rows/columns and without further adjustments can be inserted directly via the
grid (the table can also be further adjusted at any time afterwards):

Click on the small arrow of the icon  on the ribbon tab Insert | Table and move the mouse over the
expanded grid. Above the grid, you will see how many rows and columns you are currently selecting.
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As soon as the table has the desired dimensions, click with the mouse into the grid and Presentations will insert
the table into the document.

Inserting via the dialog box with additional options

If you want to insert a table with any number of rows/columns and also adjust the inner margins, select the
method via the dialog box:

1. Click on the icon itself  on the ribbon tab Insert | group Table. Alternatively, click on the icon's small
arrow and select the entry Insert table below the grid.

2. The program displays a dialog box in which you can specify the number of rows and columns the table
should contain.

In the section below, you can also specify the inner margins for the table cells if necessary.

3. If you confirm with OK, the table frame is inserted.

You can then move or resize the table frame:

Important: Click with the mouse on the border of the table frame in order to move it. While still holding the
mouse button down, drag the text frame to the desired position.

To resize it, drag one of the handles surrounding the table frame.

Of course, you can also subsequently move and resize tables at any time. However, remember that you must
first select the table by clicking on its border.
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Ribbon tab "Table"

Once you have created a table, you can switch to the contextual ribbon tab Table for editing. This always
appears automatically on the far right as an additional tab if you have set the text cursor in a table.

The contextual ribbon tab "Table"

The ribbon tab has the following buttons (from left to right):

§ Select: Select the whole table or current rows/columns. 
For more information, see Selecting table cells and cell contents.

§ Properties: Format tables and change other properties of the table.
 For more information, see Changing general table properties.

§ Shading of the selected cells can be changed with this option. For more information, see Changing cell
properties.

§ Borders of the selected cells can be changed with this option. For more information, see Changing cell
properties.

§ Text alignment of the selected cells can be changed with this option. For more information, see Changing cell
properties.

§ Delete cells: Delete individual cells, delete rows/columns or delete the entire table.
For more information, see Deleting and inserting table cells.

§ Insert rows: Insert rows or individual cells above/below.
For more information, see Deleting and inserting table cells.

§ Insert columns: Insert columns or individual cells on the left/right.
For more information, see Deleting and inserting table cells.

§ Distribute rows, columns: This option ensures the equal spacing of selected rows/columns of a table.
For more information, see Distributing rows and columns evenly.

§ Merge cells: Connect adjacent table cells to form a single cell.
For more information, see Merging table cells.

§ Split cells: Divide a table cell into several cells. For more information, see Splitting table cells.

§ Bring to front, Send to back: These options arrange the order of overlapping objects.
For more information, see Changing the order of objects.

For more information on the commands, see the specified sections.
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Moving in tables

You can enter, edit and format text within tables in the usual manner. After inserting a new table, Presentations
automatically places the text cursor in the first table cell so that you can start typing immediately.

You can also type multiple lines of text within a cell – the breaking of lines and the adjustment of row height
occur automatically. Alternatively, you can press the Enter key¿ to start a new paragraph within the cell.

To move the text cursor from one table cell to another, you can press the Tab key to move to the next cell, or
Shift+Tab to move to the previous cell. To move the text cursor from row to row, use the arrow keys â and á.

You can also click in the desired cell using the mouse.

Note: As you can see, the Tab key cannot be used to insert tabs within table cells. You must use the key
combination Ctrl+Tab in tables for this purpose.

Selecting table cells and cell contents

Selecting text within a cell works in the same way as selecting normal text with the mouse. For more
information, see Working with selections.

To select complete table cells and their contents, proceed as follows:

Selecting via the mouse

§ Select the entire table or table area: Click in the first cell to be selected and then drag the mouse with the
mouse button pressed to the last desired cell. 

§ Select a single cell: In rare cases, you only need to select a single cell. This is done via the following
"trick": Drag the mouse cursor from the cell you want to select to an adjacent cell and back again.

Alternatively, click in the table cell with the mouse and then press Shift+à to select the entire cell. To select
additional cells, continue pressing Shift+à or Shift+â.

Selecting with the commands of the ribbon tab "Table"

On the contextual ribbon tab Table, choose the command Select  (in the group Table). This opens a
submenu in which you can select whether the entire table, the current row or the current column should be
selected.
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Deleting, copying, moving cell contents

To delete, copy or move the contents of table cells, select them and then use the familiar commands:

Command Explanation

Delete Press the Del key on the keyboard to delete the contents of all currently selected cells – without them
ending up in the clipboard.

Cut The command Home | Cut cuts the contents of the selected cells and puts them in the clipboard.

Copy The command Home | Copy copies the contents of the selected cells to the clipboard.

Paste Home | Paste pastes the contents of the clipboard. (Click directly on the icon itself.) Before using
this command, position the text cursor in the desired table cell.

Paste special If you click on the small arrow below the icon rather than directly on it at Home | Paste, a dropdown
menu opens with additional options for pasting the contents. For more information, see Paste special.

Note: Bear in mind that these commands apply only to the contents of the cells. Thus, if you select some
cells and press the Del key, for example, only the contents of the cells are removed; the cells themselves
remain unchanged. For more information on deleting/inserting complete table cells (including their
contents), see the next section.

Deleting and inserting table cells

In the previous section, you learned how to delete, copy or move the contents of table cells.

In contrast, this section describes how you can completely delete cells from a table and insert additional cells in
a table.

§ Deleting cells from a table 

§ Inserting cells in a table

Deleting cells from a table

To completely delete cells (including their contents) from a table, proceed as follows:

1. Select the cells to be deleted.

Tip: To do so, don't just press the Del key because this only deletes the contents of the table cells, and not
the table cells themselves.
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2. Choose the ribbon command Table | Delete cells  (click on the icon itself). The selected cells are
deleted.

Alternatively, click on the icon's arrow and select exactly what you want to delete from the submenu:

Delete rows: deletes all rows within the selection

Delete columns: deletes all columns within the selection

Delete cells: deletes only the currently selected cells

Delete table: deletes the entire table

The table cells are now removed.

Inserting cells in a table

To add additional cells to a table, proceed as follows:

Inserting rows

1. Position the text cursor in the cell before or after which the new cells are to be inserted.

2. Choose the ribbon command Table | Insert rows  (click on the icon itself). A row is inserted below the
current cell.

Alternatively, click on the icon's arrow and select exactly what you want to insert from the submenu:

Insert row above: inserts a row above the current cell

Insert row below: inserts a row below the current cell

Insert cells: displays a dialog box with additional options (see below)

The rows or cells are now added to the table.

Note: If you have selected several rows, the following applies to the commands described above: The
program will add as many rows as you selected previously. Furthermore, if you select several rows, the
option Insert cells does not open a dialog box. Instead, the program inserts the selected number of rows
directly below those selected.

Inserting columns

1. Position the text cursor in the cell before or after which the new cells are to be inserted.

2. Choose the ribbon command Table | Insert columns  (click on the icon itself). A column is inserted to
the right of the current cell.

Alternatively, click on the icon's arrow and select exactly what you want to insert from the submenu:

Insert column left: inserts a column to the left of the current cell

Insert column right: inserts a column to the right of the current cell
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Insert cells: displays a dialog box with additional options (see below)

The rows or cells are now added to the table.

Note: If you have selected several columns, the following applies to the commands described above: The
program will add as many columns as you selected previously. Furthermore, if more than one column is
selected, the option Insert cells does not open a dialog box. Instead, the program inserts the selected number
of columns directly to the right of those selected.

Options

If you select the option Insert cells when using the above procedure for rows or columns, the program displays
a dialog box. Here, you can specify how the new cells are to be inserted.

The dialog box provides the following options:

Option Explanation

Entire rows Complete rows of cells are inserted.

Entire columns Complete columns of cells are inserted.

Single cells Individual cells are inserted. If, for example, you selected 4x4 cells before choosing the command,
4x4 cells will be inserted.

In addition, the option Number allows you to specify the number of cells to be inserted. If, for example, you
select the option Entire rows and then set the Number to 10, ten rows will be inserted instead of only one row.

Finally, click on Insert to insert the new cells before the current cell – or on Append to insert them after the
current cell.

Tip: Appending an additional row quickly to the end of a table

You can also append an additional row to the end of a table by simply pressing the Tab key when the text
cursor is in the last cell of the table. Presentations then automatically extends the table by adding a new row.
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Splitting and merging table cells

You can divide a table cell into several cells at any time – or merge several table cells into a single cell.

You will learn how to do so in this section:

§ Splitting table cells 

§ Merging table cells

Splitting table cells

You can split a table cell at any time, thus dividing it into several cells.

To do so, proceed as follows:

1. Position the text cursor in the cell that you want to split.

2. Choose the ribbon command Table | group Merge and split | Split cells .

3. A dialog box appears. In this dialog box, enter the number of rows and columns into which the cell should
be split.

4. Confirm with OK.

The cell is now split accordingly.

Splitting several cells at once

You can also select several adjacent cells before choosing the command Split cells. In this case, these cells are
all split.

Note the option Join selected cells before splitting? in the dialog box of this command:

§ If you select the option Treat the selection as one cell and split it, the selected cells will be merged into a
single cell before splitting. 

§ If you select the option Each selected cell will be split individually, however, each of the selected cells
will be split into the specified number of rows and columns.

Merging table cells

You can merge several adjacent table cells at any time. They are then merged into a single cell.

To do so, proceed as follows:
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1. Select the cells to be merged.

2. Choose the ribbon command Table | group Merge and split | Merge cells .

The cells are now merged into one cell.

In this process, the contents of the original cells are not lost; they are combined in the resulting cell. The
content of each original cell is placed in a separate paragraph.

Formatting tables

Several commands are available for formatting tables. These commands are presented in the following sections:

§ Distributing rows and columns evenly 

You can use the ribbon commands Table | Distribute rows or Table | Distribute columns to adjust
selected rows/columns to a uniform height or width.

§ Changing row properties 

Choose the ribbon command Table | Properties | Row to change the formatting of the rows in a table – for
example, the row height.

§ Changing cell properties 

Choose the ribbon command Table | Properties | Cell to format individual table cells. You can use it to
change the width, alignment and margins of cells, and to add borders or shading to cells.

§ Changing general table properties 

Choose the ribbon command Table | Properties | Table to change the formatting of entire tables. For
example, you can use this command to change the border and shading of all table cells at once.

See the following pages for more information.

Distributing rows and columns evenly

By default, rows and columns are distributed evenly, which means that all cells are the same size. However, you
can change both row height and column width as desired by dragging and dropping any of the inner or outer
borders of the table.

Note: To specify the exact row height in the dialog box, see Changing row properties, or for the column
width, see Changing cell properties.

There is also the option of distributing rows and columns evenly across the table again: You can use the ribbon
commands Table | Distribute rows and Table | Distribute columns to evenly distribute the selected rows or
columns of a table.

If you want rows of a table to have the same height, proceed as follows:
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1. Select the desired rows (all or only some) of a table.

2. Choose the ribbon command Table | group Rows and columns | Distribute rows .

3. As a result, the selected rows have the same height.

If you want the columns of a table to have the same width, proceed as follows:

1. Select the desired columns (all or only some) of a table.

2. Choose the ribbon command Table | group Rows and columns | Distribute columns .

3. As a result, the selected columns have the same width.

Changing row properties

The ribbon command Table | Properties  | Row opens a dialog box in which you can change the formatting
of the rows in a table.

Before choosing this command, select the rows whose format is to be changed. If you do not select any rows,
the changes will be applied only to the row in which the text cursor is positioned.

The dialog box for this command provides the following options:

Height

Here, you can change the height of the table row. The following options are available:

§ Auto 

This is the default setting. If it is selected, Presentations determines the optimum height for the rows
automatically (by adjusting it to the actual space requirement of the cell contents).

§ Exact 

If you select this option, you can specify the desired row height exactly in inches. However, the row will
then always assume this height, even if it is not enough to fully display the contents of the cells.

§ At least 

This option represents a combination of the two options above. If you enter "1 in" here, for example, the
height of the rows will be set to exactly 1 inch, provided that this height is sufficient for the contents of the
cells. If you enter more text in a cell than can be accommodated within 1 inch, however, Presentations will
automatically increase the row height.

Changing cell properties

The contextual ribbon tab Table contains several commands (or a dialog box) with which the appearance of the
current table cell can be changed. Of course, you can select several cells (or complete rows and columns) before
choosing the commands described below to change their properties together.
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Common options: Via the icons of the ribbon tab "Table"

For the quick application of selected cell properties, you can use the following icons of the ribbon tab Table
directly:

§ Text alignment  (in the group Format): Here, you can specify how the cell content is to be aligned
within the cell. Different combinations of left, right, top, bottom, centered are possible. 

§ Shading  (in the group Format): Here, you can apply shading to the selected cells. To do so, select the
desired cells and then click on the icon's arrow instead of the icon itself. The program opens a dropdown
menu in which you can click to select the desired type of shading.

If you then want to apply the exact same type of shading to other cells, simply select them and click on the
icon itself (not the arrow). Presentations will then reapply the last selected type of shading.

For individual adjustments, select the entry More via the icon's arrow. The program opens a dialog box in
which you can select grids and patterns in addition to colors. For more information, see "Shading tab"
below.

§ Borders  (in the group Format): Here, you can provide selected cells with a complete border or
individual border lines at the top, bottom, left or right. 

This option provides the same functionality as above for shading.

For individual adjustments, select the entry Borders via the icon's arrow. The program opens a dialog box in
which you can specify different types of borders. For more information, see "Borders tab" below.

Advanced options can be found via the dialog box below:

Additional options: Via the dialog box

You open the dialog box with the ribbon command Table | Properties  | Cell.
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The dialog box contains the following options:

Format tab

This tab provides the following settings options:

§ Size 

Here, you can change the Width of the selected cells.

Note: The width of the entire column always changes. You cannot set the width separately for individual
cells in a column.

Tip: You can also change the width with the mouse. To do so, drag the side border of the cell with the
mouse. This always adjusts the width of the entire column also.

§ Vertical alignment 

This setting determines how the cell contents should be aligned within the cell:

Top: The cell content will be aligned to the top edge of the cell. (This is the default setting.)

Centered: The cell content will be centered between the top and bottom edges of the cell.

Bottom: The cell content will be aligned to the bottom edge of the cell.
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Justified: The lines of text within the cell will be equally spaced in such a way that the top line will be flush
against the top edge of the cell and the bottom line flush against the bottom edge.

§ Rotate by... 

Here, you can specify the angle of rotation for the cell content.

§ Margins 

Here, you can change the inner margins of the selected cells.

Borders tab

On this tab, you can apply border lines and gridlines to the selected cells (or change the existing lines).

Proceed as follows:

1. First, specify what type of border line you want to apply. You have the following options:

Line style (single, double or dashed lines)

Thickness of the line

Color of the line

2. Then specify where you want to apply this type of border line (top, bottom, left, right, etc.).

For this purpose, a preview box surrounded by a set of buttons is available in the right half of the dialog box.
Use it as follows:

A. In the preview in the right half of the dialog box, simply click directly on all lines to which the set
border line is to be applied.

B. Alternatively, you can use the buttons that are displayed to the left and below the preview for this
purpose. Each button represents a specific line (see icon on the button).

C. The buttons above the preview are useful shortcuts:

The Outline button applies the currently set border line to all outer borders.

The Inside button does the same for all inner lines (the "gridlines" between the cells).

The None button removes all lines at once.

3. If required, you can add/change additional lines by simply repeating step 2.

Of course, you can always change the line style, thickness or color (step 1) before applying it (step 2).

The table cells are then provided with the relevant lines.

Shading tab

On this tab, you can highlight selected cells with colored shading or a pattern:

§ Adding a shade 

A shade is a color shading that is mixed from the selected foreground color and background color.

To add a shade, set the Type to Shading and then make the desired settings:

First, set the desired Foreground and Background colors.
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In the section Shades, different mixtures of these two colors are now offered. Select one of these
suggestions. Alternatively, you can enter an exact percentage for the shade in the input field under Shading.
Values between 0 (100% background color) and 100 (100% foreground color) are allowed.

§ Adding a pattern 

To add a pattern, click on one of the patterns in the section Patterns.

You can also select a different Foreground and Background color for the pattern.

§ Adding an effect 

Click on the Customize button to apply effects such as gradients or pictures. This will open another dialog
box "Shading: Effects". In the Fill type section, you can choose between options as described in Object
properties, Fill tab.

After you exit the dialog box with OK, the option you selected in the Type section on the "Shading" tab is
selected as either Effects, Shading or None.

§ Removing shading, pattern or effect 

To remove a shading, pattern or effect, select the option None for Type.

Changing general table properties

You can make general settings for tables via the dialog box of the ribbon command Table | Properties. These
always apply to the entire table. For example, this command allows you to change the borders and shading of
all table cells at once.

To open this dialog box, position the text cursor in any table cell and then choose the ribbon command Table |

Properties . (Click directly on the icon itself.)

Alternatively, open the dialog box by clicking on the small arrow of the icon and selecting Table in the menu that appears.

Note: You can also open this dialog box by double-clicking on one of the borders of the table.

The following settings can be made in this dialog box:

Format tab

On this tab, you can change the size and position of the table.

Borders tab

Here, you can change the borders and gridlines (the lines between the cells) for the entire table.

The options on this tab correspond to those described in Changing cell properties ("Borders tab").

Cell shading tab

Here, you can change the shading of all cells in the table.

The options on this tab correspond to those described in Changing cell properties ("Shading tab").
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Cell format tab

Here, you can change the format (alignment, margins, etc.) of all cells in the table.

The options on this tab correspond to those described in Changing cell properties ("Format tab").

Table fill tab

Here, you can change the fill of the table as a whole.

The result is basically identical to changing the shading of all cells in the table (for example, using the
aforementioned Cell shading tab). The Table fill tab contains the fill options, which can be applied as effects
via the Customize button on the Cell shading tab. These options include, for example, gradients or pictures.

The options on this tab correspond to those described in Object properties, Fill tab.

Properties tab

Here, you can change some general settings of the table.

The options on this tab correspond to those described in Object properties, Properties tab.
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Media objects
You can embed media objects, either movie clips or sounds, into your presentation and play them during the
slide show.

In this section, you will learn everything you need to know about working with media objects. The information
covers the following topics:

§ Inserting media objects 

§ Ribbon tab "Media object"

§ Changing the properties of media objects

See the following pages for more information.

Inserting media objects

To insert a media object into a slide, proceed as follows:

1. On the ribbon tab Insert | group Media object, select whether a Sound  or a Movie  file (video)
should be inserted.

Note: Movies can only be inserted and played on Windows and macOS. Sounds can only be inserted and
played on Windows, macOS and Android/iOS.

2. The program will display a dialog box in which you can select the desired movie/sound file. Select the
desired file and click on OK.

3. The program displays another dialog box in which you can make settings for playing the sound or movie
when running the slide show:
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If you select the option Automatically, the media object will play automatically as soon as the slide appears
during your slide show. If, on the other hand, you select On mouse click, the media object will only play
when you click on it with the mouse.

Enable the option Play across slides (only available for sounds) if you want the sound to continue playing
after the show has advanced to the next slide. This is useful, for example, for background music.

If you enable the option Save within document, a copy of the media file will be saved in the document.
Otherwise, only a link will be created to the original file. (This option is available only for certain types of
media files.)

5. Click on OK to insert the object.

Tip: For movies, we recommend that you insert via the movie icon in the small bar of the placeholder
(available for slide layouts with generic placeholders. For more information, see section Slide layouts). This
automatically places the movie – adjusted to the size of the placeholder – in the intended grid.

Playing media objects in the document window

Not only can you hear a sound/view a movie when you run the slide show, you can also do so in the normal
document window (for example, for test purposes). Click on the object and choose the command Play media
clip on the ribbon tab Media object. (For more information, see next section.)

Alternatively, you will find this command in the context menu by right-clicking on the object.

Ribbon tab "Media object"

When you select a media object, the contextual ribbon tab Media object appears automatically. Here, you can
specify the behavior of the media object.

On the far right, the program also displays the ribbon tab Picture on which you can customize the general
properties of the media object (size, fill, border, etc.). For more information, see the next section Changing the
properties of media objects.

After you have inserted a media object (as described in the previous section) and selected it ...

... you can make the following settings on the ribbon tab Media object:

§ Play media clip 

Preview the movie or sound directly in the document window (for example, for test purposes). To stop it,
click on the Stop media clip button. Tip: You will also find these two commands via the context menu by
right-clicking on the media object.



217Working with objects

§ Volume

Set the desired volume here with the slider.

§ Mute

Enable the checkbox to switch off the sound completely.

§ Loop

If you enable this option, the media object will start to play continuously after its initial playback during the
slide show.

§ Play list

In the dropdown list, choose one of the following options:

Play automatically: The media object is automatically played directly when the slide containing this media
object appears during the slide show.

Play in click sequence: The media object is played when you click in the slide containing the media object
while running the slide show. Note the sequence of other Object animations if necessary.

Play on mouse click: The media object is only played when you click on the media object itself while
running the slide show. Note the sequence of other Object animations if necessary.

Play user-defined sequence: If you have made specific settings for the media object (see Object
animations) that do not correspond to any of the aforementioned three options, this entry will automatically
appear in the list.

Only for movie clips:

§ Full screen

This option starts the movie in the full screen view when running the slide show.

§ Hide while not playing

This option hides the movie when running the slide show until the point is reached where the movie is to be
shown. Depending on the option you set to start the movie, you may need to link the movie to an action;
otherwise, you will not be able to start the movie during the slide show. For more information, see Adding
object actions.

§ Rewind

This option rewinds the movie to the first frame after it has been played during the slide show.

Only for sound clips:

§ Hide during show

The media object is visually hidden during the slide show, but it is still played.

§ Play across slides

This option enables the sound to continue playing after the show has advanced to the next slide. This is
useful, for example, for background music.
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Tip: Some commands of this ribbon tab can also be found in the dialog box Object properties on the Media
object tab. For more information, see next section.

Changing the properties of media objects

When you insert a media object into a slide, Presentations displays an icon (representing a sound file) or an
image (representing a movie file).

Using the ribbon tab "Picture"

If you have selected a media object, the contextual ribbon tab Picture will appear automatically on the far right
as an additional tab. Here, you can change numerous properties of the icon/image directly via the buttons. The
options on this ribbon tab correspond to those of an inserted picture file. For more information, see section
Changing picture properties via the ribbon tab.

Additional options can be found via the dialog box Object properties. For more information, see below.

Additional options: Via the dialog box

If you choose the path via the dialog box, you will find the usual object properties (for displaying the
icon/image). In addition, you will find options for the behavior of the media object itself here (on the "Media
object" tab), which correspond mainly to the commands on the Ribbon tab "Media object".

To open the dialog box, select the media object and right-click on it to open the context menu. Select the entry
Media object properties.

Tip: You can also open this dialog box by double-clicking on the object.

The following settings can be made in this dialog box:

Format, Fill, Lines tabs, etc.

These tabs are available for almost all object types. They allow you to change the following settings:

§ Format: Here, you can change the size and position of the object and rotate it. For more information, see
Object properties, Format tab. 

§ Fill: This option allows you to change the fill. For more information, see Object properties, Fill tab.

§ Lines: This option allows you to apply border lines. For more information, see Object properties, Lines tab.

§ Shadow: This option allows you to apply a shadow. For more information, see Object properties, Shadow
tab.

§ Effects: This option allows you to apply different effects. For more information, see Object properties,
Effects tab.
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§ Properties: This option allows you to change general settings. It also displays information about the media
object you are using. For more information, see Object properties, Properties tab.

Furthermore, these two additional tabs appear for media objects:

Picture tab

This tab contains settings for the graphical representation of the displayed picture/icon.

Available options:

§ Variants 

This list offers some predefined color variations of the picture/icon – for example, different color modes
(grayscale, black & white, etc.) as well as colored variants of the picture/icon.

Simply click on the desired variant. The options in the dialog box are then automatically set to the
corresponding settings.

§ Options section 

Here, you can change brightness, contrast, saturation and gamma value (an alternative way to change
brightness).

§ More button 

This button opens a dialog box with additional settings:

If you enable the option Mix with color and select a color below it, the picture/icon will be colored
accordingly.

The options in the Cropping section can be used to crop the picture/icon. This is useful if you only need a
section of the picture/icon. If, for example, you want the upper quarter of the object to be truncated, first
select Use relative values and enter "25" (percent) for Top.

If you select Use absolute values, the entries will be truncated in absolute units of length rather than as a
percentage. If you enter negative values, the areas of the picture/icon will not be truncated, but will be
extended with a frame.

§ Transparency section 

Here, you can make settings for the transparency of the picture/icon:

Use picture settings: The transparency is read from the picture file.

No transparency: This option ignores transparency, even if it is a picture with transparent areas.

Color: This option lets you select the color to be displayed transparently. If, for example, you select white,
all white areas of the picture will become transparent.

§ Sample 

In the small toolbar below the sample, you will find the option Pick transparent color (the pipette icon).
You can use it to make certain colored parts of the picture transparent, for example, to remove a distracting
background from the picture. To do so, use the pipette icon to click on an area of the thumbnail that you
want to make transparent.

The other toolbar buttons help you to fine-tune the picture (Zoom in, Zoom out, Pan picture), but do not
affect the appearance of the picture in the document.
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Note: You must first select a tool in the toolbar by clicking on it with the mouse. You can then work on the
thumbnail with the enabled tool.

Media object tab

This tab contains options that affect the media object itself.

Tip: Most of these options can also be found via the direct commands on the contextual ribbon tab Media
object.

Available options:

§ Type 

The type of media object is displayed here. This is just information and is not a setting that can be changed.

§ File 

Here, you can see the path and file name of the media object (if inserted as a link). This is also information
which you cannot change.

§ File button

You can use this button to replace the file with another one and the formatting will be retained.

§ Export button

This option is available only for media objects that are saved in the document. You can use this button to
export the media object, that is, to save a copy of the media object on your hard disk under any name.

§ Loop 

If you enable the option Loop, the media object will start to play continuously after its initial playback
during the slide show.

Only for movie clips:

§ Rewind 

This option rewinds the movie to the first frame after it has been played.

§ Full screen 

This option starts the movie in the full screen view when running the slide show.

§ Hide while not playing

This option hides the movie when running the slide show until the point is reached where the movie is to be
shown. Depending on the option you set to start the movie, you may need to link the movie to an action;
otherwise, you will not be able to start the movie during the slide show. For more information, see Adding
object actions.

Only for sound clips:

§ Hide during show 

The media object is visually hidden during the slide show, but it is still played.
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§ Play across slides 

This option enables the sound to continue playing after the show has advanced to the next slide. This is
useful, for example, for background music.
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Drawings
Presentations provides several tools for creating drawings. You can insert the following types of drawing
objects into your documents:

§ Lines and curves (lines, arrows, connectors, curves) 
§ AutoShapes (various types of predefined shapes) 
§ TextArt objects (lettering with effects) 

In this section, you will learn everything you need to know about working with drawings. The information
covers the following topics:

§ Inserting drawings 

§ Adding text to AutoShapes

§ Changing drawing properties via the ribbon tab

§ Changing drawing properties via the dialog box

See the following pages for more information.

Inserting drawings

To insert a drawing, for example, a rectangle, proceed as follows:

1. Choose the ribbon command Insert | group Objects | AutoShape . Select the desired AutoShape – a
rectangle in this case.

2. Hold down the left mouse button and draw a frame of the desired size in the document.

3. The rectangle is now inserted.

You can then move or resize the rectangle:

To move the rectangle, click on it and (while still holding the mouse button down) drag it to the desired
position.

To adjust its size, drag one of the round handles surrounding the rectangle.

The application of drawings differs somewhat depending on the drawing tool used. The following is a list of all
available drawing objects and information on how to handle them:

Note: You can adjust the shape of drawings retroactively at any time. For more information, see Editing
shapes retroactively.
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AutoShape

You can insert AutoShapes using the AutoShape  tool. These are predefined shapes for various purposes –
standard shapes such as rectangles, as well as symbols for flowcharts, stars, speech bubbles and many more.

As soon as you have selected an AutoShape, simply drag a frame of the desired size in the document while
holding down the left mouse button. If you want, you can then move the AutoShape with the mouse or resize it
by dragging one of the round handles at its corners.

Note: Additional handles  are displayed in some types of AutoShapes when they are selected. If you drag one
of these handles, a parameter controlling the shape of the object is changed. For stars, for example, the length of
the points can be changed, and for rounded rectangles, the rounding of the corners can be changed.

Tip: You can even enter text in an AutoShape – just like you can in a text frame. For more information, see
Adding text to AutoShapes.

Lines and curves

Use the Lines tool  on the ribbon tab Insert to draw lines and curves.

When you click on this icon, a list of available line and curve tools opens. Select the desired tool and then use it
as follows:

§ Lines 

You can use the tools at the top of the list to draw simple lines and arrows. After clicking on the desired
tool, simply draw a line in the document while holding down the mouse button.

Tip: If you hold down the Shift keyñ, the line is limited to 45° angles.

Note: Arrows are nothing more than ordinary lines for which an arrowhead was selected in the object
properties (Lines tab) by selecting the option Start point and/or End point.

§ Connectors (straight, elbow and curved) 

You can use these tools to drag connectors between two objects. The difference between the three types of
connectors can be seen in the following figure:

To do so, select one of these tools, and then drag the mouse cursor from one object to another while holding
down the mouse button. When you move the mouse cursor over an object, small blue rectangles will appear
at various points on the object. These show where the line can "dock" to the object. You can influence the

course of curved and angled connectors by dragging the diamond handle  via the mouse.
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Tip: You can change the type of connectors retroactively at any time. Right-click on the line to open the
context menu and choose between a straight, elbow or curved connector. Also available in the context menu:
The option Create new connector causes the shortest connection between two objects.

§ Curves 

The tools at the bottom of the list are used to draw curves:

You can use the Curve tool  to draw Bezier curves.

To do so, click on the starting point and then on any number of other positions. The curve "follows" your
mouse clicks automatically.

If you let the curve end at its starting point, the drawing automatically becomes a closed curve. If, on the
other hand, you want to obtain an open curve, you must end the drawing by double-clicking on it.

You can use the Freehand form tool  to draw curves in the same manner as if you were using a pencil.

To draw freehand, move the mouse to the desired starting point, press and hold the left mouse button and
then start drawing as if using a pencil. Alternatively, you can release the mouse button and click on
another location where a straight line will be drawn.

If you let the curve end at its starting point, the drawing automatically becomes a closed curve. If, on the
other hand, you want to obtain an open curve, you must end the drawing by double-clicking on it.

Note: The small black points on the contour line of curves enable you to further adjust the shape. Use the
mouse to drag such a point to another position. Further options can be found in the context menu by right-
clicking on the curve. For more information, see Editing shapes retroactively.

TextArt

You can insert TextArt objects using the TextArt object tool  on the ribbon tab Insert. TextArt objects are
used to create text effects.

If you enable this tool, a dialog box appears. Enter your text in the dialog box and then click on Variants to
select one of the predefined effects to be applied to the text. Then confirm with OK.

For information on the other options for TextArt objects, see Text tab.

Adding text to AutoShapes

You can add text to an AutoShape if desired. This text is then displayed within the AutoShape – exactly as it
would be in a text frame.

To do so, proceed as follows:

1. Select the desired AutoShape.

2. Right-click on it to open its context menu.

3. Choose the command Add text.
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The cursor flashes in the AutoShape. Thus, you can now type text inside the AutoShape.

Tip: There is another faster way to add text to an AutoShape: Select the AutoShape and just start typing.

You can use the commands of the ribbon tab Home | group Character and group Paragraph to format the text
according to your needs.

When you have finished adding text, click anywhere outside the object. If you want to edit the text again later,
select the AutoShape again and choose the command Edit text from the context menu.

Note: By the way, the text frames presented at the beginning of this chapter are nothing more than AutoShapes
(simple rectangles in this case) to which text has been added. Thus, all information in Text frames applies
equally to AutoShapes to which text has been added.

Changing drawing properties via the ribbon tab

Numerous properties of drawings can be changed directly via the buttons of the contextual ribbon tab Object.

The contextual ribbon tab "Object", left section

The contextual ribbon tab "Object", right section

This ribbon tab appears automatically when you select a drawing. It contains the following buttons (from left to
right):

§ New object: This option allows you to insert a new object into the document and different object types are
available. 

§ AutoShape: This option allows you to insert a new AutoShape into the document.

§ Lines: This option allows you to insert simple lines, curves and also connectors (which you can "dock" to the
text frame) into the document.

§ AutoShape templates (not included in SoftMaker FreeOffice): This option allows you to apply various
predefined color formats to the drawing.
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§ AutoShape effects (not included in SoftMaker FreeOffice): Here, you can apply effects such as shadows,
reflections, etc. This option largely corresponds to the options of the tabs Shadow, 3D and Effects of the
dialog box "Object properties". For more information, see next section.

§ Fill color: The fill can be changed here. For more information, see Object properties, Fill tab.

§ Line color, Line style, Line thickness, Line endings: These options allow you to edit border lines for the drawing
or the inserted lines. For more information, see Object properties, Lines tab.

§ Change AutoShape (not included in SoftMaker FreeOffice): This option allows you to assign a different
AutoShape to the drawing (formatting is retained). For more information, see Changing the AutoShape of
objects.

§ Edit points (not included in SoftMaker FreeOffice): This option allows you to give the drawing an individual
shape with the "Bezier tools". For more information, see Editing shapes retroactively.

§ Combine objects (not included in SoftMaker FreeOffice): This option allows you to combine two or more
shapes from different variants into one overall shape. For more information, see Combining shapes.

§ Command group Inner text: The commands of this group are only possible for shapes to which text has been
added. For more information, see Adding text to AutoShapes.

Text rotation: This option allows you to rotate the inner text by the specified angle.

Vertical alignment: This option enables you to determine how the inner text should be aligned between the
top and bottom edges of the frame.

Change text area (not included in SoftMaker FreeOffice): This option allows you to adjust the size of the
inner text area. For more information, see Changing the text area.

Columns: This option allows you to split the inner text into several columns. For more information, see
Creating columns for inner text of objects.

§ Bring to front, Send to back: These options allow you to arrange the order of overlapping object frames. For
more information, see Changing the order of objects.

§ Rotate object: This option allows you to rotate a drawing in 90° increments or flip it vertically/horizontally.
For more information, see Rotating and flipping objects.

§ Align objects: This option allows you to align or evenly distribute two or more object frames. For more
information, see Aligning and distributing objects.

§ Group: This option allows you to combine several selected objects into one unit, which can then be treated
like a single object. For more information, see Grouping objects.

§ Duplicate: This option creates an immediate copy of the selected object.

§ Reset placeholder: This option allows you to restore the original properties of a placeholder after you have
selected it. For more information, see Resetting placeholder properties.

§ Width, Height: These options change the size of the object. For more information, see Changing position and
size of objects.

Many (but not all) of these functions and some additional options can be found in the dialog box Object
properties, which you can access, for example, via the context menu. For more information, see the next
section.
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Changing drawing properties via the dialog box

To edit the properties of a drawing via the dialog box, first select it by clicking on it. Then right-click to open
the context menu and select the last entry Properties, whereupon a corresponding dialog box appears.

Also possible: Click on the group arrow  in the bottom right corner of any command group of the ribbon tab
Object.

Tip: This dialog box can also be opened by double-clicking on the drawing.

The following settings can be made in this dialog box:

Format, Fill, Lines tabs, etc.

These tabs are available for almost all object types. They allow you to change the following settings:

§ Format: On this tab, you can change the position and size of the drawing. For more information, see Object
properties, Format tab. 

§ Fill: This option allows you to change the fill. For more information, see Object properties, Fill tab.

§ Lines: Here, you can change the line style of the lines used to draw the object. For more information, see
Object properties, Lines tab.

§ Shadow: This option allows you to apply a shadow. For more information, see Object properties, Shadow
tab.

§ 3D: This option allows you to apply a 3D effect. For more information, see Object properties, 3D tab.

§ Effects: This option allows you to apply different effects. For more information, see Object properties,
Effects tab.

§ Properties: This option allows you to change general settings. For more information, see Object properties,
Properties tab.

Furthermore, some types of drawings have additional tabs with additional options. (For more information, see
the following pages.)

AutoShapes tab (available only for AutoShapes)

This tab appears for drawing objects only for AutoShapes.

On the AutoShapes tab, you can assign a different AutoShape to the object. Thus you can turn a rectangle into
a speech balloon or any other shape you like, for example.

To change the shape, simply click on the desired AutoShape in the list.
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Tip: You will also find this option as the command Change AutoShape directly on the contextual ribbon tab
Object. For more information, see Changing the AutoShape of objects.

For more information on AutoShapes, see Inserting drawings.

Inner text tab (available for AutoShapes with text added)

This tab appears only for AutoShapes to which text has been added (see Adding text to AutoShapes), as well as
for Text frames and Placeholders.

You can use this tab to change settings for the text in the text frame.

Tip: Some of these options can also be found directly as commands on the contextual ribbon tab Object |
group Inner text.

Available options:

§ Inner margins section 

Here, you can change the inner margins for the text. If you enable the option Automatic, Presentations will
automatically determine suitable margins.

§ Columns section 

You can split the text within the AutoShape into several columns. Enter the Number of columns and the
Spacing between the columns.

§ Rotate by... section 

Here, you can rotate the text by the specified angle.

§ Vertical alignment section 

This setting determines how the inner text should be aligned between the top and bottom edges of the
drawing:

Option Explanation

Top The text is aligned to the top edge of the object. (This is the default setting.)

Centered The text is centered between the top and bottom edges.

Bottom The text is aligned to the bottom edge of the object.

§ Autofit options section 

The following settings can be made here:

Resize shape to fit text: When this option is enabled, the size of the AutoShape automatically adapts to the
amount of text it contains. If, for example, you enter more text than the AutoShape can hold, the AutoShape
will expand automatically.
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Wrap text in shape: This option determines whether the text in the AutoShape should be wrapped
automatically (word by word). When you disable this option, the text will always be displayed in one single
line, regardless of its length.

Text tab (available only for TextArt objects)

This tab appears only for TextArt objects. You can use this tab to select the desired TextArt effect as well as to
enter and format the text to be displayed.

Available options:

§ Text 

Here, you can type the text to be displayed.

§ Variants 

In this list, you can select the effect with which the text should be displayed.

§ Font section 

Here, you can change the font and enable/disable the text styles Bold and Italic.

If you enable the option Same height, all letters (including lowercase letters) will be stretched to a uniform
height.

§ Spacing section 

The Characters option changes the spacing between characters. If values are less than 100%, the characters
are closer together. For values greater than 100%, the characters are further apart.

The option Lines changes the line spacing. This setting only affects text that consists of multiple lines.

§ Alignment section 

Here, you can change the alignment of the text. This setting only affects text that consists of multiple lines.

§ Vertical text 

If you enable this option, the letters of the text will be rotated by 90 degrees.

Transformation tab (available only for TextArt objects)

This tab appears only for TextArt objects.

You can use this tab to specify the type of shaping effect to be applied to the text. To do so, select the desired
type of transformation from the list.
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Animations
In the section Using slide transitions, we introduced the slide transitions that enable you to apply transition
effects when one slide moves to the next. In addition, object animations can be added to animate individual
objects of a slide.

In this way, you can emphasize certain slide content, and thus attract increased attention from your audience or
simply make the presentation appear more entertaining. However, you should ensure that these effects are not
overused.

You can apply animations either to certain objects individually – or to all objects on a slide and even an entire
presentation. You can achieve the latter using a slide animation scheme. Many of these animation schemes also
contain matching slide transitions.

This chapter provides detailed information on working with object animations:

§ Object animations 

In the first section, you will learn how to add, edit and manage animations for individual objects.

§ Slide animation schemes 

The animation schemes will then be described. Thus, you can assign slide transitions and matching object
animations to a slide or even an entire presentation at once.

Object animations
Object animations are motion effects that can be applied to individual objects. They enable you to visually
highlight important points and make your presentation more appealing.

Conveniently apply object animations directly via the buttons on the ribbon tab Animation (or via the sidebar).
Alternatively, you can choose the path via the dialog box by right-clicking on an object to open the context
menu and selecting the command Animations.

Both methods enable you to add new animations and edit or delete existing ones. Choose your preferred method
from one of the following two sections:

§ Applying object animations via the ribbon tab "Animation" 

This section explains how to add an animation to an object directly via the ribbon buttons (or via the
sidebar), and how to edit and manage animations.

§ Applying object animations via the dialog box 

In this section, you will learn how to add animations to an object and then edit and manage them via the
dialog box.
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This is followed by a detailed description of how you can adjust the properties of object animations, regardless
of whether you have added animations via the ribbon tab or via the dialog box.

§ Animation properties in detail 

Applying object animations via the ribbon tab "Animation"

You can add an animation effect to objects by applying it directly via the commands on the ribbon tab
Animation (also possible: via the sidebar with an additional selection of animation effects). You can then
change and manage the applied effects at any time using the sidebar.

Adding an object animation

To add an animation to an object, select the object (also possible for placeholders).

Then choose the command Animations  on the ribbon tab Animation.

In the dropdown menu of the command Animations, you can choose from various types of effects:

§ Appear effects make an object fade onto the slide. 
Example: The object "flies" into the slide.

§ Emphasize effects change the appearance of the object in order to emphasize it.
Example: The object flashes briefly in a different color or size.

§ Disappear effects make the object disappear from the slide.
Example: The object "flies" out of the slide.

To remove an effect from the selected object, choose None from the dropdown menu. The entry More
animations opens the dialog box with additional categories of animation effects. For more information, see
Applying object animations via the dialog box. (Note: These additional categories can also be found via the
sidebar. For more information, see the description below.)

Some animations also have different available variants , which you can select via this button if necessary. In
this case, the icon appears colored.

What is the difference between the buttons Animations  and Add animation ?

The command Animations is usually used to initially apply an animation effect to an object. When you use this
command again, you can replace the existing effect with another effect for this object. However, you use the
command Add animation to add an additional effect to this object. Thus, a sequence of different effects is
possible for the same object.
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Further commands on the ribbon tab "Animations":

§ Automatic preview: If this option is enabled, the effect is demonstrated immediately on the slide when you
hover over it in the dropdown menu of the ribbon commands Animations or Add animation. This makes it
easy to find a suitable effect. 

§ Start preview: With this command directly above it, you can check the animation for the selected object by
starting it at any time after applying an effect.

Note: If you select multiple objects, all animations for those objects will be played in succession. If no object is selected (click on the
slide), all animations of the slide will be played in succession.

Tip: In the mini sorter, slides that have an effect are indicated with a little arrow icon  in their top left
corner. If you click on this icon, you can also preview all effects in the thumbnails.

§ Actions: Use this command to assign an action to an object. This is executed when running the slide show –
either when clicking on this object or when the mouse is positioned over it. For more information, see
Adding object actions. 

§ Properties: This allows you to subsequently edit the properties of the animation effect used, for example,
options for starting an animation or its timing. For more information, see Animation properties in detail. 

§ Remove all: This command removes all animation effects from the current slide. 

§ Animation pane: This option enables (or disables) the sidebar with additional options for animation effects.
To use the sidebar for object animations, see the description below.

§ The command group Animation scheme: Animation schemes allow you to apply slide transitions and
matching object animations. For more information, see Slide animation schemes.

Using the sidebar ("Animation pane")

Object animations can also be applied very conveniently via the sidebar, which is displayed to the right of the
slide. Not only can you select from additional categories of animation effects here, but you can also edit the
effects directly.

Tip: Use the ribbon command Animation | Animation pane  to show/hide the sidebar.

Select the desired object and click on the icon  in the small toolbar above the sidebar. The sidebar then
displays options for adding and editing object animations directly.

To add an object animation, proceed as follows:

1. In the sidebar, click on the Add effect button and select the type of effect you want to apply. (Click on
Appear, Emphasize or Disappear.)

2. Then select the desired effect from the dropdown list that appears. If you click with the mouse on an effect,
you can immediately see how the effect will affect the object on the slide (if the option Preview is enabled).

Important: Finally, click Add to apply the effect.

3. In the sidebar, the applied animation effect then appears in a timeline (with the name of the related object).
If necessary, select another Variant of the effect, but this option only appears for certain effects below the
timeline.
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Tip: Above the Add effect button, you can see the type of effect used when you select an animation in the
timeline.

To change and manage object animations, the sidebar provides the following options:

§ To edit an animation, select it in the timeline and click on the Edit button. For more information, see
Animation properties in detail. 

§ The buttons with the up  and down  arrows change the position of the animation that is currently
selected in the timeline.

§ The button  deletes the selected animation.

§ In addition, the sidebar displays a timeline with bars that represent the duration and delay with respect to the
appearance of each animation. To change the timing of an animation, you can simply make the
corresponding bar larger/smaller with the mouse (for duration) or move it (for delay).

§ At the bottom of the sidebar, you will find the options for the Preview (which correspond to the
aforementioned buttons on the ribbon tab Animation | group Preview) as well as settings for the start and
duration of the selected animation.

To adjust additional settings of the selected animation, click on the Edit button in the sidebar (corresponds
to the ribbon command Animation | Properties). For more information, see Animation properties in detail.

Notes on using the SoftMaker effects: In the dropdown list Add effect in the sidebar), you will find a category
named "SoftMaker". This category contains particularly impressive animations that use a graphics technology
called OpenGL. The following restrictions apply when you use these effects:

§ The SoftMaker effects can be saved only in Presentations documents. When you save your presentation as
a PowerPoint document, they will be replaced by simple fade effects. 

§ When running a slide show, these effects can only be played accordingly in Presentations but not in
Microsoft PowerPoint. 

Meaning of the icons in the timeline

For your information, the name of the object to which the animation is applied is displayed in the timeline for
each animation. Tip: If you hover over it with the mouse here, you will also see an info text about the animation
effect used and its duration.

The icons on the left indicate when the animation starts during the slide show:

The animation starts after a mouse click.

The animation starts after the previous animation.

(No icon) The animation starts with the previous animation.

Note: You can customize these start options at the bottom of the sidebar (dropdown list "Start"). Further settings can be found via the
Edit button. For more information, see Animation properties in detail.

The icons to the right of the start icons show the animation type:

Appear effect
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Emphasize effect

Disappear effect

For media objects, the following icons are also displayed:

Play media object

Pause media object

Stop media object

Applying object animations via the dialog box

If you want to use the method via the dialog box to add an animation to an object, select the object and right-
click on it to open the context menu and choose the command Animations.

Click on the Add button here...

...whereupon another dialog box appears with all available animations:
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In the list Type, you can select the type of effect as follows:

§ Appear effects make an object fade onto the slide. 

Example: The object "flies" into the slide.

§ Emphasize effects change the appearance of the object to emphasize it. 

Example: The object flashes briefly in a different color or size.

§ Disappear effects make the object disappear from the slide. 

Example: The object "flies" out of the slide.

For media objects (movies or sounds), one additional type named Media commands also appears with
commands for playing, pausing or stopping the movie or sound.

Each of the effect types has a number of categories which are listed in the list Category. Each category, in turn,
contains many effects that are listed in the list Effect.

To choose an effect, first select the Type, then the Category and finally the specific Effect.

If you have enabled the option Preview, you can view the animations directly in the slide while clicking on an
effect in the dialog box. This enables you to quickly find a suitable effect.

Use the Add button to apply your selection.

Notes on using the SoftMaker effects

In the list of available effects, you will find a category named "SoftMaker". This category contains particularly
impressive animations that use a graphics technology called OpenGL. The following restrictions apply when
you use these effects:

§ The SoftMaker effects can be saved only in Presentations documents. When you save your presentation as
a PowerPoint document, they will be replaced by simple fade effects. 

§ When running a slide show, these effects can only be played accordingly in Presentations but not in
Microsoft PowerPoint. 
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Changing and managing existing object animations

Once you have added animations to objects, you can subsequently edit them at any time.

Right-click on any object to open the context menu and choose the command Animations. The following
dialog box shows all animations that are used on the current slide (see figure below).

Select the desired animation in the list, and then click on the Edit button. The program will display a dialog box
in which numerous other settings can be made to "fine tune" the effect. For information on the individual
options, see Animation properties in detail.

To remove an animation, select it in the list and click on the Delete button.

You can use the arrows to the right of the list to move animations up  and down  in the list to change the
order in which they appear on the slide.

To see what an animation looks like in the slide, simply select it and click on the Test button.

The dropdown list Sequence provides access to various animation sequences if you have defined any of them.
(You can always create additional animation sequences, which are only accessed when you click on a specific
object in the presentation. For more information, see Animation properties in detail.)

Meaning of the icons in the dialog box

For your information, the list of animations for each animation displays the name of the animated object, the
animation effect used and its duration.
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The icons to the left of them indicate when the animation starts during the slide show (see also the animation
properties in the next section):

The animation starts after a mouse click.

The animation starts after the previous animation.

(No icon) The animation starts with the previous animation.

The icons to the right of the start icons show the animation type:

Appear effect

Emphasize effect

Disappear effect

For media objects, the following icons are also displayed:

Play media object

Pause media object

Stop media object

Tip: Using the sidebar

Object animations can be applied even faster via the sidebar, which is displayed to the right of the slide.

To do so, click on the icon  in the small toolbar above the sidebar. The sidebar then displays options for
adding and editing object animations directly. Its use is basically similar to the dialog box described above.

§ To add an animation to an object, select the object, click on the Add effect button in the sidebar and choose
which type of effect to apply. Then choose the desired effect and click on the Add button. 

§ To edit an existing animation, select it in the timeline and click on the Edit button.

§ The buttons with the up  and down  arrows change the position of the animation that is currently
selected in the timeline.

§ The button  deletes the selected animation.

§ In addition, the sidebar displays a timeline with bars that represent the duration and delay with respect to
each animation. To change the timing of an animation, you can simply make the corresponding bar
larger/smaller with the mouse or move it.

For more information on using the sidebar, see the previous section Applying object animations via the ribbon
tab "Animation".
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Animation properties in detail

You can subsequently edit the animations for objects on the current slide in detail at any time.

To do so, select the object whose animation effect you want to adjust and choose one of the following methods
to open the dialog box Animation properties:

§ On the ribbon tab Animation, choose the command Properties (not possible for multiple effects on the
same object). 

§ Alternatively, click on the Edit button in the sidebar (Animation pane).

Even faster: Simply double-click on the animation effect in the side bar.

§ Alternatively, right-click on the object to open the context menu and choose the command Animations.
Select the Edit button in the following dialog box.

Note: For the latter two methods, make sure that you have selected the desired animation from the respective
list before clicking on the Edit button. You can also select multiple animations and apply the same settings to
all of them.

The program displays a dialog box with the following options:

Start tab

Here, you determine when to start the animation.

§ Start animation section: 

On next mouse click: The animation starts after a mouse click.

After previous animation: The animation starts as soon as the previous animation is finished (if a previous
animation exists, see note below).

Together with previous animation: The animation starts at the same time as the previous animation.

Note: If you want an animation to start automatically during the slide show, but it is the first one of a
slide, just select the option After previous animation for this purpose also. Presentations then recognizes
that no previous animation exists and will start with it immediately.

§ Sequence section: 

Here, you specify whether the animation should be started as part of the main sequence – or part of an
additional sequence that is triggered only when you click on a specific object.

Start animation as part of the main sequence: The animation is part of the "main sequence" for this slide,
which means that the animation will be executed every time this slide is displayed during the slide show
(depending on the start settings described above).

Start animation after click on the following object: The animation starts only when you click on the
specified object. You can select the desired object in the dropdown list.
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Note: Choosing the latter option will create another animation sequence in addition to the main sequence.
It will only be executed when you click on the selected object during the slide show.

If you have defined several sequences for a slide, you can access them by opening the dropdown list
Sequence in the dialog box of the context menu command Animations. In this list, you can select the
sequence that you want to edit.

Timing tab

Here, you set how long the selected animation takes, whether it has a delayed start, and whether it should be
repeated.

§ Duration: This option lets you specify how long the animation should take to complete (the shorter the time
you set, the faster the animation runs). 

§ Delay: Here, you can enter a time that should elapse before the animation starts after it is triggered. If, for
example, you set the start to "On next mouse click" and enter 5 here, it will take 5 seconds for the animation
to start after you click on it with the mouse.

§ Repeat: Here, you can set whether and how often the animation should be repeated. To do so, select an
entry from the list or enter a number. An animation only runs once by default.

§ Play across slides: For sounds only: By default, sounds in a slide show are stopped when switching to the
next slide. If you want a sound to continue playing across a number of slides (for example, for background
music), enter the number of slides here.

§ Smooth start: This option slows down the speed a little when the animation starts.

§ Smooth end: This option slows down the speed a little when the animation ends.

Effect tab

Here, you can change the originally selected animation effect again.

§ Animation type: There are three basic types of animations: Appear, Emphasize and Disappear (as described
in the previous section). Each type contains a number of different effects. 

§ Animation effect: This option lists the effects available for each type.

§ Variants (only available for certain effects): This option lists the available variants for each effect, for
example, the direction from which the animated object should fly into the slide.

Sound tab

Here, you can assign a sound to the animation also.

§ Keep previous sound: This option continues playing the sound that you set for the previous animation. 

§ Stop previous sound: This option stops the sound that you assigned to the previous animation.

§ Play new sound: This option plays a new sound as soon as the animation is triggered. To choose the sound
file to play, select it from the list or click on the File button to select a new sound file.
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End tab

Here, you specify what happens at the end of the animation. For example, you can have the object dimmed
when the animation is finished.

Note: Instead of using the limited options provided on this tab, you can alternatively assign a Disappear
effect to the object, which offers far more setting options from which to choose.

The following settings are available:

§ Don't dim: The object does not change after the end of the animation. 

§ Dim with color: The object is dimmed to the selected color after the animation ends.

§ Hide: This option hides the object when its animation ends.

§ Hide after next mouse click: This option hides the object at the first mouse click after the object animation
ends.

Note: Of course, the effect can only be seen if the associated animation is not the last animation of this
slide because then a mouse click usually switches to the next slide.

§ Rewind emphasis effect: For some Emphasize effects, for example, the object changes color and remains in
the new color at the end. If you enable this option, the object will return to its original color at the end of
such an animation. 

If the object automatically changes back to its original color in the selected effect, this option is grayed out.

Text tab

Note: This tab is available only for objects that contain text.

Here, you can specify how the text contained in the object should be animated.

§ Animate paragraphs: In this dropdown list, you can specify whether the whole text should be animated at
once or just parts of the text (all paragraphs or different list levels for hierarchical bulleted lists). 

§ Automatically animate grouped paragraphs with delay: Here, you define the delay to wait between each
paragraph group.

This option is available only if you have grouped by levels for the option Animate paragraphs.

§ Reverse animation order: This option reverses the order of the individual animated text parts. 

This option is available only if you have grouped by levels for the option Animate paragraphs.

§ Animate text: Here, you can specify whether the text is animated as a whole, word for word or letter by
letter. 

§ Delay between words/letters: This option sets additional delay times between words or letters (depending
on what you set for Animate text).
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§ Animate attached shape: If this option is enabled, the selected animation effect also applies to the object.
Otherwise, only the text is animated.

Slide animation schemes
Slide animation schemes are sets of predefined special effects that enable you to easily add some motion to your
presentation. Most of the available slide animation schemes include slide transitions and matching object
animations.

Note: The object animations contained in the slide animation schemes are applied only to placeholders that
contain text. Other objects (for example, pictures) are not animated. Of course, you can manually add
animations to these objects at any time. For more information, see Object animations.

Slide animation schemes can be applied in various ways:

§ Via the ribbon tab Animation 

§ Or via the sidebar

§ Or via the dialog box

All of the methods listed have identical options, thus depending on your preference, follow one of the
explanations below:

Applying slide animation schemes via the ribbon tab

To apply an animation scheme directly to the current slide using the ribbon commands, proceed as follows:

1. Choose the ribbon command Animation | Animation scheme .

2. In the dropdown menu of the command, you can preview the available effects on the slide by hovering over
them with the mouse. For this purpose, the option Automatic preview must be enabled on the ribbon tab
Animation.

Tip: In the status bar, a short description of the included slide transition and animation effects is displayed
on the left.

3. Then click on the desired effect to finally apply it to the current slide.

You can remove the effect using the option None in the dropdown menu.

The option More animation schemes in the dropdown menu opens the dialog box (see below), which contains
almost identical options.

Choose the command Apply to all slides  on the ribbon tab Animation | group Animation scheme to apply
the animation scheme to all slides in your presentation.

Tip: The command Start preview on the ribbon tab Animation | group Preview allows you to play the
selected effect for review at any time after applying an animation scheme. Alternatively: In the mini sorter,
click on the small icon with the arrow  above a slide to view the effect in the mini sorter.
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Applying slide animation schemes via the sidebar

Just as quickly as using the ribbon commands, animation schemes can be applied using the sidebar that is
displayed to the right of the slide.

Tip: Use the ribbon command Animation | Animation pane  to show/hide the sidebar.

Click on the icon  in the small toolbar above the sidebar. The sidebar now displays a list of all available slide
animation schemes. Simply click on one of them, and it will be applied to the current slide immediately.

Tip: When you hover over an effect with the mouse, an info text appears with a brief description of the included slide transition and
animation effects.

If the option Preview is enabled in the sidebar, you can review the effect on the slide directly when you select
it.

The Apply to all slides button assigns the selected animation scheme to all slides in your presentation.

You can remove the effect via the entry No animation at the top of the dropdown list.

For more information on the sidebar, see Using the sidebar.

Applying slide animation schemes via the dialog box

To apply a slide animation scheme via the dialog box, right-click on a free space in the slide to open the context
menu and select Animation scheme.

A dialog box appears with a dropdown list of all available slide animation schemes.
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If the option Preview is enabled, you will see a preview of the effects included in the scheme directly on the
slide. This lets you click through the dropdown list and review the effects before applying the most appropriate
one. The text box at the bottom of the dialog box contains brief descriptions of the included slide transition and
animation effects.

To apply the selected animation scheme to all slides in your presentation, click on the Apply to all button. If
you want to apply it only to the slides that are currently selected, click on Apply to selection.

You can remove the effect by selecting the entry No animation in the dropdown list.
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Working with text
On slides with placeholders, you can enter text by simply clicking in the placeholder and starting to type. In
addition, you can always add text frames and AutoShapes to your slides and enter text inside them.

Editing and formatting text with Presentations is similar to using a word processing program. In this chapter,
you will learn everything you need to know about working with other file formats. It is divided into the
following sections:

§ Character formatting 

§ Paragraph formatting

§ Bulleted and numbered lists

§ Searching and replacing

§ Moving, deleting and copying

§ Paste (special)

§ Inserting special characters

Character formatting
On the ribbon tab Home | group Character, you will find the most frequently used commands to change the
appearance of single or multiple characters in the text.

Tip: You can also change the character formatting of an entire placeholder by selecting it first.

Common commands: Via the icons of the command group "Character"

You can use the group icons to directly make the following settings:

§ Font and font size 

§ Text styles (for example, bold, italics, underlined)

§ Colors
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§ Resetting the character formatting

Additional options: In the dialog box of the command group "Character"

If you click on the group arrow  in the bottom right corner of the ribbon tab Home | group Character, the
program opens a dialog box in which you will find additional options for character formatting.

The displayed dialog box has several tabs that you can switch between by clicking on one of the tabs with the
mouse:

§ Font tab 

For selecting Font and font size, other Text styles and Colors

§ Spacing tab 

For changing properties like Superscripts and subscripts, Letter spacing and character pitch, and
enabling/disabling Kerning

§ Hyperlink tab 

For inserting and editing Hyperlinks (for example, to web pages)

Changing character formatting

There are two ways to change character formatting:
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§ To subsequently change the character formatting, select the desired text and apply the appropriate formatting
(font, font size, etc.) via the icons or via the dialog box. 

Android/iOS: If you are using these versions, please note that selecting text there works slightly
differently. For more information, see Working with selections.

§ To change the character formatting as you type new text, select a different font and then simply continue
typing. From that point on, all text that you enter will appear in the new font – until you select a different
font again. 

See the following pages for more detailed information on character formatting.

Font and font size

To change the font or font size of text, see the commands on the ribbon tab Home | group Character. Proceed
as follows:

Via the buttons of the command group "Character"

1. First, select the desired text.

2. Click on the small arrow to the right of Font or Font size.

3. Set the desired font and font size:

Font: Select the desired font from the dropdown list via a mouse click.

Font size: The dropdown list offers the most common font sizes, which you can select via a mouse click.
However, you can enter a different size manually at any time. Font sizes can be entered with a precision of a
tenth of a point – thus font sizes such as 12.7 are also allowed.

Tip: The icons  in the group Character can be used to increase or decrease the font size by one
level.

In the dialog box of the command group "Character"

If you only want to change the font and font size, these options in the dialog box are exactly the same as the
buttons described above. Thus, it is only advisable to use the dialog box if you also want to apply other
character formatting options that are unavailable as buttons.
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On the ribbon tab Home | group Character, you open the dialog box via the group arrow  in the lower right
corner and select the Font tab in the dialog box.

You can now set the desired font and font size in the dialog box:

§ To change the font, open the dropdown list Font by clicking on the little arrow to its right and selecting the
desired font. 

§ The dropdown list Size offers the most common font sizes. However, you can always enter a different size
manually. Font sizes can be entered with a precision of a tenth of a point – thus font sizes such as 12.7 are
also allowed.

Text styles

Text styles are character formatting options such as bold, italics, underlining, etc.

Presentations offers the following text styles:

§ Italic: A slanted variant of the font. 

§ Bold: A stronger ("more pronounced") variant of the font.

§ Underline: The text is underlined (with various options for line styles and line colors).

§ SMALL CAPS*: Smaller uppercase letters are used instead of lowercase letters.

§ All caps*: All characters are output as uppercase letters. 

§ ALL UPPERCASE**: All characters are converted into (real) capital letters.

§ all lowercase**: All characters are converted into (real) lowercase letters.

§ First Character Uppercase**: Each word begins with a (real) capital letter.

§ Strikethrough: The text is struck through.

§ Shadow: The text is given a shadow effect.

§ Embossed: The text looks like it is embossed.

§ Font color, Background color*: You can also change the color of text. (For more information, see Font
color).

§ Superscripts and subscripts*: for example, r2 and H2O. For more information, see Superscripts and

subscripts.

* This option is only available via the dialog box of the command group "Character"

This option is only available via the icons of the command group "Character"

Common commands: Via the icons of the command group "Character"

The most common text styles can be applied on the ribbon tab Home | group Character directly via the icons
of the group.
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To apply text styles, proceed as follows:

1. Select the desired text.

2. Click on the icon for the text style you would like to enable or disable.

The B stands for bold, the I for italics and the U for simple underlining. Click on the small arrow next to the
U to open a dropdown menu with further options for underlining (for line style and line color).

The ab stands for struckthrough and the X for shadowed.

If you click directly on the Aa icon or also on the small arrow next to it, the program opens a dropdown
menu which allows you to apply Change capitalization to the text.

Note: Using the options for Change capitalization is an actual spelling change that is also perceived as such
by the spell check. In contrast, the option All caps in the dialog box (see below) is only an effect for display
(such as italics).

Text styles can be combined (almost) as desired.

Additional options: Via the dialog box of the command group "Character"

For additional text styles that you cannot find via the buttons (for example, SMALL CAPS), open the dialog box.

On the ribbon tab Home | group Character, click on the group arrow  in the bottom right corner and switch to
the Font tab in the dialog box.

§ In the area Styles you will find small caps, all caps, strikethroughs, shadow and embossed. These can be
enabled or disabled there via a simple mouse click. 

Note: The All caps option in the Styles area is only a display effect and not an actual spelling change like
the Change capitalization button described above.

§ In the area Underline, you can use the dropdown lists to select different line styles and colors for underlined
text.

§ To enable bold and/or italics, open the dropdown list Style (to the right of font size) and select the desired
entry: Regular, Italic, Bold or Bold Italic.
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Shortcut keys

There are also shortcut keys for some text styles:

Command Windows/Linux Mac

Bold Ctrl+B Cmd+B

Italic Ctrl+I Cmd+I

Underline Ctrl+U Cmd+U

Superscript Ctrl+Shift+(Num+) Cmd+Shift+(Num+)

Subscript Ctrl+Shift+(Num-) Cmd+Shift+(Num-)

Remove superscript or subscript Ctrl+Shift+(Num*) Cmd+Shift+(Num*)

Change uppercase/lowercase of text 
(from "test" to "Test" to "TEST")

Shift+F3 Shift+F3

Note: (Num+) (Num-) (Num*) represent the keys on the numeric keypad, usually located on the right side of the keyboard.

Font color

You can change the color of the text itself and its background. The commands for this purpose can be accessed
via the ribbon tab Home | group Character.

Applying via the icons of the command group "Character"

For the Font color , proceed as follows:

1. Select the desired text and click on the small arrow to the right of the icon (i.e., not on the icon itself).

2. Select the desired color from the dropdown menu. In addition to the Standard colors, you can also select
colors from the Slide color scheme, which are defined for the slide design. For more information see
Creating and editing a color scheme.

Tip: To format more text in the same color, select the text and then click on the icon itself because the last
color used will be applied again.

If you also want to highlight the text background with a background color, switch to the dialog box of the
command group "Character"(see below).



250Working with text

Background color: In the dialog box of the command group "Character"

Insofar as only the font color is concerned, the options in the dialog box correspond exactly to the button
described above. However, you can also change the background color in addition to the font color in the
dialog box.

Proceed as follows:

1. Select the text and click on the group arrow  in the bottom right corner of the ribbon tab Home | group
Character. In the dialog box, switch to the Font tab.

2. Open the dropdown list Background color and select the desired color.

Notes

Color lists only offer a few standard colors, but you can always compose your own colors. To do so, click on
the entry Define color... at the end of the dropdown list. (For more information, see also Document properties,
Colors tab.)

Superscripts and subscripts

You can add a superscript (for example, r2) or a subscript (for example, H2O) to text.

Select the text and click on the group arrow  in the bottom right corner of the ribbon tab Home | group
Character. In the dialog box, switch to the Spacing tab and enable Superscript or Subscript.

If required, also enter the percentage of the superscript or subscript text in the field Position. You can also use
a percentage in the field Size to determine how much the font size should be reduced. For example, enter 100
percent if you do not want the font to be reduced.

Shortcut keys

You can apply superscript/subscript even faster via the following shortcut keys:

Command Windows/Linux Mac

Superscript Ctrl+Shift+(Num+) Cmd+Shift+(Num+)

Subscript Ctrl+Shift+(Num-) Cmd+Shift+(Num-)

Remove superscript or subscript Ctrl+Shift+(Num*) Cmd+Shift+(Num*)

Note: (Num+) (Num-) (Num*) represent the keys on the numeric keypad, usually located on the right side of the keyboard.

Letter spacing and character pitch

Presentations also allows you to change the letter spacing and character pitch of text if necessary.
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Letter spacing is the horizontal distance between characters. Giving a value smaller than 100% causes the
characters to appear closer together than normal; giving a value larger than 100% causes the characters to
appear farther apart.

Changing the character pitch changes the width of the characters themselves rather than the distance between
them, thus the characters are distorted.

To change these settings, click on the group arrow  in the bottom right corner of the ribbon tab Home | group
Character. In the dialog box, switch to the Spacing tab and enter the required values for Letter spacing or
Character pitch.

Note: Some printers do not support changing the character pitch for internal printer fonts. The font then
appears wider or narrower on the screen but not in the printout.

Kerning

Certain pairs of letters look better when the spacing between these letters is reduced or increased a bit. Such
adjusting is known as kerning.

The following figure illustrates what is meant by kerning:

Above: without kerning. Below: with kerning

The upper text (without kerning) shows that the letters "V" and "A" are usually too far apart. This was
corrected for the lower text (with kerning).

This adjusting occurs fully automatically. All you have to do is enable kerning:

Select the desired text, and click on the group arrow  in the bottom right corner of the ribbon tab Home | group
Character. In the dialog box, switch to the Spacing tab and enable the option Use kerning.

Presentations now automatically adjusts the spacing between all letters where this would improve the text
appearance.

Note: Not all fonts provide kerning information in their font data, which is required to determine which letter
pairs to adjust and how. Almost all font collections published by SoftMaker include extensive kerning
information.
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Hyperlinks

On the Hyperlink tab in the dialog box of the command group Home | group Character , you can add a
hyperlink to text.

For example, a hyperlink to a web page can be inserted into a slide. If you click on this link text during the slide
show, the web browser starts and displays the specified page.

Creating a hyperlink

To insert a hyperlink, select the text into which you want to include a hyperlink. Then open the dialog box by
clicking on the group arrow  on the ribbon tab Home | group Character and switch to the Hyperlink tab.

Even faster: Choose the ribbon command Insert | group Links | Hyperlink .

In the dialog box, use the Type section to specify which action should happen when you click on the link:

§ None: Do not perform any action. This is the default setting. (The settings in the Effects section will still
work independently.) 

§ Slide navigation: Jump to another slide. To do so, select the desired slide from the list.

§  Custom slide show: Start a custom slide show. To do so, select the desired slide show from the list. For
information on creating custom slide shows, see Custom slide shows. 

§ URL: Access the specified URL (web address or path to a locally stored HTML file). For web pages, your
web browser is automatically started. For this purpose, you must enter "http://" in front of the address of the
page, for example, "http://www.example.com".

In the Bookmark field, you can also enter a bookmark if you want to jump to a specific target position on
the specified website.

§ File: Open the specified file. Here, you can enter either an executable file or a document. Specify the path
and name of the file, and the associated application will then start automatically.

§ E-mail: Send an e-mail. To do so, enter the recipient's e-mail address and (optionally) the subject.

§ Object action: This option is not available for text. (For more information, see Adding object actions)

Tip: Links to URLs and e-mail addresses can be created faster and easier if the option Format URLs as
hyperlinks is enabled in the dialog box of the ribbon command File | Options (Edit tab). You can then type
the destination address (for example, "www.example.com" or "mailto:xy@example.com") directly into the
slide text and press the space bar. Presentations recognizes that you have entered a web address or e-mail
address and automatically formats it as a link.

The Effects section can be used to add sound effects that are played when you click on the hyperlink:

§ No effect: No sound is played when you click on the link during the slide show. This is the default setting. 

§ Stop previous sound: This option stops whatever sound was playing in the current slide.
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§ Play new sound: This option plays the selected sound file. Select the sound file to be played from the list or
click on the File button to specify a sound file on your hard drive.

The Reset button allows you to undo all changes made in the open dialog box provided that you have not yet
confirmed them with OK.

Opening hyperlinks

To open a hyperlink when running a slide show, simply click on the text that contains the hyperlink.
Presentations then opens the linked document.

In the normal slide view, however, click on the link text with the key combination Ctrl + left mouse button
(alternatively or for Android/iOS: in the context menu with the command Go to link).

Editing or removing a hyperlink

Existing hyperlinks can be edited as follows:

§ Changing destination 

To change the destination of a hyperlink, select the complete link text and then choose the ribbon command
again Insert | group Links | Hyperlink (alternatively via the context menu: Edit link). The program again
displays the dialog box in which you can edit the destination for the link.

To remove a hyperlink, proceed as follows:

§ Removing a hyperlink by deleting the link text 

If you delete text that contains a hyperlink, the link is also removed.

§ Removing only the hyperlink 

If you only want to remove the hyperlink but retain the associated section of text, select it and then right-
click to select the entry Remove hyperlink in the context menu.

Format painter

You can use the command Home | Format painter to instantly transfer the character formatting (font and font
size, text styles, etc.) from one character to other characters.

To do so, proceed as follows:

1. First, select the character whose format you want to transfer. You can also select multiple characters;
however, they should all have the same character format.

2. Click on the Format painter icon  on the ribbon tab Home| group Edit.

The mouse cursor then changes into a brush: 

3. Drag the mouse (with the mouse button held down) over the characters to which the format is to be
transferred.
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Tip: If you press and hold the Ctrl key while you do this, both the character formatting and paragraph
formatting will be transferred.

4. If you want to transfer the format to other sections of text, repeat step 3.

5. When you are finished, click on the Format painter icon again or simply press the Esc key.

Shortcut keys

You can also use the keyboard to perform the Format painter function:

Command Windows/Linux Mac

Format painter (copying step) Ctrl+Shift+C Cmd+Shift+C

Format painter (pasting step) Ctrl+Shift+V Cmd+Shift+V

Resetting the character formatting

Presentations allows you to remove character formatting at any time. You will find the commands for this
process on the ribbon tab Home | group Character.

Applying via the icon in the command group "Character"

1. Select the relevant section of text.

2. Click on the Reset character formatting icon .

Presentations now removes any character formatting that you have manually applied to this section of text.
However, the program retains paragraph formatting.

Shortcut key

You can also use the keyboard to choose the command Reset character formatting:

Command Windows/Linux Mac

Resetting the character formatting Ctrl+Space Cmd+Space

Resetting in the dialog box of the command group "Character"

In the dialog box of the ribbon tab Home | group Character , you will also find a Reset button on each tab.
However, the use of this button differs from the above function: You can only use it to undo all changes made
in the open dialog box provided that you have not yet confirmed them with OK.

If the changes have already been confirmed with OK, they can only be undone via the Reset character
formatting icon described above.
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Replacing fonts

You can completely replace a font with a different font in your presentation. You might do so for design
purposes (because one font looks better than another) or due to a font being unavailable on your system.

Choose the ribbon command Design | group Design | Replace font  to replace the font of the entire
presentation. The following dialog box appears:

There are two dropdown lists in the dialog box. In the top list, you select the font that you want to replace and,
in the bottom list, you specify the replacement font.

As soon as you confirm with OK, Presentations replaces all instances of this font throughout the presentation.
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Paragraph formatting
On the ribbon tab Home | group Paragraph, you will find the most frequently used commands for determining
the formatting of text paragraphs.

You can use the group icons to directly make the following settings:

§ Line spacing 

§ Paragraph alignment

§ Bulleted lists (or numbering)

Additional options: In the dialog box of the command group "Paragraph"

If you click on the group arrow  in the bottom right corner of the ribbon tab Home | group Paragraph, a
dialog box opens with additional options for paragraph formatting:

§ Indents 

§ Spacing above/below a paragraph

§ Changing the_character format for whole paragraphs

§ Tabs

§ Hyphenation frequency (see Hyphenation)

More information can be found on the following pages.

Paragraph formatting always applies to complete paragraphs. Changes to paragraph formatting always affect
the whole paragraph in which the text cursor is positioned. If you select multiple paragraphs, all selected
paragraphs will be affected.

Changing the paragraph formatting

You can change the paragraph formatting in two different ways:

§ To subsequently change the paragraph formatting, select the relevant paragraphs and make the required
changes via the icons or via the dialog box. 

§ To change the paragraph formatting as you type new text, use the icons or the dialog box to set the desired
formatting without first selecting anything. The current paragraph is now reformatted accordingly.
Furthermore, any new paragraph that you start with the Enter key¿ will be formatted in the same way until
you change the paragraph formatting again.
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Tip: To change the paragraph formatting of an entire placeholder, select it first.

Units of measure: In Presentations, dialog boxes not only accept values specified in the default unit of measure
inches*, but they also accept them in other units of measure. To enter a value in specific units, simply add one
of the following units of measure after the number:

Unit Explanation

cm Centimeter

in Inch – 1 in equals 2.54 cm.

pt Point – 72 pt equal 1 in.

pi Pica (character) – 1 pi equals 12 pt

* The default unit of measure depends on your computer's regional settings (on Windows). For information on other operating systems, see Settings,
Appearance tab.

If, for example, you type "7.62 cm" as the position for a tab, Presentations puts it at 3 inches (7.62 cm).

Indents

You can use indents to temporarily change the left and right margins of paragraphs to move text in or out. The
indent for the first line of a paragraph can be specified separately.

To use indents, place the text cursor in the desired paragraph or select multiple paragraphs. Then click on the
group arrow  in the bottom right corner of the ribbon tab Home | group Paragraph to open the dialog box of
the Paragraph tab.
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In the Indents section, you can set the Left indent, the Right indent and the First line indent of a paragraph.
Enter the desired values here.

The other options on this tab are explained in the following sections.

Using the horizontal ruler

You can also use the mouse to change indents directly in the horizontal ruler that is displayed above the

document (unless it has been hidden with the ribbon command View | Ruler ).

To do so, place the text cursor in the desired paragraph or select several paragraphs. The indents are now shown
as small handles in the ruler:

The horizontal ruler (with colored indent handles)

To change an indent, click with the mouse on the corresponding handle (see figure), hold the mouse button
down and drag the handle to the desired position.

Note: When changing the Left indent, be careful to catch hold of the correct handle because only the lower
triangle will affect this indent. Likewise, the upper triangle will affect only the First line indent. On the other
hand, the rectangular handle under both triangles changes both the Left and First line indents together.
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Line spacing

Line spacing determines the spacing between the individual lines of a paragraph.

You will find the commands for this on the ribbon tab Home | group Paragraph.

Applying via the icon of the command group "Paragraph"

You can use the icon  to quickly and easily apply common line spacing.

Proceed as follows:

1. Place the text cursor in the desired paragraph (or select several paragraphs).

2. Click on the small black arrow of the icon to open its dropdown menu.

3. Select the desired line spacing from the proposed values in the menu.

Tip: In the dialog box (see below), set a customized value in order to apply this value at any time via the
command Last in the dropdown menu of the icon.

To customize the line spacing, go to the dropdown menu of the icon and select the option More or click directly
on the icon itself. This opens a dialog box in which you will find further options for line spacing on the
Paragraph tab (see below).

Additional line spacing via the dialog box of the command group "Paragraph"

In the dialog box of the group, you can customize the values for the line spacing.

To do so, proceed as follows:

1. Place the text cursor in the desired paragraph (or select several paragraphs).

2. Click on the group arrow  in the bottom right corner of the ribbon tab Home | group Paragraph to open
the dialog box.

You will find the options for changing the line spacing in the section Line spacing:

3. First, use the dropdown list to select the method you want to use to specify the line spacing (see below).

4. Then enter the spacing in the edit box to its right.

When you confirm with OK, the line spacing will be changed according to your settings.

Methods of specifying the line spacing

In the dialog box, you can choose which method to use to define line spacing in the dropdown list Line
spacing.

The list has the following entries:
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§ Single 

Automatic single line spacing.

Here, the optimum line spacing is determined automatically:

If you increase the font size in the paragraph, the line spacing will be increased accordingly.

If you decrease the font size, however, the line spacing will be decreased automatically.

§ Multiple 

Multiple automatic line spacing.

This corresponds to the option Single and thus also provides automatic line spacing. You can increase or
decrease this spacing by specifying the desired number of lines in the input field to the right of this option.

Some examples:

Enter "1.5" for lines to obtain one and a half times the automatic line spacing.

Enter "2" to get twice the automatic line spacing.

Enter "1" to get automatic single line spacing (corresponds to selecting the option Single).

§ Exactly 

Exact line spacing.

Here, you can set the line spacing to an exact value in points. Here, the line spacing will not be
automatically adjusted to the font size.

§ At least 

Automatic line spacing with a given minimum.

This setting corresponds to the option Single, but prevents any reduction below the specified minimum
value.

Thus if you enter 12 points as the minimum value, the program uses automatic single line spacing by default.
If the automatic line spacing is less than 12 points (because you are using a very small font size), an exact
line spacing of 12 points is used instead.

Spacing above/below a paragraph

In addition to line spacing, you can also define how much space should be kept above the first line and below
the last line of a paragraph.

To change this setting, open the dialog box of the ribbon tab Home | group Paragraph with the group arrow
in the bottom right corner, and switch to the Paragraph tab.

The section Paragraph spacing contains the following options:

Option Explanation

Before Here, specify how much spacing should be maintained from the end of the previous paragraph.
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After Here, you can specify the spacing that Presentations should maintain up to the start of the next
paragraph.

Paragraph alignment

Text paragraphs can be aligned in the following ways:

   Left align

   Center

   Right align

   Justify (here, the words are distributed evenly over the available space)

Applying via the icons of the command group "Paragraph"

To change the paragraph alignment via the icons, proceed as follows:

1. Place the text cursor in the desired paragraph (or select several paragraphs).

2. Click on the desired button on the ribbon tab Home | group Paragraph.

Shortcut keys

You can also use the following shortcut keys to change the paragraph alignment:

Command Windows/Linux Mac

Left align Ctrl+L Cmd+L

Center Ctrl+E Cmd+E

Right align Ctrl+R Cmd+R

Justify Ctrl+J Cmd+J

In the dialog box of the command group "Paragraph"

If you only want to change the paragraph alignment, the options in the dialog box are exactly the same as the
buttons described above. Thus, it is only advisable to use the dialog box if you also want to use other paragraph
formatting options that are not available as buttons.
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You open the dialog box for paragraph alignment by clicking on the group arrow  in the bottom right corner of
the ribbon tab Home | group Paragraph. There, you will find the paragraph alignment in the dropdown list
Alignment.

Non-breaking space

In certain cases, two words separated by a space must remain on the same line. Presentations is unaware of this
and may put the words on separate lines when it automatically inserts line breaks.

An example: You want the price "USD 29.80" to be written as one unbroken unit. You can ensure this by
inserting a protected (non-breaking) space between "USD" and "29.80". To insert such a space, press the key
combination Ctrl+Shift+Space instead of just the space bar.

When printed, the non-breaking space looks exactly like a normal space. It differs only in directing
Presentations to ensure that the designated words are not spread over two lines.

Changing the character format for whole paragraphs

If you click on the group arrow  in the bottom right corner of the ribbon tab Home | group Paragraph, you
will also find a button labeled Character in the open dialog box. You can use this button to change the
character formatting (font, text styles, etc.) for whole paragraphs.

To change the character formatting of whole paragraphs, select the desired paragraphs and click on the
Character button in the dialog box. The program will display another dialog box, which resembles that of the
ribbon tab Home | group Character. For more information, see Character formatting.

Tabs

A tab is a kind of "jump target" that you can use to position the text cursor at a specific point within a line. Tabs
are very useful for tables, for example.

You open the dialog box with the tab settings via the group arrow  in the bottom right corner of the ribbon tab
Home | group Paragraph. In the dialog box, click on the Tabs button.

To work with tabs, two steps are required:

1. First, set the "tab stops" in the Tabs tab. You thus specify where tabs should be located.

2. Once this is done, you can use the Tab key to insert tabs in the text at any time – that is, to make the text
cursor jump to the next tab stop.
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Using tabs

By default, tab stops are preset at 0.5 inch intervals. However, these preset tab stops are merely relics from the
era of the typewriter, and you should take the opportunity to set your own tab stops.

Since tabs count as part of paragraph formatting, you can define different tab stops for each paragraph of the
document.

To set tab stops, proceed as follows:

1. Place the text cursor in the desired paragraph (or select several paragraphs).

2. On the ribbon tab Home | group Paragraph, use the group arrow  to open the dialog box and click on the
Tabs button.

Alternatively, you will find the command Tabs  directly on the ribbon tab Design | group Design or in the
context menu by right-clicking on the desired paragraph.

The following dialog box appears:

3. Enter the desired position under Tabs.

4. If desired, select another Alignment and another Tab leader for the tab (see below).

5. Don't forget: Click on the Set button.

6. If necessary, set up additional tab stops in the same way before you exit the dialog box with OK.

Once tab stops have been set, you can use the Tab key to insert tabs in the text to move from one tab stop to the
next.

Note: You can also use this dialog box to enter the Default width for the predefined tab stops mentioned earlier
(0.5 inch by default). If you define your own tabs in a paragraph, however, the predefined tabs are overridden.
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Tab alignment

You use the option Alignment in the above dialog box to specify the alignment of a tab stop.

Available options:

Alignment Explanation

Left This is a normal "left-aligned" tab stop. This tab stop determines where the following text begins.

Centered The text after the tab is centered on the tab position. This tab stop determines where the middle of
the text falls.

Right Here, the text after the tab is right-aligned. This tab stop determines where the text ends.

Decimal This option is used for formatting columns of numbers. The numbers are positioned in such a way
that their decimal points are vertically aligned.

Tab leader

You can also use the option Tab leader to specify a tab leader for a tab stop. This is then used to fill the space
that the tab skips.

Available options:

None A tab without a leader

Solid ___________ A tab with underscores as leaders

Dashed --------------- A tab with dashes as leaders

Dots .......................... A tab with dots as leaders (used frequently in tables of contents and indexes)

Middle dots ········· A tab with middle dots as leaders

Tip: To add leaders to existing tab stops, choose the command Tab (for example, via the context menu). In the
dialog box, select one of the set tab stops, choose the desired character from the list Tab leader, and click on
Set.

Deleting and moving tab stops

Once a tab stop has been created, it can be changed at any time:

To do so, select the paragraphs whose tab stops you want to edit and choose the command Tabs (for example,
via the context menu).

In the open dialog box, select one of the set tab stops in the list Tabs. The Clear button allows you to remove
it. The Clear all button removes all tab stops in the selected paragraphs.

You cannot move a tab stop to a new position via this method. However, you can clear the tab stop and then set
a new tab at the desired position. However, it is easier to move tabs via the ruler.
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Using the horizontal ruler

All tab stops set for the current paragraph are displayed in the horizontal ruler:

The horizontal ruler (after setting some left-aligned tabs)

Tab stops can also be easily set, moved and deleted via this ruler.

To set a tab, proceed as follows:

1. Place the text cursor in the desired paragraph (or select several paragraphs).

2. Select the desired tab type.

To do so, click on the icon to the left of the ruler. Each mouse click on the icon changes the tab type:

Left-aligned tab

Centered tab (the text is centered at the tab position)

Right-aligned tab (the text ends at the tab position)

Decimal tab (numbers are aligned to the decimal point)

3. Then simply click on the position on the ruler where you want to set the tab stop. Of course, you can also set
multiple tab stops directly by clicking on additional positions.

To move a tab stop, click on it on the ruler with the mouse and drag it to another position while still holding
down the mouse button.

To clear a tab stop, drag it downward outside the ruler.



266Working with text

Bulleted and numbered lists
Lists in which each item is presented in its own paragraph preceded by a marker are usually much easier to read
than lists that are separated by commas. Such markers (usually little boxes, circles, arrows, etc.) are called
bullets.

Working with bulleted lists is an easy task for Presentations users. The placeholders in the content area of most
slide layouts are already preformatted for bulleted lists. Any text you enter in it will be automatically provided
with bullets.

Alternatively, you can create lists with numbers instead of bullets. The paragraphs are then automatically
numbered as 1st, 2nd, 3rd, etc.

Bullets can be enabled and disabled for each paragraph at will, and the formatting of bullets can be changed at
any time:

To do so, use the icon  on the ribbon tab Home | group Paragraph to directly insert predefined bullets or
choose the path via the dialog box to apply individually created bullets. You can also use this option to remove
bullets or to convert a bulleted list into a numbered list.

For more information on working with bulleted and numbered lists, see the following sections.

Bulleted lists

As previously mentioned, the placeholders in the content area of most slide layouts are already preformatted for
the use of bullets. Thus, you can simply type your text next to the initial bullet. If you then press the Enter
key¿, a new bullet is automatically created for the next line.

If you want to add or delete bullets or change existing bullets, select the relevant paragraphs and proceed as
follows:

Adding bullets

You can find the commands for bullets via the icon  on the ribbon tab Home | group Paragraph.

Bullets can be added in different ways:

A. If you just want to add a bullet without any further selection, just click directly on the icon (not on the arrow
next to it). The default bullet or the last bullet you selected will be inserted.

B. For a manageable selection of predefined bullets, click on the arrow next to the icon. A dropdown menu
appears with Default bullets, Custom bullets, Picture bullets, and any previously used In the document
bullets. Click on the desired bullet to insert it directly.

C. If you want to customize bullets via the dialog box with all additional options, click on the arrow next to the
icon also, but select Format bullets. For the next steps in the dialog box, see the paragraph "Other options:
Via the dialog box Bullets and numbering" below.
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Now type the text into the document. At the end of the paragraph, press the Enter key¿ to start a new
paragraph. Presentations automatically indents the paragraph and adds a bullet.

Alternatively, you can also select existing text, of course, choose the command via one of the methods
described above, and thus add a bullet to this text.

Ending a list or removing bullets

To end a list or remove existing bullets, proceed as follows:

First, position the text cursor at the end of the last numbered paragraph and press the Enter key¿ to start a new
paragraph.

Alternatively: Select all paragraphs of the bulleted list if you want to completely remove the bullets for these
paragraphs.

As with the addition of bullets, there are now also different ways here:

A.Simply click again directly on the icon itself  to remove bullets.

B. Alternatively, click on the arrow next to the icon and select None in the dropdown menu.

C. To navigate via the dialog box, click on the arrow next to the icon, but select Format bullets. In the
following dialog box, you will find the option None under Type.

Tip: If you want to wrap a new line in a list with bullets without creating a new bullet, simply insert a
manual line break with the shortcut key Shift+¿. The next line will then appear as body text.

Promoting and demoting bullets

You can promote and demote the levels of bulleted list items by using the following icons on the ribbon tab
Home | group Paragraph:

The demote and promote icons

The left icon demotes the list item to the level below its current level, while the right icon promotes the relevant
item to the next higher list level.

Other options: Via the dialog box "Bullets and numbering"

To insert custom bullets, you will find additional options in the dialog box.

To do so, click on the arrow next to the icon  on the ribbon tab Home | group Paragraph. In the
dropdown menu, select Format bullets.

The following dialog box is displayed...
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... in which you can make the following settings for bullets:

§ Type 

Here, you can specify whether the paragraphs should be given a Bullet, Picture bullet or Numbering. (For
more information about the option Numbering, see Numbered lists below.)

Note: You can always convert a bulleted list into a numbered list by simply changing the "Type" to Numbering. You can also do it
the other way round, of course.

When you set the type to None, existing bullets or numbers are removed.

§ Default and Custom 

Here, you can select the bullet to be used. The Default row contains predefined bullets from which you can
choose, and you can create your custom bullets in the Custom row (see below).

§ Color (only for default bullets) 

You can select a different color for the bullet in the dropdown list Color. In addition to the colors offered
here, you can define new colors at any time. For more information, see Document properties, Colors tab.

Tip: If you set the color to "Auto", Presentations automatically uses the font color of the paragraph to the
right of the bullet.

§ Size (only for default bullets) 

Here, you can change the size of the bullet (in points) if required.
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Tip: If you select the option "Auto" here, Presentations automatically uses the font size of the paragraph
to the right of the bullet.

§ Character button (only for custom bullets) 

For custom bullets, the Character button appears instead of the two options above. Click on this button if
you want to change the character format (font size, color, text styles, etc.) of the bullet.

Tip: If you do not change these settings, the bullet automatically uses the character format of the
paragraph to the right of the bullet (except for the font).

§ Vertical position 

This option allows you to specify the vertical position of the bullet on the line. If the value is negative, the
bullet is positioned lower. It is positioned higher if the value is positive.

Custom bullets

If you do not like any of the bullets offered in the above dialog box, you can use any other character as a bullet
at any time.

In the middle of the dialog box, you will find two rows of bullets. The bullets in the Default row cannot be
changed. However, the bullets in the Custom row can be changed at will.

To do so, proceed as follows:

1. In the Custom row, click on the icon that you want to change.

2. Click on the Change button to the right of the row.

3. Presentations' character table is now displayed. First, set the desired font if necessary.

Tip for Windows users: Numerous characters suitable for bullets are included in the icon fonts Symbol and Wingdings.

4. Double-click on the desired character.

5. The selected character is now displayed in the list of available bullets. Click on OK to apply it.

Note: The dialog box has a total of six buttons for custom bullets. Thus, you are not limited to six different
types of bullets. The custom bullets can be redefined as often as you like – even within the same document.

Picture bullets

You can use picture bullets as an attractive alternative to traditional bullets. You can generally use any picture
as a bullet, but Presentations already comes with a wide range of picture bullets in different shapes and colors.

To use picture bullets, select the option Picture bullet in the above dialog box. A preview of all available
bullets will then appear. To select a bullet, click on it.
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Alternatively, you can use any picture file from your hard disk as a bullet. To do so, click on the Load from
file button.

Numbered lists

You can create numbered lists in Presentations just as easily as bulleted lists. Presentations automatically
indents the paragraphs at the left to make room for the numbers and assigns a consecutive number to the
paragraphs.

To number paragraphs, select the relevant paragraphs and proceed as follows:

Applying numbering

You will find the commands for numbering via the Numbering icon  on the ribbon tab Home | group
Paragraph.

Numbering can be applied in different ways after you have selected the relevant paragraphs:

A. If you only want to apply a numbering without any further changes, simply click directly on the icon itself
(not on the arrow next to it). The default numbering or the last numbering you selected will then be used.

B. For a selection of predefined numbering options, click on the arrow next to the icon. A dropdown menu
appears with default numbering and any numbering previously used in the document. Click on the desired
numbering to insert it directly.
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C. If you want to adjust numbering via the dialog box with all additional options, however, click on the arrow
next to the icon, and select Format numbering. For further steps in the dialog box, see "Other options: Via
the dialog box Bullets and numbering" below.

The selected paragraphs are now numbered.

Note: You can use as many numbered lists as you want within a document. The numbering automatically
starts again for each group of contiguous paragraphs. More specifically: If there is an unnumbered paragraph
in front of a numbered paragraph, the numbered paragraph's number is automatically reset to "1".

Skipping numbering

You can pause the numbering for a paragraph and then resume it for a subsequent paragraph.

To do so, place the text cursor in the relevant paragraph and choose one of the following paths:

A.Click on the arrow next to the icon  and select the entry Skip numbering from the dropdown menu.

B. To navigate via the dialog box, click on the arrow next to the icon, but now select Format numbering. In
the following dialog box, enable the option Skip numbering.

The selected paragraph's number has now been removed, and only its indentation is retained. The numbering
resumes for the following paragraph.

Discontinuing or removing numbering

To discontinue numbering paragraphs or to remove a previously applied numbering, proceed as follows:

First, position the text cursor at the end of the last numbered paragraph and press Enter¿ to start a new
paragraph. Alternatively: Select the numbered paragraphs if you want to completely remove the numbering of
these paragraphs.

In this case also – as when applying numbering – different paths are possible:

A.Simply click again directly on the icon itself  to remove the numbering.

B. Alternatively, click on the arrow next to the icon and select None in the dropdown menu.

C. To navigate via the dialog box, click on the arrow next to the icon, but now select the entry Format
numbering. In the open dialog box, you will find the option None under Type.

Other options: Via the dialog box "Bullets and numbering"

To insert custom numbering, you will find additional options in the dialog box.

Proceed as follows:

1. Select the relevant paragraphs.

2. Click on the arrow next to the icon  on the ribbon tab Home | group Paragraph. In the dropdown
menu, select the entry Format numbering.
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3. In the following dialog box, select the option Numbering under Type.

4. Make the desired settings for numbering if required. (For more information, see the "Options of the dialog
box" section below.)

5. Confirm with OK.

The selected paragraphs are now numbered.

Options of the dialog box

In the above dialog box, you can make the following settings for numbering:

§ Type 

Here, you can specify either numbering or bullets for the selected paragraphs. Select the Numbering option
for numbering.

Note: You can always convert a numbered list into a bulleted list simply by changing the "Type" to Bullet. You can also do it the
other way round, of course.

If you set the type to None, existing bullets or numbers are removed.

§ Before and After 

If required, you can specify text to be added before and/or after the number assigned to the paragraph. If, for
example, you want the numbers to be surrounded by dashes (-1-, -2-, -3- etc.), select the Format "1, 2, 3, ..."
and enter "-" in the Before and After fields.
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§ Format 

Here, you specify the format for the numbering. In addition to the usual "1., 2., 3., ...", you can select letters
(A, B, C, ...) or Roman numerals (I, II, III, ...).

§ Numbering starts with ... 

Presentations starts every numbered list at "1" by default. If you want to use a different start value, enter "5"
here, for example, and the numbering will start at "5".

Tip: Furthermore, you can also do the following: If, for example, you have set the numbering a, b, c, etc., for the above option
Format and have entered the start value "aa", you create numbering like aa, bb, cc, etc. 

§ Skip numbering 

Within a numbered list, you often require one or more paragraphs for which the numbering is to be
temporarily suspended but then resumed for the following paragraph. To do so, position the text cursor in
the numbered paragraphs that you want to exclude from the numbering, and select the option Skip
numbering.

§ Character button 

You can click on this button to change the character formatting (font and font size, text styles, etc.) for the
numbers.

§ Vertical position 

This option allows you to specify the vertical position of the numbers. If the value is negative, the number is
positioned lower. It is positioned higher if the value is positive.
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Searching and replacing
This section explains the functions for searching and replacing text:

§ Search 

§ Replace

§ Repeating a search/replace

You can search for terms in the text and replace them with other terms if desired. If, for example, a text
contained several occurrences of the name "Smith" misspelled as "Smyth", you could direct Presentations to
replace all occurrences of "Smyth" with "Smith".

Search

You can search a document for a specific term using the ribbon command Home | Search .

To perform a text search from this dialog box, enter the text for which you want to search in Search for and
then click on the Search button.

When Presentations finds the search text, it scrolls to its first occurrence in the document and selects it. To find
more occurrences of the text, click on the Search button again to go to the next occurrence.

Advanced search options

If you click on the Enlarge button in the dialog box of the ribbon command Home | Search , the dialog box
expands to offer additional options.

Clicking on Reduce makes the dialog box smaller again.
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The enlarged Search and replace dialog box offers the following additional options:

§ Case sensitive 

The case of letters in the search term is ignored by default. Thus, if you search for "house", not only
"house", but also "House", "HOUSE", "HouSe", etc., will be found.

If you enable this option, however, the program will only find those occurrences of the search term where
the cases of the letters correspond exactly to the cases of the letters in the search term. Thus, if you search
for "house", only "house" will be found.

§ Whole words only 

If you enable this option, the search term will only be found if it occurs as a separate word.

Thus, if you search for "test", it will be found only when it occurs as a separate word and not when it forms
part of another word like "testament" or "protest".

§ Search in ... 

In the Search in section, you can restrict the search to Selected slides only. Otherwise, Presentations will
search in all slides.

Presentations usually starts a search at the current position of the text cursor. If you enable the option
Search from top, however, Presentations starts at the beginning of the document.

If the option Search backwards is enabled, the search is performed backwards, that is, from the current
position of the cursor back to the beginning of the text.

Replace

Sometimes, you want to do more than just find a term in the text. You also want an easy way of replacing it
with another term.
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To do so, choose the ribbon command Home | group Search | Replace .

Enter the text for which you want to search under Search for, and enter the text you want to replace it with
under Replace with. Then click on the Search button to start the search, and Presentations will jump to the first
occurrence of the search term in the document and select it. If you want to replace that text, click on the
Replace button to replace it with the specified text. If you click on Search again, Presentations will jump to the
next occurrence of the search term, and you can replace it again, and so on.

Alternatively, you can click on Replace all to replace all occurrences of the search term in your presentation at
once.

Additional search options

The Search and replace dialog box also has additional options that enable you to restrict the search. You can
show these options by clicking on the Enlarge button or hide them again using the Reduce button. The
individual options were described in the previous section Search.

Repeating a search/replace

To repeat a search or replace operation or to continue it after canceling, choose the ribbon command Home |

Search again  or simply press the F3 key.

Presentations will continue the search and display the next occurrence of the search term.



277Working with text

Moving, deleting and copying
All operating systems that Presentations supports have an extremely useful feature: the clipboard.

The clipboard works as follows: You select something in the document and then cut or copy the selected text to
the clipboard. You can then reinsert the selected text elsewhere in the document. The clipboard thus facilitates
the deletion, copying and moving of sections of text (as well as objects).

All necessary commands (except Delete) can be found on the ribbon tab Home | group Edit:

Command Explanation

Delete If you select a section of text (or object) and press the Del key, the text or object will be deleted
without being moved into the clipboard.

Cut The ribbon command Home | Cut also deletes the content of a selection – but not permanently.
This content is moved instead to the clipboard, where it remains available for subsequent insertion
anywhere in the document.

Copy The ribbon command Home | Copy copies the content of the selection to the clipboard.

Paste To paste the content of the clipboard into the text, place the cursor at the desired text position and
use the ribbon command Home | Paste (click directly on the icon). You can also insert the content
of the clipboard multiple times in this manner.

Paste special If you click on the small arrow below the icon rather than directly on it at Home | Paste, a
dropdown menu opens with additional options for pasting the contents. For more information, see
the next section Paste special.

These commands work in the same way for objects such as pictures or drawings.

Moving and copying text with the mouse ("drag and drop")

Android/iOS: This function is not available in the Android and iOS version.

You can select a section of text with the mouse, drag it to another position in the slide and drop it there. With
this technique, known as drag and drop, you can move or copy text very quickly.

To do so, proceed as follows:

1. Select the section of text.

2. Position the mouse cursor on the selection.

3. Press the left mouse button and hold it down.

4. With the mouse button held down, drag the selection to the desired position on the same slide.

5. When you release the mouse button, the content of the selection is moved to the new position. When you
release the mouse button while pressing the Ctrl key, the text is copied to the new position, rather than
moved.
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Paste (special)
There is a more powerful variant for the ribbon command Home | group Edit | Paste.

If, for example, you have copied text and clicked on the small arrow below the Paste icon, you can use the
dropdown menu to specify in which form the text from the clipboard should be pasted:

§ Paste: The original formatting of the copied text is retained. This results in the same program behavior as
when you click directly on the Paste icon above the small arrow. 

§ Paste unformatted text: The original formatting of the copied text is removed, and it adopts the formatting
of the text passage where it is pasted.

§ Further entries (for example, Paste picture) appear in this dropdown menu depending on what you have
copied to the clipboard.

§ Paste special: Here, you can specify exactly how the content from the clipboard is to be pasted.

In detail:

When you use the commands Cut or Copy to save information to the clipboard, it is saved in multiple
formats simultaneously. If you have selected text, it appears in the clipboard in both formatted and
unformatted form.

When you choose the command Paste special, the program will display a dialog box with a list of all
formats in which the information currently stored in the clipboard is stored (a slide was copied in this
example).

If you select a format and then confirm with OK, the content of the clipboard will be pasted in the selected
format.
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The following settings are available:

§ Source: Here, the program displays the application from which you copied or cut the data. 

§ Paste as: Here, you can choose the format in which to paste the data.

Note: The formats offered in this list depend on the source from which you copied the data.

§ Retain design: If this option is enabled, slides are pasted together with their associated slide design (only
available if you have copied or cut entire slides).

§ Paste notes: If this option is enabled, slides are pasted together with their associated notes (only available if
you have copied or cut entire slides).

For copied objects and tables, you get different entries than for copied text. Here, the dialog box Paste special
also displays a list of all formats stored in the clipboard from which you can choose.
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Inserting special characters
Some characters, such as the copyright sign, the degree sign and the accented characters used in some
languages, cannot be entered into text directly with the keyboard. With Presentations, you can easily insert
these special characters into the text via the built-in character table.

To do so, proceed as follows:

1. Open the dialog box via the ribbon command Insert | Symbol  (in the group Text) by clicking directly
on the icon.

Tip: If you click on the icon's arrow rather than directly on the icon itself, a small selection of the last used special characters will
open for quick use. If you click on More here, you will open the dialog box again.

2. The dialog box displays all characters available in the currently selected font. You can select a different font
from the dropdown list Font if necessary.

3. You can use the dropdown list Set to jump to a specific section of the character set. For example, you can
select Cyrillic to view the Cyrillic characters (provided the selected font contains such characters).

Note: Many fonts contain only a few of the available character sets. A particularly large reservoir of
characters is available in the standard fonts supplied with your operating system. In Windows, for example,
these include such fonts as Arial, Tahoma and Times New Roman.

4. Select the character to insert with the arrow keys and press the Enter key¿ or double-click on the character
to insert it into the text.

5. You can now insert more characters in the same way or exit the dialog box with the Close button.

Tip for Windows users: Most versions of Windows include two icon fonts named Symbol and Wingdings.
These fonts contain numerous useful symbols (phone symbols, bullets, etc.).

Using shortcut keys

If you need to insert a special character frequently, you can always give it a shortcut key. The advantage of
doing so is that you can then apply the character very quickly with one press of a key.

To assign a shortcut key to a special character, proceed as follows:

1. Choose the ribbon command Insert | Symbol  to open the dialog box.

2. Select the special character to which you want to assign a shortcut key.

3. Click on the Change button next to the option Shortcut key.

4. Another dialog box appears. In the Press new shortcut key input field, press the desired key combination
(starting with Ctrl or Alt).

We recommend that you always use key combinations that include the keys Ctrl and Shift since they are not
usually assigned. If you press a key combination that is already assigned, its current assignment will be
displayed just below the Press new shortcut key input field. You should then press the Backspace keyÕ
to delete your shortcut key and use a different key combination. Otherwise, you will overwrite the key
combination of another Presentations command.
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5. Don't forget: Click on Add to assign this shortcut to the character.

6. Confirm with OK and exit the main dialog box with Close.

From now on, you can insert this special character into the text by pressing the relevant key combination.

Note: The shortcut key only remembers the selected character but not the selected font.

Inserting special characters via their character code

There is another method for inserting special characters: by typing in its hexadecimal character code (Unicode)
and then pressing the key combination Ctrl+Alt+Shift+X.

If, for example, you type 20AC and then press this key combination, you will get a euro sign € because it has
the character code 20AC in the Unicode character table.

Note: The Unicode value is displayed in the dialog box described above when you click on a special character.

Inserting special characters via Alt + numeric keypad

Here is yet another method for inserting a special character, via its ASCII code: Press and hold down the Alt
key and enter the respective sequence of numbers (only possible via the numeric keypad!). Please also ensure
that the numeric keypad is enabled by pressing the Num key.

If, for example, you type Alt+0128, you will obtain a euro sign € as soon as you release the Alt key.

Note: You can display the ASCII code of a special character in Windows via the search term "Character map".

Mac/Linux: On some systems (including macOS and several Linux distributions), these shortcut keys do not
work.

Applying selected formatting and special characters via the "Character" icon

The ribbon command Insert | Character  (in the group Text) opens a dropdown menu with some special
formatting and special characters, such as:

§ Soft hyphen / non-breaking hyphen: see Hyphenation 

§ Non-breaking space: see Non-breaking space

§ En dashes and spaces of different widths and some useful special characters.

Tip: If you click on the icon  on the far right of the character in this dropdown menu, you can assign your
own shortcut key to the character if required.

For more information on changing the keyboard mapping, see Customizing shortcut keys. You can edit the
shortcut keys for special characters described in this section by selecting the "Characters" entry in the upper left
list Categories in the dialog box.
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Comments
Presentations allows you to add comments to a slide. A comment is like a sticky note that can be "stuck"
anywhere on the slide.

Comments are useful, for example, if you receive a presentation from an employee for proofreading purposes.
Instead of having to explain to the employee at length where specific corrections should be made, simply insert
comments at the relevant places and write your suggested changes there.

Comments are not printed when the presentation is printed, and they are not displayed when you run the slide
show.

To insert a comment, choose the ribbon command Insert | Comment .

Alternatively: choose the ribbon tab Slide show | Insert comment.

Note: If you have not yet entered your name and initials (see also User info in the section Settings, General
tab), Presentations will ask you for them now. Comments have to be marked with the name of the author so
that it is clear who wrote them.

The following dialog box then appears:

At the top, the dialog box displays the author's name and the date/time. Below this, you will find an input field
in which you can enter your comment. Then click on OK.

The comment now appears as a yellow box with your initials on the slide. If desired, you can move it to any
position on the slide using your mouse.
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When you hover over the box, the complete comment is displayed:

Editing comments

When you right-click on a comment, the program displays a context menu with which you can edit the
comment.

You can use the command Edit comment to change the comment. If you choose the command Delete
comment, the comment is removed. The command Copy comment text enables you to copy the content of the
comment and paste it elsewhere. The command Insert comment lets you insert another comment.
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Running a slide show
Presentations provides various options for preparing and running a slide show. This chapter provides all the
relevant details:

§ The section Starting a slide show describes the different ways to start running a slide show. 

§ The Slide show setup section explains all options for setting up a slide show.

§ In the Custom slide shows section, you will learn how to use a single presentation file as the basis for
multiple slide shows in which certain slides are omitted or displayed in a different order.

§ The Slide show interaction section shows you how to interact during your slide show. In addition to the
navigation buttons, there are useful tools such as a highlighter feature that you can use to highlight text or
elements in a slide.

§ In the Using the presenter view section, you will become familiar with the "Presenter view". This is a
useful tool when running a slide show on a second display, for example, a projector: If it is enabled, the
audience sees the normal slide show, while the presenter himself sees useful additional information on his
own display – such as his notes on each slide.

The following pages provide detailed information on these functions.

Starting a slide show
To start a slide show, you can use the following commands of the Slide show | Start icon (in the group View):

§ Start the slide show from the first slide: 

Choose the ribbon command Slide show | Start  by clicking directly on the icon itself. Alternatively,
simply press the F5 key.

§ Start the slide show from the current slide: 

Choose Slide show | Start, click on the small arrow of the icon  and select Start from current slide .
Alternatively, simply press Shift+F5.

In the displayed slide show, you can use the space bar or the left mouse button to switch to the next slide.
Right-clicking opens a context menu with several functions for interacting with the current slide show. (For
more information, see Slide show interaction.)

Have you two displays connected? Use the presenter view!

Tip: If two displays are connected to your device and you start a slide show, it is displayed by default in the
"Presenter view".
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The Presenter view is a useful tool when running a slide show on a second display, for example, a projector: If
it is enabled, the audience sees the normal slide show, while the presenter himself sees useful additional
information on his own display – such as his notes on each slide.

You will find this option on the ribbon tab Slide show | group Display | Presenter view.

For more information on this view, see Using the presenter view.

Creating presentations that start automatically ("slide show")

An alternative method for starting a slide show is to double-click on a file in the Presentations slide show file
format. Open it directly in Windows Explorer, for example. Even if Presentations is not already running, it then
starts automatically, opens the file, plays the slide show immediately, and then ends again.

To create such a file that starts automatically, simply open any Presentations document and save it in the
"Presentations slide show" file format. To do so, choose the command File | Save as and select Presentations
slide show (*.prsx) under Save as type.

For more information on all supported file formats, see Working with other file formats.

Slide show setup

With the ribbon command Slide show | group Manage | Set up show , you can customize some options for
presenting a slide show according to your needs.

A dialog box appears:
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The following options are available here:

§ Mode 

This option determines how the slide show is displayed.

The option Presented by speaker (full screen) shows the slide show in full-screen mode. This is the default
setting.

The option Browsed by an individual (window) is used to show the slide show in a window. This allows
you to perform a test run of your slide show while still having access to other windows on your screen.

The option Browsed at a kiosk (full screen) can be used to show your slide show in full-screen mode, but
in a loop that is repeated over and over again, and with severely limited interaction options. This mode is
ideal for slide shows that are intended to run automatically without a speaker (for example, at an information
stand).

Note: In this mode, the entire keyboard is disabled (with the exception of the Esc key). Furthermore, left-
clicking in order to advance to the next slide and right-clicking to open the context menu no longer work.
However, users can still click on objects that have assigned actions (such as "Go to [Next slide]"). For
more information, see Adding object actions.
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§ Slides 

Here, you can specify whether you want to show the entire slide show, only a range of slides, or a custom
slide show. (For information on creating custom slide shows, see Custom slide shows below)

§ Options 

If the option Loop until 'Esc' pressed is enabled, the slide show will be repeated in an infinite loop until the
Esc key is pressed. This is useful for unsupervised slide shows.

If the option Suppress animations is enabled, all object animations and slide transitions included in the
presentation are suppressed.

The option Pen color lets you set the color of the pen that you use for drawing on a slide while the slide
show is running. For more information on the pen and other interaction options, see Slide show interaction).

§ Continue slide show 

If a timing was set for the Slide transitions in the slide show (via the options on the ribbon tab Transition |
group Progress or the options for Next slide in the dialog box), you can specify here whether to use or
ignore it when running the slide show.

Available options:

Using timings, if present: This is the default setting: If the slide transition has been set to automatically
switch to the next slide after x seconds, this will be done accordingly. (Alternatively, you can use the space
bar or a mouse click to continue to the next slide before this time elapses.)

Manually: If you select this option instead, any timings defined in the slide transitions are ignored. You can
then only manually continue to the next slide (for example, by pressing a key or by a mouse click).

Note: If you select the option Manually and also enable the option Browsed at a kiosk, all slides in your
presentation should include your user-defined buttons for navigating to the previous/next slide. To add such
buttons, simply insert any objects and assign the object action "Slide navigation" to them. (For more
information, see Adding object actions).

Custom slide shows
Presentations always runs slide shows from the first slide to the last slide by default. However, you can also
create custom slide shows, which can skip any desired slides and play the slides in a completely different order.

Custom slide shows allow you to customize the same slide show for different audiences instead of having to
create a separate document for each audience.

Choose the ribbon command Slide show | group Manage | Custom slide shows . The following dialog box
appears:
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The dialog box lists all custom slide shows that you have created so far for the current document. If no custom
slide shows exist, you can use the New button to create one.

The Edit, Delete and Duplicate buttons let you change, delete or make copies of existing custom slide shows.

Creating custom slide shows

To create a new custom slide show, click on the New button in the above dialog box. Another dialog box
appears:
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You can enter a descriptive name for the slide show in the Custom slide show name field.

The list All slides contains all slides in the current slide show. To add slides to the custom slide show, select
them in the list All slides and click on the right arrow button. The slides are then moved to the list Custom
show slides. This lists all slides that you want to subsequently display in the custom slide show.

You can use the left arrow button to remove individual slides.

The double arrow buttons enable you to move all slides to the other field.

In the Custom show slides field, you can also change the order in which slides are shown by selecting one or
more slides and using the up and down arrows.

Tip: By default, Presentations names slides according to their consecutive number (Slide1, Slide2, Slide3,
etc.). However, creating custom slide shows is a lot easier if you give each slide a descriptive name. You can
always rename slides via the context menu in the mini sorter by choosing the command Rename slide.

When you're satisfied with your choice and order of the slides, click on OK to create the new custom slide
show.

Playing a custom slide show

To play a custom slide show, go to the ribbon tab Slide show | group View | Start and click on the small arrow

 of the icon. In the dropdown menu that appears, you will now find a new entry Start custom slide show and
select the desired slide show from this list.

Alternatively, choose the ribbon command Slide show | group Manage | Set up show to open the dialog box
and set the desired custom slide show in a fixed manner in the "Slides" section. (For more information, see
Slide show setup.) This custom slide show is then always started immediately by choosing the usual command
Slide show | group View | Start or by pressing the F5 key.

Slide show interaction
When you run a slide show in full-screen mode, you have several ways to interact during the show. To do so,
right-click anywhere during the slide show.

Android/iOS: In these versions, you can also open the context menu with your finger by tapping on the screen
and holding your finger there for about a second.

The context menu for running slide shows appears:
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The following commands and options are available (the corresponding shortcut keys are given in parentheses):

§ Arrow (A): The arrow is nothing more than an ordinary mouse cursor that you can use to point to specific
elements in the current slide if required. 

§ Pen (R): You can use the pen to draw directly in the current slide. To do so, hold down the left mouse
button and then use the mouse like a pen.

§ Highlighter (M): Use the highlighter to emphasize text or other elements like you would with a highlighter
on paper. Hold down the left mouse button to draw in this case also.

§ Eraser (E): The eraser allows you to remove individual pen or highlighter marks by clicking on them.

§ Pen color: Here, you can change the color of the active drawing tool (pen or highlighter). This option
appears only if one of the two drawing tools is enabled.

§ Erase all ink on slide: This command deletes all marks made in the slide with the pen or highlighter.

§ Hide cursor automatically: If this option is enabled, the mouse cursor is hidden automatically whenever
the mouse is not moved for a few seconds.

§ Pause (P): This option pauses the slide show until you press a key. 

§ Black screen (B): This option displays a black screen and pauses the slide show until you press a key. 

§ White screen (W): This option displays a white screen and pauses the slide show until you press a key. 

The bottom part of the context menu contains commands for navigating during your slide show: Next slide,
Previous slide, Last viewed slide, Go to slide… and End slide show.

Tip: You can also use the following keys for navigating between slides:

Function Key
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Next slide: à or

â or

PageDownâ or

Space

Previous slide: ß or

á or

PageUpá or

Backspace

First slide: Home

Last slide: End

End slide show: Esc

Menu commands for slide shows with the option "Browsed by an individual (window)"

If you have selected the option Browsed by an individual (window) in the settings for Set up show , the
slide show will be run in a window. The top bar contains only one entry called Navigation and only provides a
simple menu for navigation.

It contains the following commands:

This menu lets you jump back and forth between different slides. Alternatively, you can use the aforementioned
shortcut keys to navigate. However, the context menu containing tools like pen and highlighter is not available
in this mode.

Using the presenter view

FreeOffice: The Presenter view is not included in SoftMaker FreeOffice. 
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In this section, you will become familiar with the "Presenter view". This is a useful tool when running a slide
show on a second display, for example, a projector: If it is enabled, the audience sees the normal slide show,
while the presenter himself sees useful additional information on his own display – such as his notes on each
slide.

Prerequisites for using the Presenter view

The Presenter view can only be used if the following prerequisites are met:

§ A second display must be connected to the device used. 

§ The slide show must be played in normal full-screen mode and not in window or kiosk mode. (For more
information, see Slide show set up.)

§ The Presenter view must be enabled (see next item).

For help with problems related to using the Presenter view – for example, the settings for displaying the screens
– see Troubleshooting at the end of this section.

Enabling/disabling the Presenter view

The Presenter view can be enabled and disabled as follows:

§ Ribbon tab Slide show: In the command group Display, you will see an option called Presenter view,
which allows you to enable or disable the Presenter view. If there is a check mark in front of the entry, the
Presenter view is currently enabled. 

§ Options: Alternatively, the Presenter view can also be enabled and disabled in the options. To do so, choose

the ribbon command File | Options , switch to the View tab and enable or disable the option Use
presenter view.

Enabling the Presenter view has the following effect:

If you now start a slide show (for example, with the command Slide show | Start ), the two displays of the
device used show the following views:

§ Second display: The slide show itself is played here. 

§ Primary display: The Presenter view with advanced functions and information for the presenter/speaker is
displayed here. The next section will reveal what additional content you can find here.

Elements of the Presenter view

In the Presenter view, the primary display shows the following content:

§ Timer 

In the upper left corner, you will see a timer that starts as soon as you start the slide show. It displays the
current runtime in hours, minutes and seconds.

You can use the pause button to its right to pause or resume the timer at any time.

§ Current slide 

The large area in the left half of the screen shows the current slide in the slide show that is running.
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In this area, you can also interact with the slide show – just like during the "normal" running of a slide show.
For example, a left click in this area (or pressing the space bar) advances the slide show to the next slide,
and a right click opens the context menu with further options for interaction and navigation. (For more
information, see Slide show interaction.)

§ Toolbar 

Directly below the current slide, some tools for operating the Presenter view are displayed.

From left to right, these individual icons have the following functions:

Drawing tools: When you click on this icon, you can choose between different drawing tools (pen,
highlighter, etc.) and draw with them in the slide. This allows you, for example, to highlight certain
components of a slide during the slide show.

Alternatively, you can also right-click on the current slide to open the context menu for the slide show and
select a drawing tool there. (For more information, see also Slide show interaction.)

Swap monitors: This option swaps the display on the primary monitor with that on the secondary monitor.
This action is undone by clicking on the icon again.

Show slide sorter on/off: This option switches the slide sorter (shown at the bottom of the screen) on/off.

Show next slide on/off: This option switches the preview of the next slide (shown in the top right corner of
the screen) on/off.

Black screen and pause: This option displays a black screen on the second display and pauses the timer.
This function is intended for pausing. Clicking on the icon again ends the pause.

End show: This option ends the slide show.

§ Slide x of y 

Below the current slide, the Presenter view shows which slide is currently displayed and the total number of
slides in the slide show.

By clicking on one of the arrows, you can switch to the previous/next slide.

§ Next slide 

A preview of the next slide is displayed in the upper right corner.

§ Notes 

The large area in the right half of the screen displays your notes for each slide.

Note: Notes cannot be edited in the Presenter view. For information on adding and editing notes, see Adding
notes.

The two icons below  can be used to change their font size.

§ Slide sorter 

At the bottom of the screen, you can see an overview of all slides of the slide show.

If you click on one of the slides displayed there, the slide show jumps directly to this slide.
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To exit the Presenter view (and thus also end the slide show), click on the End slide show icon on the toolbar
or press the Esc key.

Troubleshooting

As mentioned at the start, some prerequisites must be met to use the Presenter view. If the Presenter view does
not work on your system, please check whether you successfully performed the following steps:

1. Connect a second display

The Presenter view only works with (at least) two monitors. Thus, if you have not already done so, connect
an additional output device to the second graphics port of your system.

Your device should automatically detect and use the second display by default. You can check this in the
display settings of your system.

Note for Windows users: In the display settings of Windows, make sure that the option Extend these
displays is selected for Multiple displays.

2. Configure Presentations to use two displays

Whenever you connect a second display, Presentations detects this automatically and displays slide shows
on the second display by default.

If this doesn't work: Go to the ribbon tab Slide show | group Display and make sure that the dropdown menu
Display contains one of the following set values: Auto (recommended), Display 2 or Display 3.

You will also find this setting under File | Options , View tab, option Display.

Note: If the entry Display 2 does not appear in this list, then the second display was either not recognized by
your system or your system was not correctly set to use multiple monitors. Open the display settings of your
operating system to correct this issue. (For more information, see also the previous point.)

3. Play the presentation in normal full-screen mode

The Presenter view is only available if the slide show is played in normal full-screen mode (that is, neither
in window mode nor in kiosk mode).

Thus, choose the ribbon command Slide show | group Manage | Set up show and ensure that Presented by
speaker (full screen) is selected for the option Mode in the dialog box.

4. Enable the Presenter view

If all of the above prerequisites are met, but the slide show is still not started in Presenter view, you should
check whether the Presenter view is enabled at all. You can do so by choosing the ribbon tab Slide show |
group Display and ensuring the option Presenter view is selected. This allows you to enable and disable the
Presenter view. A check mark in front of the entry indicates whether or not the function is currently enabled.
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Outputting presentations

Android/iOS: In these versions the commands are not freely available. By clicking on the command icon,
users of SoftMaker Office NX Home and NX Universal can unlock the features free of charge via their
product key or otherwise via Google Play/Apple App Store (subject to a fee).

This chapter provides all the information you need on how to print, export, send and pack documents with
Presentations. The chapter contains the following sections:

§ Printing a presentation 

To print the current document, choose the command File | Print.

§ Exporting a presentation as a PDF file 

You can also export a document to a PDF file by using the ribbon command File | group Document |
Export as  | PDF.

PDF files can be viewed on virtually any computer, provided that a suitable PDF viewer is installed there.
All formatting and objects of the document are retained exactly as in the original file. However, slide
transitions and animations are not displayed.

§ Sending a presentation by e-mail 

FreeOffice: Sending by e-mail is not included in SoftMaker FreeOffice.

Documents can also be sent by e-mail. The ribbon command File | group Document | Send is responsible
for this process.

§ Exporting a presentation as HTML files 

FreeOffice: Export as HTML is not included in SoftMaker FreeOffice.

If you choose the ribbon command File | group Document | Export as  | HTML, you can export the slides
of a presentation to a series of HTML files that can be viewed with any web browser (without slide
transitions and animations).

§ Exporting a presentation as picture files 

If you choose the ribbon command File | group Document | Export as  | Pictures, the slides of a
presentation can be exported as picture files. One picture file is created for each slide.

§ Exporting a presentation as a movie file (available on Windows only) 

FreeOffice: Export as Movie is not included in SoftMaker FreeOffice.

The ribbon command File | group Document | Export as  | Movie exports a presentation (more precisely:
its slide show) as a movie file.

§ Portable slide show 
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FreeOffice: Portable slide show is not included in SoftMaker FreeOffice.

In addition, you can package Presentations as a file package with all associated files so that it can also be
played on other computers which do not have SoftMaker Office installed. A free Presentations viewer is
included in the file package. You create such a file package with the ribbon command File | group
Document | Export as  | Portable slide show.

See the following pages for more detailed information on these functions.

Printing a presentation
Android/iOS: This command is not freely available in these versions. For more information, see the
beginning of this chapter.

To print the current document, choose the ribbon command File | Print .
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The program will display a dialog box in which the following settings can be made:

Printer

Here, select which of the installed printers should print the printout.

The Setup button opens a window for setting up and configuring printers. For more information, see your
printer manual.

Linux users can also specify here the command to be used to initiate the printing process.

Print content

Select what to print here: the slides themselves, the notes, an outline of your presentation or handouts.

If you select "Handouts" here, the option Handouts layout is also enabled and lets you choose how many slides
to print on each page.

Print range

Here, you can specify which slides to print:

§ All slides 

Print the entire document.

§ Selected slide(s) 

Print only the slides currently selected in the mini sorter or in the slide sorter.

§ Custom slide show 

Print only the slides in the custom slide show selected here. (For more information, see also Custom shows.)

§ Slides with numbers 

Print only the slides with the specified numbers. To use this option, enter the desired slide numbers. Some
examples:

12 Print slide 12 only

12-15 Print slides 12 to 15

12- Print slide 12 and all of the following slides

-12 Print slides 1 to 12

You can also enter multiple slide numbers or ranges by separating them with commas:

2-5, 12 Print slides 2 to 5 and slide 12

etc.
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§ You can also use the option Pages to print to specify whether all selected pages or only the pages with a
even or odd page number should be printed. 

Options

This section of the dialog box contains additional printing options:

§ Copies 

Here, you can specify the number of copies of the document to be printed.

§ Collate copies 

This option specifies whether to sort the print output by page number when printing multiple copies of a
document.

If you enable this option and print multiple copies of a document with, for example, three pages, the pages
will be output in the following order: 1-2-3, 1-2-3, 1-2-3, and so on.

If it is not enabled, the order will be: 1-1-1..., 2-2-2..., 3-3-3...

Note: Some printers do not support this function.

§ Print to file 

This option redirects the print output to a file instead of a physical printer.

§ Reverse order 

This option prints the pages from last to first.

§ Frame slides 

This option prints a border around the content of each slide.

§ Print hidden slides 

This option allows you to also print those slides that were marked as hidden with the ribbon command Slide
show | Hide slide.

§ Fit to page 

This option resizes the content of each slide if necessary to ensure it fits on the printed page.

§ Color mode 

Here, you can select whether to print the presentation in its original colors, in grayscale or in black and
white.

To start printing, click on OK.
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Exporting a presentation as a PDF file

Android/iOS: This command is not freely available in these versions. For more information, see the
beginning of this chapter.

You can also export documents as a PDF file.

PDF files can be viewed on virtually any computer, provided that a suitable PDF viewer is installed there (for
example, Adobe Reader). All formatting and objects (pictures, drawings, etc.) of the document are retained
exactly as in the original file. However, slide transitions and animations are not displayed.

To export a document to a PDF file, proceed as follows:

1. Choose the ribbon command File | group Document | Export as  | PDF.

2. A dialog box appears. Make the desired settings there (see below) and confirm with OK.

3. Another dialog box now appears. Enter a file name under which you want to save the PDF file and confirm
with OK.

The PDF file will then be created. To view it, open the PDF file in a PDF viewer of your choice.

Tip: If you do not have a PDF document viewer installed on your device, simply use your web browser to
search for "PDF viewer". You will find numerous suitable programs, many of which are free.

In the dialog box of the above command, you can make the following settings for the PDF export:

General tab

On this tab, you can specify whether to output only parts of the document and make other settings. The options
are similar to the ribbon command File | Print described in Printing a presentation.

In addition, the following options are also available:

§ Create a bookmark for each slide 

If this option is enabled, Presentations automatically creates a bookmark in the PDF file for each slide that
your document contains.

Your PDF viewer will then display these bookmarks in a pane to the left of the document. You can use this
pane like an interactive table of contents: Just click on one of the bookmarks to instantly jump to the
corresponding slide in the PDF file.

Tip: If your PDF viewer does not display this pane, search for a command for displaying bookmarks in it
and enable it.

§ Create tagged PDF 

If this option is enabled, information about the logical structure of the document will also be saved in the
PDF file.
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This information ensures that your PDF files are accessible for the disabled and can also be used, for
example, with PDF viewers that reproduce or read aloud the document content in Braille.

§ Reset (see "Reset" button at the end of this section) 

Preferences tab

On this tab, you can make settings for the output quality:

§ AutoShape options 

Here, you can set the quality level (i.e., resolution) in which AutoShapes and all other types of drawings are
exported. The higher the quality level, the larger the generated PDF file.

§ Picture options 

Here, you can specify whether to save images with Lossless compression or lossy JPEG compression. If
you opt for JPEG compression, you can set the quality level of the compression.

Tip: Normally, you should choose lossless compression here because it ensures perfect image quality. If
your document contains a large number of images (especially photographs), however, the resulting PDF
file may be very large. In this case, we recommend that you use JPEG compression, which provides a
much higher compression ratio for photographs.

The option Use alpha channel for transparencies determines whether an alpha channel should be used to
represent transparency in pictures and drawings. Usually, they look best when this option is enabled.
However, some PDF viewers represent alpha channels incorrectly, thus you can also disable this option.

§ Other options 

Include Presentations document: This option saves a copy of your Presentations document within the PDF
file. You can then open this PDF file directly in Presentations, whereupon the program will extract the
original Presentations document from the PDF file and display it.

Open the file in a PDF viewer after exporting: This option launches your PDF viewer automatically and
displays the PDF file after it has been created (provided that you have a PDF viewer installed on your
computer).

Use relative paths for file links: This option automatically converts the file path from hyperlinks (links) to
files into a relative path (rather than an absolute path). If, for example, you have inserted a link to the file C:
\Documents\Lists\Test.txt and export the PDF document to the folder C:\Documents, this link will
be automatically converted into "Lists\Test.txt".

§ Font options 

The option Font embedding allows you to specify whether the fonts used in the document should be
embedded in the PDF file.

If font embedding is enabled, the resulting PDF file can be viewed in its original fonts on any computer –
even if the relevant computer does not have the fonts installed. If, on the other hand, the option is disabled,
the PDF file will be displayed with automatically selected replacement fonts.

The option Embed only used characters determines whether all characters of a font or only the characters
actually present in the document should be embedded when embedding fonts. The advantage of enabling this
option is that the resulting PDF file is smaller in size.
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§ Archiving (not included in SoftMaker FreeOffice) 

This option enables you to select from various variants in the standard PDF/A to create standard-compliant
PDF files. This standardized format allows the long-term archiving of documents and is considered a
prerequisite when documents must be stored in a non-editable manner and in an identical format to the
original documents.

§ Reset (see "Reset" button at the end of this section) 

View tab

This tab contains advanced options for displaying the PDF file in a PDF viewer:

§ Navigation pane 

Use this option to specify what should be displayed in the navigation pane of the PDF viewer. (The
navigation pane is a bar displayed to the left of the PDF document.)

Available options:

Default: Use the PDF viewer's default setting.

Empty: Do not display anything in the navigation pane.

Bookmarks: Display the document's bookmarks in the navigation pane.

Page thumbnails: Display thumbnails of the document's pages in the navigation pane.

§ Zoom 

This option specifies the zoom level at which the PDF file should be displayed:

Default: Use the PDF viewer's default setting.

Full page: Select the zoom level at which the entire page fits in the window.

Fit width: Select the zoom level at which the page width fits in the window.

Fit height: Select the zoom level at which the page height fits in the window.

Custom: Set the zoom level to a custom value (in percent).

§ Page layout 

This option specifies the layout with which the pages should be displayed:

Default: Use the PDF viewer's default setting.

Single pages: Display as single pages.

Two pages - odd pages left: Display as two facing pages (odd pages on the left).

Two pages - odd pages right: Display as two facing pages (odd pages on the right).

§ Additional options 

This section provides the following additional options:

Display document title: Display the document's title in the title bar of the PDF viewer (instead of its file
name). Tip: You can enter the title of a document on the Summary tab in the dialog box of the command
File | Properties.
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Center viewer on screen: This option automatically centers the program window of the PDF viewer on the
screen when the PDF file is opened.

Full-screen mode: This option automatically switches the PDF viewer to full-screen mode when the PDF
file is opened.

Hide menu bar: This option hides the menu bar of the PDF viewer.

Hide toolbars: This option hides all toolbars of the PDF viewer.

Hide navigation pane controls: This option hides all controls of the navigation pane.

§ Reset (see "Reset" button at the end of this section) 

Protection tab

This tab provides options that enable you to encrypt the resulting PDF file and to use passwords to protect the
file from being opened or changed.

§ Encryption type 

Here, you can specify whether the PDF file should be encrypted. You can choose between 40 bit encryption
(low level of security) and 128 bit encryption (high level of security).

Note: The other options in this dialog box are not available until you have selected an encryption type.

§ Password to open the document 

If you enter a password here, the PDF viewer will ask for this password when users try to open the PDF file.
If an incorrect password is entered, the user cannot open the file.

If you leave this field empty, any user can open the file without having to enter a password.

§ Password to set permissions 

You can also restrict the permissions for the PDF file. To do so, enter a password to change the permissions.
Then use the options in the Permissions section of the dialog box to specify which permissions should be
granted to users.

Background information: Some PDF viewers have a command for changing the permissions. If a user
chooses this command, they can only continue if they enter the password that you have set here.

§ Permissions 

Here, you can specify which permissions users should have with respect to the PDF file when they open it in
a PDF viewer. (This is only available if you have entered a password above for setting permissions.)

§ Reset ("Reset" button below) 

"Reset" button

All changes to the PDF export options are retained as global settings in Presentations and are thus applied to the
next export of a PDF document. You can restore the original default settings by clicking on the Reset button in
the lower left corner of the dialog box.
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You can click on this button on any tab of the dialog box PDF Export, thereby resetting the options of all tabs
at once.

Sending a presentation by e-mail

FreeOffice: Sending by e-mail is not included in SoftMaker FreeOffice.

Android/iOS: This command is not freely available in these versions. For more information, see the
beginning of this chapter.

If you have a suitable e-mail program installed on your device, you can send Presentations documents by e-mail
directly from Presentations.

To do so, proceed as follows:

1. Create or open the presentation that is to be e-mailed.

2. In Presentations, choose the ribbon command File group | Document | Send .

(Android/iOS: Here the command is called Share and allows sharing via several channels).

3. Select the format in which the document is to be sent.

Note: If you select the Presentations document format here, the recipient will receive an e-mail with the Presentations file as an attachment. In order
to open this attachment, the recipient must also have Presentations installed.

Presentations now generates an e-mail with the document as an attachment and passes it to your e-mail
program.

Exporting a presentation as HTML files

FreeOffice: Export as HTML is not included in SoftMaker FreeOffice.

You can choose the ribbon command File | group Document | Export as  | HTML to export a presentation
to a series of HTML files. The program will then create a HTML file for each slide, which contains an image of
the slide as a picture.

Note: Slide transitions and animations are not displayed in it.

Proceed as follows:

1. Create or open the desired presentation.

2. Choose the ribbon command File | group Document | Export as  | HTML.
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3. A dialog box appears. Make the desired settings there (see below) and confirm with OK.

Presentations will now create the relevant HTML files and pictures.

To view the result, open the main HTML file (see below) in your web browser. If desired, the main file also
includes a table of contents and buttons for navigating between slides.

Options of the dialog box

In the dialog box for this command, you can make the following settings:

§ Main HTML file 

Enter the path and file name of the main file here. The main HTML file is the file that has to be opened in
the web browser in order to view the presentation.

All other HTML files and picture files will be stored in the same folder (or a subfolder of it).

§ HTML title 

Here, you can enter a title for the main HTML file. It will be displayed in the title bar of the web browser.

§ Store supporting files in a subfolder 

In addition to the main HTML file, Presentations must create some additional files that are required to view
the presentation. For example, one HTML file and one picture file are generated for each individual slide.

If this option is enabled, these supporting files will be stored in a subfolder of the folder containing the main
HTML file. If it is disabled, the files will end up in the same folder as the main HTML file.

§ Add HTML frame with table of contents 

If this option is enabled, a frame containing a table of contents of all slides will be added to the left of the
main HTML file. Each entry contains a link to the corresponding slide. This makes navigation easier.

§ Slide range 

Here, you can specify which slides to export:

All slides: Export all slides of the presentation.

Selected slides: Export only the slides currently selected in the mini sorter or in the slide sorter.

Custom slide show: Export only the slides in the custom slide show that is selected here. (For more
information, see also Custom shows.)

Slides with numbers: Export only the slides with the specified numbers. To use this option, enter the
desired slide numbers as demonstrated in these examples:

12 Export slide 12 only

12-15 Export slides 12 to 15

12- Export slide 12 and all of the following slides

-12 Export slides 1 to 12

You can also enter multiple slide numbers or ranges by separating them with commas:

2-5, 12 Export slides 2 to 5 and slide 12
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The option Export hidden slides determines whether the slides that were marked as hidden with the ribbon
command Slide show | Hide slide should also be exported.

§ Slide pictures 

Here, you can make settings for the pictures that are displayed in the HTML files to represent the slides:

Format: This option determines the format of the pictures. For maximum quality, we recommend the PNG
format, as it compresses completely losslessly. If your slides contain a large number of photographs, you
also have the option of using the JPEG format. It provides much higher compression for such pictures, but it
is not lossless.

Width and Height: This option allows you to specify the width/height of the pictures. Note: If you change
the width, the height adjusts automatically (according to the aspect ratio of the slides) – and vice versa.

Add borders: This option adds border lines to each picture.

§ Options 

Here, you can set the following options:

Add navigation controls: This option displays buttons for navigating to the previous and next slide below
each slide picture.

Use graphical navigation buttons: This option uses graphical buttons for navigation (instead of buttons
labeled with text).

The More... button opens a dialog box with the following additional options:

Colors: This option specifies the colors in which the background and links to the HTML pages will be
displayed.

Fonts: This option specifies the font in which links to the HTML pages will be displayed.

§ Show result in browser 

This option launches your web browser and displays the main HTML file once the export is complete.

Exporting a presentation as picture files

If you choose the ribbon command File | group Document | Export as  | Pictures, the slides of a
presentation can be exported as picture files. One individual picture file will be created for each slide.

Note: Slide transitions and animations are not displayed in it.

Proceed as follows:

1. Create or open the desired presentation.

2. Choose the ribbon command File | group Document | Export as  | Pictures.

3. A dialog box appears. Make the desired settings there (see below) and confirm with OK.

Presentations will now create the picture file(s). You will find them in the folder that you specified in the File
name field of the dialog box.
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Options of the dialog box

In the dialog box of this command, you can make the following settings:

§ File name 

Here, enter the path and file name of the picture file to be created.

When you export multiple slides, Presentations creates an individual picture file for each slide. Presentations
automatically adds a consecutive number to each of these files – for example, Test0001.png, Test0002.png,
Test0003.png, etc.

§ Picture type 

This option enables you to specify the format of the picture file(s). For maximum quality, we recommend
the PNG format, as it compresses completely losslessly. If your slides contain a large number of
photographs, you also have the option of using the JPEG format. It provides much higher compression for
such pictures, but it is not lossless.

§ JPEG quality 

If the Picture type is set to JPEG format, you can specify the desired quality level for the picture file(s)
here. You can enter values between 1 and 100 (percent). The default value is 90.

Low values deliver highly compressed files but poor picture quality. High values result in less compressed
files with better picture quality.

§ Selection 

This option lets you choose which slides to export: only the current slide, only the selected slides or all
slides.

§ Size 

Here, you can set the desired Width or Height of the resulting picture file(s).

Note: If you change the width, the height adjusts automatically (according to the aspect ratio of the slides) –
and vice versa.

Exporting a presentation as a movie file

FreeOffice: Export as movie is not included in SoftMaker FreeOffice.

Note: This function is not available for Linux, macOS or the Android/iOS version.

The ribbon command File | group Document | Export as  | Movie exports your presentation (more precisely:
its slide show) to a movie file.

Proceed as follows:

1. Create or open the desired presentation.
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2. Choose the ribbon command File | group Document | Export as  | Movie.

3. A dialog box appears. Make the desired settings there (see below) and confirm with OK.

4. The slide show is now played in a window. At the same time, it is recorded as a video file.

If your presentation contains transitions or animations that have to be advanced manually, use the space bar
or press the left mouse button to continue at the desired speed. The resulting movie file will then use the
same timing.

5. When the slide show has finished, Presentations stops recording and saves the movie file.

To view the resulting video, open the movie file in a video player of your choice.

Notes

§ If you want to temporarily pause the video recording while it is running, you can always click on the button
with the pause icon. 

§ If you want to stop the recording before the slide show ends, click on the button with the stop icon.

Options of the dialog box

In the dialog box of this command, you can make the following settings:

Note: If you are unsure what to set for Movie format, Codec and Video options, you can simply apply the
default settings.

§ Movie format 

Here, you can set the file format in which you want to record the video.

§ Codec 

Here, you can choose a different video encoder to create the video.

§ Movie file 

Here, you can specify the path and file name of the movie file to be created.

§ File size limit 

Here, you can specify the maximum size of the movie file. If the limit is exceeded, Presentations stops the
video recording and issues an error message.

§ Slides 

Here, you can specify which slides to display in the video recording:

All: Use all slides of the presentation.

From ... To: Use only the range of slides between the first slide and the last slide selected here.

Custom slide show: Use only the slides in the custom slide show that is selected here. (For more
information, see also Custom shows.)
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§ Video options 

Here, you can make changes to the quality settings of the resulting movie file.

Width: This option specifies the width of the movie (in pixels).

Height: This option specifies the height of the movie (in pixels).

Frame rate: This option specifies the frame rate – that is, how many pictures are recorded per second.

Bit rate: This option specifies the bit rate – that is, how many kilobytes are stored per second.

§ Play movie after creation 

If you enable this option, the resulting movie will automatically open in your video player when the
recording is complete.

Portable slide show

FreeOffice: The Portable slide show function is not included in SoftMaker FreeOffice.

Android/iOS: This function is not available in these versions.

For various reasons, it is sometimes desirable to share an entire presentation with all associated files so that it
can be played on another computer where SoftMaker Office is not installed. A free Presentations viewer can
also be included in the resulting file package.

With the command Portable slide show, you can create all files required for the slide show as a file package in
a folder on your computer and copy them to a CD/DVD from there. If you have a USB stick available as a
storage medium, you can save the file package directly on the USB stick.

Note: A newly started presentation must first be saved.

To create a Portable slide show, proceed as follows:

1. Open Presentations and choose the command File | group Document | Export as  | Portable slide show.

2. A dialog box appears.

3. In the Files to copy section, select the files or complete folders that you want to copy for your file package.
Furthermore, you can also include any other file formats that you would like to share.

The arrow keys on the left side can be used to change the order of entries in the list. You can use the
Remove button to remove files or folders from the list.

4. Make the desired settings in the Options section (see below).

5. Specify the Output folder in which the created file package should be saved.

6. Finally, confirm with the Copy to folder button. The file package is now created in the selected folder.
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To start the slide show, double-click on the batch file play.bat in the output folder.

Setting options for the output files

The following settings are available in the Options section of the Portable slide show dialog box:

§ Add Presentations viewer 

If this option is enabled, Presentations adds a viewing software (a simplified free version of Presentations)
to the file package, which can be used to start the presentation even on computers where SoftMaker Office is
not installed.

If the option is disabled, the slide show cannot be run on a computer that does not have the relevant
software.

Mac version: The viewing software cannot be added here. Thus, the computer on which you start the
slide show must have the relevant software.

§ Include media files 

If you have inserted media objects (picture, sound or movie) into the presentation only as a link and have not
saved them in the document (see Inserting media objects), media objects are copied along with the
presentation if the option is enabled.

§ Change all documents into slide shows 

Option enabled: The document is saved as a slide show so that the presentation starts as a "slide show" when
it is opened. For more information, see Starting a slide show.

Option not enabled: The document is saved unchanged.

§ Copy used fonts 

This option enables you to specify whether the fonts used in the document should be embedded for output.

If this option is enabled, the created slide show will be displayed on every computer in the fonts that were
originally used, even if those fonts are not installed there. If it is disabled, the slide show will be displayed
with automatically selected replacement fonts.

§ Create a playlist 

Option enabled: The files play.bat and playlist.prl are created for the file package. As a result, you can start
the slide show from the batch file (play.bat). The order of the documents is stored in the playlist
(playlist.prl).

Option disabled: Playlist and batch file are not created. In this case, the slide show can then only be played
by bypassing the standard procedures described above.
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Language tools
Presentations contains sophisticated language tools consisting of a spell check, hyphenation and a thesaurus.
(Depending on your chosen language, you may have only the hyphenation feature, or the hyphenation and spell
check features.)

This chapter provides a comprehensive introduction to all available language tools. It consists of the following
sections:

§ Setting the language 

The language for spell check, hyphenation and thesaurus can be set via the ribbon command File | Options
(Language tab).

§ Spell check 

The spell check checks a document's text for typos and suggests corrections in the event of errors.

§ Hyphenation 

When you enable it, the hyphenation feature automatically hyphenates long words (according to their
spoken syllables) at the ends of lines.

§ Thesaurus 

FreeOffice: The thesaurus is not included in SoftMaker FreeOffice.

The large thesaurus integrated into Presentations shows you synonyms (words of the same or related
meaning) for a word. Thesauri are also available for many foreign languages.

§ Research 

Only available in SoftMaker Office Professional and NX Universal: Look up terms on research platforms
on the Internet (Wikipedia, Oxford dictionary, Cambridge dictionary, etc.) directly from the document.

§ SmartText 

FreeOffice: The SmartText function is not included in SoftMaker FreeOffice.

You can use SmartText to automatically correct your "favorite typos" and define abbreviations for frequently
used phrases – for example, "sd" for "sales department".

Setting the language
If you have installed more than one language, you can change the language for the spell check, hyphenation and
thesaurus at any time.

To do so, proceed as follows:
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1. Choose the ribbon command File | Options  to open the dialog box.

Alternatively: Slide show | Spell check  | Settings.

2. Switch to the Language tab.

3. Select the desired language from the list.

Note: Please note that there are two entries in this list for German:

§ "German (Germany)" stands for the new spelling (according to the 1996 German spelling reform in its last
revision in 2006). 

§ "German (Germany, old)", on the other hand, stands for the old spelling.

The same applies to "German (Austria)" and "German (Switzerland)".

Spell check

FreeOffice: SoftMaker FreeOffice does not include the premium SoftMaker dictionaries normally shipped
with SoftMaker Office. Only Hunspell dictionaries can be used here.

Only Hunspell dictionaries for English and German are already installed. If you need more languages, see
Installing Hunspell dictionaries.

The spell check checks a document's text for typos and suggests corrections in the event of errors.

This section describes the different spell check tools in detail. The information covers the following topics:

§ Manual spell check 

The manual spell check lets you check and correct possible spelling errors in an entire document.

§ Checking the spelling as you type 

The option Check spelling as you type constantly checks all text in the document for spelling errors.
Misspelled words have red wavy underlines. They can be corrected manually or via a context menu with
suggested words.

§ Conversion to the new German spelling 

If you compose documents in German, the option "Check spelling as you type" can also help you to apply
the reformed German spelling rules.

§ Editing user dictionaries 

When you teach the spell check new words, they are added to your user dictionary. You can edit this
dictionary at any time, for example, to delete incorrect entries.

For more information on these topics in the above order, see the following pages.
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Manual spell check

FreeOffice: SoftMaker FreeOffice does not include the premium SoftMaker dictionaries normally shipped
with SoftMaker Office. Only Hunspell dictionaries can be used here.

Only Hunspell dictionaries for English and German are already installed. If you need more languages, see
Installing Hunspell dictionaries.

Choose the ribbon command Slide show | group Review | Spell check  to start the subsequent spell check.
(Tip: You can also choose this command with the F7 key.)

This checks the text word for word for spelling errors. If the spell check encounters an unfamiliar word, it stops
and displays the word in a dialog box.

You can then choose to correct the word, add it to the dictionary or simply ignore the supposed error. The list
under Change to will also contain some suggestions for the correct spelling of the word (if any are found).

Use the buttons in the dialog box to specify what to do with the unfamiliar word:

Button Function

Change This option lets you correct the misspelled word. Before you use this button, type the correct
spelling in the Change to input field or select one of the suggested words from the list.

Change all This option works like the Change button, but changes all further instances of the word (from here
to the end of the document).

Ignore This option instructs Presentations to ignore this spelling error and continue with the spell check.

Ignore all This option instructs Presentations to ignore all further instances of this word.
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Note: Presentations only remembers the list of ignored words temporarily. When you exit
Presentations, it forgets it. If you want Presentations to learn words permanently, use the command
Add instead.

Add This option instructs Presentations to add the word to the user dictionary and thus increase its
vocabulary.

Use this option for correctly spelled words that Presentations does not yet know. Presentations
remembers these words permanently, even after a restart.

If you want to exit the spell check before it reaches the end of the document, click on Close.

Checking the spelling as you type

FreeOffice: SoftMaker FreeOffice does not include the premium SoftMaker dictionaries normally shipped
with SoftMaker Office. Only Hunspell dictionaries can be used here.

Only Hunspell dictionaries for English and German are already installed. If you need more languages, see
Installing Hunspell dictionaries.

The option Check spelling as you type constantly checks the whole text for spelling errors. All misspelled
words are marked with a red underline.

Enabling the option "Check spelling as you type"

To enable the function Check spelling as you type, choose the ribbon command File | Options, switch to the
Language tab in the dialog box and enable the option Check spelling as you type there.

Tip: You can also enable this setting directly on the ribbon tab Slide show | group Review | Spell check
without going via the dialog box. Click on the small arrow of the icon and select the entry Check spelling as
you type.

Presentations will now continuously check the entire document for spelling errors in the background. It will not
only recognize existing spelling errors in the document, but will also immediately examine changes and
additions to the text for correct spelling.

Correcting misspelled words

Misspelled words are highlighted with red wavy underlines on the screen. This allows you to see all misspelled
words at a glance so that you can either correct them immediately or at a later time.

To correct one of these words underlined in red, either just change its spelling manually or right-click on the
word to open the spell check's context menu:

Android/iOS: In these versions, you can also open the context menu with your finger: Just tap on the screen and
hold your finger there for about a second.
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The context menu contains the following items:

Item Function

List of 
suggestions

The upper part of the context menu offers suggestions for the correct spelling of the word if any
are found by Presentations. If you click on one of them, it will replace the word in the text.

If Presentations finds a large number of suggestions, an additional menu item called More
suggestions... appears. If you click on this item, a dialog box will appear with all suggestions that
were found. For more information, see Manual spell check.

Ignore word This option ignores the spelling error (for all instances of this word) and removes the red
underline.

Use this option for words that are spelled correctly but should not be learned. When you exit
Presentations, it "forgets" the ignored words.

Add word This option instructs Presentations to add the word to the user dictionary and thus increase its
vocabulary.

Use this option for correctly spelled words that Presentations does not yet know. Presentations
remembers these words permanently.

Create
SmartText entry

This option creates a SmartText entry from the word. For more information on this function, see
SmartText.

As soon as you correct the spelling or allow Presentations to ignore or add the word, the red underline
disappears.

Blue underlined words: If you have also enabled the option Underline old German spellings in blue in the
dialog box File | Options, you may also see blue underlined words in addition to red underlined words. These
are words that correspond to the old German spelling but have to be written differently since the new spelling
was introduced. For more information, see the next section.

Conversion to the new German spelling

As you may have already noticed, Presentations offers two entries for German in lists for selecting the
language:

§ "German (Germany)" stands for the new spelling (according to the 1996 German spelling reform in its last
revision in 2006). 

§ "German (Germany, old)", on the other hand, stands for the old spelling.

The same applies to "German (Austria)" and "German (Switzerland)".

Thus, you can decide for yourself whether you would prefer to use the old or the new German spelling:

Using the old spelling

If you select the language "German (Germany, old)", the spell check, hyphenation and thesaurus will continue
to follow the old spelling rules.
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Using the new spelling

If you want to write your documents in the new German spelling, on the other hand, select the language
"German (Germany)". In this case, the aforementioned function Check spelling as you type will provide you
with a useful tool if desired:

If you use the dialog box to enable the option Underline old German spellings in blue, a blue underline is
added to all words that correspond to the old German spelling but should be written differently according to the
new spelling.

If you right-click on such a word, you will be offered the permitted spellings. You can also find out why this
word should be spelled differently – and thus refresh your knowledge of the new spelling rules.

For more information on this topic, see the following pages.

Enabling conversion to the new German spelling

To enable checking and converting to the new spelling in texts composed in German, you must proceed as
follows:

1. Choose the ribbon command File | Options  to open the dialog box.

Alternatively: Slide show | Spell check  | Settings.

2. Switch to the Language tab.

3. Enable the option Check spelling as you type.

4. Also enable the option Underline old German spellings in blue.

5. Confirm with OK.

Note: The option Underline old German spellings in blue only works for text in the language "German
(Germany)", "German (Austria)" or "German (Switzerland)". It is irrelevant for all other languages.

Presentations now continuously checks the document in the background for words that should be written
differently since the 1996 spelling reform. Such words are underlined in blue. On the following pages, you will
learn how Presentations can help you to convert these words into the new German spellings.

Correcting words with old German spellings

If, as described in the previous section, you have selected the option Underline old German spellings in blue,
German words whose spelling was changed during the spelling reform are indicated with a blue underscore.

To correct one of these underlined words, just change its spelling manually or right-click on the word to open
the spell check's context menu.
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Android/iOS: In these versions, you can also open the context menu with your finger by tapping on the screen
and holding your finger there for about a second.

The context menu contains the following items:

Item Function

List of 
suggestions

All spellings that are correct (according to the reformed German spelling rules) are displayed in
the upper part of the menu. If you click on one of them, Presentations will replace the word in the
text with it.

Info This option opens a dialog box with additional options and information. For more information, see
Info command of the spell check.

Ignore word The option ignores the supposed spelling error and removes the blue underline.

Use this option for words that are spelled correctly but should not be learned. When you exit
Presentations, it "forgets" the ignored words.

Add word This option instructs Presentations to add the word to the user dictionary.

Presentations remembers such words permanently; they will no longer be underlined in blue. (See
note!)

Note: Use the command Add word only for those German words underlined in blue that are in fact correctly
spelled according to the new German spelling rules. If you allow the addition of words with old spellings,
rather than new spellings, you will be supplying Presentations with incorrectly spelled words.

Info command of the spell check

If you open the context menu of the spell check, as described in the last section, an additional entry appears for
German words spelled in the old way: the Info command. This command contains additional options and shows
information about the rule governing the change in the word's spelling under the German spelling reform.

This command's dialog box provides the following functions:

Item Function

List of 
suggestions

All spellings that are correct according to the spelling reform are displayed here. If you click on
one and then click on the Change button, Presentations will replace the word in the text with it.

Change This option lets you correct the word after you have chosen the correct spelling from the list of
suggestions.

If Presentations ever makes an incorrect suggestion, you can enter the correct spelling in the
Change to field manually.

SmartText This option lets you define a SmartText entry. For more information, see SmartText.

Ignore This option instructs Presentations to ignore this spelling error.
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Ignore all This option instructs Presentations to ignore all further instances of this word.

Note: Presentations only remembers the list of ignored words temporarily. When you exit
Presentations, it forgets it. If you want Presentations to learn words permanently, use the command
Add instead.

Add This option instructs Presentations to add the word to the user dictionary.

Presentations remembers such words permanently; they will no longer be underlined in blue. (See
note!)

Close This option closes the dialog box without applying a change.

Note: Use the command Add only for those German words underlined in blue that are actually spelled
correctly according to the new German spelling rules. If, on the other hand, you allow the addition of words
with old spellings, rather than new spellings, you will be supplying Presentations with incorrectly spelled
words!

Editing user dictionaries

When you teach the spell check new words, they are added to your user dictionary. You can edit this dictionary
at any time, for example, to delete incorrect entries.

To do so, click on the small arrow of the icon Spell check  on the ribbon tab Slide show | group Review and
select Edit user dictionaries from the dropdown menu. The program displays a dialog box with the following
buttons and options:

§ Language 

There is a separate user dictionary for each language. You can select the user dictionary to be edited from
the dropdown list Language.

Note: Note that there are two entries for each German in this list: "German (Germany)" stands for the new
spelling and "German (Germany, old)" for the old spelling. The same applies to "German (Austria)" and
"German (Switzerland)".

§ Entries 

This list contains all words that have been added to your user dictionary (for the selected language).

§ "Close" button 

This option closes the dialog box.

§ "Add" button 

This button enables you to manually add a word to your user dictionary. To do so, type the desired word into
the dialog box that appears after you press this button.

Words added in this way are treated exactly the same as words that were added using the Add button in the
spell check.
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§ "Change" button 

Use this button to edit the word that is currently selected in the list. This is useful for misspelled words that
you have added to your user dictionary accidentally. By clicking on the button, you open a dialog box where
you can correct the spelling of the word.

§ "Delete" button 

This button deletes the word currently selected in the list from your user dictionary.

The spell check will therefore regard this word as misspelled again in the future.

Hyphenation
If you want long words to be automatically hyphenated at the end of a line, you can always enable automatic
hyphenation.

The hyphenation can be enabled or disabled separately for each paragraph of your document.

Note: Note that hyphenation is disabled by default for all paragraphs in a document. You must thus
explicitly enable them if required.

Hyphenation works completely automatically in the background as you type.

Important: Of course, hyphenation only provides correct results if you have set the correct language in the

program settings. To set the language, choose the command File | Options , switch to the Language tab
and select the language from the dropdown list Default language.

Enabling hyphenation and setting the hyphenation frequency

By default, hyphenation is disabled for all paragraphs of the document. To enable it, proceed as follows:

1. Place the text cursor in the desired paragraph (or select several paragraphs).

2. On the ribbon tab Home | group Paragraph, use the group arrow  in the bottom right corner to open the
dialog box.

Alternatively: Right-click to open the context menu and select the entry Paragraph.

3. Select the desired option in the dropdown list Hyphenation.

The following options are available:



319Language tools

Option Explanation

None Hyphenation is not performed in this paragraph. This is the default setting.

Always Any amount of consecutive hyphenation is attempted.

Every 2 lines Hyphenation is attempted only in every second line.

Every 3 lines Hyphenation is attempted only in every third line.

If you select None, you disable hyphenation for the selected paragraphs, whereas if you select Always, the
program tries to hyphenate any line of a paragraph.

When do you use the other two options? It is not always a good idea to hyphenate at every point possible. For
text in narrow columns, for example, this may lead to words being split at the end of almost every line and thus
to a reduction in the document's legibility. Thus, you may want to use the option Every 2 lines or Every 3 lines
to instruct Presentations to attempt hyphenation only in every second or third line.

Inserting "soft hyphens"

Presentations has a very sophisticated hyphenation module that only very rarely makes mistakes. If the program
does not hyphenate a word in the desired place, you can always correct it by inserting a soft hyphen (also known
as an optional hyphen).

To do so, place the text cursor at the point where you want the word to be hyphenated and press the key
combination Ctrl+Minus (minus sign). From now on, Presentations will only hyphenate the word at this point.

If a word contains multiple syllables, you can also insert several soft hyphens (for example, one after each
syllable).

Inserting "non-breaking" hyphens

If a word (or a number) that contains a hyphen is located at the end of a line, Presentations may use this hyphen
to hyphenate the word. In certain cases, this is not desirable.

In the case of a phone number like 936386-0, for example, you do not want the zero to be separated from the
rest of the phone number by hyphenation. The number is ultimately easier to read if it is moved completely to
the next line rather than distributed over two lines.

If you want to prevent Presentations from performing hyphenation at a hyphen that a word contains, insert a
non-breaking hyphen instead of a regular hyphen. You can insert this by pressing the key combination
Ctrl+Shift+Hyphen.

You could also call this character a "non-separating hyphen" because it looks like a normal hyphen but prevents
hyphenation from being performed at this point.

Thesaurus

FreeOffice: The Thesaurus is not included in SoftMaker FreeOffice.
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You can use the ribbon command Slide show | group Review | Thesaurus  to instruct Presentations to
search for synonyms (terms with the same or similar meaning) for a word.

This function can help you express yourself precisely and avoid repetition. Even if you have a large vocabulary,
the thesaurus may still find alternative words. This function is particularly useful for foreign languages.

A particularly large thesaurus is available for German (not included in all Presentations versions). It was
created under the guidance of a renowned German linguist over many years and contains no less than 400,000
synonyms. You will hardly find a more comprehensive thesaurus currently in any other presentation graphics
program.

Using the thesaurus

To open the thesaurus, type a word or move the text cursor to an existing word. Then choose the ribbon
command Slide show | group Review | Thesaurus.

Presentations now searches for the word in the thesaurus. If the word is not found, words with similar spellings
are displayed for selection. Otherwise, synonyms for the word are displayed.

Note: If a word has several meanings, several entries are displayed in the list Meaning. First, select the
desired meaning and then view the corresponding synonyms that appear in the list Synonyms as a result.

You can now click to select a word from the list Synonyms and then choose one of the following functions via
the buttons:

Button Function

Look up This option looks for alternatives to the selected synonym.

Replace This option replaces the word in the text with the selected synonym.

Close This option exits the thesaurus.
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Research

FreeOffice: The Research function is not included in SoftMaker FreeOffice.

Note: This feature is only available in SoftMaker Office Professional and NX Universal.

You can use the Research function to look up the meaning of the terms you selected in Presentations directly in
online dictionaries and encyclopedias. Presentations suggests various online research platforms (Wikipedia,
Oxford dictionary, Cambridge dictionary, etc.) that you can open interactively for your search.

To do so, proceed as follows:

1. Select one or more terms in your document.

2. Choose the ribbon command Slide show | group Review | Research .

3. In the dropdown menu, click on the desired platform on which you want to look up your research term.

The selected online platform will then be opened directly with the results for your selected term.

Available categories

In the open menu of the Research icon , you can choose from the following categories:

§ Recently used 

The platforms most recently used by the research function are displayed here for quick access again (the last
3 searches).

§ English (depending on the selected language)

General reference contents are displayed here in the language you selected in the settings (see "More"
below).

§ German - English (depending on the selected languages)

If you have selected multiple languages in the settings (see "More" below), this category will appear with
translation platforms corresponding to the selected languages.

§ More

You use the entry More to open a dialog box with the settings. Here, you specify the languages for which
Presentations should suggest research platforms to you. Enable the desired language(s) by clicking on the
respective checkbox.

This results in the menu of the Research icon displaying the general reference books and translation
platforms for all languages you selected, insofar as they are available in these languages.
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SmartText
FreeOffice: The SmartText function is not included in SoftMaker FreeOffice.

The SmartText function in Presentations can save you a lot of work: You can create SmartText entries for
frequently used phrases and then insert them instantly in the text.

For example, create a SmartText entry called "sd" with the content "sales department". You can now insert this
SmartText entry at any time. To do so, simply type "sd" in the text and then press the space bar, the Enter key¿

or a punctuation mark. "Sales department" immediately replaces "sd".

In this way, you can create your personal "computer steno" with Presentations and save a lot of time when
typing.

In this section, you will learn about working with SmartText entries:

§ Creating SmartText entries 

New SmartText entries can be created in a dialog-box-controlled manner with the ribbon command Insert |
group Text | SmartText or via the spell check. A name (for example, "sd") and the desired content must be
specified (for example, "sales department") for each text module.

§ Inserting SmartText entries 

If the option Expand SmartText entries is enabled in the program settings, SmartText entries can be
inserted very easily: To do so, type the name of the SmartText entry and then press the space bar, Enter
key¿ or a punctuation mark. The name will be immediately replaced by the content of the SmartText entry.

Alternatively, entries can be inserted manually with the ribbon command Insert | group Text | SmartText.?

§ Editing SmartText entries 

Not only can you create new SmartText entries with the ribbon command Insert | group Text | SmartText,
but you can also edit, rename or delete existing ones.

For more information, see the following pages.

Creating SmartText entries

You can choose to create SmartText entries a) in a dialog-box-controlled manner or b) using Check spelling as
you type:

A) With the command Insert | SmartText

To create a SmartText entry with the name "sd" and the content "sales department", for example, proceed as
follows:

1. Choose the ribbon command Insert | group Text | SmartText .

2. Click on the New button to create a new SmartText entry.
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3. Give the SmartText entry a name ("sd" in our example).

The SmartText entry can be retrieved later by its name.

4. Confirm with OK. You now return to the main dialog box.

5. Now, type the text for the SmartText entry in the large input field on the right (in our example: "sales
department").

6. Click on Save to save your new SmartText entry.

7. Exit the dialog box with Close.

The SmartText entry has now been created. You will find out how to insert it in the next section (Inserting
SmartText entries).

B) Via the option "Check spelling as you type"

If you have enabled Check spelling as you type, you can also create SmartText entries as follows:

1. In the dialog box of the ribbon command File | Options  and on the Language tab, make sure that the
option Check spelling as you type is enabled.

2. Type the two letters "sd" and press the space bar.

3. Presentations underlines "sd" in red because it does not know this word. Right-click on this word to open the
context menu.

Android/iOS: In these versions, you can also open the context menu with your finger by tapping on the
screen and holding your finger there for about a second.

4. Choose the command Create SmartText entry from the context menu.

5. In the open dialog box, type "sales department" into the large input field on the right.

6. Confirm with OK.

The result is the same: The SmartText entry "sd" has now been created.

For more information on the option Check spelling as you type, see Checking the spelling as you type.

Inserting SmartText entries

You can now insert the SmartText entry created in the previous section at any time.

This is very simple: Type the name of the SmartText entry in the text – "sd" in our example – and then a space,
a punctuation mark or the Enter key¿. Presentations immediately replaces "sd" with the content of the
SmartText entry.

Note: If this does not work, the option Expand SmartText entries is disabled. Choose the command File |
Options and enable this option again on the Edit tab (or in the dialog box of the command Insert | group
Text | SmartText).
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Alternatively, you can access the defined SmartText entries via the dialog box by choosing the ribbon command
Insert | group Text | SmartText, selecting the desired SmartText entry on the left side of the dialog box, and
then pressing the Insert button.

Tip: Do not expand SmartText entries

If you do not want a defined SmartText entry to be inserted when you type in the text, then use the key
combination Alt+. (period) in the place directly behind the SmartText entry. In this case, the specified addition
is then suppressed.

Editing SmartText entries

By choosing the ribbon command Insert | group Text | SmartText , you can still edit the already created
SmartText entries via the dialog box:

§ Creating a new SmartText entry 

Click on the New button to create a new SmartText entry in the dialog box. For more information, see
Creating SmartText entries.

§ Deleting a SmartText entry 

To delete a SmartText entry, select it in the list SmartText entries on the left of the dialog box and then
click on the Delete button.

§ Renaming a SmartText entry 

To change the name of a SmartText entry, select it in the list on the left, and click on the Rename button.
The program displays a dialog box in which you can enter the new name.

§ Editing a SmartText entry 

To edit an entry, select it in the list on the left and then click in the large input field on the right of the dialog
box. You can now change the content of the SmartText entry.

When you have made the desired changes, click on the Save button.

§ Inserting a SmartText entry 

To insert a SmartText entry into the text, select it in the list on the left of the dialog box and click on the
Insert button. For more information, see also Inserting SmartText entries).

You can finally exit the dialog box with the Close button. If the enabled SmartText entry has been changed but
not yet saved, Presentations will ask automatically if it should save the changes.
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Document management
Presentations has functions that make it easier for you to manage and access your documents faster:

§ Quick paths 

You can create quick paths in Presentations in order to quickly switch to frequently used folders when
opening or saving files.

§ Document summary 

Every document can have some additional info that you can display and edit using the Summary tab in the
dialog box of the ribbon command File | Properties. You can enter the title, subject and author of the
document, specify keywords for the file manager's search function and write a brief summary of the content.

§ File manager 

FreeOffice: The File manager is not included in SoftMaker FreeOffice.

You can use the integrated file manager to easily access your documents. It allows you to see the names and
the document infos on the Summary tab for all documents at a glance. You can view, open, print or delete
documents at the touch of a button.

The Search function of the file manager not only lets you search for your documents by file name, but it
also allows you to search by topic, title, author, etc.

§ Backup copies (file versions) 

If desired, Presentations creates a backup copy of the document each time the document is saved. You can
even instruct the program to automatically take "snapshots" of the document at regular intervals while you're
working on it.

The following pages provide detailed information on these functions.

Quick paths
Presentations allows you to create up to twenty quick paths via which you can quickly switch to a specific
folder when opening or saving files.

A quick path is a symbolic specification, such as "Documentation of the court building", which represents a
specific folder on the hard disk (for example, the folder C:\Court\New Building).

If you want to open a presentation from this folder, you must first choose the ribbon command File | Open and
then simply click on the Quick path button in the dialog box to select the created quick path. The dialog box
then switches immediately to the C:\Court\New Building folder.
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Quick paths are not only available in the dialog box of the command Open, but they are also in all other dialog
boxes that are used to open or save files.

Creating quick paths

To create a new quick path, proceed as follows:

1. Open any file dialog box, for example, with the ribbon command File | Open. (Click directly on the icon
itself to open the file dialog box.)

2. Click on the Quick path button in the file dialog box.

3. A menu opens below the button. Choose the command Create new quick path from it.

4. Enter any name for the quick path in Name of quick path – for example, "Documentation of the court
building".

5. Enter the desired folder under Path, – for example, "C:\Court\New Building".

Tip: Alternatively, click on the button with the three dots next to this input field. This opens a file dialog
box in which you can easily select the desired folder.

6. Confirm with OK.

Presentations now knows that the quick path "Documentation of the court building" should switch to the C:
\Court\New Building folder.

Opening quick paths

Quick paths are available in all file dialog boxes – for example, in those of the ribbon commands File | Open or
Insert | Picture. (Click on the icon itself to open the file dialog boxes.)

To use a quick path, proceed as follows:

1. Click on the Quick path button in a file dialog box.

2. A menu of all the previously created quick paths opens. Select the desired quick path.

Presentations now switches to the folder specified for the quick path.

Editing and deleting quick paths

To edit or delete an existing quick path, proceed as follows:

1. Click on the Quick path button in a file dialog box.

2. A menu opens. Choose the command Change quick paths in it.

3. A dialog box appears. Select the desired quick path in it.

4. Click on Change to edit the name or path, or click on Delete to remove the quick path.
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Document summary

The ribbon command File | group File management | Properties  not only enables you to make document-
specific settings but also to enter some document info on the Summary tab.

You can enter additional information (such as subject, author, keywords, etc.) about a document here. To view
or edit this information, choose the command File | Properties and switch to the Summary tab:

Make the desired changes and confirm with OK.

Tip: You can use the file manager (see next section) to search for documents by their document info, for
example, to find all documents on a specific topic.

Automatic prompt for summary information when saving: You can have Presentations prompt you to fill in the
document info on the summary tab whenever you save a new document.

To do so, choose the ribbon command File | Options , switch to the Files tab and enable the option Prompt
for summary information when saving. The dialog box for entering the document info on the summary tab
will now appear every time you save a new document for the first time.
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File manager

FreeOffice: The File manager is not included in SoftMaker FreeOffice.

Android/iOS: The File manager is not available in these version.

The file manager displays a list of documents from one or more folders and lets you open, print, delete or view
any document by clicking on it.

You start the file manager with the ribbon command File | File manager .

You can use the mouse to move or resize the file manager window at any time. You can also change the column
widths by dragging the separator lines between the column headings.

By clicking on one of the column headings, you can specify the column according to which the files are to be
sorted.

You can use the Search button to select a different folder and also use the Search function to start searching for
files. Furthermore, you can search for a specific title, subject, author, keyword, etc., within the Document
summary located on the Summary tab.

To perform an action with a file, select it and then click on one of the buttons. The individual buttons have the
following functions:

§ Open 

If you click on this button, Presentations opens the selected file.

Tip: You can also double-click on a file name to open the file.

§ Close 

Clicking on this button will close the file manager.
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§ Search 

Click on this button to search for specific files or simply to select the folder you want to display in the file
manager. For more information on searching with the file manager, see the next section.

§ Output 

Use this button to output the selected file. When you click on the button, a menu opens with the following
functions (depending on the operating system):

E-mail: Send the document by e-mail

Print: Print the document

§ Delete 

If you click on this button, the selected file will be deleted (after confirmation).

§ Preview 

Click on this button to open a preview window where you can view the selected document without having to
open it.

To actually open this document, click on the Open button in the preview. To exit the preview window, click
on the Cancel button.

§ Rename 

If you click on this button, you can rename the selected file.

Searching with the file manager

FreeOffice: The File manager is not included in SoftMaker FreeOffice.

Android/iOS: The File manager is not available in these versions.

You can use the Search button in the file manager to have Presentations search for specific files or simply
choose the folder to be displayed in the file manager.
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You can search for files that meet the following criteria: file name, folder, file type and the document info (title,
subject, author, keywords) on the Summary tab.

Several search criteria can also be combined. If, for example, you specify a specific folder in the dialog box,
Presentations will display all documents in this folder. If you also enter a search term in the Title field,
however, Presentations will find only those documents that are both in the selected folder and contain the
specified search term in the Title field on the summary tab.

With the dialog box shown above, you control the search function:

§ File name 

You can use this input field to search for specific files.

If you do not enter anything here (thus accept the default setting), the search function will find all
documents of the selected file type in the selected folder.

If you specify a unique file name like Sales.prdx, only documents with the exact same name will be
found.

If you specify an ambiguous file name like Sal*.prdx, the search will find all Presentations documents
whose file name begins with "Sal".

§ File type 

You can use this list to select the type of files to be targeted in the search. If, for example, you want to
search for files in Rich Text Format, select this format from the list File type.

§ Title, Subject, Author, etc. 

By entering content in these fields, the file manager will search the document info of your documents (see
Document summary).

If you fill in several fields, Presentations will search for documents that meet all of your specified
conditions. If, for example, you enter "court" in the Keywords field and "Smith" in the Author field, only
documents whose document info contain corresponding entries for both fields will be found.

You can also specify only part of the term for which you are searching. If, for example, you entered "court"
as the search term in the Keywords field, your search would return all documents that contained the word
"court" – thus terms like "courthouse", and "district court" would be found.
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Case is of no significance in search terms. If the search term is entered as "court", the search will also find
documents whose keywords contain "Court".

§ Folders 

Here, you can select the folder in which Presentations should perform the search.

§ Include subfolders 

If this option is enabled, Presentations not only searches the selected folder but also all folders that are
subordinate to it.

§ New list button 

If you click on this button, you start a new search with the current settings.

§ Add to list button 

Clicking on this button also starts a new search; however, any previous search results remain in the list
instead of being cleared from the list.
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Backup copies (file versions)

FreeOffice: These functions are not available in this form in SoftMaker FreeOffice. Only simple backups
can be made here, and this setting can be found on the Files tab.

If desired, Presentations creates a backup copy of the previous version of the document each time the document
is saved. You can even instruct the program to automatically take "snapshots" of the document at regular
intervals while you're working on it (similar to the common Auto-Recover function). You can also access these
snapshot versions later even if you have not saved the document manually using the command File | Save.

The settings for this can be found on the Backup tab in the dialog box of the command File | Options .
Select here whether and how file backups are to be created:

§ Keep older versions of the document (if you save a file manually) 

Several generations of file backups are created for each document. All of these copies are stored in a special
Backup folder.

Tip: If this option is selected, the command File | Versions  (in the group File management) is also
available and can be used to easily return to a previous file version of the document that is currently open
(see below).

Use the Number of versions to keep field to specify the maximum number of versions of backups
(generations) to be kept per document.

§ Automatically created file versions ("snapshots")

If you want automatic "snapshots" to be created as an additional backup while the document is being edited,
enable the checkbox here. In the dropdown field to the right, you specify the interval at which the snapshots
are to be taken regularly.

In the dropdown field below, enter the maximum number of snapshots you want to save.

§ Folder for file versions

Here, you can change the path for the Backup folder in which all backups are stored.

§ "Clean up" button

This button provides the following two commands for deleting backups:

Delete orphaned file versions removes all file backups for which the corresponding original document
no longer exists.

Delete file versions of all documents removes all file backups in the folder for file versions.

How do I use the command "File | Versions"?

If you enable the creation of file backups (see above), all backups end up in a special Backup folder. This
folder is managed automatically by the program. We do not recommend that you manually move or rename the
files in this folder.
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To return to a previous version of a document, you don't need to be interested in this folder at all – as there is a
separate command for it: File | Versions.

You can use this command to revert to a previous version of a document as follows:

1. Open the desired document (if it is not already open).

2. Choose the ribbon command File | group File management | Versions . (Click directly on the icon itself
to open the version manager.)

Tip: You can proceed even faster by clicking on the icon's arrow for the dropdown menu instead of on the
icon itself. The available backups are listed here. Restore the desired version by clicking on the version
entry – this will open the version in a new document window.
However, the icon  to the right of it will open the version in the current document window. (Warning:
This will overwrite the currently open document with an older version.)

If you click on the small black arrow of the Versions icon and select the entry File versions in the
dropdown menu, you will also reach the version manager which will provide you with additional details for
a better overview. For more information, see the following steps 3. and 4.

3. Version manager: The program displays a dialog box that lists all available backups for the current
document. Use the dates and times to find and select the version that you want to restore. You can use the
Preview button to display a preview of the selected version.

The version manager list shows that a backup for the file Test.prdx might be called
Test.prdx.135.prbak, for example. Thus, a consecutive number and the extension .prbak are always
appended to the file name (and an "s" is also inserted into the consecutive number for snapshots).

4. If you click on the Restore button, the selected previous version of the document will be restored in the
current window.

Warning: The currently open document is now replaced by the selected previous version. So if you save it
now, you're overwriting the current version with an older version!

Alternatively, you can also click on the Open as copy button. This opens the selected file version in a new
document window (instead of replacing the document in the current window). This is useful if you want to
compare the current version with an older version.

What should I do if I lose the original file?

The aforementioned procedure only works if the original document is still available. What should you do if the
original file has been lost, for example, because it was accidentally deleted?

Even in this case, you can still access the backup copies of this document (unless they have also been deleted).
Simply open the backup copy itself.

You can see where the backups are in the dialog box of File | Options . On the Backup tab, the file path is
displayed below in the Folder for file versions field. By default, this is a folder called Backup within the
SoftMaker folder.

When you choose a backup from this folder in your file browser, Presentations immediately starts to open the
file. The procedure is as follows:
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1. In your file browser (for example, Windows Explorer), navigate to the Backup folder.

2. In this folder, search for files whose name starts with the name of the original file. A backup for the file
Test.prdx might be called Test.prdx.135.prbak, for example. Thus, a consecutive number and the
extension .prbak are always appended to the file name (and an "s" is also inserted into the consecutive
number for snapshots).

Tip: The higher the consecutive number in the file name, the more recent the file version.

3. In the file browser, double-click on the file version that you want to open.

4. Presentations detects that you are trying to open a backup and asks you what you would like to do now. It
displays a dialog box with the following options:

Open the backup file: This option opens the selected file version.

Invoke the version manager: This option opens the version manager like the command File | group File
management | Versions. This then offers all available earlier versions of the original document for
selection. For more information on using this command, see above.

Open the original file: This option opens the original file for this file backup. (Of course, this only works if the
original file still exists.)

5. Make your choice, and then click on OK.

Once again, please note that Presentations automatically creates and manages the files in the Backup folder.
Thus, you should not make any manual changes to these files, such as renaming or moving the files.

If you need more space on the disk, you can delete all files in this folder at any time, but then you will lose all
file backups as a result.
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Document protection
You can protect your documents from being read or saved by unauthorized persons by applying document
protection – or more specifically, read and/or write protection. For example, you can require the entry of a
password to open or save a protected document.

To protect a document, choose the ribbon command File | Properties, switch to the Protection tab in the
dialog box and select the type of document protection. Also enter the desired read and/or write password.

The following types of protection are available:

§ No protection (this is the default setting whereby the document is not protected) 

§ Write protection (the document can be opened, but saving is only possible with the password)

§ Read protection (the document can be opened only with the password)

§ Protection depending on password (a combination of read and write protection)

For more information on enabling and disabling document protection, see the following pages.

Enabling document protection
You can protect your documents from being read or saved by unauthorized persons by applying document
protection – or more specifically, read and/or write protection. For example, you can require the entry of a
password to open or save a protected document.

Read protection also encrypts the document so that it cannot be viewed with programs other than Presentations.

To protect a document, proceed as follows:

1. Choose the ribbon command File | group File management | Properties .

2. Switch to the Protection tab.

3. Select the desired type of document protection (see below).

4. Enter the read and/or write password (between 4 and 15 characters).

Important: If you forget a password, you can no longer open or save the document. It is thus advisable to
make a note of the password. Pay close attention to uppercase/lowercase!

5. Confirm with OK.

6. The program displays a dialog box in which you are required to verify the read and/or write password by re-
entering it.

7. Confirm with OK.
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8. Exit the dialog box with OK.

9. Save the document in order for the changes to take effect.

From now on, anyone who attempts to open this document will be asked automatically for the password. If the
correct password is entered, the protection is temporarily overridden.

Types of document protection

You can choose between the following types of document protection in the above dialog box:

§ No protection 

The document is not protected. This is the default setting.

§ Write protection 

When the document is opened, the user is prompted to enter the write password. The document can only be
saved if the correct write password has been entered here.

However, it is still possible to open the document as read-only, even if the user does not have the password.
However, it cannot be saved – not even under a different name.

§ Read protection 

If you try to open the document, you are prompted to enter the read password. If you enter an incorrect
password, you will not be able to open the document.

The document is saved in an encrypted form so that it cannot be viewed with programs other than
Presentations.

§ Protection depending on password 

Here, two dialog boxes prompting for a password appear in succession when the document is opened. The
first dialog box asks for the read password, while the second one asks for the write password.

If the user enters the read password, he is permitted to open the document but not to save it.

If he also enters the write password, he has full access and can thus save the document.

If you enter an incorrect password or nothing at all, access to the document is completely denied.

Encryption method: "Most compatible" or "Most secure"?

For documents with Read protection or Protection depending on password, you can also select the desired
Encryption method.

Note: This setting primarily affects newly created documents. When you open an existing encrypted
document, the encryption method used in it is automatically determined and this option is set accordingly.

Choosing an encryption method is especially important for documents in Microsoft PowerPoint file format (.ppt
and .pptx). Some old versions of Microsoft Office may not be able to open documents encrypted with the new
"Most secure" encryption method.

Available options:
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§ Most compatible 

When you save the document, an old encryption method is used that can be read by all versions of Microsoft
Office. However, this method is less secure than the other method.

§ Most secure 

Here, a more modern and more secure encryption method is used. However, some old versions of Microsoft
Office may not be able to read documents encrypted with this method.

Detailed information about the currently selected encryption method is displayed at the bottom of the dialog
box.

Disabling document protection
When you succeed in opening a read-protected or write-protected document by entering the correct password,
protection is disabled – but only temporarily. If you close this document, the protection will be enabled again;
the next time you open it, the password prompt will appear again.

To permanently remove the protection on a document, proceed as follows:

1. Open the document.

2. Choose ribbon command File | group File management | Properties .

3. Switch to the Protection tab.

4. Select the option No protection.

5. Confirm with OK.

6. Save the document in order for the change to take effect.

Document protection is now permanently disabled.

The next time someone opens the document, no password prompt will appear. All users can now open and save
it.
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Working with other file formats
Presentations normally saves documents in its "in-house" file format called Presentations document.
Presentations documents can be recognized easily by the name extension .prdx. If, for example, you save a
document under the name "Company Profile", its complete file name will be Company Profile.prdx.

You can also instruct Presentations to save files in another file format. This is necessary, for example, if you
want to edit a Presentations document with another program. You can also open documents in Presentations,
which have been created with other programs.

Note: In addition, you can export presentations as PDF files, HTML files, picture files or as a movie. For
more information, see Outputting presentations.

This section provides information on saving and opening documents in another file format.

Saving a document in another file format

To save the current document in another file format, choose the ribbon command File | Save as and open the
dropdown list Save as type. Select the desired format, enter a different file name if required and confirm
saving.

Opening a document in another file format

To open a document in another file format, use the ribbon command File | Open (click directly on the icon
itself) to open the file dialog box, open the dropdown list of file types and select the format in which the file is
available. Then select the file you want to open and confirm that it is open.

Supported file formats

In the dialog boxes for opening and saving documents, the list of file types includes the following file formats:

§ Presentations document 

This is the in-house format for Presentations documents in which you usually save documents (name
extension: .prdx).

§ Presentations slide show 

This is generally the same as a Presentations document (name extension: .prsx).

The difference: When you double-click such a file in Windows Explorer, Presentations opens the file, starts
running it automatically, and then closes the document again. (Also see notes below.)

§ Presentations template 

This is the document template for Presentations documents (name extension:.prvx).
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§ PowerPoint document 

You can also open and save documents in Microsoft PowerPoint file format. The program supports .ppt files
(PowerPoint 97 to 2003) as well as .pptx files (PowerPoint 2007 or higher).

§ PowerPoint template 

This is the document template for Microsoft PowerPoint documents.

§ PowerPoint slide show 

This is generally the same as a PowerPoint document. If you double-click on such a file in Windows
Explorer, however, Microsoft PowerPoint will open the file (or Presentations, depending on the setting),
automatically start running the slide show, and then close the document again.

§ Presentations 2016 document 

Documents are saved in the file format of Presentations 2016, an older version of Presentations (name
extension: .prd).

§ Rich Text Format 

Outline of a presentation in Rich Text Format (RTF). This format can be used to export the outline of a
presentation to a document in RTF format or to import the outline from such a document.

Notes on the "Presentations slide show" file format

As mentioned above, the Presentations slide show format is identical to the Presentations document format –
except for the following special feature:

§ If you open a Presentations slide show (.prsx) in Presentations with the command File | Open, it behaves
like a normal document. 

§ If you double-click on such a file in Windows Explorer, however, Presentations will open this file,
automatically start running the slide show, and then close the document again.

If Presentations is not already running at this time, it will start automatically, run the slide show, and then
end again.

To create such a file that starts automatically, simply open any Presentations document and save it in the
Presentations slide show file format. To do so, choose the command File | Save as and select the entry
Presentations slide show from the list of file types.
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Working with multiple documents

Android/iOS: This function is not available for smartphones. For tablets, multiple documents can be opened
in the same program window.

You can have multiple documents open at any time – to compare them, edit them at the same time, exchange
data between them, etc.

You work with multiple documents as follows:

§ Opening multiple documents in the same program window 

You can open any number of documents at the same time in the current program window.

There are many ways to switch between these documents, including a bar that contains tabs for each
currently open document (displayed above the current document):

FreeOffice: The functions for working with document tabs are not included in SoftMaker FreeOffice.
However, you can open documents in different program windows.

 

§ Opening files in a new program window 

You can also open documents in a new program window.

To do so, select the option New program window in the dialog box of the command File | New or of the
command File | Open when you create/open the document.

Note: To open the dialog box of the commands File | New or File | Open, click directly on their actual
icons and not on their small arrow.

The methods can be combined as desired. You can open as many program windows as you like and open any
number of documents as tabs in each of these windows. You can also open all documents in just one program
window. Alternatively, you can ensure that each document appears in its own program window. It is entirely
your choice.

In this chapter, you will learn everything you need to know about working with multiple documents at the same
time. For more information, see the following pages.
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Creating or opening a document
To create a new document or to open a document, proceed as follows:

§ To create a new document, choose the ribbon command File | New . 

Note: The option "New program window" (see below) can only be accessed via the dialog box: To do so,
click on the icon itself. If you click on the small arrow of the icon, however, the slide designs used so far are
displayed for quick access.

§ To open an existing document, use the ribbon command File | Open .

Note: The option "New program window" (see below) can only be accessed via the dialog box: To do so,
click on the icon itself. If you click on the small arrow of the icon, however, you can choose from the most
recently opened files.

These two commands New and Open are described in detail in File operations.

Option "New program window"

The option New program window in the dialog box of these two commands has the following significance:
When it is enabled, the document appears in a new program window. If it is disabled, the document will be
opened with a new tab in the existing program window.

This setting is also saved and is applied each time a document is opened, both when new documents are created
and when existing documents are opened.

(Note: In the Android/iOS version for smartphones and in SoftMaker FreeOffice, a separate program window is
always opened, while in the version for tablets, a new tab is always opened in the same program window.)

Switching between open documents

Android/iOS: This function is not available for smartphones. For tablets, you can switch between
documents within the program window.

If you have multiple documents open at the same time, you can switch to a specific document and thus make it
the active document:

§ Ribbon interface: "Windows" icon 

In the ribbon, you will find an icon called Windows  on the ribbon tab View. If you click on it, a list of
all open documents appears. Click on the desired document.

§ Classic menu interface: "Window" menu item 

For classic menus, you will find a list of all currently open documents in the Window menu. Select the entry
for the document to which you want to switch.
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§ Toolbar interface (Android/iOS only): "Window" menu item 

You will find a list of all currently open documents for tablets via the hamburger menu  in the Window
menu. Select the entry for the document to which you want to switch.

§ Mouse: Clicking on a document tab 

Above the document, you will find a bar with tabs for all currently open documents. Click on the tab for the
document to which you want to switch.

FreeOffice: The functions for working with document tabs are not included in SoftMaker FreeOffice.
However, you can open documents in different program windows.

 

§ Mouse: Clicking into the program window containing the document 

Of course, if you have documents open in multiple program windows (see previous section), you can also
simply click into the program window with the desired document to make this document the active
document.

§ Keyboard: Ctrl+F6 

You can also use the keyboard to switch between the currently open documents: Ctrl+F6 switches to the
next document and Ctrl+Shift+F6 switches to the previous one.

Mac: On a Mac, you have to use the key combinations Cmd+F6 or Cmd+Shift+F6 to switch between
documents.

Arranging documents on the screen

FreeOffice: The functions for working with document tabs are not included in SoftMaker FreeOffice.
However, you can open documents in different program windows.

Android/iOS: This function is not available for smartphones. For tablets, document tabs can be moved
within the program window.

If you have multiple documents open, you can arrange them as follows:

§ The document tabs (the tabs in the bar above the document) can be moved within the bar and thus arranged
in any order. 

You can even drag a document tab out of the program window with the mouse in order to have a separate
program window for this document.

Alternatively, you can drag a document tab from one program window to another. The document will then
be integrated into the tab bar of the other program window.
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§ If documents are open in different program windows, you can move the individual windows manually and
resize them, of course – just as you can with all types of program windows.

§ If you choose the ribbon command View | Windows  | View side by side (in the classic menus interface:
Window > View side by side), you can display the current document side by side with another open
document on the screen. If more than two documents are currently open, the program first asks which of
them is to be used in the other window.
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Closing a document

Android/iOS: Not all of the listed methods are available in these versions.

If you want to stop working on a document, you can close it at any time. If the document has been modified
since it was last saved, the program automatically asks you if you want to save the document first.

To close a file, you have the following options:

In the ribbon interface

The ribbon tab File contains a Close icon  which closes the current document. 

Tip: Use the ribbon command View | Windows  | Close all to close all currently open documents at once.

In the classic menu interface

Choose the menu command File > Close to close the current document.

Tip: Use the menu command Window > Close all to close all currently open documents at once.

In the toolbar interface (Android/iOS only)

In the group File , choose the command Close .

Tip: For tablets, you can close all currently open documents at once via the hamburger menu  by choosing
the menu command Window > Close all.

Tabs for documents

FreeOffice: Document tabs are not included in SoftMaker FreeOffice.

Above the document, you will find a bar with tabs for all currently open documents. If you click on one of these
tabs with the middle mouse button, the corresponding document is closed.

Alternatively, left-click on the x icon displayed on the far right of each tab to close it.

Furthermore: If you right-click on a tab, a small menu appears with commands for closing the current document
(Close tab) or all other open documents (Close all other tabs).

Via the keyboard

You can also use the shortcut key Ctrl+F4 or alternatively Ctrl+W to close the current document.
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Mac: On a Mac, you have to use the key combination Cmd+F4 or Cmd+W for this purpose.
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Customizing Presentations
Presentations lets you determine a variety of program settings so that you can customize the program to suit
your personal work style.

In this chapter, you will learn everything you need to know about it. It is divided into the following sections:

§ Changing Presentations settings 

You can use the ribbon command File | Options to change the program settings. These settings apply to the
program as a whole and thus to all documents.

§ Changing document properties 

The document properties, on the other hand, are settings that only affect the current document and are also
saved in this document. They can be changed with the command File | Properties.

§ Customizing the document display 

This section describes how to customize the appearance of the document on the screen. Most of the required
commands can be found on the ribbon tab View.

§ Customizing the ribbon 

Only for "Ribbon": This section is relevant only for users who have selected in the settings that they want
to operate the program with the "ribbon".

Here, you will learn how to configure and customize the ribbon.

§ Customizing toolbars 

Only for "Classic menus with toolbars": This section is relevant only for users who have selected in the
settings that they would prefer to operate the program with "Classic menus with toolbars".

Here, you will learn how to configure the toolbars (Standard toolbar, Formatting toolbar, etc.) with the menu
command View > Toolbars and how to customize them to your liking with Tools > Customize.

§ Creating user-defined icons 

You can create user-defined icons at any time and add them to the ribbon or to a toolbar. Such icons can be
used to start any program.

§ Customizing shortcut keys 

You can also customize the shortcut keys for choosing frequently used commands. The ribbon command
File | Customize is responsible for this purpose.

§ Using the grid and Using guides 

Grid and guides are positioning aids for moving objects with your mouse. They can be enabled and
configured with the ribbon command View | Grid and guides.

§ Installing additional dictionaries 

In this section, you will learn how to install additional dictionaries (such as Hunspell) if required.

For more information on the above topics, see the following pages.



347Customizing Presentations

Changing Presentations settings

General settings can be changed with the ribbon command File | Options . These settings apply to all
documents.

The options in the dialog box of this command are distributed by topic across multiple tabs. If you click on the
Files tab, for example, you can make settings for opening and saving files.

The following pages contain detailed information on all available settings.

Settings, View tab

On the View tab in the dialog box of the ribbon command File | Options , you can make settings for the
appearance of documents on the screen:

"Editing mode" section

Here, you can specify how slides should be displayed when you edit them.

§ Show scrollbars 

Here, you can select whether to display a horizontal and vertical scrollbar for slides.

§ Show rulers 

Presentations displays two rulers (one vertical and one horizontal) for slides by default. If you want to hide
the rulers, disable this option.

Note: This option can also be found directly on the ribbon tab View | Ruler 

§ Show object boundaries 

By default, Presentations displays dashed lines around objects on a slide (for example, when inserting text
frames) if the objects are not already sufficiently highlighted by their own border lines or fill colors. These
dashed lines are only intended to reflect the position and size of the object on the screen; they will not be
printed. If you want to hide these lines, disable this option.

Note: This option can also be found directly on the ribbon tab View | Object boundaries 

§ Show unprintable characters 

If this option is enabled, tabs and manual line breaks will be indicated as symbols on the slides. These are
only displayed on the screen; they will be neither printed nor displayed during the slide show.

Note: This option can also be found directly on the ribbon tab View | Unprintable characters 
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§ Show formatted text in outline view 

If this option is enabled, Presentations displays text with its actual formatting (font and font size) in the
outline view and the mini outliner.

§ Color mode 

Here, you can specify how colors are displayed in slides on the screen. The original colors are displayed
with the default option "Colors". If you select "Grayscale" or "Black and white", the colors are reduced to
shades of gray or just black and white.

Note: This option can also be found directly on the ribbon tab View | Color mode 

"Full-screen show mode" section

Here, you can specify on which display and in which resolution slide shows should be displayed when they are
run in full-screen mode:

§ Display 

If you have two displays connected to your device, you can specify here on which of them full-screen slide
shows are to be displayed.

This is useful, for example, if you have connected a projector to the secondary port of your graphics card
and want the slide show to be run on this projector rather than on the primary display.

Note: This option can also be found directly on the ribbon tab Slide show | Display.

Tip: We recommend that you select the setting Auto (which is also the default setting) here. This uses the
primary display by default when playing a slide show – as long as no second display is available. As soon
as you connect a second display and start the slide show again, Presentations automatically plays it on the
second display.

§ Use presenter view 

Here, you can enable or disable the Presenter view.

If two displays are connected to your device and you start a slide show, it is displayed by default in the
"Presenter view". This is a useful tool when running a slide show on a second display, for example, a
projector: If it is enabled, the audience sees the normal slide show, while the presenter himself sees useful
additional information on his own display – such as his notes on each slide.

For more information, see Using the presenter view.

§ Screen resolution 

Windows only: This option allows you to change the resolution in which slide shows are displayed when
run in full-screen mode.

You should usually select the default setting Use current resolution here. The resolution currently set in
your Windows system is then used for the output device.

If you want to use a different resolution for your slide shows, select it from the list.
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Settings, General tab

On the General tab in the dialog box of the ribbon command File | Options , you can make general settings:

Maximum number of undo steps

Here, you can set how many actions can be undone with the command Undo  (in the Quick access toolbar).
You can increase this number up to a maximum of 999 undo operations.

Note: On devices with little main memory, it is not recommended to increase this value.

User info

Here, you can enter your name and initials. This information will then appear, for example, in all comments that
you insert.

Show warning when loading OLE objects

Mac, Linux, Android/iOS only: If this option is enabled, the program displays a warning that OLE objects
cannot be displayed when you open a document containing such objects. (OLE objects can only be displayed on
Windows.)

Settings, Edit tab

On the Edit tab of the dialog box of the ribbon command File | Options , you can change settings for editing
text:

Capitalize first letter of sentences

If this option is enabled, Presentations automatically capitalizes the first letter of every sentence you type –
even if you accidentally enter a lowercase letter.

If, for example, you typed the sentence "this is a new sentence.", it would be corrected automatically to "This is
a new sentence.".

Correct first TWo UPpercase LEtters

If this option is enabled, Presentations automatically corrects the case of words whose first two letters have
been capitalized inadvertently.

If, for example, you typed the word "HEnry", it would be corrected automatically to "Henry".

Tip: If you would like to exclude certain expressions from this correction (for example, "BSc"), then simply define a SmartText entry for
this and enable the option Expand SmartText entries described below.
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Expand SmartText entries

As described in SmartText entries, you can use Presentations to create SmartText entries (for example, "sd" for
"sales department").

If this option is enabled, your SmartText entries can be directly expanded as the text is entered. To do so, you
simply have to type the abbreviation for the SmartText entry (for example, "sd") and then a space, Enter¿ or a
punctuation mark, and Presentations will automatically replace the abbreviation with the SmartText content.

If this option is disabled, however, SmartText entries can only be inserted via the dialog box of the ribbon
command Insert | group Text | SmartText.

Tip: The option "Expand SmartText entries" can also be enabled or disabled in this dialog box.

Smart quotes

Presentations can automatically convert double quotes (") and single quotes (') as they are typed to ensure that
they are typographically correct for the selected language. Here, set the desired language or select "None" if
you want Presentations to leave your quotes unchanged.

If, for example, you type "Text" or 'Text', the relevant setting will produce the following results:

Setting "Text" 'Text'

Auto*

None (no change) "Text" 'Text'

German „Text“ ‚Text‘

Swiss German »Text« ›Text‹

English “Text” ‘Text’

French** «Text» ‹Text›

Swedish ”Text” ’Text’

* A special position is assumed by the option Auto: If you select this option, Presentations automatically
determines the language (thus uses the language specified in the settings) and converts the quotes accordingly.

** For the single quote in the French setting, please note the following: the closing quote is first executed as an
apostrophe ('). If you press the single quote on the keyboard once again, it will be converted into the single
guillemet (›).

Tip: You can use the command Undo  (or the key combination Ctrl+Z) to convert smart quotes into
"neutral" quotes immediately after typing. The simple smart quote then becomes an apostrophe, while the
double smart quote becomes a normal double quote.

Automatically add spacing around punctuation marks (French only)

Enable the option to automatically add spaces both before punctuation marks : ; ! ? as well as between quotes «
text » ‹ text ›. This option is only effective if French is the default language in the following setting:

§ In the dialog box of the command File | Options, Language tab: French 
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Select whole words when selecting

Windows, Mac and Linux only: If this option is enabled, Presentations automatically extends any selection
that you make with the mouse to whole words. If it is not enabled, the selection is extended on a character-by-
character basis.

Add or remove spaces when pasting

If this option is enabled, spaces before and after words are automatically added or removed as required when
you delete, cut, or paste words from the clipboard.

If, for example, you select the word "is" in the sentence "This is a test" and cut it with the command Cut,
Presentations automatically deletes the space behind "is" that is now superfluous.

If you now insert the word "is" before another word using the command Paste, Presentations automatically
inserts a space after "is".

Middle mouse button

Mac and Linux only: Here, you can specify what should happen when you click somewhere using the middle
mouse button. Available options:

§ No function: The middle mouse button doesn't have any function. 

§ Paste selected content: If you click in the document with the middle mouse button, a copy of the currently
selected content is inserted at this point (for example, the currently selected text).

Apply character formatting to entire words

Enabling this option has the following effect:

If the text cursor is inside a word and you change the character formatting (for example, select a different font
or enable bold), this will affect the entire word.

This allows you to quickly change the formatting of a single word without first having to select it.

Format URLs as hyperlinks

If this option is enabled, URLs (web page addresses) are automatically formatted as hyperlinks immediately
after entering them.

If, for example, you type "www.softmaker.de" in the text, it will automatically be converted into a clickable
hyperlink and displayed accordingly (usually blue and underlined).

Ordinal numbers with superscript

This option only supports the following languages: English, French, Italian, Portuguese and Spanish.

In these languages, superscripts are usually added to abbreviated ordinal numbers – for example 1st, 2nd, 3rd in
the English language.
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If this option is enabled, superscripts are added automatically whenever you enter such a number. If, for
example, you type "2nd" in an English text and then press the space bar, it will be automatically reformatted as
"2nd" – the "nd" will be converted into a superscript.

Note: This only works if one of the supported languages is set (thus English in our example). For
information on how to change this setting, see Setting the language.

Use the insert key to control overwrite mode

This option is enabled by default and has the effect that you can toggle between Insert mode and Overwrite
mode with the Ins key (see also section Status bar).

If you remove the checkmark in front of this option, this typical function of the Ins key is disabled, when you
are working in Presentations. This prevents accidental switching to overwrite mode.

Insert frames and drawings immediately

This option determines what should happen if you insert a frame or a drawing into a document (text frame,
picture frame, AutoShape, etc.) – for example, with the ribbon command Insert | Text frame:

§ Always: The corresponding object is inserted immediately. Its position and size are fixed without further
action. 

(Of course, you can always change the object's position after insertion by simply dragging it to the desired
location with the mouse. You can also resize it by dragging one of the round handles that surround the
object.)

§ Never: Before the object is actually inserted, the mouse cursor changes to a crosshair. In order to proceed,
drag a rectangle in the document to specify the desired position and size. The object will then be inserted
exactly according to your specifications. 

§ Auto: This is a smart combination of the two aforementioned options that is already preset in Presentations
for each specific object type. Objects such as charts or tables are inserted directly (as with Always), for
example, while objects such as AutoShapes or text frames are inserted via the mouse cursor (as with Never).
 

Use left Alt as shortcut key

Mac only: This option determines which function the left Alt key on your keyboard should have:

§ Off: The left Alt key does the same as the right Alt key: It inserts icons into the text. 

Alt+E, for example, returns a euro sign €.

§ On: The left Alt key can be used to open menus in the classic menu. 

Note: This only works if you use the program with the classic menu interface instead of the ribbon interface.

Here, Alt+E no longer returns a euro sign, but opens the Edit menu instead.
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Settings, Appearance tab

On the Appearance tab in the dialog box of the ribbon command File | Options , you can make settings that
affect the appearance of the Presentations user interface:

Dialog language

Here, you can select the language in which the user interface (ribbon, menus, dialog boxes, etc.) is to be
displayed.

User interface

If you click on the User interface button, the program displays a dialog box in which you can select the type of
user interface that the SoftMaker Office applications should use:

§ Ribbon (top row) 

If you select one of the styles from the top row, the programs use a "ribbon" as the user interface. The
differences between the individual styles are only in the color scheme used.

§ Classic menus with toolbars (bottom row) 

If you select one of the styles from the bottom row, the programs will use classic menus with toolbars. You
can also choose between different color variants here.

In the dialog box, you can also make the following settings:

§ Quick access toolbar (only in the ribbon interface) 

Use this option to determine where the Quick access toolbar, which contains icons for some of the most
frequently used commands, should be displayed: to the left of the tabs for the currently open documents or
in a separate toolbar directly below the ribbon.

§ Touch mode 

If you enable this option, all icons in the ribbon user interface or menu interface and toolbars will be slightly
enlarged. This is useful when operating the software with your finger (for example, on a tablet).

Tip: Alternatively, you can also enable/disable touch mode with the following commands:

Ribbon user interface: Here, you choose the command Touch mode  in the Quick access toolbar.

Classic menu interface: Here, you choose the command View > Touch mode.

Android/iOS: If you are using these versions, select the user interface via the dropdown list. Here, you
have an additional option: Toolbars. For more information, see User interface on Android/iOS. The options
Quick access toolbar and Touch mode can be found separately elsewhere on this Appearance tab and work
as described above.
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Prefer using larger controls

Windows only: This option is important when using 4k monitors. If the program's icons appear too small on
your screen (caused by a higher monitor scaling), enabling this option will enlarge the icons appropriately.

Show status bar in ribbon mode

This applies only to the ribbon interface: You can enable/disable the display of the status bar here. To change
this for the classic menu interface, see Showing and hiding toolbars.

Show fonts in font list

If this option is enabled, Presentations displays all font names in the respective font in font lists (for example, in
the font list of the command group Home | Character in the ribbon or in the Formatting toolbar in the classic
menu interface). This lets you see the actual appearance of each font at a glance.

Show tooltips

This option lets you specify whether or not tooltips should be displayed. These are short info texts that are
displayed next to the mouse cursor when you hover over a screen element (for example, a button in the ribbon
or in the Standard toolbar for the classic menu interface).

Beep on errors

If this option is enabled, Presentations emits a beep for error or warning messages.

Live preview

FreeOffice: The live preview is not included in SoftMaker FreeOffice.

Here, you can enable/disable a live preview for the dropdown lists that are located, for example, in the
command group Home | Character.

If this is enabled, for example, you can select text, open the font list in the command group Home | Character
and then hover over the fonts in it. The document immediately shows how the selected text would look "live" in
the corresponding font.

To actually apply the font, simply click on it. To discard the change, click anywhere outside the font list or
press the Esc key.

Use system menus

Mac only: This option determines whether or not the program should display its main menu in the menu bar at
the very top of the screen (as is customary for Mac applications).

Depending on the type of user interface you have selected ("Ribbon" or "Classic menus with toolbars"), this
option has the following effect:

§ Disabled: The main menu is not displayed in the menu bar at the top of the screen. 
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Details:

Ribbon: If you have selected the "ribbon" user interface, only the "hamburger menu" (the icon  in the
Quick access toolbar) is now available to you if you still want to access the classic main menu.

Classic menus: In the case of the classic user interface, the main menu is no longer displayed at the top
of the screen, but in its own bar (below the title bar).

§ Enabled: The main menu is displayed in the menu bar at the top of the screen. 

Details:

Ribbon: Ribbon users now not only have access to the ribbon user interface, but they can also use classic
menus in the menu bar.

Classic menus: The main menu is now displayed in the menu bar at the top of the screen – and not in its
own bar below the title bar.

Use system file dialogs

This option controls the type of dialog boxes that appear when you use commands for opening and saving files.
The options are:

§ Disabled: Presentations uses its own file dialogs. 

§ Enabled: The default file dialogs of the operating system appear, which you know from the majority of
applications.

The former are easier to use; the latter offer more options.

(In the iOS version, the operating system file dialogs are always used automatically.)

Smooth edges of screen fonts

If this option is enabled, Presentations uses a technology called "anti-aliasing" to smooth the edges of fonts and
thus improve their appearance on the screen.

Different options are available depending on the operating system.

Workspace color

This option allows you to change the background color of document windows.

User interface size

Mac, Linux, Android/iOS only: This button opens a dialog box that allows you to reduce or enlarge the user
interface (menu, toolbars, dialog boxes, etc.).

If you select a lower setting here, all user interface elements will be reduced, which will allow you to see more
elements at a time. A higher setting, on the other hand, increases legibility.

The option Size of dialog elements changes the size of the user interface in large steps. The option Font size
adjustment also allows some fine-tuning in smaller steps.
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The Sample field acts as a small tool to help you find a suitable setting: It gives you a preview of how a
checkbox in a dialog box will look after you have applied your changes.

Note: Inappropriate settings may cause the user interface to be far too small or too large, especially on
devices with a relatively low resolution. If this happens, you can always click on the Reset to default button
in the lower left of this dialog box to return to the default settings.

Document scaling (DPI)

Mac, Linux, Android/iOS only: You can scale the document higher or lower for a larger/smaller view. To do
so, select Custom and enter the desired value.

Unit of measure

Mac, Linux, Android/iOS only: Here, you can specify the units of measure which Presentations should use by
default: Metric (centimeter) or U.S. (inch).

(On Windows, this option is not required because the program automatically uses the setting that was selected
in the options "Region and Language" of the Windows Control Panel.)

Tip: You can always override this setting and enter a value into dialog boxes in another unit of measure by
typing one of the following unit of measures after the value:

Unit Explanation

cm Centimeter

in Inch – 1 in equals 2.54 cm.

pt Point – 72 pt equal 1 in.

pi Pica (character) – 1 pi equals 12 pt

If, for example, you type "5.08 cm" for the left margin, Presentations sets it to 2 inches (5.08 cm).

Tablet mode

Android/iOS only: If you are using a tablet, you should enable this option to optimize the display of the
application. If you are using the application on your smartphone, leave this option disabled.

Use ribbon animations

Android/iOS only: The command groups of the ribbon tabs can be collapsed and expanded when you tap on
them with your finger (only in ribbon mode). If you enable this option, expanding and collapsing will be
performed in animated mode.
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Settings, Language tab

On the Language tab in the dialog box of the ribbon command File | Options , you can make settings for
Presentations' language tools:

Default language

Here, you can select the language to be used for spell check, hyphenation and the thesaurus. To do so, open the
dropdown list and select the desired language from the available options.

Note: Please note that there are two entries in this list for German:

§ "German (Germany)" stands for the new spelling (according to the 1996 German spelling reform in its last
revision in 2006). 

§ "German (Germany, old)", on the other hand, stands for the old spelling.

The same applies to "German (Austria)" and "German (Switzerland)".

Spell check

Here, you can specify whether Presentations should automatically check the spelling of text. The following
settings are available:

§ Check spelling as you type 

If you enable this option, the spelling of the entire document will be continuously checked in the
background. Incorrectly spelled words are indicated with wavy red underlines and can be corrected at any
time. For more information, see Checking the spelling as you type.

Note: If this option is disabled, you don't have to do without a spell check – you can always start it manually
with the ribbon command Slide show | Spell check. For more information, see Manual spell check.

§ Color 

Here, you can change the color of the red underlines used by the function "Check spelling as you type" to
indicate misspelled words.

§ Underline old German spellings in blue 

If this option is enabled, the function Check spelling as you type also underlines with a blue wavy line all
words that correspond to the old German spelling but should be spelled differently according to the new
spelling of the spelling reform of 1996. For more information, see also Conversion to the new German
spelling.

Note: This option only works for text in the language "German (Germany)", "German (Austria)" or
"German (Switzerland)".

§ Ignore words that start with a number 

If you enable this option, the spell check ignores all words that start with a number (for example, "1980s").
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§ Hunspell dictionaries 

FreeOffice: SoftMaker FreeOffice does not include the premium SoftMaker dictionaries normally
shipped with SoftMaker Office. Only Hunspell dictionaries can be used here.

Only Hunspell dictionaries for English and German are already installed. If you need more languages, see
Installing Hunspell dictionaries.

As an alternative to its own dictionaries, SoftMaker Office also supports the use of Hunspell dictionaries.
These dictionaries are available as free downloads. Most of them were created by private users or non-profit
organizations.

The Hunspell dictionaries button allows you to install downloaded Hunspell dictionaries and also set the
languages for which Hunspell dictionaries are to be used. For more information, see Installing additional
dictionaries.

Settings, Files tab

On the Files tab in the dialog box of the ribbon command File | Options , you can make settings for opening
and saving files:

Template folder

Here, you can specify the folder in which the templates for new Presentations documents are stored.

The dialog box that appears when you choose the ribbon command File | New to let you select a Presentations
template displays all templates that are in this folder.

Note: Normally, this setting should not be changed. Change it only in the event that you have actually moved
the template folder to another place.

Bullets folder

Here, you can specify the folder in which the bullets for Presentations are stored.

Note: Normally, this setting should not be changed. Change it only in the event that you have actually moved
the bullets folder to another place.

Default file format

Here, you can select the file format in which Presentations should save newly created documents by default.

If you create a new document with the ribbon command File | New and then save it for the first time, the Save
dialog box always suggests the file format set here as default.
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You can choose between the Presentations format, several versions of the Microsoft PowerPoint format and the
RTF format.

Saving section

In the Saving section, you can make settings for saving documents:

§ Prompt for summary information when saving 

If you enable this option, a dialog box will appear automatically the first time you save a new document to
enable you to enter some additional information about it. For more information, see Document summary.

Opening section

In the Opening section, you can make settings for opening documents:

§ Recently used files in File menu 

If you click on the small arrow on the ribbon command File | Open , Presentations displays a list of the
most recently opened files. If you select one of these entries, the corresponding file will be opened
immediately. Here, you can specify the number of files to be displayed in the list.

SoftMaker FreeOffice only: Backup section

SoftMaker FreeOffice does not contain a "Backup" tab and its settings, which are described in the next section.
Instead, you have to choose either No backup or Simple backup in the dropdown list on the "Files" tab.

§ No backup 

If you select this option, no backups will be created when documents are saved. (This option is not
recommended.)

§ Simple backup 

This makes one backup per document. It contains the previous version of the document. It has the name
extension .bak and is in the same folder as the document itself.

In SoftMaker FreeOffice there is also the following option for the above Opening section:

§ Auto recovery: Save state every ... minutes 

When this option is enabled, Presentations automatically makes a temporary backup copy of every open
document on a periodic basis. You can enter a period of 1 to 100 minutes.

Note: These temporary backup copies work completely independently of the Simple/No backup copies
option described above.

When you exit Presentations in the normal manner, these temporary backup copies are automatically
deleted. However, if Presentations is abruptly shut down by a power failure, for example, while you are
working on open documents, these copies become available when the program is restarted. Presentations
recognizes that there has been a failure and offers to open the automatic backup copies of all documents that
had been modified but not saved just prior to the failure.
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You can then check each of the restored documents to determine if any of the most recently made changes
have actually been lost, and then save them.

Settings, Backup tab

FreeOffice: This tab is not included in SoftMaker FreeOffice. However, simple backups can be made here.
This setting can be found on the Files tab.

On the Backup tab in the dialog box of the ribbon command File | Options , you can make settings for
creating backup copies:

"When you save a file manually..." section

§ Keep older versions of the document (if you save a file manually) 

Several generations of file backups are created for each document. All of these copies are stored in a special
Backup folder.

Tip: If this option is enabled, the command File | Versions  (in the group File management) is also
available, which allows you to easily return to a previous file version of the currently open document.

§ Number of versions to keep 

Here, you specify the maximum number of backups (generations) to be kept per document.

"Automatically created file versions (snapshots)" section

§ Save unsaved changes every ... minutes 

If you want automatic "snapshots" to be created as an additional backup while the document is being edited,
enable the checkbox here. In the dropdown field to the right, you specify the interval at which the snapshots
are to be taken regularly.

§ Number of snapshots to keep

In this dropdown field, you specify the maximum number of snapshots you want to keep.

Folder for file versions

Here, you can change the path for the Backup folder in which all backups are stored.

"Clean up" button

This button provides the following two commands for deleting backups:

§ Delete orphaned file versions 

This option removes all file backups where the corresponding original document no longer exists.
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§ Delete file versions of all documents 

This option removes all file backups in the folder for file versions.

For more information on using file backups, see Backup copies (file versions).

Settings, System tab

On the System tab in the dialog box of the ribbon command File | Options , you can make the following
system settings:

Smooth edges of pictures

If this option is enabled, Presentations uses anti-aliasing to smooth edges and lines in pictures. Advantage: The
display quality of scaled pictures is improved. Disadvantage: This procedure consumes some CPU time when
displaying pictures, of course.

Enable OpenGL AutoShapes

If this option is enabled, Presentations uses the OpenGL graphics engine to display AutoShapes optimally. If
you disable this option, 3D effects used for AutoShapes may no longer be displayed correctly. Thus, you should
usually leave this option enabled.

Enable OpenGL animations and transitions

If this option is enabled, the program uses the OpenGL graphics engine in order to speed up the display of
animations and slide transitions. Apart from that, it allows Presentations to offer some additional, particularly
impressive animations and transitions (which can be found in the "SoftMaker…" category in the relevant dialog
boxes).

Note: On systems with a very outdated or faulty OpenGL installation, display errors may occur when playing
animations and slide transitions. This depends on your individual system configuration and especially on the
graphics driver you are using. In this case, disable this option and restart the application.

However, the slide transitions and object animations from the "SoftMaker..." category can then no longer be
displayed. A simple fade effect is shown instead.

Check for updates

Windows, Mac and Linux only: Here, you can specify how often you want the software to check whether
there are updates for SoftMaker Office. Updates provide bug fixes and feature improvements.

Note: Checking for updates only works if your device can access the Internet.

You can also disable the automatic update check (not recommended) by selecting Never from the dropdown
list. Checking for updates can then only be done manually (by clicking on the Check now button).
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Tip: Subscribe to our free newsletter at www.softmaker.com to automatically receive an e-mail whenever
updates are available. The newsletter will also provide you with other useful information and special offers
with respect to SoftMaker Office on a regular basis.

Android/iOS: For applications installed from the Google Play/Apple App Store, your device will automatically
notify you of updates (unless disabled in the Play Store settings).

Associate file types

Windows only: This button opens a dialog box where you can associate certain file types with Presentations.
This will make Presentations the default application for the corresponding file types.

If, for example, you associate the file type "Microsoft PowerPoint documents" with Presentations, files of this
type will always be opened in Presentations when you double-click on such a file in Windows Explorer.

Show/hide keyboard automatically

Android/iOS only: If this option is enabled, the on-screen keyboard opens automatically when you can type
something (for example, if you click into a placeholder or click into an input field in a dialog box).

Change keyboard layout automatically

Android/iOS only: If this option is enabled, the layout of the on-screen keyboard will automatically adapt to
the current situation. If, for example, you type into an input field in a dialog box which only accepts numbers,
the keyboard will automatically be switched to numeric mode.

Use OpenGL engine

Linux only: If this option is enabled, the program uses the OpenGL graphics engine. This speeds up the screen
display. Thus, this option should usually be enabled.

Note: On systems with a very outdated or faulty OpenGL installation, display errors may occur within the
application. This depends on your individual system configuration and especially on the graphics driver you are
using. In this case, disable this option and restart the application.

Furthermore: If the program detects problems with the installed OpenGL engine at startup, it will automatically
disable this option.

Use SHM extensions

Linux only: This option is only available if the option Use OpenGL engine is disabled (not recommended).

If the SHM extensions are enabled, the program uses shared memory (if available), which can speed up the
responsiveness of the display.

Use XIM

Linux only: If this option is enabled, Presentations supports the composition of accented characters (à, ô, é,
etc.) using "XIM".

http://www.softmaker.com/
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On a German keyboard, for example, the character "ô" can be created by first pressing the ^ key and then the O
key.

If you disable this option, you can no longer compose characters in this way.

Note: On some systems, disabling this option improves the responsiveness of the display when you are typing
text quickly.

Show hidden files and folders

Mac, Linux only: If this option is enabled, hidden files and folders are also displayed in file dialogs (for
example, those of the ribbon command File | Open).

Mouse wheel

Mac, Linux only: If your mouse has a mouse wheel, you can set the scrolling increment for a turn of the wheel
either by page (one complete page) or by a certain number of lines.

External applications

Mac, Linux only: This button opens a dialog box where you can specify the external programs that start
automatically for specific events. When a PDF file is created, for example, the application specified in the PDF
viewer field will be launched to display the result.

Note: You don't have to fill in these fields. For all fields that you leave empty, your system's default application
will be automatically used for this action. Make changes to this dialog box only if you want an application other
than the default application to be used. To do so, simply enter the file name of the corresponding executable file
(including the entire file path, if necessary).

User-defined font paths

Mac, Linux, Android/iOS only: Here, you can specify paths for additional fonts that Presentations should use.
To do so, enter the subdirectory in which the font files are located. If you want to enter multiple directories,
separate them with a colon.

Presentations can then use these fonts in addition to the fonts available in your system.

Note: Changes to this setting only become effective after the program is restarted.

Settings, Fonts tab

On the Fonts tab in the dialog box of the ribbon command File | Options , you can specify which fonts are
to be displayed in font lists (for example, the font list on the ribbon command Home | group Character).

The tab presents a list of all fonts installed on your system. To enable or disable a font in the list, click on the
checkbox in front of its name. All fonts for which you have removed the check mark are no longer displayed in
font lists.
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Background information: The fonts installed on your system by default include several fonts that you will
probably never need – for example, fonts that only contain scripts for foreign languages that you don't use. If
you like, you can hide such fonts as described above.

Use font filtering of the operating system

Windows only: Windows users will also find the option Use font filtering of the operating system on this
tab. If this option is enabled, Windows will automatically hide all fonts that only contain scripts for foreign
languages in font lists.

"Manage" button

In the dialog box of the ribbon command File | Options , you will find the Manage button on each tab. You
can use it to save the settings of the program and, for example, transfer them to a new version.

See the next section for more detailed information.
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Export/import settings
You can save your individual settings that you have configured in the SoftMaker Office applications. In the first
step, export the settings data – for example, before you install a new version. Then, in the second step, import
this data into the newly installed version.

For both steps, use the Manage button in the File | Options dialog box .

Which settings you can exactly export/import, you will find below.

Note: Export and import of settings data is only possible for version 2021 and later.

What reasons could there be to export/import settings?

The following reasons could be considered for exporting/importing your settings:

§ You want to apply the settings from the old version to a new version of SoftMaker Office that you install on
the same computer. 

§ You have also installed the current version of SoftMaker Office on another computer and would like to use
the same settings there.

§ You want to apply the settings of an old version of SoftMaker Office to another computer on which you
have installed the new version of SoftMaker Office.

Which files are saved?

For the export Presentations accesses the settings files (...config.ini, ...tools.dat etc.) that are stored in the
SoftMaker > Settings folder on your device. Depending on your operating system, these files are located
in the following directory:

§ Windows: In the SoftMaker\Settings folder of your Documents folder. 

§ macOS: In the SoftMaker/Settings folder of your Documents folder.

§ Linux: In the SoftMaker/Settings folder of your Home-directory.

§ Android: In the SoftMaker/Settings folder of your SD card.

§ iOS: In the SoftMaker/Settings folder of your App folder.

Note: The above information is for illustrative purposes only and you usually don't need to do anything here.
Presentations will automatically replace these files for you if you follow the steps described below for
exporting/importing the settings.
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Step 1: Export the settings

To export, choose the command File | Options  to open the dialog box "Settings". Here, click on the
Manage button located at the bottom left of each tab of this dialog box.

Another dialog box "Manage Settings" will open. Here, choose from the following options which settings you
want to save:

Tip: You can also just export all of them, but later when importing you must make sure that you only select
the options you really want.

§ Configuration files 

This option saves all the settings you have made in the dialog box of the File | Options command. Some of
these settings are also located directly on the ribbon tabs (or in the toolbars).

§ Customized ribbon/toolbars

If you have changed the arrangement on the ribbon, in the Quick access bar or in toolbars (see section
Customizing the Ribbon), you can save your individual arrangement with this option.

Please note for the import of settings from an old to a new version of SoftMaker Office: If this option is enabled, command icons
that have been newly added in the more recent version will then not be displayed there. So if you prefer the new icons to be displayed
instead of keeping your old arrangement, you should disable this option. Or you can import your old arrangement anyway and pick
out by yourself afterwards the new icons relevant for you by using the command File | Customize (see section Customizing icons
and groups in the ribbon).

§ Keyboard shortcuts

This option allows you to import keyboard shortcuts that you have assigned yourself (see section
Customizing shortcuts keys).

§ User dictionaries

This option allows you to save the words you have added to your user dictionaries (see section Editing user
dictionaries).

§ Other (SmartText, Labels, ...)

Enable this option if you want to apply all other settings that can be saved in SoftMaker Office (for example,
SmartText).

When you finally click on Export, a Zip file is created with the options you selected. Save this file to any
location that you can easily access for later import.

Note: The settings of all SoftMaker Office applications will be exported in this process (TextMaker,
PlanMaker, Presentations, BasicMaker). The same applies to the import in the following step. In the iOS
version, the steps has to be performed separately for each application.

Step 2: Import the settings

To import the settings to another installation of the program, choose the command File | Options there. In the
"Settings" dialog box, click on the Manage button.
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In the following dialog box "Manage settings", place a check mark in front of the settings you want to import.
(Details about the options are described above in step 1).

Now click the Import button and select the Zip file you created in step 1. The imported settings will take effect
in the current Presentations application when you restart the program.

"Reset" button

The Reset button resets all the program's settings to their delivery state.

Note: This action resets the settings for all SoftMaker Office applications (TextMaker, PlanMaker,
Presentations, BasicMaker) of this version. For iOS users, resetting applies to each application separately.
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Changing document properties

You can use the ribbon command File | group File management | Properties  to change settings that only
affect the current document and are saved with it. These settings are called document properties.

The available document properties are distributed by topic across multiple tabs. If you click on the Summary
tab, for example, you can edit the document info.

The following pages provide detailed explanations of all available document properties.

Document properties, Summary tab

On the Summary tab in the dialog box of the ribbon command File | Properties , you can enter some
additional info for the current document.

This can include explanatory information about the current document (subject, author, keywords, etc.) that the
file manager can use in searches.

For more information, see Document summary.

Document properties, View tab

On the View tab in the dialog box of the ribbon command File | Properties , you can make settings for the
appearance of the document on the screen.

Objects section

As described in Hiding objects, you can make inserted objects invisible on the screen and/or on the printed
page.

You can still make such objects visible again by means of these two options:

§ Show invisible objects: If you enable this option, any object whose Visible property is disabled becomes
visible on the screen. 

§ Print unprintable objects: If you enable this option, any object whose Printable property was disabled
will also be printed again. 

Both options are disabled by default.
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Document properties, Colors tab

On the Colors tab in the dialog box of the ribbon command File | Properties , you can edit the color palette
of the current document.

When you open a color list – for example, the color list for the font color – you see only a small selection of the
up to 16 million colors available. This selection is called the color palette of the document.

You can modify this color palette at any time. You can add new colors and change colors that you have added.
However, the first 24 colors in the palette are default colors that cannot be changed.

Important: Changes to the color palette are saved in the document. This means that you can create a separate
color palette for each document.

Adding a color

To add a color to the palette of the current document, proceed as follows:

1. Choose the command File | Properties  and switch to the Colors tab.

Tip: Alternatively, this color palette can be accessed via any button that contains a color list (for example,
font color). To do so, select the entry Define color... in the color list (the last entry).

2. Set the desired color. For more information, see "Working with the color controls" section below.

3. Click on the New button.

4. Give the new color whatever name you like and confirm with OK.

5. Exit the dialog box with OK.

Presentations now adds the new color to the document's color palette. From now on, the color will be available
in all dialog boxes where a color can be selected.

Changing a color

Note: You can only change colors that you have added. The first 24 colors in the color palette are default
colors that cannot be changed.

To change a color, proceed as follows:

1. Choose the command File | Properties  and switch to the Colors tab.

Alternatively: You can also select the entry Define color... in any color list (for example, font color) to open
this dialog box.

2. Select the color to be changed from the Color palette list.
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3. Make the desired changes. For more information, see "Working with the color controls" section below.

4. Click on Change.

The color has now been changed for the current document.

Renaming a color

You can change the name of self-defined colors at any time. To do so, open the color dialog, select a color from
the dropdown list Color palette and click on the Rename button.

Working with the color controls

The controls in the above dialog box let you set colors in many ways. All these ways lead to the same result –
just select your preferred method:

§ Using the color field and luminance slider 

The easiest way to set colors is to use the large color field and the luminance slider to its right. The color
field presents all available hues in all available saturations, while the luminance slider next to it provides a
means of varying the luminance.

To set a color, first click on the desired color in the large color field. Then click on the desired luminance in
the luminance slider.

§ Using the hue, saturation and luminance controls 

Alternatively, you can set colors with the controls labeled Hue, Sat (saturation) and Lum (luminance).
Values between 0 and 240 are allowed.

§ Using the Red, Green and Blue controls 

Colors can also be set via their red, green and blue components. The controls labeled Red, Green and Blue
are provided for this purpose. Values between 0 and 255 are allowed.

§ Typing the hex code for a color 

You can also specify a color by typing its hex code in the input field with the hash (pound) sign #.

Such hex codes are common in the HTML code of web pages, for example. The hex code consists of 3 two-
digit hexadecimal values for the colors red, green and blue (RRGGBB). For example, 00FF00 represents
pure green.

Document properties, Statistics tab

On the Statistics tab in the dialog box of the ribbon command File | Properties , you can retrieve statistical
information about the current document (number of slides, words and objects, creation date, etc.).
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Document properties, Protection tab

On the Protection tab in the dialog box of the ribbon command File | Properties , you can provide
document protection to the current document.

You can ensure that opening or saving a protected document is only possible after entering the correct
password. Documents with read protection are also encrypted so that they cannot be viewed with programs
other than Presentations.

For more information, see Document protection.

Document properties, Fonts tab

FreeOffice: Embedding fonts is not included in SoftMaker FreeOffice.

You can use the Fonts tab in the dialog box of the ribbon command File | Properties  to embed the fonts
that you used in a document into the document file.

Note: This feature is available only on Windows. This includes embedding fonts as well as displaying fonts
that were embedded in a file.

Embedding fonts into a document file is useful when you are sharing a presentation with others. If you want to
make sure that the fonts used in your presentation look exactly the same on your computer and on other devices,
it's a good idea to embed all fonts in the file.

If a file with embedded fonts is opened on another computer, Presentations will install all embedded fonts
temporarily. After you exit Presentations, they are automatically removed.

To embed fonts into a presentation, proceed as follows:

1. Create or open the desired presentation.

2. Choose the command File | Properties  and switch to the Fonts tab.

3. The dialog box presents a list of all fonts that were used in the document. A checkbox is displayed in front
of each font. Click to place a check mark in front of all fonts that you want to embed in the document.

Tip: You can use the Select all and Deselect all buttons to select or deselect all embeddable fonts at once.

4. Confirm with OK.

5. Save the file.

The selected fonts are now embedded into the document file.
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Notes

§ Embedding fonts works with Microsoft PowerPoint documents in addition to Presentations documents. 

§ Some fonts generally do not allow users to embed them into documents. For such fonts, the checkbox for
embedding is unavailable.

§ Many commercial fonts allow embedding, but not editing documents in these fonts. When you embed such
fonts, a message will appear when the document is opened on a different computer. The user can then decide
whether he wants to edit the document, print it or just view the slide show. If he chooses "Edit", the
embedded fonts will not be available.

§ When sharing documents (for example, by e-mail), keep in mind that embedding fonts can significantly
increase file size, especially when using fonts with large character sets (for example, Asian fonts).

§ System fonts like Arial, Courier New, Times New Roman or Symbol cannot be embedded. These fonts are
available on every Windows system anyway.
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Customizing the document display
In this section, you will learn how to customize the appearance of the document on the screen. Most of the
required commands can be found on the ribbon tab View.

The ribbon tab View contains the following commands for displaying the screen:

Command Function

Slides This command switches to the slide view. This is the view that you normally use when working
with Presentations. You can use this command to return to the normal slide view from another
view at any time.

Slide sorter This command switches to the Slide sorter view. It displays small thumbnails of all slides. For
more information, see Using the slide sorter and outline.

Outline This command switches to the Outline view. This only shows the text in the slides; all graphic
elements are hidden. For more information, see Using the slide sorter and outline.

Notes This command switches to the Notes view. For more information, see Adding notes.

Group Master Here, you can switch to one of the different "master views". You can edit the masters for slide
layouts, notes and handouts in these views. For more information, see Working with masters.

Group View Here, you can enable various display elements – for example, the display of rulers (see
Settings, View tab) – or change the settings for grids and guides (see Using the grid / Using
guides).

Group Zoom You can use these commands to specify the zoom level at which the slides are displayed. For
more information, see Zoom level.

Mini sorter The mini sorter is a narrow strip at the edge of the document window with small thumbnails of
all slides. (For more information, see Working with the mini sorter.) Here, you can select where
you want the mini sorter to be displayed in the document window or you can hide it completely.

Mini outliner This is similar to the mini sorter, but instead of small thumbnails, the mini outliner shows an
outline view of the text in the slides. (For more information, see Working with the mini
outliner.) Select here whether and where the mini outliner should be displayed. 

Sidebar Here, you can enable/disable the sidebar. The sidebar allows extra quick access to numerous
slide formatting options. For more information, see Using the sidebar.

Full screen This command allows you to switch to full screen view, where the program uses the entire
screen to display the document. For more information, see Full screen view. (Full screen view
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is not included in SoftMaker FreeOffice.)

Windows With this command, you can place documents side by side, close all documents or select from
the list of all currently open documents. For more information, see Working with multiple
documents.

Further settings for displaying the screen can be made via the ribbon command File | Options . (For more
information, see Settings, View tab.)

Zoom level

Presentations offers you many options for determining the zoom level at which a document should be displayed
on the screen.

The command group "Zoom" on the ribbon tab View

Use the following commands of the ribbon tab View | group Zoom for this purpose:

Command Function

Set zoom This option allows you to select the zoom level from a list. You can also enter a value
(between 25% and 400%) manually.

Magnify selection This command enables the magnifying glass. Then use the mouse to drag a frame around any
section of the document to enlarge it.

Actual size This command sets the zoom level to 100%.

Fit to slide This command automatically selects the zoom level at which a slide fits exactly in the window.
This is the default setting.

Using the zoom slider

You can also use the zoom slider in the bottom right corner of the screen to change the zoom level:

To change the zoom level, either drag the slider with your mouse or click on the plus or minus icon.

If you click on the percentage to the right of the zoom slider, you open the dialog box of the aforementioned
command View | group Zoom | Set zoom.
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Full screen view

FreeOffice: The full screen view is not included in SoftMaker FreeOffice.

With the ribbon command View | group Windows | Full screen , you can switch to the full screen view in
which the program uses the entire screen to display the document. Presentations enlarges its program window to
the full screen size. (All other toolbars are hidden in the classic menu interface.)

To exit this view mode, press the Esc key or choose the ribbon command View | Full screen again.

Using the toolbar of the full screen view

When you enable full screen mode, an additional mini toolbar appears on the screen.

The mini toolbar "Full screen mode"

The icons in this toolbar have the following functions (from left to right):

§ Show/hide ribbon 

§ Show/hide sidebar

§ Enable/disable "Drag sheet" mode

If you enable "Drag sheet" mode, you can scroll your document using the mouse. Simply click into the
document and drag the mouse cursor in the desired direction (with the mouse button still held down).

Note: Clicking on text to set the text cursor or selecting text or objects is no longer possible in this mode.

To exit "Drag sheet" mode, click on this icon again.

§ Clicking on the Close button exits full screen mode. 
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Customizing the ribbon

"Ribbon" only: This section is relevant only for users who have configured the program to use the ribbon
interface. (For information on customizing the classic menu interface, see Customizing toolbars.)

Tip: You can switch the user interface between ribbon and classic menus at any time. To do so, choose the
command File | Options in the ribbon (or choose Tools > Options in the classic menu interface). In the
dialog box, switch to the Appearance tab and click on the User interface button. The program will display a
dialog box in which you can choose the desired user interface.

In this section you will learn how to configure the ribbon and add additional icons.

The "Ribbon" and the Quick access toolbar (below)

The information covers the following topics:

§ Showing and hiding the ribbon 

§ Customizing icons and groups in the ribbon 

§ Changing the position of the Quick access toolbar

§ Customizing icons on the Quick access toolbar

For more information, see the following pages.
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Showing and hiding the ribbon

"Ribbon" only: This section is relevant only for users who have configured the program to use the ribbon
interface. (For information on customizing the classic menu interface, see Customizing toolbars.)

The ribbon is usually fully visible:

The "Ribbon" and the Quick access toolbar (below)

However, you can hide the ribbon at any time by minimizing it. This is useful if you want to have as much
screen space as possible to display the document.

Proceed as follows:

1. Choose the ribbon command File | group Settings | Customize .

Also possible: Right-click anywhere on the ribbon.

2. A menu opens. There, you will find the option Minimized ribbon, which can be enabled or disabled by
clicking on it (a check mark appears in front of the option if it is currently enabled).

After you enable this option, the ribbon will be minimized. Only the ribbon tabs can then be seen.

Tip: Alternatively, you can use the icon  in the upper right corner of the program window next to the ?
icon to minimize the ribbon. If you click on the icon again, the ribbon is restored to its full size.

In addition, you can use the key combination Ctrl+F1 (Mac: Cmd+F1) to enable/disable minimization of the
ribbon.

Working with a minimized ribbon

You work with a minimized ribbon as follows:

§ When you click on one of the ribbon tabs of the minimized ribbon, the ribbon becomes completely visible
again temporarily and displays the corresponding ribbon tab. As soon as you trigger a command (for
example, click on the icon for a command), however, the ribbon will be automatically minimized again. 

§ If you double-click on one of the ribbon tabs, the ribbon will be permanently visible again, thus removing
the minimization. 

§ As mentioned above as a tip, you can also use the icon  in the upper right corner of the program window
to enable/disable the minimization of the ribbon.
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Customizing icons and groups in the ribbon

FreeOffice: The Customize ribbon function is not included in SoftMaker FreeOffice.

"Ribbon" only: This section is relevant only for users who have configured the program to use the ribbon
interface. (For information on customizing the classic menu interface, see Customizing toolbars.)

The command Customize ribbon  allows you to customize the ribbon to a certain extent. The main purpose
of this command is to add additional icons, command groups or even complete ribbon tabs to the ribbon.

Important: The icons in the predefined command groups on the ribbon cannot be changed. This means that
you cannot add, remove, or change the order of icons in the existing command groups. Additional icons can
only be inserted in new command groups at the end of a ribbon tab (or optionally in a completely new ribbon
tab).

To customize the ribbon, proceed as follows:

1. Choose the command Customize ribbon under File | group Settings | Customize  to open the dialog box.
Alternatively: Right-click anywhere on the ribbon with the mouse button.

Tip: The dialog box can be opened even faster by double-clicking on any empty area of the ribbon.

2. Use one of the procedures described below to edit the ribbon tabs.

Basic structure of the dialog box

The dialog box of the command Customize ribbon contains two lists:

§ Left list: all available commands 

The left list shows all commands available in the program.

Tip: You can use the option Categories (above the left list) to filter the list by a specific category (for
example, all commands of the "File" category).

You can also search the list by typing something in the Quick search field.

§ Right list: icons of the currently selected ribbon tab 

The right list displays the icons contained in the currently selected ribbon tab.

You define the ribbon tab to be displayed here via the dropdown list Customize (top right).

In this dialog box, you can perform the following actions:
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Adding an icon

Note: You can only add icons to command groups that you have added yourself (or to completely new ribbon
tabs). You cannot insert an icon into the predefined groups.

To add an icon to a specific ribbon tab, perform the following steps in the dialog box of the command File |
group Settings | Customize | Customize ribbon:

1. In the dropdown list Customize (top right), select the ribbon tab to which you want to add an icon.

The right list now displays all icons that are currently on the selected ribbon tab.

2. In the left list, select the icon that you want to add.

3. Click on the button .

Even faster: Simply double-click on the icon in the left list.

The icon is now added to the ribbon tab. If you have not yet created a new group here, the program
automatically creates a new command group for the icon at the end of the ribbon tab.

Removing an icon

Note: You can only remove icons that you added to the ribbon yourself. You cannot delete any of the
predefined icons.

To remove one of the icons you added from a ribbon tab, perform the following steps in the dialog box:

1. In the dropdown list Customize, select the ribbon tab on which the icon is located.

2. In the right list below it, select the icon to be removed.

3. Click on the button .

The icon is now removed from the ribbon tab.

Moving an icon

Note: You can only move icons that you added to the ribbon yourself. You cannot change the position of any
of the predefined icons.

To move an icon in a ribbon tab, perform the following steps in the dialog box:

1. In the dropdown list Customize, select the ribbon tab on which the icon is located.

2. In the right list below it, select the icon to be moved.

3. Use the up  and down  arrow buttons to move the icon within the ribbon tab.

Note: If you want to move an icon to a different ribbon tab, you must first remove it from its current ribbon
tab and then add it to the other ribbon tab.
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Adding a new command group

Note: New command groups can only be added after the default command groups. You cannot insert a user-
defined group between the predefined command groups.

To add a new command group (a new section) to a ribbon tab, perform the following steps in the dialog box:

1. Select the desired ribbon tab from the dropdown list Customize.

2. Click on the New group button (displayed below the right list).

The new command group is now created (at the end of the ribbon tab).

Renaming a command group

Note: Only user-defined command groups can be renamed. You cannot rename any of the predefined
command groups.

To rename a user-defined command group in a ribbon tab, perform the following steps in the dialog box:

1. Select the desired ribbon tab from the dropdown list Customize.

2. Select the desired command group from the right list below it.

3. Click on the Rename button (displayed below the right list).

4. Type in the new name and confirm it.

The command group will now be renamed accordingly.

Removing a command group

Note: Only user-defined command groups can be removed. You cannot delete any of the predefined
command groups.

To remove a user-defined command group from a ribbon tab, follow these steps in the dialog box:

1. Select the desired ribbon tab from the dropdown list Customize.

2. Select the desired command group from the right list below it.

3. Click on the button . (Any icons must have been removed from the group.)

Even faster: Simply double-click on the command group in the right list.

The command group is now removed from the ribbon tab.

Assigning shortcut keys

If you click on the Shortcut keys button in the dialog box, the dialog box will expand to include an additional
area called Shortcut keys, which can be used to edit shortcut keys for commands.
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Summary: You can assign a shortcut key of your choice to any command here: Select the command in either of
the two lists, click on the Press new shortcut key field and then press the key combination with which you
want to choose this command in future.

For more information, see Customizing shortcut keys.

“Edit" button

The Edit button is only enabled if you have selected a user-defined icon in the list on the left side of the dialog
box. For more information see Creating user-defined icons.

Buttons for managing the ribbon tabs (right side)

Above and below the list on the right side of the dialog box, there are buttons for managing the ribbon tabs.
Some of these buttons have already been mentioned in this section. To ensure that users understand them better,
all buttons and their functions are clearly listed again below.

Above the list on the right:

§ New 

This button creates a new empty ribbon tab. You can then customize this ribbon tab by adding icons and
command groups.

§ Rename

Use this button to rename the ribbon tab selected in the dropdown list Customize (only available for user-
defined ribbon tabs).

§ Reset

This button resets the ribbon tab selected in the dropdown list Customize back to its delivery state.

§ Delete

This button deletes the ribbon tab selected in the dropdown list Customize (only available for user-defined
ribbon tabs).

Below the list on the right:

§ New group 

This button adds a new command group to the ribbon tab selected in the dropdown list Customize.

§ Rename

Use this button to rename a command group (only available for user-defined command groups). First, select
the desired command group in the list on the right of the dialog box.

§ Reset all

This button resets all ribbon tabs back to their delivery state.

The Close button closes the dialog box and all changes are applied.
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Changing the position of the Quick access toolbar

FreeOffice: Customizing the Quick access toolbar is not included in SoftMaker FreeOffice.

"Ribbon" only: This section is relevant only for users who have configured the program to use the ribbon
interface. (For information on customizing the classic menu interface, see Customizing toolbars.)

The Quick access toolbar is displayed below the ribbon. It provides a selection of frequently used commands.

The "Ribbon" and the Quick access toolbar (below)

The Quick access toolbar can either share the space with the document tabs – or it is located in its own toolbar.
To change this, proceed as follows:

1. Choose the ribbon command File | group Settings | Customize .

Alternatively, right-click anywhere on the ribbon.

2. The program opens a menu that contains one of the following two commands:

Show Quick access toolbar as separate toolbar: By default, the Quick access toolbar is displayed in the
toolbar that also contains the document tabs. When you choose this command, the Quick access toolbar
moves to its own toolbar instead.

Show Quick access toolbar beside the document tabs: This command does exactly the opposite: If the
Quick access toolbar is currently displayed as a separate toolbar, choosing this command will cause the
Quick access toolbar to be moved back to the toolbar that also contains the document tabs.

Tip: You can also click on the double arrow button  directly in the Quick access toolbar itself. There, you
can use the entry Position to find the corresponding options for displaying the Quick access toolbar: Beside the
document tabs or Below the ribbon.

Customizing icons on the Quick access toolbar

FreeOffice: Customizing the Quick access toolbar is not included in SoftMaker FreeOffice.
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"Ribbon" only: This section is relevant only for users who have configured the program to use the ribbon
interface. (For information on customizing the classic menu interface, see Customizing toolbars.)

The Quick access toolbar is displayed below the ribbon. It provides a selection of frequently used commands.

The "Ribbon" and the Quick access toolbar (below)

If desired, you can customize the icons on the Quick access toolbar at any time, for example, you can add,
remove and reposition icons.

To do so, choose File | group Settings | Customize  | Customize Quick access toolbar (or click on the icon
 in the Quick access toolbar and select Customize there). In the following dialog box, you can edit the Quick

access toolbar according to the descriptions in Customizing toolbar icons – except for the passage "Managing
toolbars".

Tip: Alternatively, you can simply drag a command from the dialog box into the Quick access toolbar with
the mouse. Even quicker (without opening the dialog box): Hold down the Alt key and drag a command icon
directly from the ribbon to the Quick access toolbar. To remove it, drag the icon back into the ribbon while
holding down the Alt key.
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Customizing toolbars

Only for "classic menus with toolbars": This section is relevant only for users who have configured the
program to use the classic menus interface. For information on customizing the ribbon, see Customizing
the ribbon.

Tip: You can switch the user interface between ribbon and classic menus at any time. To do so, choose the
command File | Options in the ribbon (or choose Tools > Options in the classic menu interface). In the
dialog box, switch to the Appearance tab and click on the User interface button. The program will display a
dialog box in which you can choose the desired user interface.

In this section, you will learn how to configure the toolbars (Standard toolbar, Formatting toolbar, etc.) with the
menu command View > Toolbars and how to customize them with Tools > Customize.

A toolbar (here: the Standard toolbar)

The following topics are covered:

§ Showing and hiding toolbars 

§ Positioning toolbars on the screen

§ Managing toolbars (creating, deleting, renaming, resetting toolbars)

§ Customizing toolbar icons (adding, removing, moving icons)

§ Using the toolbar menu (for extra quick access to the above functions)

For more information, see the following pages.

Showing and hiding toolbars

Only for "classic menus with toolbars": This section is relevant only for users who have configured the
program to use the classic menus interface. For information on customizing the ribbon, see Customizing
the ribbon.

You can enable or disable the available toolbars at any time to make them visible or to hide them.

To do so, proceed as follows:

1. Choose the menu command View > Toolbars.

Alternatively, click on the double arrow  at the end of a toolbar and select Toolbars.

2. Click on the checkbox in front of the desired toolbar to enable or disable it. When the toolbar is enabled, a
check mark appears in the box.
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3. Exit the dialog box with Close.

The corresponding toolbar has now been enabled or disabled.

Tip: There is a faster way to do this: If you right-click on any toolbar, a list of all available toolbars is
displayed. If you click on one of these menu items, the corresponding bar will be enabled or disabled.

Visible in mode...

Some toolbars are visible only in particular situations. The Picture toolbar, for example, appears only when you
select a picture.

This is due to the option Visible in mode, which determines when a toolbar should be visible. Some examples:

Option Explanation

All modes The selected toolbar is always visible (unless it has been disabled). Example: the Standard
toolbar

Sorter The bar is only visible in the Slide sorter view. (For more information, see also Using the slide
sorter and outline.)

Outline The bar is only visible in the Outline view. (For more information, see also Using the slide
sorter and outline.)

Normal The bar is visible in all view modes except Slide sorter and Outline.

Normal + Outline The bar is visible in all view modes except the Slide sorter.

Picture The bar only appears if a picture is selected in the document.
Example: the Picture toolbar

Table The bar only appears if the text cursor is in a table.
Example: the Table toolbar

Chart The bar only appears if a chart is selected in the document.
Example: the Chart toolbar

AutoShape The bar only appears if a drawing or text frame is selected in the document.

To change this setting for one of the toolbars, choose the menu command View > Toolbars, select the toolbar
in the list Toolbars and select the desired option for Visible in mode.

Note: Changing this setting in the default toolbars (Standard toolbar, Formatting toolbar, etc.) is usually not
recommended. This option is primarily intended for user-defined toolbars.
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Positioning toolbars on the screen

Only for "classic menus with toolbars": This section is relevant only for users who have configured the
program to use the classic menus interface. For information on customizing the ribbon, see Customizing
the ribbon.

You can position each toolbar as desired on the screen. To do so, use one of the following procedures:

Changing the position with the command View > Toolbars

You can change the position of a toolbar at any time with the menu command View > Toolbars. To do so,
proceed as follows:

1. Choose the menu command View > Toolbars.

2. Select the desired toolbar by clicking on it in the list.

3. Select the desired position for the toolbar in the list Position.

Note: If you select the option Floating, the toolbar icons are displayed in a window that can be freely moved or
resized just like an application window.

Changing the position with the toolbar menu

Each toolbar has a button with a double arrow  at its right edge. Select the entry Position for the desired
toolbar. The following submenu provides a dropdown list of possible positions for the toolbar.

Note: If you have selected the option Floating, you can also use this button  to integrate the toolbar back into
a desired fixed position via the entry Position entry.

For more information on the toolbar menu options, see Using the toolbar menu.

Changing the position with the mouse

Some toolbars can also be repositioned with the mouse. To do so, proceed as follows:

1. Position the mouse cursor over an empty area of the toolbar.

2. Press the left mouse button and hold it down.

3. While still holding the mouse button down, drag the toolbar to the desired position.

4. Release the mouse button to place the toolbar in the new position.

Note: By default, most toolbars are locked to prevent unintentional movement with the mouse. However, you
can release this lock at any time: To do so, choose the menu command View > Toolbars, select the toolbar
and disable the option Locked. From now on, this bar can also be moved with the mouse.
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By the way, a positioning aid is enabled while dragging a toolbar: If you drag the toolbar near one of the edges
of the program window, it automatically jumps to the corresponding edge. If, for example, you release the bar at
the top edge, this corresponds to selecting the Top position in the dialog box of the menu command View >
Toolbars.

Managing toolbars

Only for "classic menus with toolbars": This section is relevant only for users who have configured the
program to use the classic menus interface. For information on customizing the ribbon, see Customizing
the ribbon.

You can create new toolbars at any time and delete or rename existing toolbars, etc. To do so, use the buttons in
the dialog box of the menu command View > Toolbars.

Creating new toolbars

The program lets you create your own toolbars at any time.

If, for example, you frequently need to use commands of the Window menu that are not present in the Standard
toolbar, it might be worth your while to create your own toolbar for them.

You create a new toolbar as follows:

1. Click on the New button (in the dialog box of the menu command View > Toolbars).

2. The program displays a dialog box in which you enter a name for the new toolbar – for example, "My
toolbar". Then confirm with OK.

3. The new toolbar has been created. Close the dialog box or click on the Customize button to add icons to the
toolbar. For more information, see Customizing toolbar icons.

Customizing toolbar icons

You can edit the icons on toolbars with the Customize button. For more information, see the next section.

Deleting toolbars

The Delete button allows you to delete a user-defined toolbar as follows:

1. Select the toolbar to be deleted from the list.

2. Click on the Delete button.

Note: You can only delete user-defined toolbars. The default toolbars (Standard toolbar, Formatting toolbar,
etc.) cannot be removed.

However, you can disable a Standard toolbar at any time if you don't need it by removing the check mark in
front of it. For more information, see Showing and hiding toolbars.
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Renaming toolbars

The Rename button can be used to rename a user-defined toolbar as follows:

1. Select the desired toolbar from the list.

2. Click on the Rename button.

3. Type in the new name and confirm it with OK.

Note: You can only rename user-defined toolbars. The default toolbars (Standard toolbar, Formatting toolbar,
etc.) cannot be renamed.

Resetting toolbars

You can undo any changes you have made to one of the default toolbars by clicking on the Reset button:

1. Select the desired toolbar from the list.

2. Click on the Reset button.

The toolbar now contains the default icons again. In addition, the default settings for the options Visible in
mode and Position are restored.

Note: This command only applies to the default toolbars (Standard toolbar, Formatting toolbar, etc.) but not to
user-defined toolbars.

Resetting all toolbars

To reset all toolbars at once, click on the Reset all button.

Note: This command only resets the default toolbars. User-defined toolbars remain unchanged.

Customizing toolbar icons

Only for "classic menus with toolbars": This section is relevant only for users who have configured the
program to use the classic menus interface. For information on customizing the ribbon, see Customizing
the ribbon.

The menu command Tools > Customize allows you to customize the icons as desired on a toolbar. You can add
icons and remove or reposition existing icons, among other things.

Proceed as follows:

1. Choose the menu command Tools > Customize to open the dialog box. Alternatively: Click on the button

 at the end of a toolbar and select the entry Customize here.

Even faster: Double-click on an empty area in any toolbar.
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2. Use one of the procedures described below to add, remove or reposition icons.

Basic structure of the dialog box

The dialog box of the menu command Tools > Customize contains two lists:

§ Left list: all available commands 

The left list shows all commands available in the program.

Tip: You can use the option Categories (above the left list) to filter the list by a specific category (for
example, all commands of the "File" category).

You can also search the list by typing something in the Quick search field.

§ Right list: icons of the currently selected toolbar 

The right list displays the icons contained in the currently selected toolbar.

You define the toolbar to be displayed here via the dropdown list Customize (top right).

In this dialog box, you can perform the following actions:

Adding an icon

To add an icon to a specific toolbar, perform the following steps in the dialog box of the command Tools >
Customize:

1. In the dropdown list Customize (top right), select the toolbar to which you want to add an icon.

The right list now displays all icons that are currently in the selected toolbar.

Optional: In the right list, select the icon behind which the new icon is to be inserted.

2. In the left list, select the icon that you want to add.

3. Click on the button .

Even faster: Simply double-click on the icon in the left list.

The icon is now added to the toolbar.

Tip: Alternatively, you can add an icon to any toolbar as follows: Choose the command Tools > Customize.
Then simply drag the icon out of the dialog box with the mouse and drop it at the desired position in the
toolbar. (Do this in the toolbar itself and not in the dialog box!) Of course, this procedure only works when
the toolbar is currently visible on the screen.

Removing an icon

To remove an icon from a toolbar, perform the following steps in the dialog box:

1. Select the desired toolbar from the dropdown list Customize (top right).

2. In the right list below it, select the icon to be removed.

3. Click on the button .
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Even faster: Simply double-click on the icon in the right list.

The icon is now removed from the toolbar.

Tip: Alternatively, you can remove an icon from a toolbar as follows: Choose the command Tools >
Customize. Then simply drag the icon out of the toolbar with your mouse and drop it somewhere outside the
toolbar, for example, in the document. (Do this in the toolbar itself and not in the dialog box!)

Moving an icon

To move a toolbar icon to a different position, perform the following steps in the dialog box:

1. Select the desired toolbar from the dropdown list Customize.

2. In the right list below it, select the icon to be moved.

3. Use the up  and down  arrow buttons to move the icon within the toolbar.

Note: If you want to move an icon to a different toolbar, you must first remove it from its current toolbar and
then add it to the other toolbar.

Tip 1: Alternatively, you can also move an icon as follows: Choose the command Tools > Customize. Then
drag the icon directly in the toolbar to the desired position (in the toolbar itself and not in the dialog box!).
This method also allows you to move an icon directly from one toolbar to another.

Tip 2: Moving icons works even if this dialog box is not open: When you hold down the Alt key, you can
move a toolbar icon by clicking on it and then dragging it to the desired position (while still holding down
the mouse button).

Inserting a separator

To insert a separator in front of an icon in a toolbar, perform the following steps in the dialog box:

1. Select the desired toolbar from the dropdown list Customize.

2. In the right list, select the icon in front of which the separator is to be inserted.

3. Click on the New separator button (displayed below the right list).

The separator is now inserted.

Tip: Alternatively, you can proceed as follows: Choose the command Tools > Customize. To insert a
separator to the left of an icon in any toolbar, simply drag the icon slightly to the right (in the toolbar itself
and not in the dialog box!).

Removing a separator

To remove a separator from a toolbar, perform the following steps in the dialog box:

1. Select the desired toolbar in the dropdown list Customize.

2. In the right list below it, select the separator to be removed.
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3. Click on the button .

Even faster: Simply double-click on the separator.

The separator is now removed from the toolbar.

Tip: Alternatively, you can also use the following procedure: Choose the command Tools > Customize. If
you now drag the icon that is to the immediate right of the separator a little bit to the left, the separator will
be removed. (Do this in the toolbar itself and not in the dialog box!)

Assigning shortcut keys

If you click on the Shortcut keys button in the dialog box, the dialog box will expand to include an additional
area called Shortcut keys, which can be used to edit shortcut keys for commands.

Summary: You can assign a shortcut key of your choice to any command here: Select the command in either of
the two lists, click on the Press new shortcut key field and then press the key combination with which you
want to choose this command in future.

For more information, see Customizing shortcut keys.

Managing toolbars

The dialog box of the command Tools > Customize also has buttons for managing toolbars:

§ New 

This button creates a new empty toolbar.

§ Rename 

This button renames the toolbar selected in the dropdown list Customize (only available for user-defined
toolbars).

§ Reset 

This button resets the toolbar selected in the dropdown list Customize back to its delivery state.

§ Delete 

This button deletes the toolbar selected in the dropdown list Customize (only available for user-defined
toolbars).

§ Reset all (displayed below the right list) 

This button resets all toolbars back to their delivery state.

Further options for managing and configuring toolbars are available in the dialog box of the menu command
View > Toolbars. For more information, see Managing toolbars.
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Using the toolbar menu

Only for "classic menus with toolbars": This section is relevant only for users who have configured the
program to use the classic menus interface. For information on customizing the ribbon, see Customizing
the ribbon.

Some toolbars end on the right with a double arrow  as shown in the following figure:

If you click on this double arrow, the toolbar menu will open for this toolbar.

This menu gives you quick access to all toolbar-related commands described in the previous sections. The
toolbar menu contains the following commands:

§ Add/remove buttons 

This command displays a list of all icons available for a toolbar. If you click on one of the entries, the
corresponding icon in the bar will immediately be enabled or disabled.

(Note: This command is only meant for quickly enabling or disabling icons. For information on customizing
the icons in a toolbar, see Customizing toolbar icons.)

§ Position 

You can use this command to change the position of a toolbar. The available options include top, bottom,
left, right or floating (in a little window that can be moved and resized with the mouse).

§ Toolbars 

This option chooses the menu command View > Toolbars that allows you to enable or disable, configure
and manage toolbars.

For more information, see Customizing toolbars.

§ Customize 

This option chooses the menu command Tools > Customize that allows you to edit the icons on a toolbar
(add, remove, reposition icons).

For more information, see Customizing toolbar icons.

§ Reset this toolbar 

This option resets the toolbar. The bar then displays its default icons again. In addition, all settings made for
the bar are discarded.
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Creating user-defined icons

FreeOffice: The Customize ribbon function is not included in SoftMaker FreeOffice.

You can create user-defined icons at any time and then add them to the ribbon or a toolbar. Such icons can be
used to start other desired programs.

To create a user-defined icon – for example, an icon to start the Windows Editor – proceed as follows:

1. Choose the following command in the ribbon or menu:

Ribbon: File | group Settings | Customize  | Customize ribbon

Menu: Tools > Customize

2. In the dropdown list Categories, select the User category.

3. Select one of the icons from the list Commands.

The first three icons are pre-assigned (as examples) to the Windows Calculator, the Windows Character
Map and the Windows Control Panel. Select the fourth icon, for example.

4. Click on the Edit button displayed below the list. Another dialog box appears.

5. Enter a short description of the program to be started in the Description field – for example, "Notepad".

6. Enter the complete path and file name for the program to be started in the Command line field, for example,
C:\Windows\notepad.exe.

7. Optional: If you want the program to display an icon other than its default icon, enter the path and file name
of the desired icon file in the Icon file field.

Note that icons in toolbars are slightly smaller than the usual Windows icons.

As soon as you confirm with OK, the user-defined icon is created.

If you now want to add the user-defined icon to the ribbon or toolbar, proceed as described in the following
sections:

§ Ribbon: Customizing icons and groups in the ribbon 

§ Toolbars: Customizing toolbar icons 

Customizing shortcut keys

FreeOffice: The Customize shortcut keys function is not included in SoftMaker FreeOffice.
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Commands that are frequently used in a program can also be chosen via shortcut keys. For example, the
command for saving the current document can be chosen very quickly by pressing the key combination Ctrl+S.

The predefined shortcut keys can be customized at any time in the dialog box of the ribbon command File |
Customize | Customize ribbon. You can assign a shortcut key to any command and change or remove existing
shortcut keys.

To do so, proceed as follows:

Adding shortcut keys

To assign a shortcut key to a command, perform the following steps:

1. Choose the following command in the ribbon or in the classic menu interface:

Ribbon: File | group Settings | Customize  | Customize ribbon

Classic menus: Tools > Customize

2. In the dialog box that appears, click on the Shortcut keys button.

The dialog box now expands to include an additional section called Shortcut keys, which can be used to
edit the shortcut keys for commands.

3. In the left or right list, select the command to which you want to assign a shortcut key.

The left list shows all commands available in the program. (You can use the option Categories to filter this
list by a specific category and perform a search using the Quick search field.)

The right list displays only the icons that are in the currently selected ribbon tab or toolbar.

4. Once you have selected the desired command, click into the Press new shortcut key field and press the
intended key combination (starting with Ctrl or Alt).

Tip: If you make a typing mistake, you can always press the BackspaceÕ key to delete the shortcut key you
entered.

5. Do not forget: Click on Add to assign this shortcut to the command now.

6. Exit the dialog box with Close.

From now on, you can execute the selected command with the specified shortcut key.

Editing shortcut keys (removing, changing, etc.)

You can also edit existing shortcut keys for commands (for example, delete or change them) at any time.
Proceed as follows:

1. Choose the following command in the ribbon or in the classic menu interface:

Ribbon: File | group Settings | Customize  | Customize ribbon

Classic menus: Tools > Customize

2. In the dialog box that appears, click on the Shortcut keys button.

The dialog box now expands to include an additional section called Shortcut keys, which can be used to
edit the shortcut keys for commands.
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3. In the left or right list, select the command whose shortcut keys you want to edit.

4. In the Shortcut keys section, perform one of the following actions:

Remove shortcut keys: The list Current shortcut keys displays all shortcut keys currently assigned to the
selected command. To remove a shortcut key, select it from the list and click on Remove.

Change shortcut keys: To change the shortcut key for a command, first remove it (as described above) and
then assign it a new shortcut key (as described at the beginning of this section).

Reset shortcut keys: To reset all shortcut keys for the entire program to their default values, click on the
Reset all shortcut keys button and confirm the confirmation prompt. Any changes you have made to
shortcut keys will then be discarded.

Display a list of all shortcut keys: When you click on the Export button, a table listing all currently assigned
shortcut keys is displayed. The buttons next to the table allow you to copy it to the clipboard, for example.

5. Exit the dialog box with Close.

Available shortcut keys

Note that some of the key combinations that are possible on your keyboard are not allowed for shortcut keys.

As a rule, you should use alphabetic keys, numeric keys or function keys for shortcut keys. You can combine
them with Ctrl, Alt and/or the Shift keyñ.

You can easily check whether the desired key combination is allowed. Click in the Press new shortcut key
field in the dialog box described above, and then enter the key combination. If it does not appear in the field, it
is not allowed.

Some examples of valid shortcut keys include:

§ Ctrl+A 

§ Alt+A (However, key combinations with the Alt key are not recommended – Alt+A, for example, is
responsible for opening the View menu!)

§ Ctrl+Alt+A

§ Ctrl+Shift+A

§ Ctrl+Alt+Shift+A

§ Ctrl+F2

§ etc.

Note: Letters on their own are not allowed, of course. Thus, you can't use A or Shift+A as shortcut keys.

Shortcut key already assigned: If you press a shortcut key that is already assigned, the current assignment will be
shown just below the input field. You should then press the Backspace keyÕ to delete your shortcut key and
try a different shortcut key. Otherwise, you will overwrite the existing assignment of this shortcut key.

Two-part shortcut keys: You can also use two-part shortcut keys (according to the WordStar standard) – for
example, Ctrl+K+X. However, only shortcut keys according to the scheme "Ctrl + letter + letter" are allowed
here.
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Using the grid
The grid is a positioning aid for objects (placeholders, picture frames, text frames, etc.). When the "Snap to
grid" function is enabled, such objects can no longer be moved freely with the mouse because they snap from
one grid point to the next instead. Something similar happens when you resize an object with your mouse.

Enabling the "Snap to grid" function

To enable or disable the "Snap to grid" function, proceed as follows:

1. Choose the ribbon command View | Grid and guides by clicking directly on the icon  itself.

2. In the dialog box, switch to the Grid tab.

3. Enable or disable the option Snap to grid.

Alternatively: Choose the ribbon command View | Grid and guides  by clicking on the arrow of the icon and
selecting the entry Snap to grid directly in the dropdown menu. A check mark in front of it indicates that the
option is enabled.

If the option is enabled and you move a graphic frame by dragging it with the mouse, for example, it can no
longer move freely. It snaps from grid point to grid point instead.

If you disable this option again, however, objects can be moved completely freely with the mouse.

Temporarily disabling this function: If the option Snap to grid is enabled, you can temporarily disable it at any
time by holding down the Alt key while moving an object with the mouse.

Changing the grid distance

You can set the distance between two grid points to any value.

To do so, proceed as follows:

1. Choose the ribbon command View | Grid and guides by clicking directly on the icon  itself.

2. In the dialog box, switch to the Grid tab.

3. Enter the desired values in the Grid distance section.

Showing the grid on the screen

By default, the grid is not shown on the screen. If you want it to appear on the screen, enable the option Show
grid in the above dialog box.

Alternatively: Click on the arrow of the icon  and select Show grid in the dropdown menu.

Note: The grid appears only on the screen. It does not appear during a slide show or in printouts.
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Using guides
In addition to the grid discussed in the previous section, there is another positioning aid for objects: guides.

You can add horizontal and vertical guides (see below for more information) and enable the "Snap to guides"
function. As soon as you move an object near a guide with the mouse, the object automatically snaps to it – as if
the guide were magnetic. Something similar happens when you resize an object with your mouse.

Enabling the function "Snap to guides"

To enable or disable the "Snap to guides" function, proceed as follows:

1. Choose the ribbon command View | Grid and guides by clicking directly on the icon  itself.

2. In the dialog box, switch to the Guides tab.

3. Enable or disable the option Snap to guides.

Alternatively: Choose the ribbon command View | Grid and guides  by clicking on the arrow of the icon and
selecting the entry Snap to guides directly in the dropdown menu. A check mark in front of it indicates that the
option is enabled.

Note: Even if this option is disabled, the guides can still be displayed and changed, but they will not have any
effect on the repositioning of objects.

Temporarily disabling this function: If the option Snap to guides is enabled, you can temporarily disable it at any
time by holding down the Alt key while moving an object with the mouse.

Showing guides

The option Show guides in the above dialog box allows you to specify whether guides should be displayed on
the screen.

Alternatively: Click on the arrow of the icon and select Show guides in the dropdown menu.

By default, this option is enabled.

Tip: If the option Show guides is disabled, but the option Snap to guides is enabled, the guides become
invisible, but they still retain their function.

Note: Guides appear only on the screen. They do not appear during a slide show or in printouts.

Adding guides in a dialog-box-controlled manner

To set up a new guide, proceed as follows:

1. Choose the ribbon command View | Grid and guides by clicking directly on the icon  itself.
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2. In the dialog box, switch to the Guides tab.

3. Under Horizontal or Vertical, enter where the guide should be set.

4. Click on the Add button.

Note: Guides can only be seen on the screen if the option Show guides (see above) is enabled.

Adding guides with the mouse

Alternatively, guides can also be added with the mouse: You can drag vertical guides from the vertical ruler and
horizontal guides from the horizontal ruler.

To do so, click with the mouse on one of the rulers and drag the mouse cursor into the text area while holding
down the mouse button. Release the mouse button at the point where you want to set the guide.

Tip: If the required rulers are not displayed, enable the option Ruler on the ribbon tab View.

Repositioning and deleting guides

To reposition or delete a guide, proceed as follows:

Dialog box: Choose the ribbon command View | Grid and guides to open the dialog box and switch to the
Guides tab. To remove a guide, select it in the list and click on the Delete button. To reposition a guide, delete
it and then set a new guide at the desired position.

Mouse: Guides can simply be grabbed with the mouse and dragged to another position. Furthermore: If you
slide a guide into the horizontal or vertical ruler, it will be deleted.

Locking guides

To prevent guides from being inadvertently moved with the mouse, they can be "locked".

To do so, choose the ribbon command View | Grid and guides and enable the option Lock guides in the dialog
box.

Guides can no longer be moved with the mouse. Their position can only be changed via the dialog box of the
ribbon command View | Grid and guides.

Using the "Snap to slide borders" function

If you choose the ribbon command View | Grid and guides and enable the option Snap to slide borders, the
four outer edges of slides will behave like guides. Thus, if you drag an object near one of these outer edges, the
object will snap to it.

Temporarily disabling this function: If the option Snap to slide borders is enabled, you can temporarily disable it
at any time by holding down the Alt key while moving an object with the mouse.



399Customizing Presentations

Using the "Snap to other objects" function

FreeOffice: The Snap to other objects function is not included in SoftMaker FreeOffice.

If you choose the ribbon command View | Grid and guides and enable the option Snap to other objects, the
program automatically creates "magic" guides for the edges of each object on the current slide. These guides
make it a lot easier to position objects perfectly aligned and evenly distributed.

These "magic" guides are usually invisible. They only become visible when you drag an object near such a
guide with the mouse. As soon as the guide appears, the object automatically snaps to it. Something similar
happens when you resize an object with your mouse.

Some examples of such guides:

§ If you drag an object to a position where it is roughly left-aligned with another object, a guide will
automatically appear representing the left edge of the other object. If you let your object snap to it, it will be
exactly left-aligned with the existing object. 

§ The same applies to the right edge of objects.

§ If you drag an object to a position where it is roughly centered with another object, a guide will
automatically appear representing the center of the object. If you let your object snap to it, it will be aligned
exactly centered with the other object.

§ If you drag an object to a position below two other objects, you will also see a horizontal guide at the
position where this third object would have exactly the same relative distance as the other two objects. (The
three objects would then be distributed evenly.)

All of this works in both directions (horizontally and vertically) – for example, an automatic guide is generated
for the top and bottom edges of each object.

Temporarily disabling this function: If the option Snap to other objects is enabled, you can temporarily disable it
at any time by holding down the Alt key while moving an object with the mouse.

Changing the tolerance of guides

When moving objects, the mouse cursor snaps automatically to a guide by default when it is moved to within 8
pixels of the guide. However, you can change this tolerance at any time. If, for example, you increase the
tolerance to "20", the mouse cursor will already snap to the guide if it is within 20 pixels of the guide.

To change the tolerance, use the ribbon command View | Grid and guides (click directly on the icon itself) to
open the dialog box and enter the desired value in pixels in the option Tolerance on the Guides tab.
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Installing additional dictionaries

FreeOffice: SoftMaker FreeOffice does not have the premium SoftMaker dictionaries normally included in
SoftMaker Office. Only Hunspell dictionaries can be used here.

You can install additional dictionaries for the spell check as required. For information on how to install these
dictionaries, see the following sections:

§ Installing additional SoftMaker dictionaries 

This section explains how to add additional SoftMaker dictionaries to your installation.

Note: This is only relevant for the Android and iOS version. When you install SoftMaker Office for
Windows, Mac or Linux, all available SoftMaker dictionaries are already included.

§ Installing Hunspell dictionaries 

In addition to SoftMaker dictionaries, SoftMaker Office also supports the use of Hunspell dictionaries. Read
this section to learn more.

§ Choosing a different dictionary for a language 

If you have multiple dictionaries installed for a language (for example, one from SoftMaker and one from
Hunspell), you can also specify which of these dictionaries to use. Read this section for details.

For more information on these topics, see the following pages.

Installing additional SoftMaker dictionaries

FreeOffice: SoftMaker FreeOffice does not have the premium SoftMaker dictionaries normally included in
SoftMaker Office. Only Hunspell dictionaries can be used here.

For information on installing additional Hunspell dictionaries, see the next section (Installing Hunspell
dictionaries) rather than this section.

SoftMaker Office comes with premium dictionaries for numerous languages. In this section, you will learn how
to install dictionaries that are not currently installed:

Windows, Mac and Linux

When you install SoftMaker Office for Windows, Mac or Linux, all available SoftMaker dictionaries are
already included – so there is no need to subsequently install additional SoftMaker dictionaries.
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Android and iOS

The situation is different with SoftMaker Office for Android and iOS: SoftMaker dictionaries that were not yet
installed can be downloaded free of charge from our server at any time and can be installed automatically.

To do so, proceed as follows:

1. Launch any of the apps (TextMaker, PlanMaker or Presentations) on your Android/iOS device.

2. Choose the ribbon command File | Options  for the dialog box and switch to the Language tab.

3. Click on the Get more dictionaries button.

4. The program opens a dialog box with a list of all available languages. To download a language, click on the
download icon to the right of it.

Once the download is complete, the dictionary is automatically installed and will be available from now on in
all SoftMaker Office applications.

Installing Hunspell dictionaries

FreeOffice: SoftMaker FreeOffice does not have the premium SoftMaker dictionaries normally included in
SoftMaker Office. Only Hunspell dictionaries can be used here.

Hunspell dictionaries for English and German are pre-installed. In this section, you'll learn how to
download and install additional Hunspell dictionaries as required.

In addition to SoftMaker dictionaries, SoftMaker Office for Windows, Mac and Linux also support the use of
Hunspell dictionaries. These dictionaries are available as free downloads. Most of them were created by private
users or non-profit organizations.

Hunspell dictionaries are available for numerous languages. If you can't find a dictionary for a language in
SoftMaker Office, it's worth checking if a Hunspell dictionary is available for it.

A list of all Hunspell dictionaries available for SoftMaker Office can be found in the "Downloads" section of
our website www.softmaker.com. There, you can also download the dictionaries free of charge.

To download and install a Hunspell dictionary, proceed as follows:

1. Use your web browser to navigate to our website www.softmaker.com

2. Select "Downloads" from the website menu, and then click on "Dictionaries".

3. Your browser now displays a page with a list of all Hunspell dictionaries supported by SoftMaker Office.
Download the desired dictionary.

4. Launch any SoftMaker Office application (TextMaker, PlanMaker or Presentations).

5. Choose the ribbon command File | Options  for the dialog box and switch to the Language tab.

6. Click on the Hunspell dictionaries button.

http://www.softmaker.com/
http://www.softmaker.com/
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7. The program displays a dialog box with a list of all installed languages/dictionaries. Click on the Add
Hunspell dictionary button.

8. A file dialog appears. Use it to navigate to the folder where the downloaded dictionary has been stored.

9. Select the dictionary file from the file list and click on Open.

The dictionary is now installed and will be available from now on in any SoftMaker Office application.

Choosing a different dictionary for a language

FreeOffice: SoftMaker FreeOffice does not have the premium SoftMaker dictionaries normally included in
SoftMaker Office. Only Hunspell dictionaries can be used here. For more information, see Installing
Hunspell dictionaries.

If you have multiple dictionaries installed for a language (for example, a SoftMaker dictionary and a Hunspell
dictionary), you can always choose which of these dictionaries to use for the language. To do so, proceed as
follows:

1. Choose the ribbon command File | Options  for the dialog box and switch to the Language tab.

2. Click on the Hunspell dictionaries button.

The program displays a dialog box with the list of all installed languages. On the right side of the list, you
can see what type of dictionary the respective language is currently using.

3. Select the desired language from this list.

4. Then specify the dictionary to be used for the selected language in the dropdown list Dictionary. Depending
on which dictionaries are installed, the list may have the following entries:

SoftMaker: The SoftMaker dictionary included in SoftMaker Office

Hunspell: Freely downloadable Hunspell dictionary, see previous section

5. Confirm with OK.

From now on, the spell check will use the selected dictionary for the specified language.
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Appendix
The appendix of the manual contains the following information:

§ Ribbon commands and corresponding menu commands 

In this section, you will find a table of all commands in the ribbon interface and the respective
corresponding menu command in the classic menu interface.

§ Shortcut keys 

This section contains tables with the most important shortcut keys that you can use in the program.

§ Command-line parameters 

Here, you will find an overview of parameters that can be used to directly trigger a specified program option
when you start Presentations.

Ribbon commands and corresponding menu commands
In this section, you will find a table of all commands in the ribbon interface and the respective corresponding
menu command in the classic menu interface.

Tip 1: You can switch the user interface between ribbon and classic menus at any time. To do so, choose the
command File | Options in the ribbon (or choose Tools > Options in the classic menu interface). In the
dialog box, switch to the Appearance tab and click on the User interface button. The program will display a
dialog box in which you can choose the desired user interface.

Tip 2: Use the "hamburger menu" (the icon  on the left in the Quick access toolbar) if you still want to
access the classic menu commands from the ribbon interface.

The subsequent table contains the following columns:

§ Left column: The left column lists all ribbon commands in the program, listed according to the order of
ribbon tabs and in the following format: Ribbon tab | Command group | Command 

§ Right column: The right column lists all corresponding classic menu commands in the program in the
following format: Menu > Command

Example: The ribbon command File | Document | Save can be found under File > Save in the classic menu
interface.

Another entry >> is also added for some commands if the command can only be found in the submenu of an
icon or in a dialog box.

Thus, here is the aforementioned table:
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Ribbon Menu

File | File | New File > New

File | File | Open File > Open

File | File | Close File > Close

File | Document | Save File > Save

File | Document | Save as File > Save as

File | Document | Save all File > Save all

File | Document | Export as >> File > Export as >

File | Document | Export as >> PDF File > Export as > PDF

File | Document | Export as >> HTML File > Export as > HTML

File | Document | Export as >> Pictures File > Export as > Pictures

File | Document | Export as >> Movie File > Export as > Movie

File | Document | Export as >> Portable slide show File > Export as > Portable slide show

File | Document | Send File > Send

File | Print | Page setup File > Page setup

File | Print | Print File > Print

File | File management | Properties File > Properties

File | File management | Versions File > File versions

File | File management | File manager File > File manager

File | Settings | Options Tools > Options

File | Settings | Customize >> Customize ribbon Tools > Customize

File | File | Close (if no document is open) File > Exit
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Ribbon Menu

in the Quick access toolbar Edit > Undo

in the Quick access toolbar Edit > Redo

in the Quick access toolbar View > Touch mode

Home | Edit | Paste Edit > Paste

Home | Edit | Paste >> Paste special Edit > Paste special

Home | Edit | Cut Edit > Cut

Home | Edit | Copy Edit > Copy

Home | Edit | Format painter Format > Transfer formatting

Home | Slide | Add Slide > Insert new slide

Home | Slide | Add >> Slides from presentation Insert > Slides from presentation

Home | Slide | Add >> Slides from outline Insert > Slides from outline

Home | Slide | Layout Slide > Slide layout

Home | Slide | Reset Slide > Reset

Home | Slide | Manage

Home | Slide | Manage >> Duplicate slide Slide > Duplicate

Home | Slide | Manage >> Delete slide Slide > Delete

Home | Slide | Manage >> Rename slide Slide > Rename

Home | Slide | Manage >> Hide slide Slide > Hide slide

Home | Character | Increase font size Toolbar: Formatting

Home | Character | Decrease font size Toolbar: Formatting

Home | Character | Bold Toolbar: Formatting

Home | Character | Italic Toolbar: Formatting
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Ribbon Menu

Home | Character | Underline Toolbar: Formatting

Home | Character | Strike out

Home | Character | Shading Toolbar: Formatting

Home | Character | Font color Toolbar: Formatting

Home | Character | Change capitalization

Home | Character | Reset character formatting Format > Standard

Home | Paragraph | Toggle bullets Toolbar: Formatting

Home | Paragraph | Toggle numbering Toolbar: Formatting

Home | Paragraph | Demote list level Toolbar: Formatting

Home | Paragraph | Promote list level Toolbar: Formatting

Home | Paragraph | Alignment Toolbar: Formatting

Home | Paragraph | Set line spacing

Home | Objects | New object Toolbar: Standard

Home | Objects | New object >> Picture Object > New picture frame

Home | Objects | New object >> Text frame Object > New text frame

Home | Objects | New object >> Chart frame Object > New chart frame

Home | Objects | New object >> AutoShape Object > New drawing > AutoShape

Home | Objects | New object >> Line Object > New drawing > Line

Home | Objects | New object >> Equation Object > New OLE object frame >> SoftMaker
Equation Editor

Home | Objects | New object >> TextArt object Object > New drawing > TextArt

Home | Objects | Fill color Toolbar of the respective object

Home | Objects | Line color Toolbar of the respective object
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Ribbon Menu

Home | Objects | Text rotation Toolbar: AutoShape

Home | Objects | Vertical alignment Toolbar: AutoShape

Home | Objects | Columns Object > Columns > More

Home | Objects | Columns >> One Object > Columns > One column

Home | Objects | Columns >> Two Object > Columns > Two columns

Home | Objects | Columns >> Three Object > Columns > Three columns

Home | Search | Search Edit > Search

Home | Search | Replace Edit > Replace

Home | Search | Search again Edit > Search again

Home | Search | Go to Edit > Go to slide

Home | Selection | Select all Edit > Select all

Insert | Slide | Slide Slide > Insert new slide

Insert | Slide | Photo album Insert > Photo album

Insert | Slide | Summary slide Insert > Summary slide

Insert | Table | Table Object > New table frame

Insert | Objects | Picture frame Object > New picture frame

Insert | Objects | Picture frame >> From scanner File > Acquire

Insert | Objects | Picture frame >> Select source File > Select source

Insert | Objects | Text frame Object > New text frame

Insert | Objects | Chart frame Object > New chart frame

Insert | Objects | AutoShape Object > New drawing > AutoShape

Insert | Objects | Lines Object > New drawing > Line
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Ribbon Menu

Insert | Objects | TextArt object Object > New drawing > TextArt

Insert | Objects | Equation Editor object Object > New OLE object frame >> SoftMaker
Equation Editor

Insert | Objects | OLE object frame Object > New OLE object frame

Insert | Objects | OLE object frame >> TextMaker object Object > New OLE object frame >> TextMaker
Document

Insert | Objects | OLE object frame >> PlanMaker worksheet
object

Object > New OLE object frame >> PlanMaker
Spreadsheet

Insert | Objects | OLE object frame >> PlanMaker chart
object

Object > New OLE object frame >> PlanMaker
Chart

Insert | Media | Movie Object > New media object > Movie

Insert | Media | Sound Object > New media object > Sound

Insert | Links | Hyperlink Format > Link

Insert | Links | Actions Object > Actions

Insert | Comments | Comment Insert > Comment

Insert | Text | Header / footer Insert > Header and footer

Insert | Text | SmartText Insert > SmartText

Insert | Text | Symbol Insert > Symbol

Insert | Text | Character

Design | Design | Layout Slide > Slide layout

Design | Design | Design Slide > Slide design

Design | Design | Tabs Format > Tabs

Design | Design | Replace font Format > Replace font

Design | Scheme | Color scheme Slide > Color scheme

Design | Page setup | Page size File > Page setup
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Ribbon Menu

Design | Page setup | Page orientation File > Page setup

Design | Page setup | Background Slide > Background

Design | Placeholders | Restore Slide > Recreate missing placeholders

Design | Placeholders | Reset placeholder >> Object > Placeholder >

Transition | Preview | Start preview

Transition | Transitions | Transitions Toolbar: Standard

Transition | Transitions | Variants Toolbar: Standard

Transition | Settings | Apply to all slides in the sidebar

Animation | Preview | Start preview in the sidebar

Animation | Animations | Animations

Animation | Animations | Variants

Animation | Animations | Add animation in the sidebar

Animation | Animations | Properties

Animation | Animations | Remove all

Animation | Windows | Animation pane (View > Sidebar)

Animation | Animation scheme | Animation scheme in the sidebar

Animation | Animation scheme | Apply to all slides in the sidebar

Slide show | Review | Spell check Tools > Check spelling

Slide show | Review | Spell check >> Edit user dictionaries Tools > Edit user dictionaries

Slide show | Review | Thesaurus Tools > Thesaurus

Slide show | Review | Research Toolbar: Standard

Slide show | Review | Insert comment Insert > Comment
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Ribbon Menu

Slide show | Manage | Set up show Show > Set up slide show

Slide show | Manage | Custom slide shows Show > Custom slide shows

Slide show | Manage | Hide slide Slide > Hide slide

Slide show | Display | Presenter view Show > Presenter view

Slide show | View | Start Toolbars: Status bar

Slide show | View | Start >> Start from first slide Show > Start slide show

Slide show | View | Start >> Start from current slide Show > Start slide show from current slide

Slide show | View | End Show > End slide show

View | Views | Slides View > Slide

View | Views | Slide sorter View > Slide sorter

View | Views | Outline View > Outliner

View | Views | Notes View > Notes

View | Master | Slide master View > Master > Slide master

View | Master | Handout master View > Master > Handout master

View | Master | Notes master View > Master > Notes master

View | View | Grid and guides Object > Grid and guides

View | View | Grid and guides >> Show grid View > Options > Grid

View | View | Grid and guides >> Show guides View > Options > Guides

View | View | Ruler View > Options > Ruler

View | View | Unprintable characters View > Options > Unprintable characters

View | View | Object boundaries View > Options > Object boundaries

View | View | Color mode >> Color View > Options > Color
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Ribbon Menu

View | View | Color mode >> Grayscale View > Options > Grayscale

View | View | Color mode >> Black and white View > Options > Black and white

View | Zoom | Set zoom View > Zoom level

View | Zoom | Magnify selection View > Magnifying glass

View | Zoom | Actual size View > Actual size

View | Zoom | Fit to slide View > Zoom to slide

View | Windows | Mini sorter View > Mini sorter

View | Windows | Mini outliner View > Mini outliner

View | Windows | Sidebar View > Sidebar

View | Windows | Full screen View > Full screen

View | Windows | Windows >> Window >

View | Windows | Windows >> View side by side Window > View side by side

View | Windows | Windows >> Close all Window > Close all

Table | Table | Select Object > Table > Select table

Table | Table | Select >> Row Object > Table > Select row

Table | Table | Select >> Column Object > Table > Select column

Table | Table | Properties Object > Table > Table properties

Table | Table | Properties >> Row Object > Table > Row properties

Table | Table | Properties >> Cell Object > Table > Cell properties

Table | Format | Shading Toolbar: Table

Table | Format | Borders Toolbar: Table

Table | Format | Text alignment Toolbar: Table
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Ribbon Menu

Table | Rows and columns | Delete cells Toolbar: Table

Table | Rows and columns | Delete cells >> Delete rows Object > Table > Delete rows

Table | Rows and columns | Delete cells >> Delete columns Object > Table > Delete columns

Table | Rows and columns | Delete cells >> Delete table Object > Table > Delete table

Table | Rows and columns | Insert rows Toolbar: Table

Table | Rows and columns | Insert rows >> Insert row above Object > Table > Insert rows above

Table | Rows and columns | Insert rows >> Insert row below Object > Table > Insert rows below

Table | Rows and columns | Insert columns Toolbar: Table

Table | Rows and columns | Insert columns >> Insert column
left

Object > Table > Insert columns to the left

Table | Rows and columns | Insert columns >> Insert column
right

Object > Table > Insert columns to the right

Table | Rows and columns | Distribute rows Object > Table > Distribute rows evenly

Table | Rows and columns | Distribute columns Object > Table > Distribute columns evenly

Table | Merge and split | Merge cells Object > Table > Merge cells

Table | Merge and split | Split cells Object > Table > Split cells

Table | Position | Bring to front Object > Order > Bring to front

Table | Position | Bring to front >> Bring forward one level Object > Order > Bring forward one level

Table | Position | Send to back Object > Order > Send to back

Table | Position | Send to back >> Send backward one level Object > Order > Send backward one level

Slide master | Edit | New design Master > New design

Slide master | Edit | Duplicate layout/design Master > Duplicate layout/design

Slide master | Edit | Add layout Master > Add layout to design
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Ribbon Menu

Slide master | Edit | Delete layout/design Master > Delete layout/design

Slide master | Edit | Rename layout/design Master > Rename layout/design

Slide master | Placeholders | Restore Master > Recreate missing placeholder areas

Slide master | Placeholders | Insert placeholder Master > Insert placeholder

Slide master | Placeholders | Title Master > Title

Slide master | Placeholders | Footers Master > Footers

Slide master | Color scheme | Color scheme Master > Color scheme

Slide master | Format | Page size File > Page setup

Slide master | Format | Page orientation File > Page setup

Slide master | Format | Background Master > Background

Slide master | Close master

Handout master | Format | Number of pages >> (x-per-page)
handouts

Handout > (x-per-page) handouts

Handout master | Format | Number of pages >> Outline Handout > Outline

Media object | Preview | Play media clip Via the context menu

Media object | Preview | Stop media clip Via the context menu

Object | Format | AutoShape templates Toolbar: AutoShape

Object | Format | AutoShape templates >> More Object > Properties

Object | Format | AutoShape effects Toolbar of the respective object

Object | Format | Fill color Toolbar of the respective object

Object | Format | Line color Toolbar of the respective object

Object | Format | Line style Toolbar of the respective object

Object | Format | Line thickness Toolbar of the respective object
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Ribbon Menu

Object | Format | Line endings Toolbar: AutoShape

Object | Edit | Change AutoShape Toolbar: AutoShape

Object | Edit | Edit points Via the context menu

Object | Edit | Combine objects Via the context menu

Object | Inner text | Change text area Toolbar: AutoShape

Object | Position | Rotate object Object > Rotate or flip

Object | Position | Align objects Object > Align or distribute

Object | Objects | Group Object > Group

Object | Objects | Duplicate Edit > Duplicate

OLE object | OLE | OLE object Edit > OLE object

OLE object | OLE | Edit link Edit > Link

OLE object | Size | Cropping Toolbar: Picture

OLE object | Adjust | Recolor picture Toolbar: Picture

Picture | Adjust | Change source Object > Properties: Picture tab >> File...

Picture | Adjust | Reset Toolbar: Picture

Picture | Format | Photo frame Toolbar: Picture

Chart | Type | Chart type Toolbar: Chart

Chart | Type | Chart subtype Toolbar: Chart

Chart | Data | Edit data Object > Chart > Edit data

Chart | Design | Chart colors Toolbar: Chart

Chart | Chart elements | Add chart element Toolbar: Chart

Chart | Chart elements | Select chart element Toolbar: Chart
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Ribbon Menu

Chart | Chart elements | Edit properties Object > Chart > xy element: Properties

Chart | Chart elements | Fill color

Chart | Chart elements | Line color

Chart | Chart elements | Line style

Chart | Chart elements | Line thickness

not available Edit > Delete

Home | Character >> group arrow Format > Character

Home | Paragraph >> group arrow Format > Paragraph

Via the context menu Object > Chart > Save as picture
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Shortcut keys
The following pages contain tables with Presentations' most important shortcut keys:

§ Shortcut keys in Windows and Linux versions 

§ Shortcut keys in Mac version

Tip: If you choose the ribbon command File | Customize , you can customize the default shortcut keys
and create new shortcut keys. For more information, see Customizing shortcut keys.

Shortcut keys in Windows and Linux versions

In the Windows and the Linux version, the following shortcut keys are available:

Shortcut keys for commands

Command Shortcut key

Quick access toolbar: Undo last command Ctrl+Z

Quick access toolbar: Redo Ctrl+Y

File | New Ctrl+N

File | Open Ctrl+O

File | Close Ctrl+F4 or Ctrl+W

File | Save Ctrl+S

File | Print Ctrl+P

File | File manager F12

File | Exit Alt+F4 or Ctrl+Q

Home | Paste Ctrl+V

Home | Paste Special Ctrl+Alt+V

Home | Cut Ctrl+X

Home | Copy Ctrl+C
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Command Shortcut key

Home | Format painter (copying step) Ctrl+Shift+C

Home | Format painter  (pasting step) Ctrl+Shift+V

Home | Add new slide Ctrl+M

Home | group Character:

Select font from the list Ctrl+D

Bold on/off Ctrl+B

Italics on/off Ctrl+I

Underline on/off Ctrl+U

Superscript Ctrl+Shift+Plus key (numeric keypad)

Subscript Ctrl+Shift+Minus key (numeric keypad)

Remove superscript or subscript Ctrl+Shift+Multiply key (numeric keypad)

Change uppercase/lowercase of selected text 
(from "test" to "Test" to "TEST")

Shift+F3

Reset character formatting Ctrl+Space

Home | group Paragraph:

Alignment: Left Ctrl+L

Alignment: Centered Ctrl+E

Alignment: Right Ctrl+R

Alignment: Justified Ctrl+J

Home | Search Ctrl+F

Home | Replace Ctrl+H

Home | Search again (or Replace again) F3

Home | Go to slide... Ctrl+G

Home| Select all Ctrl+A

Insert | Hyperlink Ctrl+K

Insert | Character

Insert a soft hyphen (optional hyphen) Ctrl+Hyphen
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Command Shortcut key

Insert a non-breaking hyphen Ctrl+Shift+Hyphen

Insert an en dash (–) Ctrl+Minus key (numeric keypad)

Insert an em dash (—) Ctrl+Alt+Minus key (numeric keypad)

Insert a non-breaking space Ctrl+Shift+Space

Slide show | Spell check F7

Slide show | Thesaurus Shift+F7

Slide show | Start from first slide F5

Slide show | Start from current slide Shift+F5

View | Full screen F6

Shortcut keys for selecting text

Command Shortcut key

Select single characters (forward) Shift+à

Select single characters (backward) Shift+ß

Select single words (forward) Ctrl+Shift+à

Select single words (backward) Ctrl+Shift+ß

Select up to the end of the line Shift+End

Select up to the beginning of the line Shift+Home

Select paragraph (down) Ctrl+Shift+â

Select paragraph (up) Ctrl+Shift+á

Select up to the end of the placeholder Ctrl+Shift+End

Select up to the beginning of the placeholder Ctrl+Shift+Home

Select all Ctrl+A
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Shortcut keys in current slide shows

Command Shortcut key

Arrow tool (cursor) A

Pen tool R

Highlighter tool M

Eraser tool E

Pause P

Black screen B

White screen W

Previous slide PageUpá or Backspace

Next slide PageDownâ or Space

First slide Home

Last slide End

End slide show Esc

Other useful shortcut keys

Command Shortcut key

Display help content F1

Show/hide ribbon Ctrl+F1

Switch to the next ribbon tab Ctrl+F12

Switch to the previous ribbon tab Ctrl+Shift+F12

For open dialog boxes: switch to the next tab Ctrl+Tab

For open dialog boxes: switch to the previous tab Ctrl+Shift+Tab

Switch to the next slide PageDownâ

Switch to the previous slide PageUpá

Switch to the first slide Home
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Command Shortcut key

Switch to the last slide End

Switch to the next placeholder Tab

Switch to the previous placeholder Shift+Tab

If the cursor is in the placeholder:

Switch to the next placeholder Ctrl+¿

Switch to the previous placeholder Ctrl+Shift+¿

Switch to the beginning of the placeholder Ctrl+Home

Switch to the end of the placeholder Ctrl+End

Insert current date Ctrl+. (period)

Insert current time Ctrl+Shift+. (period)

Convert a hexadecimal character code into Unicode characters* Ctrl+Alt+Shift+X

* If, for example, you type 20AC and then press this shortcut key, a euro sign € will appear (since this character has the code 20AC in the Unicode
character set).

Shortcut keys in Mac version

Note: For most shortcut keys with the Cmd key, you can also use the Ctrl key instead of the Cmd key. For
the shortcut key Cmd+S, for example, you can also press Ctrl+S.

In the Mac version, the following shortcut keys are available:

Shortcut keys for commands

Command Shortcut key

Quick access toolbar: Undo last command Cmd+Z

Quick access toolbar: Redo Cmd+Y

File | New Cmd+N

File | Open Cmd+O

File | Close Cmd+F4 or Cmd+W
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Command Shortcut key

File | Save Cmd+S

File | Print Cmd+P

File | File manager F12

File | Exit Alt+F4 or Cmd+Q

Home | Paste Cmd+V

Home | Paste Special Cmd+Alt+V

Home | Cut Cmd+X

Home | Copy Cmd+C

Home | Format painter (copying step) Cmd+Shift+C

Home | Format painter  (pasting step) Cmd+Shift+V

Home | Add new slide Cmd+M

Home | group Character:

Select font from the list Cmd+D

Bold on/off Cmd+B

Italics on/off Cmd+I

Underline on/off Cmd+U

Superscript Cmd+Shift+Plus key (numeric keypad)

Subscript Cmd+Shift+Minus key (numeric keypad)

Remove superscript or subscript Cmd+Shift+Multiply key (numeric keypad)

Change uppercase/lowercase of selected text 
(from "test" to "Test" to "TEST")

Shift+F3

Reset character formatting Cmd+Space

Home | group Paragraph:

Alignment: Left Cmd+L

Alignment: Centered Cmd+E

Alignment: Right Cmd+R

Alignment: Justified Cmd+J
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Command Shortcut key

Home | Search Cmd+F

Home | Replace Cmd+H

Home | Search again (or Replace again) F3

Home | Go to slide... Cmd+G

Home| Select all Ctrl+A

Insert | Hyperlink Cmd+K

Insert | Character

Insert a soft hyphen (optional hyphen) Cmd+Hyphen

Insert a non-breaking hyphen Cmd+Shift+Hyphen

Insert an en dash (–) Cmd+Minus key (numeric keypad)

Insert an em dash (—) Cmd+Alt+Minus key (numeric keypad)

Insert a non-breaking space Cmd+Shift+Space

Slide show | Spell check F7

Slide show | Thesaurus Shift+F7

Slide show | Start from first slide F5

Slide show | Start from current slide Shift+F5

View | Full screen F6

Shortcut keys for selecting text

Command Shortcut key

Select single characters (forward) Shift+à

Select single characters (backward) Shift+ß

Select single words (forward) Alt+Shift+à

Select single words (backward) Alt+Shift+ß

Select up to the end of the line Shift+End

Select up to the beginning of the line Shift+Home
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Command Shortcut key

Select paragraph (down) Alt+Shift+â

Select paragraph (up) Alt+Shift+á

Select up to the end of the placeholder Cmd+Shift+End

Select up to the beginning of the placeholder Cmd+Shift+Home

Select all Ctrl+A

Shortcut keys in current slide shows

Command Shortcut key

Arrow tool (cursor) A

Pen tool R

Highlighter tool M

Eraser tool E

Pause P

Black screen B

White screen W

Previous slide PageUpá or Backspace

Next slide PageDownâ or Space

First slide Home

Last slide End

End slide show Esc

Other useful shortcut keys

Command Shortcut key

Expand or collapse the ribbon Cmd+F1

Switch to the next ribbon tab Ctrl+F12

Switch to the previous ribbon tab Ctrl+Shift+F12



424Appendix

Command Shortcut key

For open dialog boxes: switch to the next tab Ctrl+Tab

For open dialog boxes: switch to the previous tab Ctrl+Shift+Tab

Switch to the next slide PageDownâ

Switch to the previous slide PageUpá

Switch to the first slide Home

Switch to the last slide End

Switch to the next placeholder Tab

Switch to the previous placeholder Shift+Tab

If the text cursor is in the placeholder:

Switch to the next placeholder Cmd+¿

Switch to the previous placeholder Cmd+Shift+¿

Switch to the beginning of the placeholder Cmd+Home

Switch to the end of the placeholder Cmd+End

Insert current date Ctrl+. (period)

Insert current time Ctrl+Shift+. (period)

Convert a hexadecimal character code into Unicode characters* Cmd+Alt+Shift+X

* If, for example, you type 20AC and then press this shortcut key, a euro sign € will appear (since this character has the code 20AC in the Unicode
character set).
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Command-line parameters

Note: The command-line parameters described here only work on Windows.

Command-line parameters allow you to specify that Presentations is started immediately with a specific
program option rather than with the usual default behavior. Example: You would like Presentations to switch to
the dialog box for selecting a presentation template directly upon startup.

To insert a command-line parameter, proceed as follows:

1. Create a new shortcut to Presentations on the desktop. Ideally, give the link a distinctive name in order to
distinguish it more clearly.

2. Choose the properties of the shortcut: Right-click on the link for the context menu and select the entry
Properties.

3. The following dialog box with the Shortcut tab will then appear:
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4. In the input field Target after the file path "...\Presentations.exe", enter the desired parameter from
the table below. In the figure, for example, this is the parameter -FN.

Important: There must be a space in front of the parameter and the parameter starts with a hyphen.

5. Confirm with OK.

When you open Presentations via this newly created link (double-click on the link), the program will start
directly with the behavior of the parameter that was used.

Command-line parameters

Parameter Description

 -N Presentations starts without opening a new default document

 -FO Presentations starts with an open dialog box for selecting a file.

 -FN Presentations starts with an open dialog box for selecting a presentation
template.

 -P"Path\FileName" Presentations starts and prints the specified file directly on the default
printer.

 -Q"PrinterName","Path\FileName"
Note: No space is inserted
within the parameter.

Presentations starts and prints the specified file directly on the specified
printer.

 -S"Path\FileName"
Note: No space is inserted
within the parameter.

Presentations starts directly in slide show mode.
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3
3D effect (for objects)   126

A
Actions (object)   120

Actual size (view)   374

Add notes   97

Add or remove spaces when pasting   349

Add spacing around punctuation marks (French)   349

Add/edit text  
for AutoShapes   224
for text frames   224

Align (object)  
align and distribute objects   113
snap to grid   396
snap to guides   397
snap to slide borders   397
to other objects with guides   397

Alignment  
of tabs   262
of text in tables   209
of text in text frames   131, 133

All caps   247

All lowercase   247

ALL UPPERCASE   247

Android/iOS  
context menu   26
input method   23
select   62
share a document   303
user interface   23

Animations   230
animation schemes for slides   241
for object animations   94
object animations   230
slide transition   90, 92
SoftMaker effects   231, 234

Anti-aliasing   353

Area chart   154

Associate file types   361

Auto-Recover   358, 360

AutoShape  
add/edit text   224
AutoShape effects   225
AutoShape templates   225
change on ribbon tab Object   225
change on the ribbon tab Object   114
change text area   135
change via the dialog box   128, 227
drawing   222

AutoText   322

Axes (in charts)   160, 180, 181, 183, 185

Axis title (in charts)   184

Axis titles (in charts)   160

B
Background (slide)   88

Background color  
of text   249

Backup copies   332, 360

Backup folder   332, 360

BAK files   332

Bar chart   154

Beep on errors   353

Bold (font)   247

Borders  
of entire tables   213
of objects   125
of table cells   209

Box and whisker plot   154

Boxplot chart   154

Bubble chart   154

Bulleted lists   266

Bullets and numbering   266, 270

Bullets folder   358

C
Capitalize first letter of sentences   349

CAPITALS (all capital letters)   247

Category axis (in charts)   160, 180

Cells (table)   209
cell properties   209
cell width   209
delete   204
insert   205
merge   207
split   207

Center (paragraph)   261

Change shape   114

Change text area  
of AutoShapes   135
of text frames   135

Change the text formatting in master   102

Character format   244
all caps   247
background color   249
bold   247
character pitch   250
embossed (text effect)   247
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Character format   244
font   246
font color   249
font size   246
italics   247
kerning   251
letter spacing   250
point (pt)   246
replace font   255
shadow (text effect)   247
small caps   247
strikethrough   247
superscripts and subscripts   250
text styles   247
underline   247

Character formatting  
apply to entire word   349
change   244
change for whole paragraph   262
change in master   102
reset   254
transfer   253

Character pitch   250

Chart (dialog box)   188

Chart (ribbon tab)   152

Chart area   171

Chart title   162, 185

Charts   149
add/delete data series   158, 188
change chart type   154
change properties   188
edit   152
enter/edit data   150, 158
insert   149
insert manually   150
insert via PlanMaker   150
save as picture   191
select chart elements   169

Check for updates   361

Classic menus with toolbars   11, 353
list of all ribbon commands and menu commands  
403
user interface   22

Close (file)   344

Close document   344

Close tabs   344

Color  
of objects   123
of text   249

Color gradient (for objects)   123

Color mode   347

Color scheme (slide)   37, 85
apply   86

create   87
edit   87

Column chart   154

Column width (table)   209

Columns  
for text in AutoShapes   111
for text in placeholders   111
for text in text frames   111, 131, 133

Combine (object shapes)   115

Combine shapes   115

Command-line parameters   425

Cone chart   154

Context menu   26

Copy  
objects   277
slides   72
text   277

Corners (in charts)   174

Correct first TWo UPpercase LEtters   349

Count keystrokes   370

Count words   370

Create new document   341

Cropping (of pictures)   145, 146

Custom slide shows   287

Customize  
create user-defined icons   393
customize shortcut keys   393
customize toolbars   388
ribbon   378

Cut  
objects   277
slides   72
text   277

Cylinder chart   154

D
Data labels (in charts)   163, 174

Data points (in charts)   174

Data series (in charts)  
Add   158
Delete   158
edit   174

Decimal tab   262

Default file format when saving   358

Default language for spell check   310, 357

Default template (slide design)  
"Normal"   40
switch   40

Default unit of measure   353

Delete  
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Delete  
objects   277
slide   71
table   204
text   38, 277

Design Science   198

Designs (slide designs)   74

Dialog language   353

Dictionaries for spell check[edit]   317

Dictionaries for spell check[install]   400

Display   347

Display help content (F1 key)   416

Distribute (object)   113

Distribute columns evenly (table)   208

Distribute rows evenly (table)   208

Document info  
enter   327
prompt for summary information when saving   358

Document management   325

Document properties   368
Colors tab   369
Fonts tab   371
Protection tab   335, 371
Statistics tab   370
Summary tab   327, 368
View tab   368

Document protection   335

Document statistics   370

Document tabs   26, 340

Document, print   45

Document, save   44

Doughnut chart   154

Drag and drop   277

Draw circles   222

Draw connectors   222

Draw curves   222

Draw ellipses   222

Draw rectangles   222

Drawing object (dialog box)   227

Drawing object (ribbon tab)   225

Drawings   222
change properties   225, 227
combine   115
edit retroactively   117
insert   222
rotate   110

Duplicate (object)   112

Duplicate (slide)   72

E
Edit  

links (OLE objects)   195

Edit chart elements   169
axis title   184
chart area   171
chart title   185
corners   174
data labels   174
data series   174
error bars   174
floor   173
gridlines   186
legend   186
lines   174
plot area   172
trendline   178
up/down bars   174
walls   173
X axis   180
Y axis   181
Z axis   183

Edit color palette   369

Edit points (of objects)   117

Edit shapes retroactively   117

Effects (for objects)   127

E-mail a document   303

Embed fonts   371

Embedding fonts   371

Embossed (text effect)   247

En dashes, different widths   280

Enable OpenGL animations and transitions   361

Enable OpenGL AutoShapes   361

Encryption   335

Equation Editor   198

Error bar (in charts)   163, 174

Exit (file)   45

Export (other file format)   338

Export as  
HTML   303
movie   306
PDF   299
pictures   305
Portable slide show   308

Export/Import of settings   365

F
File  

export as HTML   303
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File  
export as movie   306
export as PDF   299
export as pictures   305
export as portable slide show   308
send by e-mail   303

File formats   338

File manager   328

File properties   368
Colors tab   369
Fonts tab   371
Protection tab   335, 371
Statistics tab   370
Summary tab   327, 368
View tab   368

File type   338

File versions   332, 360

File: Close   344

File: Exit   45

File: New   40, 64

File: Open   42, 338

File: Print   45, 296

File: Properties   368

File: Save   44

File: Save all   44

File: Save as   44, 338

Fill (of objects)   123

First Character Uppercase   247

First line (indent)   257

Fit to slide (view)   374

Flip (objects)   110

Floor (in charts)   173

Folder for bullets   358

Folder for file versions   332, 360

Font   246
bold   247
italic   247
replace   255
underline   247

Font color   249

Font lists, hide fonts   363

Font size   246

Footers   77

Footers (master)   100

Format painter   253

Format URLs as hyperlinks   349

Formatting toolbar   22

Frames  
combine   115
edit retroactively   117

Freehand drawing   222

Full screen mode (view)   375

G
Generic placeholders   136

German spelling reform   314, 357

Glow effect (for objects)   127

Go to slide   67

Grid and guides for objects   396, 397

Grid between table cells   209

Gridlines in charts   164, 186

Group (objects)   113

Guides for objects   397

H
Hamburger menu   18, 20

Handout master   104

Handouts   98

Headers and footers   77
in master view   80
insert in handouts   80
insert in notes   80
insert in slides   78

Hide  
objects   114, 127
slides   73

High-low chart   154

Horizontal ruler  
show   347

HTML export   303

Hunspell dictionaries   357, 400

Hyperlinks (links)   252, 349
for objects   120
for OLE objects   195
format URLs as hyperlinks   349
in text   252

Hyperlinks, remove   252

Hyphen   318
non-breaking hyphen   280, 318
soft (optional) hyphen   318
soft hyphen   280

Hyphenation  
non-breaking hyphen   318
set language   310
soft hyphen   318
use   318
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I
Ignore words that start with a number   357

Import (other file format)   338

Import/Export of settings   365

Indentation   257

Indents   257

Inner margins  
of text frames   131, 133
of text in AutoShapes   228

Inner text (Object properties tab)   228

Input method (Android)   23

Insert  
characters   280
charts   149
comments   282
drawings   222
equations   198
headers and footers   77
media objects   215
objects   107, 277
OLE objects   193
photo album   142
pictures   141
slides   65
slides from a presentation   66
slides from an outline   66
SmartText entries   322
special characters   280
summary slide   83
tables   200
text   277

Insert a new slide   65

Insert characters   280

Insert comment   282

Insert frames and drawings immediately   349

Insert mode / Overwrite mode   29
disable   349

Insert movie   215

Insert pictures from the gallery/camera (Android and
iOS only)   144

Insert sound   215

Insert special characters   280

Installation   14
Android   16
iOS   16
Linux   16
macOS   15
Windows   14

iOS/Android  
context menu   26
input method   23

select   62
share a document   303
user interface   23

Italic (font)   247

J
Justify (paragraph)   261

K
Keep aspect ratio   122

Keep scaling   122

Kerning   251

L
Landscape format   82

Language  
for spell check and hyphenation   310
for user interface   353

Layout (master)  
add   100
delete   100
duplicate   100
new design   100
rename   100

Layout (slide layout)   75

Left (indent)   257

Left align (paragraph)   261

Legend (in charts)   165, 186

Letter spacing   250

Line chart   154

Line spacing   259

Linear regression  
show trend in charts   178

Lines  
as borders of objects   125
drawing   222

Lines (in charts)   166, 174

Links (hyperlinks)  
for objects   120
format URLs as hyperlinks   349
in text   252

Links (OLE objects)  
edit   195
update   195

List   266
with bullets   266
with numbering   270

Live preview   353

Lock  
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Lock  
guides   397
objects   127

Lowercase (all lower letters)   247

M
Magnify selection (view)   374

Manage  
file versions   332, 360

Manage (button in the settings)   364

Management  
slide commands   77

Margins  
inner margins of AutoShapes   228
inner margins of text frames   131, 133

Markers for formatting marks   347

Master (formatting)  
change character formatting in master   102
change paragraph formatting in master   102
change text formatting in master   102

Master (ribbon tab)   100
footers   100
insert placeholder   100
layout   100
new design   100
title   100

Master (view)   373
handout master   104
notes master   104
slide master   75, 99

Master view   75

MathType   198

Maximum number of undo steps   349

Media object (dialog box)   218

Media object (ribbon tab)   216

Media objects   215
change properties   218
insert   215
options   216

Menu bar   22

Menus with toolbars or ribbon?   18, 353

Middle mouse button   349

Mini outliner (view)   28, 69, 373

Mini sorter (view)   28, 67, 373

Mirror (objects)   110

Movie export   306

N
Names (of objects)   112

Names (of tables)   112

New (File)   40, 64

New design (master)   100

New program window   341

Non-breaking hyphen   280, 318

Non-breaking space   262, 280

Normal.prvx   40

Notes (view)   373

Notes master   104

Numbered list   270

Numbered lists   266

O
Object  

copy   277
cut   277
delete   277
paste   277
select   61, 108

Object (dialog box)   122

Object animations   94, 230
add   231, 234
change properties   238

Object properties  
change default settings   129
for charts   188
for drawings   225, 227
for media objects   218
for OLE objects   195, 197
for pictures   146
for tables   213
for text frames   131, 133
general properties   122
of placeholders   138

Object toolbar   22

Objects   106
add actions   120
align and distribute   113
animations   230
change order   111
change position and size   108
change properties   122
combine   115
create columns for inner text   111
duplicate   112
edit retroactively   117
group   113
Hide   114
insert   107
position   122
print unprintable objects   368
rotate   122
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Objects   106
rotate or flip   110
show hidden objects   114, 368
show invisible objects   368
show object boundaries   347
size   122
ungroup   113

OLE object (dialog box)   197

OLE object (ribbon tab)   195

OLE objects   192
change properties   195, 197
edit   194
edit links   195
Equation Editor   198
insert   193
update links   195
warning when loading   349

Open (file)   42, 338

Optional hyphen   318

Order  
change slide order   71

Order of objects  
change   111

Ordinal numbers with superscript   349

Orientation  
of the slide   82

Other file formats   338

Outline (view)   70, 373

Overlapping objects   228

Overwrite mode / Insert mode   29
disable   349

P
Page setup  

page orientation   82
page size   82
slide format   82

Paper size   82

Paragraph alignment   261

Paragraph format   256
change character formatting   262
indent   257
indentation   257
line spacing   259
non-breaking space   262
paragraph alignment   261
paragraph spacing   260
ruler   257, 262
tabs   262

Paragraph formatting  
change   256
change in master   102

Paragraph spacing   260

Password  
for documents   335

Paste  
slides   72
special   278

Paste copied contents   278

Paste special   278

PDF export   299

PDF/A export   299

Photo album, insert   142

Photo frames   114, 145

Picture (dialog box)   146

Picture (ribbon tab)   145

Pictures   141
change properties   146
change source   145
copy to document's folder   141
export   146
export slides as pictures   305
from scanner   144
insert   141
insert photo album   142
recolor   145, 146
rotate or flip   110
save within document   141
select source   144

Pie chart   154

Pinned files   42

Pinned templates   40

Placeholders   135
change properties   138
delete   140
edit   136
insert   100, 136
recreate missing placeholders   140
reset properties   139
restore deleted placeholders   100, 140
rotate or flip   110

Plot area (in charts)   172

Point (pt)   246, 256

Portable slide show   308

Portrait format   82

Position (of objects)   108, 122

PowerPoint file format   338, 358

PPT file format   338

PPTX file format   338

PRBAK files   332

PRD file format   338

PRDX file format   338

Presentations  
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Presentations  
basics   17
customize   346
manual   12
settings   347
user interface   18

Presentations basics   17

Presentations file format   338

Presentations manual   12

Presentations tour   46

Presenter view   291, 347

Prevent hyphenation of words   262

Preview (of a document)   42

Print (File)   296

Print a presentation   45, 296

Print unprintable objects   368

Printable (object property)   127

Prompt for summary information when saving   358

Properties (document)   368
Colors tab   369
Fonts tab   371
Protection tab   335, 371
Statistics tab   370
Summary tab   327, 368
View tab   368

Properties (object)  
for charts   188
for drawings   225, 227
for media objects   218
for OLE objects   195, 197
for pictures   146
for tables   213
for text frames   131, 133
of placeholders   138

Properties (objects in general)  
change default settings   129
general properties   122

Protect  
documents   335

Pyramid chart   154

Q
Quick access toolbar   20

change position   353, 382
customize icons   382

Quick paths   325

Quotes, smart   349

R
Radar chart   154

Recreate missing placeholders   100, 140

Redo   47

Redo (changes)   47

Reflection effect (for objects)   127

Rename (slide)   73

Replace  
fonts   255
text   275

Replace again   276

Research via the Internet   321

Reset  
character formatting   254
PDF export options   299
picture settings   145
placeholders   139
ribbon   378
slide   73
SoftMaker Office settings   365
toolbars   387

Restore (placeholders)   140

Restore deleted placeholders   100, 140

Retain design (master)   100

Revert to previous version (file)   332

Ribbon   11, 20
create user-defined icons   393
customize   376
customize groups   378
customize icons   378
list of all ribbon commands and menu commands  
403
manage   378
reset   378
show/hide   377
user interface   20, 353, 376

Ribbon or menus with toolbars?   18, 353

Rich Text Format   338

Right (indent)   257

Right align (paragraph)   261

Rotate  
axis labels   180, 181, 183, 185
objects   110, 122
text in AutoShapes   228
text in text frames   131, 133

Rotate or flip (object)   110

Row height (table)   209

Row properties (table)   209

Ruler  
for indents   257
for objects   108
for tabs   262

Run a slide show   284
custom slide shows   287
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Run slide show  
interaction   289
presenter view   291

Running a slide show   284

S
Save (File)   44

Save all (File)   44

Save as (File)   44, 338

Scale document   353

Scan pictures   144

Screen resolution   347

Scribble mode on iOS   23

Search   274
files   329
go to slide   67
text   274

Search (file manager)   329

Search again   276

Search and replace   274

Search files (file manager)   329

Select   38, 61
always select whole word   349
object   61
objects   108
slides   67
table   203
text   38, 61

Select all   61, 67

Select chart elements   169

Select source (file)   144

Select whole word   349

Select whole words when selecting   349

Send a document by e-mail   303

Series axis (in charts)   160, 183, 185

Set as default (object properties)   129

Settings (Presentations)   346, 347
Appearance tab   353
Backup tab   360
Edit tab   349
Files tab   358
Fonts tab   363
General tab   349
Language tab   357
System tab   361
View tab   347

Settings (SoftMaker Office)  
export/import   365
reset   365

Shading  

of entire tables   213
of table cells   209

Shadow  
as text effect   247
for objects   125

Share a document (via Android/iOS)   303

Shortcut keys  
customize   393
for special characters   280
predefined: Mac   416
predefined: Windows/Linux   416

Show fonts in font list   353

Show formatting in outline view   347

Show formatting marks   347

Show hidden files and folders   361

Show hidden objects   368

Show invisible objects   114, 368

Show non-printable characters   347

Show object boundaries   347

Show paragraph marks   347

Show scrollbars   347

Show tooltips   353

Show unprintable characters   347

Show warning when loading OLE objects   349

Show/hide chart elements   160
axes (X, Y, Z)   160
axis title   160
chart title   162
data labels   163
error bars   163
gridlines   164
legend   165
lines   166
trendline   166
up/down bars   167

Show/hide keyboard automatically   361

Sidebar  
for object animations   95, 231
for slide animation schemes   95, 241
for slide background   88, 95
for slide color scheme   86, 95
for slide design   74, 95
for slide layout   75, 95
for slide transition   90, 95

Sidebar (view)  
options   95
show   28, 373

Size (of objects)   108, 122

Slide  
background   88
change order   71
color scheme   85, 86, 87
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Slide  
copy   72
cut   72
delete   71
duplicate   72
handouts   98
headers and footers   77
hide   73
insert from a presentation   66
insert from an outline   66
management   77
orientation   82
paste   72
rename   73
reset   73
select   67

Slide background   88

Slide color scheme   86

Slide design   34, 74

Slide layout   36, 75

Slide master   75, 99

Slide show  
setup   285

Slide sorter (view)   70, 373

Slide transition   90, 92

Small caps   247

Smart quotes   349

SmartText   322

SmartText entries  
create   322
edit   324
expand   349
insert   323
replace automatically   323

Smooth edges of pictures   361

Smooth edges of screen fonts   353

Snap to grid   396

Snap to guides   397

Snap to other objects   397

Snap to slide borders   397

Snapshots (backup copies)   332, 360

Soft edges effect (for objects)   127

Soft hyphen   280, 318

SoftMaker   12

SoftMaker effects   90, 92, 231, 234, 361

SoftMaker Equation Editor   198

Space  
non-breaking   262

Spaces, different widths   280

Special placeholders   136

Spell check   311

edit user dictionaries   317
in the background (as you type)   313, 357
install additional dictionaries   400
manual   312
set language   310

Standard toolbar   22

Start a slide show   284
automatically   284
with the current slide   284
with the first slide   284

Statistics   370

Status bar   29
show/hide   353

Stock chart   154

Strikethrough   247

Subscripts   250

Summary slide, insert   83

Superscripts   250

Support   12

Surface chart   154

Synonym dictionary (thesaurus)   319

System requirements   13

T
Tab alignment   262

Tab leaders   262

Table   200
cell properties   209
cell width   209
delete   204
delete cells   204
delete, copy, move cell contents   204
distribute columns evenly   208
distribute rows evenly   208
format   208, 209
insert   200
insert cells   205
merge cells   207
row height   209
row properties   209
select   203
split cells   207
table properties   213

Table (dialog box)   213

Table (ribbon tab)   202

Table position   200, 213

Table size   200, 213

Tablet mode (Android/iOS)   353

Tabs   262

Tabs for documents   26, 340

Technical support   12
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Template folder   358

Text   38
copy   277
cut   277
delete   38, 277
highlight   249
paste   277
select   38, 61

Text (Object properties tab)   229

Text alignment  
of paragraphs   261
of table cells   209

Text frames   131
add/edit text   224
change properties   131, 133
change text area   135
insert   131

Text styles   247

TextArt objects  
change properties   229
drawing   222
transformation   229

Thesaurus   319
set language   310
use   319

Title (master)   100

Title bar   19

Title placeholders   136

Toolbars for Android/iOS  
customize   23
user interface   23, 353

Toolbars for classic menus  
create user-defined icons   393
customize   384, 388
delete   387
locked   386
manage   387
position   386
rename   387
reset   387
show/hide   384
user interface   353, 384
visible in mode   384

Touch mode   353

Transformation (of TextArt objects)   229

Transparency (of pictures)   146

Trendline (in charts)   166, 178

U
Underline (font)   247

Underline old German spellings in blue   315, 357

Undo (changes)   47

Ungroup (objects)   113

Unit of measure   256, 353

Unpinned files   42

Unpinned templates   40

Up/down bars (in charts)   167, 174

Updates   361

UPPERCASE (all capital letters)   247

Use as default  
slide design   40

Use left Alt as shortcut key   349

Use OpenGL engine (Linux only)   361

Use SHM extensions   361

Use system file dialogs   353

Use system menus   353

Use XIM   361

User dictionaries   317

User info   349

User interface (ribbon or menus?)   18, 353

User interface on Android/iOS   23, 353

User interface size   353

V
Value axis (in charts)   160, 181

Version management   332, 360

Vertical alignment  
of text frames   131, 133
of text in AutoShapes   228

View  
actual size   374
fit to slide   374
full screen   375
magnify selection   374
master   99, 373
mini outliner   373
mini sorter   373
notes   97, 373
outline   70, 373
sidebar   95, 373
slide   70, 373
slide sorter   70, 373
touch mode   353
windows   342
zoom   374
zoom level   374

View (master)  
handout master   104, 373
notes master   104, 373
slide master   75, 100, 373

View (options)   373
color mode   347
grid and guides   396, 397
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View (options)   373
horizontal ruler   347
object boundaries   347
unprintable characters   347

View side by side (windows)   342

Visible (object property)   127

W
Walls (in charts)   173

Windows  
close all   344
View side by side   342

Workspace color   353

X
X axis (in charts)   160, 180

XY scatter chart   154

Y
Y axis (in charts)   160, 181

Z
Z axis (in charts)   160, 183, 185

Zoom (view)   374

Zoom level (view)   374
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